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Product Symbols for Xerox® PrimeLink® B9100/B9110/B9125/ 
B9136 Production Press

SYMBOL DESCRIPTION

Warning: 

Indicates a hazard that can cause serious injury or death if not avoided.

Hot Warning: 

Hot surface on or in the printer. Use caution to avoid personal injury.

Pinch Hazard: 

This warning symbol alerts users to areas where there is the possibility of personal 
injury.

Caution: 

Indicates a mandatory action to take to avoid damage to the property.

Do not touch the part or area of the printer. 

Do not touch the part or area of the printer. 

Do not expose the drum cartridges to direct sunlight. 

Do not burn the item. 

Do not burn the toner cartridges. 

Do not burn the drum cartridges. 

Do not burn the waste cartridge. 

Do not touch the surface of the drum cartridge. 

To avoid damage to the printer, do not open the document feeder wider than 40° 
maximum. 



SYMBOL DESCRIPTION

Hot surface. Wait for the indicated time before handling. 

On 

Off 

Standby 

Do not use paper attached with staples or any form of binding clip. 

Do not use folded, creased, curled, or wrinkled paper. 

Do not load or use inkjet paper. 

Do not reload paper previously printed on or used. 

Do not use postcards. 

Do not use envelopes. 

Do not use transparencies or overhead projector sheets. 

Do not copy money. 

Add paper or media. 

Paper Jam 

14 Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide

Product Symbols for Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press



SYMBOL DESCRIPTION

Lock 

Unlock 

Paper Clip 

Cooling 

Elapsed Time 

Supply Paper 

Supply Paper Face Down 

1-Sided Original 

Hole-punched Paper 

Indicates the direction to feed paper. 

Envelope print side up, flap down and closed. 

Heavy weight paper is equal to or greater than 117 g/m2. 

Toner Waste Container 

USB 

Universal Serial Bus
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SYMBOL DESCRIPTION

LAN 

Local Area Network

Fax 

Clean the indicated area or part. 

Weight 

Start Button 

Stop Button 

Pause Printing Button 

Log In/Out Button 

Help Button 

Services Home Button 

Services Button 

Job Status Button 

Printer Status Button 

Language Button 

Power Saver Button 

Sleep Mode 
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SYMBOL DESCRIPTION

Clear All Button 

Dial Pause Button 

This item can be recycled. 
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Notices and Safety

Carefully read the following instructions before operating your printer. Refer to these instructions to ensure the 
continued safe operation of your printer.

Your Xerox® printer and supplies are designed and tested to meet strict safety requirements. Safety requirements 
include safety agency evaluation and certification, and compliance with electromagnetic regulations and 
established environmental standards.

The safety and environment testing and performance of this product have been verified using Xerox® materials 
only.

Unauthorized alterations, which can include the addition of new functions or connection of external devices, can 
affect the product certification. For more information, contact your Xerox® representative.
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Electrical Safety

GENERAL GUIDELINES

Warning:  

• Do not push objects into slots or openings on the printer. Touching a voltage point or shorting out a 
part could result in fire or electric shock.

• Do not remove the covers or guards that are fastened with screws unless you are installing optional 
equipment and are instructed to do so. Turn off the printer when performing these installations. 
Disconnect the power cord when removing covers and guards for installing optional equipment. Except 
for user-installable options, there are no parts that you can maintain or service behind these covers.

EMERGENCY POWER OFF

The following are hazards to your safety:

• The power cord is damaged or frayed.

• Liquid is spilled into the printer.

• The printer is exposed to water.

• The printer emits smoke, or the surface is unusually hot.

• The printer emits unusual noise or odors.

• The printer causes a circuit breaker, fuse, or other safety device to activate.

If any of these conditions occur, do the following:

1. Turn off the printer immediately.

2. Disconnect the power cord from the electrical outlet.

3. Call an authorized service representative.

POWER CORD AND ELECTRICAL SUPPLY

Warning:  

• Use the power cord supplied with your printer.

• Do not remove or modify the power cord.

• Ensure that the electrical outlet is near the printer and is easily accessible.

• Plug the power cord directly into a properly grounded electrical outlet. Ensure that each end of the 
cord is connected securely. If you do not know if an outlet is grounded, ask an electrician to check the 
outlet.
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Warning:  

• To avoid risk of fire or electrical shock, do not use an extension cord.

• Do not use a ground adapter plug to connect the printer to an electrical outlet that does not have a 
ground connection terminal.

• The electrical supply for the printer must meet the requirements stated on the data plate on the rear 
of the device. If necessary, consult your local electricity provider or a licensed electrician.

• Do not place the printer in an area where people can step on the power cord.

• Do not place objects on the power cord.

• Do not plug or unplug the power cord while the power switch is in the On position.

• If the power cord becomes frayed or worn, replace the power cord.

• To avoid electrical shock and damage to the cord, grasp the plug when unplugging the power cord.

DISCONNECT DEVICE

The power cable is the disconnect device for this equipment. To remove all electrical power from the machine, 
disconnect the power cable from the electrical outlet.
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Operational Safety

Your Xerox equipment and supplies were designed and tested to meet strict safety requirements. These include 
safety agency examination, approval, and compliance with established environmental standards.

Your attention to the following safety guidelines helps to ensure the continued, safe operation of your printer.

OPERATIONAL GUIDELINES

• Do not remove any trays when the printer is printing.

• Do not open the doors when the printer is printing.

• Do not move the printer when it is printing.

• Keep hands, hair, neckties, and so on, away from the exit and feed rollers.

• Covers, which require tools for removal, protect the hazard areas within the printer. Do not remove the 
protective covers.

• Do not override any electrical or mechanical interlock devices.

• Do not attempt to remove paper that is jammed deeply inside the printer. Power off the printer promptly, then 
contact your local Xerox representative.

Warning:  

• The metallic surfaces in the fuser area are hot. Always use caution when removing paper jams from 
this area and avoid touching any metallic surfaces.

• To avoid a tip hazard, do not push or move the device with all of the paper trays extended.

• Do not place containers of coffee or other liquid on the Production Press.

OZONE INFORMATION

This printer produces ozone during normal operation. Ozone is heavier than air. The amount of ozone produced is 
dependent on copy volume. Install the printer in a well-ventilated room.

For more information, refer to Facts about ozone and Facts about ventilation on www.xerox.com/en-us/about/ehs/ 
health-and-safety.

PRINTER LOCATION

• Place the printer on a level, solid, non-vibrating surface with adequate strength to hold the weight of the printer. 
To find the weight for your printer configuration, refer to Physical Specifications in the User Guide.

• Do not block or cover the slots or openings on the printer. These openings are provided for ventilation and to 
prevent overheating of the printer.

• Place the printer in an area where there is adequate space for operation and servicing.

• Do not attempt to move the Production Printer. A leveling device that was lowered when your Production Printer 
was installed may damage the carpet or floor.
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• Place the printer in a dust-free area.

• Do not store or operate the printer in an extremely hot, cold, or humid environment.

• Do not place the printer near a heat source.

• Do not place the printer in direct sunlight to avoid exposure to light-sensitive components.

• Do not place the printer where it is directly exposed to the cold air flow from an air conditioning system.

• Do not place the printer in locations susceptible to vibrations.

• For optimum performance, use the printer at the altitude specified in the Environmental Specifications in the 
User Guide.

PRINTER SUPPLIES

• Use the supplies designed for your printer. The use of unsuitable materials can cause poor performance and a 
possible safety hazard.

• Follow all warnings and instructions marked on, or supplied with, the product, options, and supplies.

• Store all consumables in accordance with the instructions given on the package or container.

• Keep all consumables away from the reach of children.

• Never throw toner, toner cartridges, drum cartridges, or waste cartridges into an open flame.

Warning: When handling cartridges containing ink, toner or fuser fluid, avoid skin or eye contact. Eye 
contact can cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can 
increase the risk of skin or eye contact.

Caution: Use of non-Xerox supplies is not recommended. The Xerox Warranty, Service Agreement, and 
Total Satisfaction Guarantee do not cover damage, malfunction, or degradation of performance caused 
by use of non-Xerox supplies, or the use of Xerox supplies not specified for this printer. The Total 
Satisfaction Guarantee is available in the United States and Canada. Coverage could vary outside these 
areas. Contact your Xerox representative for details.
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Laser Safety

NORTH AMERICA LASER SAFETY

This product complies with safety standards and is certified as a Class 1 Laser product under the Center for Devices 
and Radiological Health (CDRH) of the United States Food and Drug Administration (FDA) implemented regulations 
for laser products. This product complies with FDA performance standards for Laser products except for deviations 
pursuant to Laser Notice No. 50 dated June 24, 2007. These regulations apply to laser products marketed in the 
United States. The label on the machine indicates compliance with CDRH regulations and must be attached to laser 
products marketed in the United States. This product does not emit hazardous laser radiation.

LLaasseerr WWaarrnniinngg

Use of controls or adjustments or performance of procedures other than those specified herein may result in 
hazardous exposure of laser light.

Since radiation emitted inside this product is completely confined within the protective housing and external covers, 
the laser beam cannot escape from the machine during any phase of the user operation.

This product contains laser warning labels. These labels are intended for use by the Xerox Service Representative 
and are placed on or near panels or shields that require special tools for removal. Do not remove any of the panels. 
There are no operator serviceable areas in these covers.

EUROPEAN UNION LASER SAFETY

This product complies with IEC’s safety standard EN 60825-1: 2014.

The equipment complies with laser product performance standards set by governmental, national, and international 
agencies as a Class 1 Laser Product. It does not emit hazardous radiation as the beam is totally enclosed during all 
phases of customer operation and maintenance.

Warning: Use of controls or adjustments or performance of procedures other than those specified herein 
may result in hazardous radiation exposure.

This product contains laser warning labels. These labels are intended for use by the Xerox Service Representative 
and are placed on or near panels or shields that require special tools for removal. Do not remove any of the panels. 
There are no operator serviceable areas in these covers.

If you need additional safety information concerning the product or Xerox supplied materials, you may send email 
request to EHS-Europe@xerox.com.
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Battery Safety

One or more circuit boards in the printer contain a lithium battery.

Do not attempt to repair or replace the lithium battery. If there is a problem with the battery, contact an 
authorized service representative to correct the problem.

Warning: If the battery on a circuit board is installed incorrectly, there is a risk of explosion.

The lithium battery in the printer contains Perchlorate Material. For information about the special handling 
procedures associated with Perchlorate Material, refer to www.dtsc.ca.gov/hazardouswaste/perchlorate.
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Telephone Line Cord Safety

Warning: To reduce the risk of fire, use only No. 26 American Wire Gauge (AWG) or larger 
telecommunication line cord.
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Maintenance Safety
• Do not carry out any maintenance procedure that is not described in the customer documentation.

• Use supplies and cleaning materials only as directed. 

Warning: Do not use aerosol cleaners. Aerosol cleaners can cause explosions or fires when used on 
electromechanical equipment.

• Do not remove the covers or guards that are fastened with screws. Customer service items are not located 
behind these covers.

• In case of a dry ink or toner spill, use a broom or a wet cloth to wipe off spilled dry ink or toner. Sweep slowly to 
minimize generation of dust during clean up. Avoid using a vacuum. If a vacuum must be used, the unit should 
be designed for combustible dusts having an explosion rated motor and non-conductive hose.

HHoott WWaarrnniinngg

The metallic surfaces in the fuser area are hot. Use caution when removing paper jams from this area and avoid 
touching any metallic surfaces.

Note: Your Xerox Production Press is equipped with a power saving device to conserve power when the 
Production Press is not in use. The Production Press can be left on continuously.
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Consumable Information

Warning: When handling cartridges containing ink, toner or fuser fluid, avoid skin or eye contact. Eye 
contact can cause irritation and inflammation. Do not attempt to disassemble the cartridge, which can 
increase the risk of skin or eye contact.

• Store all consumables in accordance with the instructions given on the package or container.

• Keep all consumables away from the reach of children.

• Never throw toner, print cartridges, or toner containers into an open flame.

For information on Xerox® supplies recycling programs, go to www.xerox.com/recycling.
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Environmental, Health, and Safety Contact Information

For more information on Environment, Health, and Safety in relation to this Xerox product and supplies, contact: 

• United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

• Europe: EHS-Europe@xerox.com

For product safety information in the United States and Canada, go to www.xerox.com/environment.

For product safety information in Europe, go to www.xerox.com/environment_europe.
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Parts of the Printer

1. Optional High Capacity Feeder (HCF), Trays 6 and 7

2. Bypass tray, Tray 5

3. Duplex Automatic Document Feeder (DADF)

4. Document cover

5. Document glass

6. User Interface (UI); Control Panel

7. Optional Production Ready Finisher

8. Front cover

9. Left cover for toner

10. Trays 1–4

11. Waste cartridge cover

12. Front cover on optional HCF

13. Lower left cover

14. Interface Decurler Module (IDM)

15. Optional Inserter Module

16. Optional Crease and Two-Sided Trimmer

17. Optional C/Z Folder
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INTERNAL PARTS

1. Left cover

2. Top cover

3. Confirmation indicator

4. Document guides

5. Document feeder tray

6. Document output tray

7. Document stopper

8. Main power switch

9. Waste toner container cover

10. Waste toner container

11. Fusing unit

12. Handle

13. Transfer module

14. Toner cartridge
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DUPLEX AUTOMATIC DOCUMENT FEEDER

Tips for using the Duplex Automatic Document Feeder (DADF):

• Use the DADF to scan a maximum of 250 documents at a time.

• If you use mixed-size original documents, align the top-left corners in the document handler.

• Before you load documents in the DADF, remove all staples and paper clips.

• For the best output, do not load wrinkled or torn documents into the DADF.

USER INTERFACE (UI)

The user interface contains a control panel and touch screen, where you can select options, view printer 
information, and do selected tasks. 

NUMBER COMPONENT FUNCTION 

1 Touch screen Displays messages required for operation and buttons for features. 
Touch the screen to instruct operations and set features. 

2 Machine Status Press this button to verify the machine status, usage meters, the 
status of consumables, and to print reports. 

3 Job Status Press this button to verify or cancel the current job, to verify or print 
stored jobs, or to verify completed jobs. 
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NUMBER COMPONENT FUNCTION 

4 Services Home Press this button to display the main Services Home screen. The 
Services Home screen, by default, displays the available service 
buttons such as Copy, Email, Network Scanning, Store to Folder, and 
Send from Folder. A system administrator can change the Services 
Home screen to display a specific feature, such as Copy. For more 
information, refer to the Xerox® PrimeLink® B9100/B9110/B9125/ 
B9136 Production Press System Administrator Guide. 

5 Services Illuminates when the main power is on. 

6 Help Press this button to display the Help system. 

7 Dial Pause Press this button to insert a dial pause in a telephone or fax number. 

8 C Press this button to clear the last entry. 

9 Keypad Use the keypad to enter alphanumeric data. 

10 Interrupt Press this button to suspend a copy or print job in progress and stop 
the device to process another job. During the Interrupt mode, the 
Interrupt button illuminates. To exit the Interrupt mode and resume 
the suspended job, press the Interrupt button again. 

11 Start Press this button to perform certain functions, such as scanning a 
document. 

12 Stop Press this button to pause the current job or communication. 

13 Clear All Press this button to return all selections to the default values. The 
printer returns to the same state as at power-on. 

14 Power Saver When the printer is inactive, it enters the Power Saver mode to 
reduce power consumption. When the Power Saver mode is active, 
the Power Saver button illuminates. Press this button to exit the 
Power Saver mode. 

15 Log In/Log Out This button illuminates when a user is logged in through the System 
Administration mode, the Authentication mode, or the Accounting 
mode. Press this button to display the User ID entry screen for 
entering the System Administration mode, the Authentication mode, 
or the Accounting mode. Press the button again to exit the modes. 

16 Services on screen Use the onscreen options to enter the various service windows to 
make feature selections. The Copy, Network Scanning, Store to USB, 
and other options are available. 

17 Login field Displays the currently logged-in user. Select this option to log in to 
the System Administration, Authentication, or Accounting modes. 

18 Message field Displays messages to users. 

19 Language Press the button to display the language options to users.  
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Accessories

Various optional feeding and finishing devices are available with your Xerox printer. The devices are discussed 
briefly on the following pages, along with where to find specific information on each device.

FEEDING ACCESSORIES

The following optional feeding accessories are compatible with your printer.

High Capacity Feeder, Trays 6 and 7

The letter-size two-tray High Capacity Feeder (HCF), Trays 6 and 7, provides an extra 4000-sheet capacity for A4 
(210 x 297 mm) or 8.5 x 11 in. paper. Each tray holds 2000 sheets, from 16–lb. Bond to 80–lb. Cover, or 52–216 g/ 
m2.

The High Capacity Feeder (HCF) has four fixed Long Edge Feed (LEF) positions, which are marked on the tray:  

• B5

• 10.5 in.

• 11 in.

• A4

The High Capacity Feeder (HCF) has one variable LEF custom position, which supports custom paper sizes from 297 
x 182 mm (11.69 x 7.2 in.) to 330.2 x 241 mm (13 x 9.5 in.).

Oversized High Capacity Feeder (OHCF), Trays 6 or 7

The Oversized High Capacity Feeder (OHCF) is available in a 1-tray or 2-tray option. The OHCF feeds a variety of 
stock sizes, including standard and oversized stock up to 330.2 x 488 mm (13 x 19.2 in.). Each tray holds 2000 
sheets.
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Note:  

• The 2-Tray Oversized High Capacity Feeder (OHCF) is not available with the Xerox® PrimeLink® B9100 
Production Press configuration.

• The 1-Tray Oversized High Capacity Feeder (OHCF) is not available with the Xerox® PrimeLink® B9136 
Production Press configuration.
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High Capacity Vacuum Feeder

High Capacity Vacuum Feeder (HCVF) Components

1. Error Indicator

2. Paper Level and Tray in Use Indicator

3. Tray 5, Bypass Tray

4. Circuit Breaker Switch

5. Tray 6 of High Capacity Vacuum Feeder

6. Tray 7 of High Capacity Vacuum Feeder

7. Right Side Cover

The following information applies to the High Capacity Vacuum Feeder:

• When a paper jam occurs, the error indicator illuminates.

• For the paper level indicator, when the corresponding tray is active, the top active indicator illuminates. The four 
center indicators, 1=25%, indicate the amount of remaining paper. When all four indicators are off, the tray is 
empty and the Empty Paper Indicator illuminates.

• In the event of fault current or a short circuit, the circuit breaker disconnects the electrical supply to the device 
automatically.

• To clear paper jams, open the right side cover.

FINISHING ACCESSORIES

The following optional finishing accessories are compatible with your printer.
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Interface Module

The Interface Decurler Module provides the following functions:

• Communication between the press and the attached finishing device.

• An aligned paper path between the press and the attached finishing device.

• Cooling and decurling of the paper as it exits the press.

The following finishing accessories require the Interface Decurler Module:

• GBC® AdvancedPunch® Pro

• High Capacity Stacker

Inserter Module

Use the Inserter Module to load paper such as blank, pre-printed, or special stock that you want inserted into the 
finished output. 

Note: The Inserter Module is provided with the production ready finisher. For details, refer to Overview of the 
Production Ready Finishers.

GBC® AdvancedPunch™ Pro

The GBC® AdvancedPunch™ Pro is an automatic hole-punch module that integrates with the press to streamline the 
production of reports, directories, pricing guides and other bound books. The hole-punch module equals or 
surpasses traditional quality while saving time and increasing productivity by eliminating the labor-intensive steps 
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of manual punching. The compact AdvancedPunch Pro requires minimal space and accepts various optional, 
multiple hole-punch die sets.

The GBC® AdvancedPunch™ Pro can be connected to various optional finishing devices and sits in line with the 
devices.

Note: This optional finishing device requires the Interface Decurler Module.

The GBC® AdvancedPunch™ Pro provides the following capabilities:

• Punches a broad range of media sizes and types

• Trailing edge, LEF (Long-Edge Feed), and SEF (Short-Edge Feed) hole punching

• A die set detection control panel shows the die type and cycle count

• User die set options include comb, wire, coil, and 3–7 hole varieties to enable the most popular binding formats

• Operates at rated print engine speed for most paper sizes 

• Quick-change die sets that can be interchanged without any tools

• All die sets include an identification label that provides users with the hole pattern and name

• Convenient storage area for two extra die sets adjacent to the Punch Chip Container

For detailed information and instructions for using the GBC® AdvancedPunch™ Pro, refer to the guide on the 
customer documentation disk that shipped with the device, or go to www.xerox.com and in the Search box, type 
GBC AdvancedPunch Pro.

High Capacity Stacker

The High Capacity Stacker is an optional finishing device that provides large-capacity stacking and offsetting 
capabilities for production output to a stacker tray and cart. The stacker provides a top tray that is convenient for 
short stack runs. 

Note: The High Capacity Stacker requires the Interface Decurler Module.
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Crease and Two-Sided Trimmer

The Crease and Two-Sided Trimmer provides crease capabilities and trimming on two sides of the output.

The Crease and Two-Sided Trimmer trims the top and bottom of sheets or booklets to produce full bleed output. 
When this device is combined with the SquareFold® Trimmer Module, all sides of booklets can be trimmed, except 
the binding. This enables the creation of full bleed booklets. For more information, refer to SquareFold® Trimmer 
Module

This optional finishing device requires one of the following Production Ready Finishers: 

• Production Ready Finisher

• Production Ready Booklet Maker Finisher

• Production Ready Finisher Plus

C/Z Folder

The C/Z Folder is an optional finishing device that provides C-fold and Z-fold output for the following paper sizes:  

• A4 or Letter-sized: 210 x 297 mm (8.5 x 11 in.) 

• A3 or Tabloid: 297 x 420 mm (11 x 17 in.) 
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The C/Z Folder is available only with the Production Ready (PR) Finisher, Production Ready Finisher Plus, and the 
Production Ready Booklet Maker Finisher.

Production Ready Finishers

Three Production Ready (PR) Finishers are available for your printer:

• The Production Ready (PR) Finisher consists of two output trays, a stapler, and an optional basic punch. 

• The Production Ready (PR) Booklet Maker Finisher provides all the same features as the PR Finisher. In addition, 
the PR Booklet Maker Finisher creates saddle-stitched booklets automatically of up to 30 sheets, and performs 
bi-folding, also called single-folding. 
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• The Production Ready (PR) Finisher Plus includes the same features and functions as the PR Finisher. In addition, 
the PR Finisher Plus serves as an interface to transfer paper between the press and any third-party finishing 
device attached to the press. 

SquareFold® Trimmer Module

The SquareFold® Trimmer module flattens the spine of a booklet and performs a face trim of the booklet. 

The SquareFold® Trimmer module is available only with the Production Ready Booklet Maker Finisher.
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Power Options

The device is provided with the power switch and the main power switch.

POWER ON

After you power on the printer, it takes approximately 3 minutes to warm up before you can start making copies.

1. Open the cover.

2. Press the power switch to the On position.  

The Please wait message indicates that the printer is in the warm-up stage. You cannot use the printer 
during the warm-up stage. 

POWER OFF

Before you power off the device, ensure that all job processing, copying, and printing is completed. Ensure that the 
Data indicator is not illuminated. 

1. Press the power switch on top of the printer. The printer powers off. 

2. To continue to power off the main power, ensure that the control panel touch screen is blank and the Power 
Saver indicator is not illuminated.

3. Open the front cover.

4. To power off the main power switch, press the main power switch to the zero [0] position. When the main 
power is off, the Main Power indicator is not illuminated. 
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5. Close the front cover.

POWER SAVER

The Power Saver feature has two modes: 

• Low Power: After remaining inactive for a preset time period, the device enters the Low Power mode.

• Sleep: After entering Low Power mode and remaining inactive for another preset time period, the device enters 
the Sleep mode.

Examples: 

• If the Low Power mode is set to 15 minutes and the Sleep mode is set to 60 minutes, the Sleep mode activates 
after 60 minutes of total inactivity and not 60 minutes after the Low Power mode begins.

• If the Low Power mode is set to 15 minutes and the Sleep mode is set to 20 minutes, the Sleep mode activates 
5 minutes after the Low Power mode begins.

To set the time periods for Low Power mode and Sleep mode, from the control panel, log in as the system 
administrator. Press the Machine Status button, then touch Tools > System Settings > Common Service 
Settings > Power Saver Settings.

Exiting the Power Saver Mode

1. To exit the Power Saver mode, at the control panel, press the Power Saver button.

2. Send a print job to the printer or make copies at the printer.
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More Information

Refer to the following sources for more information about your device and its capabilities.

RESOURCE LOCATION 

Installation and Planning Guide Packaged with the printer. 

Documentation for Xerox® EX Print Server, 
powered by Fiery® 

For more information, refer to the documentation provided with 
the print server. After installation is complete, it is recommended 
that you or your System Administrator print the print server 
documentation for later reference.  

Tested Substrate List (TSL) A list of substrates, or media, is validated on this printer. To obtain 
the list, go to www.xerox.com/digital-printing/latest/PB9DS-02.pdf
or contact your Xerox sales representative. 

For optional IPDS or LCDS workflow availability, contact your 
Xerox sales representative.

Technical support information for your 
printer; including online technical support, 
Online Support Assistant, and print driver 
downloads. 

www.xerox.com/office/PLB91XXsupport

Information Pages To print from the control panel, press the Machine Status button, 
then touch Device Information. 

To print from the Embedded Web Server, click Support, then on 
the Online Support screen, click Connect.

Order supplies for your printer Go to www.xerox.com/office/PLB91XXsupplies, then select your 
specific device model. 

Local sales and Technical Customer Support www.xerox.com/office/worldcontacts

Printer registration www.xerox.com/office/register

Help on the World Wide Web For system support, user help, documentation, and service support, 
go to www.xerox.com/office/worldcontacts, then click the Contact 
Us link for specific contact information or telephone numbers in 
your area. 

It is recommended that you print all customer documentation and keep it close to the device.

Note: For the latest documentation updates for your Xerox device, go to www.xerox.com/support.

Before you contact Xerox for support, ensure that you have the serial number of your Xerox device. The serial 
number is on the Machine Information tab. To access the Machine Information tab, at the device control panel, 
press the Machine Status button, then touch Device Information. From the General Information area, note the 
serial number of your Xerox device.
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Network Printing

Print procedures vary depending on the application software that you are using. For more information, refer to the 
documentation provided with each application.

To learn about print features, in the print driver screen, click Help, then review the feature information.

Note: PostScript and PCL print drivers have different print features and printing options.

PRINTING WITH THE POSTSCRIPT PRINT DRIVERS

1. Load the paper in the paper tray. Refer to Paper and Media.

2. From your computer, open the document that you want to print.

3. Select File > Print.

4. Select the required printer.

5. Select Properties.  

A new window appears with Printing Options, Image Options, Document Options, and Advanced tabs.

6. On the Printing Options tab, select the appropriate settings for Job Type, Paper, 2–Sided or 1–Sided Printing, 
Finishing, Print Quality, and Output Destination.

7. Click the Image Options tab, then select the appropriate settings for Lightness and Image Shift.

8. Click the Document Options tab, then select the appropriate settings for Page Layout, Special Pages, 
Watermark, and Orientation.

9. Click the Advanced tab, then select the appropriate settings for Advanced Settings.

10. To save and close the Properties window, click OK.

11. Select the needed copies, then click Print. 

Note: For additional information, in the print driver screen, click Help (?), then review the feature information.

PRINTING WITH THE PCL PRINT DRIVERS

1. Load the paper in the paper tray. Refer to Paper and Media.

2. From your computer, open the document that you want to print.

3. Select File > Print.

4. Select the required printer.

5. Select Properties.  

A new window appears with Printing Options, Image Options, Document Options, and Advanced tabs.

6. On the Printing Options tab, select the appropriate settings for Job Type, Paper, 2–Sided or 1–Sided Printing, 
Finishing, Print Quality, and Output Destination.

7. Click the Image Options tab, then select the appropriate settings for Image Shift.

8. Click Document Options tab, then select the appropriate settings for Page Layout, Special Pages, Watermark, 
and Orientation.
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9. Click the Advanced tab, then select the appropriate settings for Advanced Settings. 

Note: Advanced Settings options are different in PostScript and PCL print drivers.

10. To save and close the Properties window, click OK.

11. Select the needed copies, then click Print.  

Note: For additional information, in the print driver screen, click Help (?), then review the feature information.
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Network Printing on Tabs

NETWORK PRINTING ON TABS USING THE POSTSCRIPT AND PCL PRINT DRIVERS

1. Load the tab stock in Tray 3, Tray 4, or Tray 5 (Bypass tray). Refer to Loading Tab Stock in Trays 3 and 4.

2. From your computer, open the document that you want to print.

3. Select File > Print.

4. Select the required printer.

5. Select Properties.

6. Click Printing Options > Paper > Other Type.

7. To print on tabs, select Pre-Cut Tab or Pre-Cut Tab Cardstock.

8. For the Pre-Cut Tab window, select a number in the Number in Sequence field. In the Tab Margin Shift field, 
select a margin measurement.

9. To save and close the Pre-Cut Tab window, click OK.

10. If Tray 3 or Tray 4 is used for the tab stock, select Printing Options > Paper > Select By Tray > Automatically 
Select.

11. If Tray 5 (Bypass tray) is used for the tab stock, select Printing Options > Paper > Select By Tray > Bypass 
Tray.

12. To save and close the Properties window, click OK.

13. Select the needed copies. To print the job, click Print. 

Note: For additional information, in the print driver screen, click Help (?), then review the feature information.
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Copying Using the Duplex Automatic Document Feeder
1. Adjust the movable document guides to the widest position. 

2. Load the documents face up with the first page on top and with the headings or text toward the back or left 
side of the printer. 

If you loaded the documents correctly, the confirmation status indicator illuminates.

3. Press the Services Home button.

4. On the Services Home screen, select Copy.

5. From the Copy screen, select the needed features or options. 

• Reduce/Enlarge 

• Paper Supply

• 2-Sided Copying

• Copy Output

• Image Shift

• Original Type

• Darken/Lighten

Note: The features that appear on the main Copy screen vary depending on how the system administrator 
configured the main Copy screen.

6. Enter the copy quantity.
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7. Press the Start button.
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Copying Using the Document Glass
1. Open the automatic document feeder. 

2. Place the document face down on the document glass. Align the document as shown. 

3. Press the Services Home button.

4. On the Services Home screen, select Copy.

5. From the Copy screen, select the required options. 

• Reduce/Enlarge

• Paper Supply

• 2-Sided Copying

• Copy Output

• Image Shift

• Original Type

• Darken/Lighten
The features that appear on the main Copy screen vary depending on how the system administrator 
configured the main Copy screen.

6. Enter the copy quantity using the numeric keypad.

7. Press the Start button.
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Selecting Copy Options for a DFA Finishing Device

If your Xerox device has an optional third-party Document Finishing Architecture (DFA) device attached, the DFA 
Finisher Profile is available, and you can select copy options for jobs. 

Note: You can attach optional DFA devices to a Xerox® PrimeLink® B9110 Production Press, PrimeLink® 

B9125 Production Press, and PrimeLink® B9136 Production Press.

Before you attach a DFA device to your Xerox PrimeLink® Production Press, create a device profile. A device profile 
represents the characteristics of your finishing device.

Note: For information about setting the profile values for the DFA device that is attached to the PrimeLink 
Production Press, refer to the documentation that shipped with the DFA device.

You can select a job profile from the print server, the print driver on your computer, or the control panel touch 
screen on your Xerox PrimeLink device. Depending on the DFA device, a maximum of 12 profiles are available. Set 
up the DFA device with Paper Size, Staple, Cover, Staple Position, Fold Position, and other specifications that are 
required for your print job.

1. Place your original documents in the document feeder or on the document glass.

2. Press the Services Home button.

3. On the Services Home screen, touch Copy.

4. Touch Copy Output, then touch Output/Offset. 

a. Touch DFA Finisher. 

The DFA Finisher Profile tab appears.

b. Touch the DFA Finisher Profile tab. 

The DFA Finisher Profile window appears.

c. To select a profile for the job, from the list, touch a name. 
If the device is an e-binder, to select the Binding Position, touch Left or Right.

d. Touch Save.

5. To save the DFA Finisher settings, touch Save again.

6. Touch the Output Format tab, then touch Face Up/Down Output. 

a. To select the required option for the job, touch Face Up or Face Down.

b. Touch Save.

7. From the Copy screen, select the required options. 
The options that appear on the Copy screen vary, depending on how the administrator configured the Copy 
screen.

8. Enter the copy quantity.

9. Press Start. 
If prompted, to correct any job-submission errors, follow the onscreen instructions. If there is a DFA problem, 
refer to your DFA documentation.
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Copying on Tab Stock
1. Load the tab stock in Tray 5 (Bypass).

2. The Tray 5 (Bypass) screen opens automatically. In the print driver, confirm or change the paper size. 

• If the paper size and type shown are correct, select Confirm.

• To change the paper settings, select Change Settings.

3. Select the following: 

• For Paper Type, select Tab Stock.

• For Paper Size, select Standard-Size A4 (210 x 297 mm) or 8.5 x 11 in.

4. Touch Save, then touch Confirm until you return to the Copy screen.

5. On the Copy screen, touch the Output Format tab.

6. Touch Face Up/Down Output. 

a. Touch Face Down.

b. Touch Save.

7. From the Output Format tab, touch Tab Margin Shift. 

a. Touch Shift to Tab, then follow the tab-loading instructions. Review your tab stock selections.

b. Touch Save.

8. Enter the required output quantity using the numeric keypad.

9. To begin copying, press Start.
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Using the Copy Option

The Copy tab contains the following options:

• Reduce/Enlarge

• Paper Supply

• 2-Sided Copying

• Copy Output

• Image Shift

• Original Type

• Darken/Lighten

Note: The features that appear on the main Copy screen vary, depending on how the administrator 
configured the Copy screen.

REDUCE/ENLARGE

You can set the reduce or enlarge copy features in the Reduce/Enlarge area, on the Copy screen.

1. On the Services Home screen, touch Copy.

2. From the Reduce/Enlarge tab, touch the applicable reduce or enlarge ratio. 

Note: To set the Reduce/Enlarge ratio, touch the Plus (+) or Minus (–) icons. The ratio is shown in the text 
box.

PAPER SUPPLY

You can select a paper tray that does not appear in the Paper Supply area of the Copy screen.

1. On the Services Home screen, touch Copy.

2. For the Paper Supply feature, select the required paper.

3. From the Paper Supply area, touch More.

4. From the list, select the tray that contains the applicable paper size and paper type.

5. To save your changes, touch Save.

2-SIDED COPYING

You can copy one or both sides of 1-sided and 2-sided documents.

1. From the Copy screen, in the 2 Sided Copying area, select the copy options for your job.

2. If you want Side 2 rotated head-to-foot, select the check box for Rotate Side 2.

COPY OUTPUT

To define the copy output, on the Copy screen, use the Copy Output tab.
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1. From the Copy screen, touch the Copy Output tab.

2. From the Hole Punch & More screen, select the output features for your job: 

• Paper Supply: To view the Paper Supply screen, touch Paper Supply.

• Staple: This option is available only when you select Collated.

• Hole Punch: This option is available only when you select Collated.

• Collation 

• Separator Tray 

• Output/Offset/Subset 

3. To save the changes, touch Save.

IMAGE SHIFT

To define Image Shift features, on the Copy screen, use the Image Shift tab.

1. From the Copy screen, touch the Image Shift tab.

2. From the Image Shift screen, select the applicable image shift features.

3. Touch Margin Shift. To set the image shift parameters, use the left, right, up, or down arrows.

4. Touch Original Orientation. Select Upright Images or Sideways Images. To save the image orientation 
settings, touch Save.

5. To mirror the Side 1 settings to Side 2, select the check box for Mirror Side 1.

6. To save your changes, touch Save.

ORIGINAL TYPE

To define the Original Type specifications, on the Copy screen, select the Original Type tab.

1. From the Copy screen, touch the Original Type tab.

2. Select the applicable specifications for the original type.

3. To save the changes, touch Save.

DARKEN/LIGHTEN

You can adjust the copy density to one of seven levels from the Copy screen, in the Darken/Lighten area.

To adjust the density, you can touch the left or right arrows on the touch screen.
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Image Quality

The Image Quality option contains the following options:  

• Original Type

• Image Options

• Background Suppression

ORIGINAL TYPE

The Original Type feature provides a convenient way to enhance the quality of your output, based on the type of 
original document images that you are copying. In the Image Quality section, select the Original Type tab, then 
select the required option.

1. Touch Original Type, then select an option. 

• Photo & Text: Use this option if your original document is from a magazine or other source that contains 
high-quality photographs with text. This setting produces better pictures, but reduces the sharpness slightly 
for text and line art.

• Text: Use this option if your original document contains only text or line art. The result is sharper edges for 
the text and line art.

• Photo: This option is designed specifically to copy photographs or magazine images without any text or 
line drawings. This option prevents faint reproduction of colors.

• Light Text: Select this option for text that requires enhancement, such as handwritten pencil text.

• Text on See-Through Paper: Select this option to reduce blurs on tracing paper documents or to suppress 
background shadows on lightweight paper documents.

2. To save the changes, touch Save.

IMAGE OPTIONS

Use the Image Options feature to make adjustments to the following options: 

• Lighten/Darken: This option provides manual control to adjust the lightness or darkness of the scanned 
images. To darken the scanned image from light original documents such as pencil images, move down the 
slider control. To lighten the scanned image from dark original documents such as halftones or original 
documents with colored backgrounds, move up the slider control.

• Sharpness: This option controls the balance between sharp text and moiré patterns within the image.  

– To produce an image with a smooth, uniform appearance, and soften the image, move down the slider 
control. This setting is suited ideally for photographic scanned images. 

– To produce an image with better quality text or line art, and sharpen the image, move up the slider control. 
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BACKGROUND SUPPRESSION

When Background Suppression is selected, the background color of documents such as newspapers and colored 
paper documents is erased on the copy.

Note: When Document Type is set to Photo, the Background Suppression feature is not functional.

1. From the Copy screen, touch the Image Quality option.

2. Touch Background Suppression.

3. For no background suppression, touch Off. For automatic background suppression, touch Auto Suppression.

4. To save the changes, touch Save.
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Layout Adjustment

The Layout Adjustment section includes the following features:  

• Book Copying

• 2 Sided Book Copying

• Original Size

• Edge Erase

• Image Shift

• Image Rotation

• Invert Image

• Original Orientation

BOOK COPYING

You can place bound original documents, such as books, on the document glass to make 1-sided or 2-sided copies.

1. Place the bound original document face down and to the rear-left corner of the document glass. Align the top 
of the bound original document against the rear edge of the document glass.

2. On the Services Home screen, touch Copy, then touch the Layout Adjustment tab.

3. Touch Book Copying, then touch On or Off.

4. With Book Copying set to On, select an option: 

• Both Pages: This option copies both pages in page order.

• Left Page Only: This option copies the left page only.

• Right Page Only: This option copies the right page only.

• Binding Edge Erase: This option erases the shadow from the center section of the document. You can set 
the binding edge erase width in the range 0–50 mm (0–1.96 in.) in 1-mm (0.039-in.) increments.

5. Touch Save.

2-SIDED BOOK COPYING

This feature allows you to make 2-Sided copies of facing pages of the original bound document.

Note: You cannot activate simultaneously this feature and Book Copying. To make copies from books, 
magazines, or pamphlets, use the document glass. Do not place bound original documents in the document 
feeder. Non-standard size documents cannot separate accurately into two pages.

1. On the Services Home screen, touch Copy, then touch the Layout Adjustment tab.

2. Touch 2-Sided Book Copying, then touch On.

3. To specify the copy start page and copy end page, touch Starting & Ending Page. 

• For Starting Page: Touch Left Page or Right Page.

• For Ending Page: Touch Left Page or Right Page.
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4. To specify the Binding Edge Erase amount, the space between the image area and the binding, touch the Plus 
(+) or Minus (–) icons.

5. Touch Save.

ORIGINAL SIZE

1. On the Services Home screen, touch Copy, then touch the Layout Adjustment tab.

2. Touch Original Size. 

• The printer can pre-scan the first page of the original document to determine the area to copy. To have the 
printer determine the area to copy, select Auto Detect.

• If the area that you want to copy matches a particular paper size, select Manual Size Input, then select 
the required paper size. To view the list of paper sizes, touch the Up or Down arrows.

• If the original document contains pages of different sizes, select Mixed Size Originals.

3. Touch Save.

EDGE ERASE 

You can erase content from the edges of your copies. Specify the amount to erase on the right, left, top, and 
bottom edges.

1. On the Services Home screen, touch Copy, then touch the Layout Adjustment tab.

2. Touch Edge Erase.

3. To erase all the edges by the same amount: 

a. Touch All Edges.

b. Touch the Plus (+) or Minus (–) icons.

4. To specify different amounts for the edges: 

a. Touch Individual Edges.

b. For each edge, touch the Plus (+) or Minus (–) icons.

c. If you select 2-sided copies: To specify the amount to erase from each edge on Side 2, touch the Plus (+) or 
Minus (–) icons, or select Mirror Side 1.

5. To specify the original orientation of the document that you loaded in the automatic document feeder or on 
the document glass, select an option:  

• For a vertical orientation, where the top of the document is oriented toward the back of the printer, touch 
Original Orientation, then touch Upright Images.

• For a horizontal orientation, where the top of the document is oriented toward the left side of the printer, 
touch Original Orientation, then touch Sideways Images. 

6. Touch Save.

7. To cancel edge erase, touch Print to Edge.

8. If you saved the preset values such as Hole Punch Erase or Header/Footer Erase, you can select the preset in the 
lower-left corner of the screen.
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9. Touch Save.

IMAGE SHIFT

You can change the placement of the image on the copy page. This feature is useful if the image size is smaller 
than the page size. For image shift to work as expected, position the original documents correctly.

1. On the Services Home screen, touch Copy, then touch the Layout Adjustment tab.

2. Touch Image Shift.

3. To center the image on the page, touch Auto Center.

4. To specify the position of the image, select the appropriate options for your job: 

• To shift the corners of the image on the page, touch Corner Shift.

• To adjust the margins, touch Margin Shift.

• To specify the amount of up or down and left or right shift for Side 1, touch the Plus (+) or Minus (–) icons.

• If you selected 2-sided copies: To specify the amount to erase from each edge on Side 2, touch the Plus (+) 
or Minus (–) icons, or touch Mirror Side 1.

5. To specify the original orientation of the document in the automatic document feeder or on the document 
glass, touch Original Orientation. Touch Upright Images or Sideways Images. Touch Save. 

If the Preset values are not saved, select Shift Right or Shift Down.

6. Touch Save.

IMAGE ROTATION 

If the orientation of the paper that is loaded in the tray differs from the orientation of the document that is loaded, 
the printer rotates the document image automatically to match the document and paper orientation.

1. On the Services Home screen, touch Copy, then touch the Layout Adjustment tab.

2. Touch Image Rotation.

3. Select the applicable image rotation: 

• Off

• Always On

• On during Auto

4. Touch Save.

INVERT IMAGE

You can make copies with a negative image of the original document, or with the left-side images and right-side 
images of the document reversed.

1. On the Services Home screen, touch Copy, then touch the Layout Adjustment tab.

2. Touch Invert Image. The default is Normal Image, which does not mirror the images.
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3. Touch an option: 

• Mirror Image: This option reverses the left-side images and right-side images of the document.

• Negative Image: This option creates a negative image. The printer default is Positive Image, which does 
not print the image as a negative.

4. Touch Save. 

Note: When the Negative Image and Edge Erase options are set simultaneously, the edge erase area turns 
to white.

ORIGINAL ORIENTATION

Set the document orientation to indicate the top of the document. 

1. At the control panel, on the Services Home screen, touch Copy, then touch the Layout Adjustment tab.

2. Touch Original Orientation.

3. Select the orientation of the document that is loaded in the printer: 

• Upright Images

• Sideways Images

4. Touch Save. 

Note: If the Original Orientation setting differs from the physical document orientation, the printer can 
mistakenly detect the wrong side as the head or top of the document.
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Output Format

The Output Format section includes the following features:

• Booklet Creation

• Covers

• Page Layout

• Poster

• Folding

• Annotations

• Watermark

• Tab Margin Shift

• Face Up/Down Output

• ID Card Copy

BOOKLET CREATION

You can print copies in the form of a booklet. The page images are reduced to print two images per side of each 
printed page. The pages can be folded and stapled manually, or the pages can be creased and stapled 
automatically with the appropriate finisher.

In the Booklet Creation mode, the printer does not print the copies until all the original documents are scanned.

1. On the Services Home screen, touch Copy, then touch the Output Format tab.

2. Touch Booklet Creation, then touch On.

3. For Original Input, select 1 Sided Originals, 2 Sided Originals, or 2 Sided, Rotate Side 2.

4. If the PR Booklet Maker Finisher is installed, touch Fold & Staple, then select an option:  

• Fold Only

• Crease Only

• Fold & Staple

5. To add margins in the center binding area to compensate for the thickness of the booklet: 

a. Touch Binding Shift. To set the shift, touch the Plus (+) or Minus (–) icons.

b. Touch Save.

6. To add covers, touch Covers, then touch Blank Cover, Print on Both, or 1 Sided Covers Print Outside. 

a. Select the tray loaded with cover paper and the tray loaded with paper for the main body. Touch Save.

b. To print the copy of the last original page on the back cover, for Blank Cover and Print on Both, touch the 
check box for Last Page on Back Cover. Touch Save.

7. To enter the number of sheets for each subset, touch Divide Output, then touch On. For Sheets per Subset, 
touch the Plus (+) or Minus (–) icons, then touch Save.
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8. Offset Stacking places each stack of printed pages slightly to the left or right of the previous stack for easier 
separation. To set the offset stacking options: 

a. Touch Output/Offset/Subset.

b. Touch Right-Top Output Tray or Right-Middle Output Tray. For automatic creasing, touch Right-Middle 
Output Tray > Offset Stacking. 

c. For Offset Stacking, select an option: 

• System Default

• No Offset

• Offset per Set

• Offset per Job

d. Touch Save.

9. For automatic image positioning, touch Auto Image Positioning, then touch On or Off. To save the settings, 
touch Save.

10. To save all the settings for Booklet Creation options, touch Save.

COVERS

To add covers to a copy job, select different paper trays for the first and last page. You can load the trays with 
heavier stock, color, or pre-printed paper. The covers can be blank or printed.

The paper used for the covers must be the same size as the paper used for the rest of the document.

1. On the Services Home screen, touch Copy, then touch the Output Format tab.

2. Touch Covers.

3. To include both front and back covers that use the same paper tray and printing options: 

a. For the Front Cover and Back Cover options, select the required settings for your job:  

• Blank Cover: This option does not print any text on the cover.

• Print on Side 1: This option prints a cover on Side 1.

• Print on Side 2: This option prints a cover on Side 2.

• Print on Both: This option prints a front and back cover.

b. To select the paper tray to use for the covers and the main body of the document, touch Paper Supply.

c. Touch Save.

4. To include a front cover only, in the Back Cover field, touch Off. To include a back cover only, in the Front Cover 
field, touch Off.

5. Touch Save.

PAGE LAYOUT

The Page Layout feature has two options: 
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• Pages per Side

• Repeat Image

Pages per Side

You can copy multiple original pages onto one side of a sheet of paper. According to the size of the page, the 
image is reduced proportionally to fit on the selected paper.

1. On the Services Home screen, touch Copy, then touch the Output Format tab.

2. Touch Page Layout, then touch Pages per Side.

3. To select the number of original pages for each sheet of paper, touch 2 Pages, 4 Pages, or 8 Pages. For a 4-up 
page signature or an 8-up page signature, select the required reading order.

4. To change the orientation of the copies, touch Original Orientation, then touch Upright Images or Sideways 
Images. Touch Save.

5. To save all the settings, touch Save.

Repeat Image

A document image can be copied on one sheet of paper repeatedly for a specified number of times.

1. On the Services Home screen, touch Copy.

2. Touch Output Format.

3. Touch Page Layout > Repeat Image.

4. Select the required Repeat Image option. 

a. For the number of times to repeat the same image on a page, touch 2 Times, 4 Times, or 8 Times.

b. To calculate automatically the number of times to repeat the image vertically or horizontally, based on the 
document size, paper size, and the enlarge/reduce ratio, touch Auto Repeat.

c. To specify the number of times to repeat the image vertically or horizontally, touch Variable Repeat, then 
touch the Plus (+) or Minus (–) icons. You can repeat an image from 1–33 times vertically in columns, and 
from 1–23 times horizontally in rows.

5. To change the orientation of the copies, touch Original Orientation, then touch Upright Images or Sideways 
Images. Touch Save.

6. To save your changes for the Repeat Image option, touch Save. 

Tip: When the copy ratio is set to Auto, the repeated copies of the image are reduced to fit on the selected 
paper. You can specify how the repeated copies of the image are arranged.

Note: When making repeat copies at the same size as the document image, you can specify a number of 
repeated images that fit on the paper.
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POSTER

The Poster feature allows you to create a large poster when you paste together the copies that are spread over 
multiple sheets. Copied sheets are provided with a paste margin so that they can be pasted together. The paste 
margin is fixed to 10 mm (0.4 in.).

Note:  

• When you select Uncollated or Uncollated with Separators in the Copy screen, the Poster feature is 
enabled.

• When you select Collated in the Hole Punch & More screen, the Poster feature is disabled.

1. On the Services Home screen, touch Copy, then touch the Output Format tab.

2. Touch Poster.

3. Touch Output Size, then touch the required size of the poster.

4. To select the width and length enlargement percentages independently, touch Enlargement %, then select the 
Plus (+) or Minus (–) icons. To set the width and length proportionally, touch Lock X–Y%.

5. Touch Paper Supply, then set the applicable paper supply tray options.

6. To save the paper supply options, touch Save.

7. To save your changes, touch Save. 

Tip: Access the Scan Options screen. Confirm that the Original Orientation setting and the orientation of the 
document are the same.

FOLDING

If the Xerox device is equipped with a Folding option, you can select folds for your job. For example, if a C-fold or Z- 
fold type is available, the device can fold your job in thirds. For information about each type of fold, refer to C/Z Fold 
Types.

1. At the control panel, on the Services Home screen, touch Copy, then touch the Output Format tab.

2. Touch Folding, then touch Fold/Crease.

3. On the Fold/Crease screen, select the required folding and creasing features: 

• Fold Only

• Crease Only

4. Touch Save. 

Note: The orientation of documents is limited to short-edge feed (SEF). To use the Folding option, select a 
paper tray that is loaded with short-edge feed paper.

ANNOTATIONS

You can add an annotation stamp, date, page number, and Bates Stamp to the final copies that are not included 
on the original document.

1. On the Services Home screen, touch Copy, then touch the Output Format tab.
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2. Touch Annotations.

3. To insert a comment: 

a. Touch Comment, then touch On.

b. On the next screen, in the list of stored comments, select the required comment.

c. To create a comment, touch an <Available> comment, then touch Edit. Using the touch screen keyboard, 
enter the new comment, then touch Save.

d. Touch Apply To, then touch First Page Only, All Pages, or All Pages Except First. Touch Save.

e. To select the location of the comment on the page, touch Position, then select the required location.

f. Touch Save twice.

4. To insert the current date: 

a. Touch Date, then touch On.

b. Select the format for the date.

c. To select the pages on which the date appears, touch Apply To, then touch First Page Only, All Pages, or 
All Pages Except First. Touch Save.

d. To select the position of the date stamp on the page, touch Position, then select the required position.

e. Touch Save twice.

5. To insert page numbers: 

a. Touch Page Numbers, then touch On.

b. To enter the starting page number, touch the Plus (+) or Minus (–) icons.

c. To select the pages on which the page number appears, touch Apply To, then touch All Pages or All 
Pages Except First. Touch Save.

d. To select the position of the date stamp on the page, touch Position, then select the required position.

e. Touch Save twice.

6. To insert a Bates Stamp: 

a. Touch Bates Stamp, then touch On.

b. Select an existing prefix or create a prefix. 

c. To create a prefix, touch an <Available> prefix, then touch Edit. Using the touch screen keyboard, enter 
the new prefix, then touch Save.

d. To enter the starting page number, touch the Plus (+) or Minus (–) icons.

e. To select the pages on which the Bates Stamp appears, touch Apply To, then touch All Pages or All Pages 
Except First. Touch Save.

f. To select the position of the Bates Stamp on the page, touch Position, then select the required position. 
Touch Save.

g. To specify the number of digits, touch Number of Digits. To select the minimum number of digits 
necessary, touch Auto Assign, then touch Save. 

h. To select a specific number of digits, touch Manual Assign. To insert up to nine leading zeros, touch the 
Plus (+) or Minus (–) icons. Touch Save.
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i. Touch Save.

7. To specify the orientation of the original documents that you place in the automatic document feeder or on 
the document glass, for Original Orientation, touch Upright Images or Sideways Images.

8. To change the format used for annotations: 

a. Touch Format & Style.

b. To select the font point size, touch the Plus (+) or Minus (–) icons.

c. To select the placement of the annotations on the second side when printing 2-sided copies, touch Same 
as Side 1 or Mirror Side 1.

d. Touch Save.

9. To save all the settings, touch Save.

WATERMARK

You can print a watermark of a sequential control number, stored watermarks, date and time, or serial number on 
the background of each copy set.

1. On the Services Home window, touch Copy, then touch the Output Format tab. 

2. Touch Watermark.

3. To add a control number, touch Control Number, then touch Add. To select the starting number, touch the 
Plus (+) or Minus (–) icons. Touch Save.

4. To add a stored watermark, touch Stored Watermarks, then touch On. From the list, select a stored 
watermark, then touch Save.

5. To print the current date and time on the copies, touch Date & Time, then touch Add. Touch Save.

6. To print the serial number of the printer on the copies, touch Serial Number, then touch Add. Touch Save.

7. The watermark image is faint so that the content of the page is readable. To make the watermark visible on 
copies used as original documents, touch Watermark Effect, then touch Embossed or Outline. Touch Save.

8. To save all the settings, touch Save.

Secure Watermark

Secure Watermark, sometimes called a hybrid watermark, is an optional feature and requires the purchase of an 
optional package. For information, contact Xerox Technical Customer Support.

Secure Watermark is a security-management feature that embeds a copy-protection digital code into a document 
to restrict the document from being copied. With the digital code, you can determine when, from which device, and 
by whom the document originated.

The following limitations or conditions apply to the Secure Watermark feature:

• Using the Secure Watermark feature can cause print quality to deteriorate, such as: 

70 Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide

Copying



– Colors can appear darker. 

– Resolution for text and dots, such as decimal characters and periods, can be slightly out of focus and harder 
to read. 

• The Secure Watermark feature may not function properly for a document if any of the following apply: 

– The document size is smaller than A5: 148 x 210 mm (5.5 x 8.5 in.). 

– The background color is not white. 

– The Watermark or Secure Watermark feature was used previously for the document. 

• Secure Watermark options include: 

– Protection Code: This option embeds a code into the document, and prevents the document from being 
copied or scanned. 

– Stored Secure Watermark: This option embeds hidden text into the document. With this hidden-text 
feature, the specified text is embedded in the sheet. When you copy a document with hidden text, the 
embedded text on the printed output appears in white, even if the optional Secure Watermark kit is not 
installed on the Xerox device. 

TAB MARGIN SHIFT

You can copy images to a tab location on tabbed paper. Specify the position of the tab so that the image is copied 
onto the tab. You can copy A4 (210 x 297 mm) and 8.5 x 11 in. tabbed paper.

1. At the control panel, on the Services Home screen, touch Copy, then touch the Output Format tab.

2. Touch Tab Margin Shift.

3. Select the required shift feature option: 

• Shift to Tab: The image is copied only to the tab part of the paper.

• Shift All: The whole document image is copied to the tab paper.

4. To specify the shift value, touch the Plus (+) icon or the Minus (–) icon.

5. To select the required tabbed paper size and type, from Paper Supply, touch More.

6. To set the tabbed paper quantity, touch Add Tab Stock.

7. Load the tabbed paper into tray 3, tray 4, or tray 5: 

• For tray 5, load the tabbed paper with the side to be copied facing up, and with the edge that is opposite to 
the tab leading into the printer.

• For tray 3 or tray 4, select Tab Stock 106–216 g/m2. Load the tabbed paper with the side to be copied 
facing down, and with the tabbed edge trailing into the printer.

8. Touch Save.

FACE UP/DOWN OUTPUT

1. On the Services Home screen, touch Copy, then touch the Output Format tab.

2. Touch Face Up/Down Output.

3. Touch the required option: 
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• Auto This option determines automatically if the copies are output as face up or face down.

• Face Up: This option delivers all output face up, with the first page on top of the output stack.

• Face Down: This option delivers all output face down, with the first page on the bottom of the output stack.

• Face Up (Reverse Order): This option delivers all output face up, with the last page on the top of the 
output stack. The availability of the Face Up (Reverse Order) option depends on how your system 
administrator configured the Xerox device.

4. Touch Save.

ID CARD COPY

The identification card copying feature allows you to copy both sides of a small original document, such as an 
identification card, onto the same side of a page.

1. Open the Automatic document feeder, then place the card in the upper left corner of the document glass.

2. Close the Automatic document feeder. On the Services Home screen, touch Copy, then touch the Output 
Format tab.

3. Touch ID Card Copy, then touch On. 

4. Touch Save.

5. To scan side one, press the green Start button.

6. To scan side two, turn over the card without changing the location on the document glass, then press the Start 
button. Both sides of the card print onto the same side of a sheet of paper.
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Job Assembly Tab

The Job Assembly section includes the following features: 

• Build Job

• Sample Job

• Combine Original Sets

• Form Overlay

• Delete Outside/Delete Inside

• Stored Programming

BUILD JOB

You can use this feature for complex copy jobs that include various original documents that require different copy 
settings. Each segment can have different copy settings. After all segments are programmed and scanned, the page 
images are stored temporarily in the printer, and the complete copy job prints.

1. On the Services Home screen, touch Copy, then touch the Job Assembly tab.

2. Program and scan the first segment: 

a. Place the original documents in the automatic document feeder or on the document glass.

b. Select the required copy settings.

c. Touch the Job Assembly tab.

d. Touch Build Job, then touch On.

e. Touch Save.

f. To scan the first set of original documents, press the green Start button.

3. Program and scan the additional segments: 

a. Place the original documents in the automatic document feeder or on the document glass, then touch 
Next Original.

b. When printing 2-sided jobs, to set the start page of the next 2-sided segment, touch Chapter Start, then 
select an option: 

Off: The first page of the next segment prints on the next available side.

On: The first page of the next segment prints on Side 1 of a new sheet of paper.

Pages per Side-New Page: If the first segment has an odd number of pages, the second segment starts 
on side 1. If the first segment has an even number of pages, the second segment starts on side 2.

c. Touch Change Settings. Select the settings for the segment.

d. To scan the next set of original documents, at the control panel, press the green Start button.

4. For each additional segment that you want to copy, repeat Step 3.

5. When all segments are scanned, on the Copy screen, touch Last Original.
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Build Job Options

1. On the Services Home screen, touch Copy, then touch the Job Assembly tab.

2. Touch Build Job, then touch On.

3. Select the required options: 

• Copy Output: Touch Paper Supply, Staple, Hole Punch, Collation, and Output/Offset/Subset options, 
then touch Save.

• Booklet Creation: Select the required settings, then touch Save.

• Covers: Select the required settings, then touch Save.

• Annotations: Select the required settings, then touch Save.

• Segment Separators: To insert separator pages between segments, touch Segment Separators, then 
select the required options: 

• No Separators: Separators are not inserted. Select the required settings, then touch Save.

• Blank Separators: Blank separators are inserted. To specify the quantity of separators, select the Plus 
(+) or Minus (–) icons, then touch Save.

• 1-Sided Side 1 Only: The first page of the loaded document copies on the front side of a separator. 
Select the required settings, then touch Save.

• 1-Sided Side 2 Only: The first page of the loaded document copies on the back side of a separator. 
Select the required settings, then touch Save.

• 2-Sided Separators: The first two pages of the loaded documents are copied onto each side of a 
separator. Select the required settings, then touch Save.

• Watermarks: Select the required settings, then touch Save.

• Face Up/Down Output: Select the required settings, then touch Save.

4. To save all the changes, touch Save.

SAMPLE JOB

With a complicated copy job, it can be helpful to print a test copy before printing multiple copies. This feature prints 
a single copy and holds the remaining copies. After you inspect the sample, you can print the remaining copies 
using the same settings, or you can cancel the job.

The sample copy is counted as part of the total quantity selected. For example, when copying a book, if you enter 3 
as the number of copies, one copy of the book prints, and two copies are held until you release the copies for 
printing.

1. On the Services Home screen, touch Copy, then select the required copy settings.

2. Touch the Job Assembly tab.

3. Touch Sample Job, then touch On.

4. Touch Save.

5. Press the green Start button. The sample set prints.
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6. To print the remaining copies of the job, touch Start, or press the green Start button on the control panel.

7. If the sample copy is unsatisfactory, touch Delete.

COMBINE ORIGINAL SETS

This feature allows you to copy sets of documents that cannot be loaded into the automatic document feeder. Use 
the document glass when copying documents that are damaged, ripped or torn, or too wrinkled to go through the 
automatic document feeder. The Combine Original Sets feature allows you to copy each original document on the 
document glass and create one copy job for the set.

1. On the Services Home screen, touch Copy. Select the required copy settings, then enter the number of copies 
using the alphanumeric keypad on the control panel.

2. Touch the Job Assembly tab, then touch Combine Original Sets.

3. Touch On, then touch Save.

4. Copy the first set of original documents: 

• If the first set of original documents is not damaged, place the documents in the automatic document 
feeder.

• If the set of original documents is damaged, place the documents on the document glass.

5. Press the green Start button on the control panel. Copying begins.

6. Scan additional sets: 

a. Use the automatic document feeder or the document glass to copy the next set of original documents.

b. On the Copy screen, touch Next Original.

7. Touch Start on the touch screen, or press the green Start button on the control panel.

8. When the final set is copied, on the Combine Original Sets screen, touch Last Original.

9. To cancel the job, touch Delete.

FORM OVERLAY

You can make copies that overlay the first page of the document on the rest of the documents. For example, if the 
first page of the document has a header and footer only, you can copy the rest of the documents with the same 
header and footer.

1. On the Services Home screen, touch Copy, then touch the Job Assembly tab.

2. Touch Form Overlay.

3. From the Form Overlay screen, touch On or Off.

4. Touch Save. 

• If the first page is 2-sided, only the top side is used for the form overlay.

• The Center/Corner Shift, Image Shift, Delete Outside/Delete Inside, Edge Erase, and Border Erase features 
are applied to the text body.
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DELETE OUTSIDE/DELETE INSIDE

1. At the control panel, on the Services Home screen, touch Copy, then touch the Job Assembly tab.

2. Touch Delete Outside/Delete Inside.

3. Touch Delete Outside or Delete Inside.

4. If the original documents are 2-sided, select the applicable delete option: 

• Both Sides

• Side 1 Only

• Side 2 Only

5. Touch Area 1.

6. To define a specific area, enter the two XY coordinates within a range of 0.0–431.8 mm (0.0–17.0 in.). To 
navigate from coordinate to coordinate, touch each X and Y setting: 

a. To enter the value for Y1, touch the Y1 box. To enter a number range, use the numeric keypad.

b. To enter the value for Y2, touch the Y2 box. To enter a number range, use the numeric keypad.

c. To enter the value for X1, touch the X1 box. To enter a number range, use the numeric keypad.

d. To enter the value for X2, touch the X2 box. To enter a number range, use the numeric keypad.

To clear a deletion area, touch Clear Area X, then use the numeric keypad and press 1, 2, or 3.

7. Touch Save.

8. Touch Save again.

9. Enter the Quantity, then press the green Start button.

STORED PROGRAMMING

You can save frequently used features and job settings as Stored Programming, then access the settings using a 
shortcut button. For more information, refer to Stored Programming.

The Stored Programming option not only remembers feature settings, but the option can record a series of 
operations. This feature enables you to record the hierarchy of displayed screens for each step. For example, you 
could use Stored Programming to record the following actions: Press the Machine Status button, and display the 
Print Reports screen to print reports.

• You can record up to 100 consecutive operations in each stored program.

• Store up to 40 programs.

• You cannot use the Build Job option with the Stored Programming option.

• There are situations where a stored program becomes invalid: 

– When default values or paper tray settings are changed in the system setting, a stored program becomes 
invalid. 

– When buttons are added or removed from the touch screen, a stored program becomes invalid. The Stored 
Programming feature remembers the location only of a button on the screen, not the name of the button. 
For example, button positions can change when a job flow or job template is added or deleted. 
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– If you change the values of the Watermark feature when a watermark is used in a stored program, the 
stored program becomes invalid. 

– After the program is stored, if you change the password to the folder that is used in the stored program, the 
stored program becomes invalid. 

• The following options cannot be used with the Stored Programming feature: 

– System Settings 

– Job Flow Sheets 

– Network Scanning 

– Address Book 

– Browse 

– Scan to PC 
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Basic Scanning

The basic scanning procedure involves loading documents, selecting features, scanning the job, and identifying 
where to store the scanned job. 

Note: Users can scan up to 5000 impressions per job.

BASIC SCAN PROCEDURE

To initiate a scan job:

1. Load the original document into the document feeder or onto the document glass. For details, refer to Loading 
Documents.

2. At the control panel, press the Services Home button.

3. Select a scan feature: 

• Email

• Network Scanning

• Scan to PC

• Store to USB

• Store to Folder

• Send from Folder

• Store to WSD

Note: For details on these scan features, refer to Scan Methods.

4. Press the Start button.

LOADING DOCUMENTS

There are two methods to load documents: 

• Document feeder: Use the document feeder to print or scan a single sheet or multiple sheets.

• Document glass: Use the document glass to print or scan a single sheet or a bound book.

1. Before you load the document, remove any paper clips and staples.

2. Load the document using the appropriate method: 

• Document feeder: Load the document face up, then adjust the document guides to match the size of the 
document that you loaded.

• Document glass: Load the document face down, position the document using the rulers and size guides, 
then close the scanner cover.

Note: Users can scan up to 5000 impressions per job.
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SCAN METHODS

You can select the following scan methods: 

• Email: This option scans a document, converts the data to TIFF, JPEG, PDF, PDF/A, or XPS (XML Paper 
specification), then sends the scanned data as an email attachment. Refer to Email.

• Network Scanning: This option scans a document using a job template that was created on the Embedded 
Web Server. Refer to Network Scanning.

• Scan to PC: This option scans a document, then sends the scanned data to a network computer using the FTP 
or SMB protocol. Refer to Scan to PC.

• Store to Folder: This option scans a document, then saves the scanned data in a folder on the device. Refer to 
Store to Folder.

• Send from Folder: Send from Folder allows you to access files that have been sent to the device using any of 
the following methods: 

– Store to Folder feature on the control panel 

– Store File in Folder in the print driver 

– Copy & Store option or Store Only option in the Copy feature on the control panel 

Refer to Send from Folder.

• Store to USB: This option scans a document, then saves the scanned data to a USB memory device. Store to 
USB is an optional feature. Refer to Store to USB.

• Store to Web Services on Devices (WSD): You can scan documents set on the device and save the scanned 
data from a computer. You can save the scanned data to a computer on the network. Store to Web Services on 
Devices (WSD) is an optional feature. Refer to Web Services on Devices (WSD).

STARTING A SCAN JOB

1. Load the document into the document feeder or place the document on the document glass.

2. Select a scanning method. Refer to Scan Methods.

3. Select options, as needed.

4. At the control panel, press the Start button.

5. To scan more than one document, or scan another page of a bound book, touch Next Original. Place the 
document that you want to scan in the document feeder or on the document glass, then touch Start.

6. When scanning the last original document, touch Save (Last Original), then touch Start.

7. To view the status of the scanned job, press the Job Status button.

CANCELING A SCAN JOB

To cancel a scan job in process:

1. At the control panel, press the Stop button.
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2. To cancel the scan, on the Stop / Pause screen, touch Cancel Scanning. To continue the scan, touch Resume 
Scanning. 

Note: When a scan is canceled, any scan data that has been stored to a folder is deleted.

3. Touch Close. 

CHANGING SCAN SETTINGS WHILE SCANNING

While your scan job is scanning, you can change settings for the job. To change the settings:

1. At the control panel, touch Next Original.

2. Touch Change Settings.

3. Select the appropriate section, then adjust the settings as needed. You can adjust the following features: 

• Color Scanning: Refer to Color Scanning.

• Original Type

• Resolution

• Lighten / Darken: Refer to Lighten / Darken.

• Original Orientation

• 2 Sided Scanning: Refer to 2 Sided Scanning.

• Original Size

4. After you have adjusted the settings, touch Save.

5. To resume scanning the job, touch Start.
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Scan Settings

The following tabs and options appear for the following scan method features: 

• Network Scanning

• Scan to PC

• Store to Folder

• Email

After you select a scan method, the following tabs appear onscreen:

MMaaiinn ssccaann ttaabb

This tab shows the name of the scan method. For example, if you selected Network Scanning on the Services Home 
screen, the name of this tab is Network Scanning. 

Options on this tab include:

• Color Scanning

• 2 Sided Scanning

• Original Type

• Scan Presets

AAddvvaanncceedd SSeettttiinnggss

Options on this tab include: 

• Image Options

• Image Enhancement

• Resolution

• Quality / File Size

• Photographs

• Shadow Suppression

LLaayyoouutt AAddjjuussttmmeenntt

Options on this tab include: 

• Original Orientation

• Book Scanning

• Original Size

• Reduce / Enlarge

• Edge Erase
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FFiilliinngg OOppttiioonnss

When Email is the selected scan feature, the Filing Options tab does not appear. Options on this tab include: 

• File Name

• File Format

• File Name Conflict

EEmmaaiill OOppttiioonnss

This tab appears only when Email is the selected scan feature. Options on this tab include: 

• File Name

• File Format

• Reply To

• Read Receipts

MAIN SCAN TAB

The name of this tab coincides with the scanning method that you selected on the Services Home screen.

1. On the Services Home screen, select a scan method. 

The scan screen appears with the main tab selected.

2. Select the following options, as needed: 

• Color Scanning

• 2 Sided Scanning

• Original Type

• Scan Presets

Preview Scanned Images of a Job

To set a scan job to allow a preview of the scanned images:

1. Start a scan job. For details, refer to Starting a Scan Job.

2. On the main tab for the selected scan method, select the check box for Preview.

3. Adjust other scan settings as needed, then scan the document as required.

4. After the document scans, touch Preview.

5. To specify display and rotation options, select the appropriate icons.  

Note: Rotation options are not available for all scan methods.

6. To close the preview screen, touch Close.
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Color Scanning

To set the output color for the scanned document:

1. On the main tab for the selected scan method, touch Color Scanning.

2. From the list, select a color option: 

• Auto Detect: The device determines the color of the document automatically. When scanning a colored 
document, the device scans in full color. When scanning a black and white document, the device scans in 
monochrome.

• Color: The device scans the document in color.

• Black & White: The device scans the document in monochrome.

• Grayscale: The device scans a document in grayscale. Grayscale adds shading to monochrome documents, 
which creates intermediate tones that change gradually. This option is suitable for documents that contain 
gradations that cannot be reproduced with monochrome.

2-Sided Scanning

You can scan a 1-sided or 2-sided document.

1. At the control panel, on the main tab for the selected scan method, touch 2 Sided Scanning.

2. From the list, select an option: 

• 1 Sided: To scan only one side of the document, select this option.

• 2 Sided: When both sides of the 2-sided document are in the same orientation, select this option.

• 2 Sided, Rotate Side 2: When the sides of the 2-sided document are in opposite orientations, select this 
option.

Original Type

1. On the main tab for the selected scan method, touch Original Type.

2. From the list, select an option: 

• Photo & Text: When you scan a document that contains both text and photos, select this option. The 
device identifies text and photo areas automatically, then scans each area for optimum quality.

• Text: When you scan a document that contains clear text, select this option.

• Photo: When you scan a photo, select this option.
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Scan Presets

1. On the main tab for the selected scan method, touch Scan Presets.

2. Select a preset option: 

• Sharing and Printing: This setting is used for sharing files to be viewed onscreen and for printing most 
standard business documents. This setting results in small file sizes and higher image quality.

• Archival Record: This setting is best used for standard business documents that are stored for record- 
keeping purposes. This setting results in the smallest file size and normal image quality.

• OCR: This setting is best used for documents that are processed by optical character recognition software. 
This setting results in large file sizes and the highest image quality.

• High Quality Printing: This setting is best used for documents that contain detailed graphics and photos. 
This setting results in large file sizes and maximum image quality.

• Simple Scan: This setting is best used for faster processing, but can result in excessively large file sizes. This 
setting applies the minimal amount of image-processing and compression.

• Custom: This setting applies the scan settings as defined in the current template. 

Note: The Custom option is available for Network Scanning only.

ADVANCED SETTINGS TAB

You can set the following options from the Advanced Settings tab.

1. From the Services Home window, select a scan method.

2. Select the Advanced Settings tab.

3. Select options, as needed: 

• Image Options

• Image Enhancement

• Resolution

• Quality / File Size

• Photographs

• Shadow Suppression
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Image Options

1. On the Advanced Settings tab, touch Image Options, then set options, as needed. 

• Lighten / Darken: This option provides manual control to adjust the lightness or darkness of the scanned 
image. To darken the scanned image from light original documents, such as pencil images, touch a preset 
closer to the Darken limit. To lighten the scanned image from dark originals, such as halftones or original 
documents with colored backgrounds, touch a preset closer to the Lighten limit.

• Sharpness: This option controls the balance between sharp text and moiré, which are patterns within the 
image. To produce an image with a smooth, uniform appearance, touch a preset closer to the Soften limit. A 
softer level is ideally suited for photographic scanned images. To produce an image with better quality text 
or line art, select a preset closer to the Sharpen limit.

2. Touch Save.

Image Enhancement

1. On the Advanced Settings tab, touch Image Enhancement.

2. For Background Suppression and Contrast, set options as needed: 

• For Background Suppression, select an option: 

• Off: Scans the document backgrounds with no filtering.

• Auto Suppression: When Color Scanning is set to Black & White, the background of a document 
printed on colored paper, such as newspaper, is suppressed. When Color Scanning is set to Color, the 
background of a document printed on white-color paper is suppressed.

• For Contrast, on the bar, select a contrast level. More contrast makes the difference between light and dark 
areas greater so that light areas become lighter and dark areas become darker. Less contrast makes the 
difference between light and dark areas smaller.

3. Touch Save.

Resolution

You can select preset resolution settings.

1. At the control panel, on the Advanced Settings tab, touch Resolution.

2. Specify the image resolution.

3. Touch Save. 

Quality/File Size

This feature allows you to select the ratio of data compression for color and grayscale scanned images.

Note: When the Black and White option is selected, the Quality/File Size feature is unavailable.

1. From the Advanced Settings tab, select Quality/File Size.
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2. To specify the output quality/file size, use the right or left arrow buttons. 

Note: When MRC High Compression is enabled for PDF Multiple Pages per File in File Format, only three 
compression levels are available.

3. Select Save.

Photographs

If Color is selected from the Color Scanning section of a tab screen, the Photographs enhancement feature is 
available.

1. From the Advanced Settings tab, select Photographs.

2. Select Off or Enhance Photographs: 

• Off: This option disables the feature.

• Enhance Photographs: This option enhances images scanned from color photographs with Output Color set 
to Full Color.

3. Select Save. 

Note: When Enhance Photographs is selected, the Shadow Suppression and Background Suppression 
features are not available.

Shadow Suppression

You can use the Shadow Suppression feature to hide background colors and image bleed-through.

1. From the Advanced Settings tab, select Shadow Suppression.

2. Select Off or Auto Suppression.

3. Select Save.

LAYOUT ADJUSTMENT TAB

You can specify layout adjustment settings from the Layout Adjustment tab.

1. From the Services Home screen, select a scan method.

2. Select the Layout Adjustment tab.

3. Select the applicable option: 

• Original Orientation

• Original Size

• Edge Erase 

• Book Scanning

• Reduce/Enlarge

88 Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide

Scanning



Original Orientation

Ensure that the document orientation is set to indicate the top of the document.

1. On the Layout Adjustment tab, touch Original Orientation.

2. Select the orientation for the document that is loaded.

3. Touch Save. 

Note: If the Original Orientation setting differs from the physical document orientation, the Xerox device can 
mistakenly detect the wrong side as the top of the document.

Original Size 

When you scan standard-sized and custom-sized documents or when you make copies at a size that is different 
than the currently loaded document, you can specify the size of the document.

1. On the Layout Adjustment tab, touch Original Size.

2. Select an option: 

• Auto Detect: The device detects the original document size.

• Manual Size Input: Select a size from a pre-defined list or specify a custom page size.

• Mixed Size Originals: The device detects the size automatically for each page of the original document.

3. Touch Save. 

Note: If the Xerox device cannot detect the document size, a screen appears where you can enter the 
document size.

Edge Erase

When you scan using the document-feeder in the open position or from a book, you can remove the black shadows 
along the edges using the Edge Erase feature.

1. From the Layout Adjustments tab, select Edge Erase.

2. Select All Edges or Individual Edges: 

• All Edges: This option erases the same amount of length from all four edges of your document. The edge 
erase amount is specified by the system administrator. If you do not want to erase any edges, select 
[Individual Edges], then specify 0 for the top, bottom, left, and right edges.

• Individual Edges: This option allows you to specify the lengths to be erased from the top, bottom, left, and 
right edges of your document. You can specify up to 50 mm (2 in.) in each field.

3. For individual edges, to set the values, use the up or down arrow buttons.

4. For Original Orientation, select an option: 

• Upright Images: This option selects the vertical orientation, where the top of the document is oriented 
toward the back of the printer.

• Sideways Images: This option selects the horizontal orientation, where the top of the document is 
oriented toward the left of the printer.

5. Select Save.
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Book Scanning

The Book Scanning feature allows you to scan facing pages of a document on separate sheets of paper in page- 
number order.

1. From the Layout Adjustments tab, select Book Scanning.

2. From the Book Scanning screen, select the features.

3. The Binding Edge Erase feature erases the center binding area of the book that is sometimes in shadow due to 
the fold in the pages. To set the dimensions, use the left or right arrow buttons.

4. To save the changes, select Save. 

Tip: You cannot use the document feeder when using the book scanning feature.

Note: A document of non-standard size or undetectable size can result in two non-equal sizes.

Reduce/Enlarge

The Reduce/Enlarge feature allows you specify a reduction or enlargement value for the scanned document.

1. From the Layout Adjustments tab, select Reduce/Enlarge.

2. Select the appropriate options for your job: 

a. Proportional% is the default setting. 

• In the Variable% area, to specify the ratio, use the Plus (+) and Minus (-) buttons.

• You can choose a preselected value from the Preset% area.

• To save the changes, select Save.

• To set the output size, for Output Size, select from preset standard scanning ratios.

b. In the Output Size area, select the applicable preset.

c. To save the changes, select Save.

FILING OPTIONS

File Name

You can enter and save a file name.

1. At the control panel, on the Filing Options tab, touch File Name.

2. In the text box, type a file name.

3. Touch Save.

File Format

You can select a file format for scanned data.

1. At the control panel, on the Filing Options tab for the selected scan feature, touch File Format.
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2. Select the appropriate file format for the output data: 

• TIFF/JPEG Auto Select: This option saves scanned data automatically as TIFF or JPEG files. Full color and 
grayscale scanned images are stored in the JPEG format. Monochrome scanned images are saved in the 
TIFF format.

• TIFF: This option saves scanned data in TIFF format.

• JPEG: This option saves scanned data in JPEG format. This option is available when Color or Grayscale is 
selected in Color Scanning.

• PDF: This option saves scanned data in PDF format.

• PDF/A: This option saves scanned data in PDF/A format. The PDF/A format is used primarily for archiving 
and long-term file preservation.

• XPS: This option saves scanned data in XPS format.

3. Depending on the file format selected, you can select the following options: 

• Compression Method: This option allows you to set the compression method for scanned image data. You 
can set the compression method to be selected automatically or you can manually select the compression 
method for color and grayscale pages.

• MRC High Compression: This option allows you to save the PDF and XPS files with high compression.

• Searchable Text: This option allows you to select whether to perform character recognition in the PDF files.

• Add Thumbnail: When you select XPS, this option allows you to attach thumbnails to the XPS files. A 
thumbnail is a reduced, small file-size image that helps you view the file contents.

• XPS Signature: When you select XPS, you can select XPS Signature. A digital signature is a feature that 
allows a sender to add a digital fingerprint that is used to confirm that email content sent to a receiver has 
not been altered. 

Note: XPS Signature is an optional feature. A valid certificate is required for this feature.

• Single File for Each Page: This option saves each page as a single file in the specified format.

• Optimize For Quick Web View: This option optimizes the PDF file so that the file appears faster in a Web 
browser. 

If you select one of the PDF file format options, the Optimize for Quick Web View option is available. The 
Optimize for Quick Web View feature allows you to open and view the first page of a multiple-page PDF 
document within a Web browser, while the remainder of the document continues to load in the 
background. This action can increase the overall file size. The Optimize for Quick Web View feature 
restructures an Adobe PDF document for page-at-a-time downloading from web servers. With page-at-a- 
time downloading, the Web server sends only the requested page, rather than the entire PDF document. 
This feature is especially important with large documents that can take a long time to download from a 
server.

Check with your administrator to ensure that the web server software that you use supports page-at-time 
downloading. To ensure that the PDF documents on your website appear in older browsers, you can create 
HTML links to the PDF documents and keep the path names or URLs to the files at fewer than 256 
characters.

4. To save your settings, touch Save.
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File Name Conflict

To resolve a file-name conflict:

1. On the Filing Options tab, touch File Name Conflict.

2. Select the appropriate option: 

• Do Not Save: This option cancels the scan operation so that you can enter another file name.

• Rename New File: This option attaches a 4-digit number (0000–9999) to the end of the duplicate file 
name, then saves the file in the same directory.

• Overwrite Existing File: This option deletes the existing file with the duplicate file name, then saves the 
new file with the specified file name in the same directory.

3. Touch Save.

EMAIL OPTIONS TAB

File Name

You can enter and save a file name.

1. At the control panel, on the Email Options tab, touch File Name.

2. In the text box, type a file name.

3. Touch Save.

File Format

You can select a file format for scanned data.

1. At the control panel, on the Email Options tab, touch File Format.
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2. Select the appropriate file format for the output data: 

• TIFF/JPEG Auto Select: This option saves scanned data automatically as TIFF or JPEG files. Full color and 
grayscale scanned images are stored in the JPEG format. Monochrome scanned images are saved in the 
TIFF format.

• TIFF: This option saves scanned data in TIFF format.

• JPEG: This option saves scanned data in JPEG format. This option is available when Color or Grayscale is 
selected in Color Scanning.

• PDF: This option saves scanned data in PDF format.

• PDF/A: This option saves scanned data in PDF/A format. The PDF/A format is used primarily for archiving 
and long-term file preservation.

• XPS: This option saves scanned data in XPS format. If you select this file format, the Add Thumbnail option 
appears. This option adds a thumbnail image to the email.

• Optimize for Quick Web View: 

If you select one of the PDF file format options, the Optimize for Quick Web View option is available. The 
Optimize for Quick Web View feature allows you to open and view the first page of a multiple-page PDF 
document within a Web browser, while the remainder of the document continues to load in the 
background. This action can increase the overall file size. The Optimize for Quick Web View feature 
restructures an Adobe PDF document for page-at-a-time downloading from web servers. With page-at-a- 
time downloading, the Web server sends only the requested page, rather than the entire PDF document. 
This feature is especially important with large documents that can take a long time to download from a 
server.

Check with your administrator to ensure that the web server software that you use supports page-at-time 
downloading. To ensure that the PDF documents on your website appear in older browsers, you can create 
HTML links to the PDF documents and keep path names or URLs to the files at fewer than 256 characters.

• Single File for Each Page: This option saves each page as a single file in the specified format.

3. To save your settings, touch Save.

Reply To

Use the Reply to feature to specify or search for a reply recipient.

1. From the Email Options tab, select Reply to.

2. Use the keypad to enter or search for the applicable reply-to name.

3. To save the changes, select Save.

Read Receipts

To allow email read receipts to be sent to the sender:

1. At the control panel, on the Email Options tab, touch Read Receipts.

2. Touch On.

3. Touch Save.
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Network Scanning

You can use the Network Scanning feature to create job templates on a computer using the Embedded Web Server. 
Scanned data is converted to the format specified in a job template, and sends the data automatically to a server. 
The device allows you to retrieve job templates automatically that are stored in a server.

When Scan to Home is enabled, an authenticated user can transfer the scanned document to a different 
destination, as needed.

STARTING A NETWORK SCAN JOB

1. Load the original document into the document feeder.

2. At the control panel, press the Services Home button.

3. Touch Network Scanning.

4. From the list, select a template. 

• To view a description of the selected template, touch Template Description. After viewing the description, 
touch Close. Template descriptions are optional.

• To refresh the template list, touch Update Templates.

5. Adjust scan settings as needed. Refer to Scan Settings.

6. Press the Start button.
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Scan to PC

The Scan to PC service allows you to scan documents and send the scanned data to a network server using the FTP 
or SMB protocol.

STARTING A SCAN TO PC JOB

To start a Scan to PC operation:

1. Load the original document into the document feeder.

2. At the control panel, press the Services Home button.

3. Touch Scan to PC.

4. By default, the transfer protocol is set to SMB. To select a different transfer protocol, touch Transfer Protocol. 
Refer to Transfer Protocol.

5. Select a destination. Refer to Specify Destination.

6. Adjust the scan settings as needed. Refer to Scan Settings.

7. Press the Start button.

TRANSFER PROTOCOL

1. On the Scan to PC tab, touch Transfer Protocol.

2. Select a forwarding protocol: 

• FTP: This option transfers files using the FTP protocol.

• SMB: This option transfers files using the SMB protocol.

• SMB (UNC Format): This option transfers files using the SMB protocol, with the Universal Naming 
Convention (UNC) format. The UNC format is as follows: \\host name\shared name\directory 
name

3. Touch Save.

SPECIFY DESTINATION

Use this option to specify a destination PC using the control panel keypad. To specify a forwarding destination, for 
the selected protocol, enter information in the fields provided.

To populate the appropriate server information into the fields provided, on the main tab of the Scan to PC screen, 
select an option:

• Using the Address Book

• Browse Network for PC

To add destination information manually, refer to Add Destination Information Manually.

Using the Address Book

You can use the address book to populate the fields.
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1. On the main tab for Scan to PC, touch Address Book.

2. From the list, select a destination that uses the selected protocol. To retrieve entries, touch List all public 
entries, then select an option: 

• List all public entries: Use this option to select from a list of all public destination folders.

• Retrieve entries using index: Use this option to search for all entries that use a specific index term. Type 
the search term on the screen keypad, then touch Save.

3. To use the selected destination, touch Add.

4. Touch Close. 

The information for the selected destination populates the fields on the main screen.

Browse Network for PC

You can use the Browse option to display a hierarchy of available server names and folders on your network. From 
the list, you can select a destination server.

1. On the main tab for Scan to PC, touch Browse.

2. Select a folder from the list. The destination appears in the Save in field. 

• To locate a folder, touch Previous. To move to another level and view other destinations, touch Next.

• To add the selected destination folder to the server address book, touch Add to Address Book.

3. Touch Save. The information for the selected destination populates the fields on the main screen.

Add Destination Information Manually

You can type the appropriate destination information directly into the fields. The fields available differ according to 
the selected protocol.

1. For Server, type the server name or IP address. When the save location is in the DFS namespace on Windows, 
type a domain name or server name of up to 64 characters.

2. For Shared Name, type a shared name. When the save location is in the DFS namespace on Windows, type a 
root name of up to 64 characters. The Shared Name field appears only when SMB is the selected transfer 
protocol.

3. For Save in, type a directory path. When the save location is in the DFS namespace on Windows, type a folder 
name of up to 128 characters. When SMB (UNC Format) is the selected transfer protocol, type the information 
into the Save in field using the following directory path: "\\Host Name\Shared Name\Directory 
Name".

4. For User Name, type the user name of the computer to which you are forwarding. When a user name is not 
required for the destination, you can skip this field.

5. For Password, type the password for the user name. Up to 32 characters are allowed.
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Store to Folder

The Store to Folder option allows you to scan documents and save the scanned data in a folder on the device. 

Note: Before using the Store to Folder feature, ensure that folders have been created. For details, refer to 
Creating a Folder.

1. At the control panel, press the Services Home button.

2. Touch Store to Folder.

3. From the list, select a folder. 

Note: To view the files in the folder, touch File List.

4. Load the original document into the document feeder.

5. On the Advanced Settings, Layout Adjustment, and Filing Options tabs, change the settings for the file, as 
needed. For details, refer to Scan Settings.

6. Press the Start button. 

The scanned document file is stored to the selected folder.

SAVING THE SCANNED DATA USING THE EMBEDDED WEB SERVER

You can use the Embedded Web Server to import a file from a device folder to your computer.

1. At your computer, launch a Web browser.

2. In the Web browser address field, type the printer IP address, then press Enter.

3. Click the Scan tab.

4. In the Scan navigation pane at the left of the page, click Folder.

5. In the Folder list, select a folder. If necessary, enter the folder password, then click Apply. The Folder: List of 
Files page appears.

6. From the list, select a file.

7. From the Retrieving Format menu, click the required file format. Select options for the file format using the 
check boxes and menus, as needed. Options vary by file format.

8. Click Retrieve.

9. On the Retrieve Files from Folder page, click the link to the selected file.

10. Click Save, select the required storage location, then click Save.

11. If a stored file is no longer needed, select the file. In the upper right corner of the page, click Delete. When 
prompted, click OK.

AAddddiittiioonnaall FFiillee RReettrriieevvee OOppttiioonnss

The following options are available when using the Embedded Web Server to retrieve a stored file: 

• To retrieve a single page of a multiple-page document, for Retrieve Page, select Enabled. Type the page number 
in the Page Number field.

• To add a thumbnail view when using XPS format, for Add Thumbnail, select Enabled.
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• To apply MRC High Compression to PDF and XPS format files, for MRC High Compression, select Enabled. From 
the Quality menu, select the required quality setting.

• To create a searchable-text PDF or XPS file: 

– For Searchable Text, select Enabled. 

– From the Language of the Original menu, select the language. 

– To apply text compression, from the Text Compression menu, select Enabled. 

Note: Not all the file retrieval settings can be enabled. For assistance, contact your system administrator.
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Store to USB

The Store to USB is an optional service that allows you to scan documents and save the scanned data to a USB 
memory device.

GUIDELINES FOR USING A USB STORAGE DEVICE

A commercially available Memory Card Reader with a single slot can be used for this feature, but safe performance 
of the reader is not guaranteed. When you use a Memory Card Reader with multiple slots, only one particular slot is 
available.

The following USB memory devices are supported:

• A formatted USB memory device

• A USB 2.0 compliant memory device (USB 1.1 is not supported.)

• A USB memory device with a storage capacity of up to 128 Gbyte

A USB memory device encrypted with software is not supported.

When you insert a USB memory device into the USB memory slot while the device is in Power Saver mode, the 
touch screen does not light. To exit Power Saver mode, press the Power Saver button, then insert the USB memory 
device again or touch Store to USB on the Services Home window.

Before you remove the USB memory device, ensure that the screen that indicates that data is being transferred is 
not displayed. If you remove the USB memory device while the data is being stored, the data in the device can 
become damaged. You can also confirm that the data has been stored to the USB memory device on the Job 
Status window.

SAVING SCAN DATA TO A USB MEMORY DEVICE

To save scan data to a USB memory device:

1. Insert a USB memory device into the USB memory slot on the printer.

2. The USB Device Detected screen appears. If this screen does not appear, press the Services Home button, 
then touch Store to USB.

3. Touch Save In.

4. Select a folder for saving the data.

5. Touch Save.

6. Adjust scan settings, as needed. For details, refer to Scan Settings.

7. To start the scan job, press the Start button.

REMOVING THE USB DEVICE

Before you remove the USB memory device, ensure that the window that indicates that data is being transferred is 
not displayed. If you remove the USB memory device while the data is being transferred, the data in the device can 
be damaged. You can confirm if data is being transferred to the USB memory device on the Job Status window.
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DISPLAYING STORAGE DETAILS

1. At the control panel, on the Services Home screen, touch Store to USB.

2. Touch Details. 

The folder and file names to be saved appear.

3. Touch Close.
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Web Services on Devices (WSD)

Web Services on Devices allows a client to discover and access a remote device and its associated services across 
the network. WSD supports device discovery, control, and use.

WSD STARTING A SCAN JOB

The Store to WSD service allows you to scan documents set on the device from a network computer. It also allows 
you to save the scanned data to a network computer.

You can scan documents on the device by sending a request from a network computer.

1. Load the document on the document glass or in the document feeder.

2. Scan from a network computer. To operate scan from a network computer, use an application which supports 
the image loading feature, such as Windows Fax and Scan. Follow the instructions using the application you 
choose.

3. After you scan the document, the scanned data transmits to the specified computer.

STORING TO WSD

1. At the control panel, press the Services Home button.

2. Touch Store to WSD.

3. In the List of Computers area, select a scan job type: 

• Scan to PC

• Scan for Print

• Scan for Email

• Scan for Fax

• Scan for Optical Character Recognition (OCR): This feature requires an Optical Character Recognition 
solution, such as Google Docs.

4. Load the document onto the document glass or into the document feeder.

5. Press the Start button. 

The scanned data is forwarded to the specified destination.

6. On the destination computer, check the forwarded data.
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Email

You can scan a document and send the scanned data as an email attachment.

1. At the control panel, press the Services Home button.

2. Touch Email.

3. To specify one or more recipients, select one or both options: 

• To add a recipient, touch New Recipient, type the new recipient email address, touch Add, then touch 
Close.

• To search for and specify recipients, touch Address Book, select an email address, select To, Cc, or Bcc, then 
touch Close.

4. To add the device as a recipient, touch Add Me.

5. To remove or change a recipient: 

a. Select the applicable recipient.

b. From the menu, touch Remove or Edit.

6. To add or change the email subject, touch Subject, edit the text, then touch Save.

7. To add or change the email message, touch Message, edit the text, then touch Save.

8. Set the various scan features, as needed. For details, refer to Scan Settings. 

• Select the Advanced Settings tab, then set and save the advanced settings. Refer to Advanced Settings 
Tab

• Select the Layout Adjustment tab, then set and save the layout adjustments. Refer to Layout Adjustment 
Tab.

• Select the Email Options tab, then set and save the email options. Refer to Email Options Tab.

9. Press the Start button. 

Note: The Mail Delivery Notification (MDN) and Split Send features on the File Format screen are available 
only when using the email feature.

ADDRESS BOOK

1. At the control panel, press the Services Home button.

2. Touch Email.

3. Touch Address Book.

4. From the address list, select a recipient. If necessary, you can search for an address using one of the following 
options: 

• List all public entries: This option displays the local address list.

• Retrieve entries using index: This option searches recipients in the index.

• Search Public: This option searches recipients in the local address list.

• Search Network: This option searches recipients in the remote address list.
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5. Specify the To, CC, or BCC fields.

6. To navigate the Name list, use the scroll-bar.

7. If necessary, to view the Details screen, touch Details.

8. Touch Close.

ADDING EMAIL RECIPIENTS

1. On the Email tab, touch New Recipient.

2. Enter one or more new recipients. To add another recipient, touch +Add.

3. Touch Close.

REMOVING EMAIL RECIPIENTS

1. From the Email tab, in the Recipient list, select the recipient name that you want to delete.

2. Touch Remove.

SUBJECT

The email subject can contain up to 128 characters.

1. On the Email tab, touch Subject.

2. In the text box, type the email subject.

3. Touch Save.

MESSAGE CONTENTS

The email message can contain up to 128 characters.

1. On the main tab for email, touch Message.

2. In the text box, type a brief message.

3. Touch Save.

EMAIL PRINT

You can send email with TIFF, JPEG, or PDF documents attached from a computer to the Xerox device. Received 
email is printed automatically. This feature is called Email Print.

Sending Emails

This example describes how to use Microsoft Outlook to send email from a computer to each printer.
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1. Use your email client to create the email body, then attach to the email a TIFF, JPEG, or PDF document. 

Note:  

• Only plain text is supported in the email message body. Before sending an email to the printer, in the 
Microsoft Outlook email client, ensure that the message body text format is set to Plain Text. Message 
body text that uses the HTML format or the Rich Text format cannot print.

• Attach files that have a file extension of .tif, .jpg, or .pdf only. Files with other extensions can produce 
unexpected results.

• The Email Print feature does not support password-protected PDFs.

• The number of files that you can attach to an email depends on the file-size limit allowed on the server.

2. For the email recipient, enter the email address of the Xerox printer. 

Note: You can view the email address of the printer on the printer Configuration Report.

To print a Configuration Report:

a. At the control panel, press the Machine Status button.

b. Touch Printer Reports, then touch Configuration Report

c. Press the Start button.

The Configuration Report prints.

3. Send the email. 

The device prints the plain-text message body and the attached file.
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Send from Folder

FOLDER TYPES

The following types of folders are available: 

• Folders that contain files for copy jobs and print jobs: These folders are listed on the Copy & Print Jobs tab. You 
can edit the files, change the file settings, save the files again, and reprint the files from the folder.

• Folders that contain files for scan jobs and other job types: These folders contain scan files and print files 
submitted from a computer. The folders are listed on the Scan & Other Jobs tab. You can retrieve files stored in 
these folders from a network server and send the files by email. You can automate routine tasks or register 
private folders and shared folders separately.

COPY & PRINT JOBS TAB

Selecting a Folder

The following describes how to select a folder on the Copy & Print Jobs tab. Access to some folders can be 
restricted, depending on authentication settings.

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. On the Send From Folder screen, select the Copy & Print Jobs tab, then select a folder.

Checking Files

You can check or operate files stored in a folder on the Copy & Print Jobs tab. Folders that are listed on the Copy & 
Print Jobs tab contain both copy jobs and print jobs.

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select a folder.

4. Select a file.
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5. Select the following options as needed: 

• Refresh: Displays the updated information.

• List: Lists the files that are stored in the folder. Additional file information, such as date stored and number 
of pages, is listed.

• Thumbnail: Displays the images and names of the files stored in the folder.

• Select All Files: Select or deselect all of the files in the folder.

• Review: Displays the settings for the selected file.

• Delete: Delete the selected files in the folder.

• Copy / Move: Preview and check details for the selected file and copy or move the file to another folder.

• Edit Pages: Insert a file or separator pages.

• Merge / Batch Print: Merge multiple files in the folder, then batch-print the files.

• Change Settings / Print: Change the file settings before you print the files.

Deleting Files

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select a folder.

4. Select a file, then touch Delete.

5. To confirm the deletion, touch Delete.

Copying and Moving Files Between Folders

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select a folder.

4. Select a file, then touch Copy / Move.

5. Select an option: 

• Whole Page: Select whether to display the whole page or to enlarge the image by 200%.

• Rotation: Select an angle from which to preview the image: Right 90 degrees, Left 90 degrees, or 180 
degrees.

• Change File Name: Change the file name.

• Apply To: To preview a specific page on the screen, use the Plus (+) and Minus (-) buttons or type the page 
number on the numeric keypad.

• Copy: Copy files from one folder to another folder.

• Move: Move files from one folder to another folder.
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Copy

To copy a file from one folder to another folder:

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select the folder that contains the file to be copied.

4. Select a file, then touch Copy / Move.

5. Touch Copy.

6. Select the destination folder for the copied file, then touch Save.

Move

To move a file from one folder to another folder:

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select the folder that contains the file to be moved.

4. Select a file, then touch Copy / Move.

5. Touch Move.

6. Select the destination folder for the file, then touch Save.

Editing Files

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then. From the list, select a folder.

4. Select a file, then touch Edit Pages.

5. Select an option: 

• Insert Separators

• Chapter Start + Insert File

• Insert File

• Add to Delete List

• Edit List / Delete Pages

Insert Separators

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select a folder.

4. Select a file, then touch Edit Pages.

5. Touch Insert Separators.
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6. Select a paper tray from which the separators are to be inserted.

7. To enter the number of separators to be inserted, use the Plus (+) and Minus (-) buttons or type the number on 
the numeric keypad, then touch Save.

Chapter Start and Insert File

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then touch Chapter Start + Insert File.

5. Select the file that you want to insert, then touch Save.

6. Touch Insert File.

7. Select the file that you want to insert, then touch Save.

Insert File

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select the folder that contains the file to be inserted.

4. Select a file, then touch Insert File.

5. Select the file that you want to insert, then touch Save.

Add to Delete List

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select a folder.

4. Select a file, then touch Edit Pages.

5. To select the page that you want to delete, use the numeric keypad, then touch Add to Delete List.

6. Touch Edit List / Delete Pages.

7. Touch Delete.

Edit List / Delete Pages

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select a folder.

4. Select a file, then touch Edit Pages.

5. Select Edit List / Delete Pages

6. Select Delete.
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Merging and Batch Printing Files in a Folder

You can merge multiple files that are stored in a folder on the Copy & Print Jobs tab, then batch-print the files.

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select a folder.

4. Select two or more files, then touch Merge / Batch Print.

5. Select print options. To specify the number of prints, use the numeric keypad.

6. Touch Merge, Merge & Print, or Print.

File Details

Use this option to check the content of selected files.

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file.

5. Touch Review. The file settings appear.

Merge

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then touch Merge / Batch Print.

5. Touch Merge.

6. Select an option: 

• Delete Source Files

• Keep Source Files

• Cancel

Merge and Print

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then touch Merge / Batch Print.

5. Touch Merge & Print.
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6. Select an option: 

• Delete Source Files

• Keep Source Files

• Cancel

Separators

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then touch Merge / Batch Print.

5. Touch Separators.

6. Select an option: 

• No Separators

• Blank Separators

• Printed Separators

• No Chapter Start

• Separator Tray

• Separator Quantity

Covers

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select a folder.

4. Select a file, then touch Change Settings / Print.

5. Touch Covers.

6. Select Last Saved Settings or Change Settings.

7. If you selected Change Settings, select an option: 

• Front Cover:  
This option cancels the front cover settings for the source files and reprograms the front cover settings for 
the newly merged file.

• Back Cover: This option cancels the back cover settings for the source files and reprograms the back cover 
settings for the newly merged file.

• Front Cover Quantity: Specify the number of blank sheets to be used as front covers.

• Back Cover Quantity: Specify the number of blank sheets to be used as back covers.

• Paper Supply: From Front Cover Tray and Back Cover Tray, select the trays for front covers and back covers.
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Watermark

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then select an option.

5. Touch Watermark, then touch Change Settings.

6. Select an option: 

• Control Number: To print control numbers, select this option, then touch Add. Select or type a value for the 
control number in the range from 1–9999, then touch Save.

• Stored Watermarks: To select the text that prints on copies from a predefined list of watermarks, select 
this option. Touch Add, then touch Save.

• Date & Time: To print the current date and time, select this option. Touch Add, then touch Save.

• Serial Number: To print the device serial number, select this option. Touch Add, then touch Save.

• Watermark Effect: To print a watermark on the output, select this option. Select Embossed or Outline, 
then touch Save.

File Name

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then touch Change Settings / Print.

5. Select the check box for Save As.

6. Touch Save.

7. Type a file name using the onscreen keyboard.

Output

After merging files, use this option to program stapling, hole-punching, and Z-fold settings.

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select a folder.

4. Select a file, then touch Change Settings / Print.

5. Touch Output.
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6. Select an option: 

• Paper Supply

• Staple

• Hole Punch

• Output

• Output / Offset / Subset

• Offset Stacking

• Subset Finishing / Pad Printing

7. Touch Save.

Annotations

You can add a comment, date, and page numbers to copies. From preset formats, you can select a comment, date, 
and page numbers, and select their print positions on a page.

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select a folder.

4. Select a file, then touch Change Settings / Print.

5. Touch Annotations.

6. Touch Last Saved Settings or Change Settings.

7. If you selected Change Settings, select an option: 

• Format & Style

• Comment

• Date

• Page Numbers

• Bates Stamp

Secure Watermark

Secure Watermark is a security-management feature to embed a copy-protection digital code into a document, to 
restrict the document duplication. The digital code enables you to analyze when, from which device, and by whom 
the document was output.

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then select an option.

5. Touch Secure Watermark.
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6. Select an option: 

• Last Saved Settings

• Off

• On 

• Protection Code: Select Off or Prevent Duplication.

• Stored Secure Watermarks: This screen allows you to embed hidden text into documents. With this 
hidden-text feature, the specified text is embedded in the entire sheet. When you copy a document that 
has been copied with this hidden-text feature, the embedded text on the output appears in white, 
regardless of whether the optional Secure Watermark Kit is installed.

PRINTING FILES FROM A FOLDER

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then select Change Settings / Print.

5. Select any option, then use the numeric keypad to specify the needed number of prints.

6. Select one of the following options: 

• Save

• Save & Print

• Print

File Details

Use this option to check the content of selected files.

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file.

5. Touch Review. The file settings appear.

Output

After merging files, use this option to program stapling, hole-punching, and Z-fold settings.

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select a folder.

4. Select a file, then touch Change Settings / Print.
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5. Touch Output.

6. Select an option: 

• Paper Supply

• Staple

• Hole Punch

• Output

• Output / Offset / Subset

• Offset Stacking

• Subset Finishing / Pad Printing

7. Touch Save.

Covers

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select a folder.

4. Select a file, then touch Change Settings / Print.

5. Touch Covers.

6. Select Last Saved Settings or Change Settings.

7. If you selected Change Settings, select an option: 

• Front Cover:  
This option cancels the front cover settings for the source files and reprograms the front cover settings for 
the newly merged file.

• Back Cover: This option cancels the back cover settings for the source files and reprograms the back cover 
settings for the newly merged file.

• Front Cover Quantity: Specify the number of blank sheets to be used as front covers.

• Back Cover Quantity: Specify the number of blank sheets to be used as back covers.

• Paper Supply: From Front Cover Tray and Back Cover Tray, select the trays for front covers and back covers.

Folding

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then touch Change Settings / Print.

5. Touch Folding.

6. Touch Fold / Crease.
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7. Select an option: 

• Last Saved Settings

• Off

• Fold Only

• Crease Only

8. If you selected Fold Only, select one of the following options: 

• Single Fold

• C Fold

• Z Fold

• Z Fold Half Sheet

Note: The icons on the button depict how the fold appears.

9. If you selected Crease Only, select one of the following options: 

• Single Fold

• C Fold

• Z Fold

• Z Fold Half Sheet

• Double Gate Fold

• Double Parallel Fold

• 3Fold Accordion Fold

• 4Fold Accordion Fold

• 5Fold Accordion Fold

10. Touch Save.

2 Sided Printing

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Touch Copy & Print Jobs, then select a folder.

4. Select a file, then touch Change Settings/Print.

5. Touch 2 Sided Printing.
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6. Select an option: 

• Last Saved Settings

• 1 Sided

• Head to Head: Select this option when the front and back sides of the document are in the same 
orientation.

• Head to Toe: Select this option when the front and back sides of the document are in opposite 
orientations.

7. Touch Save.

Image Shift

Use this option to set a margin of white space on the top, bottom, left, and right of your copy. If you make 2-sided 
copies, you can set the image shift for Side 1 and Side 2 individually.

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then touch Change Settings / Print.

5. Touch Image Shift.

6. Select one of the following options: 

• Last Saved Settings

• Margin Shift

7. If you selected Margin Shift, select one of the following options: 

• Side 1

• Side 2

8. To adjust the margins for each side, press the Plus (+) or Minus (-) icons. 

9. If side 2 margins are the same as side 1, touch the check box for Mirror Side 1.

10. Touch Save.

Booklet Creation

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then select an option.

5. Touch Booklet Creation.
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6. Select an option: 

• Last Saved Settings

• Off 

Note: Depending on paper settings, the Off setting may not be available.

7. Select Save.

Annotations

You can add a comment, date, and page numbers to copies. From preset formats, you can select a comment, date, 
and page numbers, and select their print positions on a page.

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab. From the list, select a folder.

4. Select a file, then touch Change Settings / Print.

5. Touch Annotations.

6. Touch Last Saved Settings or Change Settings.

7. If you selected Change Settings, select an option: 

• Format & Style

• Comment

• Date

• Page Numbers

• Bates Stamp

Watermark

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then select an option.

5. Touch Watermark, then touch Change Settings.
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6. Select an option: 

• Control Number: To print control numbers, select this option, then touch Add. Select or type a value for the 
control number in the range from 1–9999, then touch Save.

• Stored Watermarks: To select the text that prints on copies from a predefined list of watermarks, select 
this option. Touch Add, then touch Save.

• Date & Time: To print the current date and time, select this option. Touch Add, then touch Save.

• Serial Number: To print the device serial number, select this option. Touch Add, then touch Save.

• Watermark Effect: To print a watermark on the output, select this option. Select Embossed or Outline, 
then touch Save.

Face Up/Down Output

Use this option to select prints are delivered face up or face down.

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then select an option.

5. Touch Face Up/Down Output.

6. Select an option: 

• Last Saved Settings

• Auto: Determines automatically if the copies should be delivered face up or face down.

• Face Up: Copies are delivered face up from the last page.

• Face Down: Copies are delivered face down from the last page.

• Face Up (Reverse Order): Copies are delivered face up from the first page.

7. Touch Save.

Add Tab Stock

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Copy & Print Jobs tab, then select a folder.

4. Select a file, then touch Change Settings / Print.

5. Touch Add Tab Stock.
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6. Select an option: 

• Last Saved Settings

• On

• Off

• Number of Sheets

7. Touch Save.

SCAN & OTHER JOBS TAB

Selecting a Folder

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Scan & Other Jobs tab, then select a folder.

Checking or Executing Operations on Files

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Scan & Other Jobs tab.

4. From the list, select a folder. The File List screen appears and shows the files as thumbnails. To display the files 
as a list, from the Thumbnail / List setting, select List.

5. Select one or more files. To select all files, select Select All.

6. Select options as needed: 

• Refresh: Refreshes the list of folders.

• Review: Displays the settings of the selected file.

• Delete: Deletes the selected files.

• File Details (Preview): Shows a preview of the file. You can rotate the image, delete the file, or change the 
file name.

• Job Flow Settings: Link a job flow sheet to the folder, change settings for a linked job flow sheet, unlink a 
job flow sheet, execute a different job flow sheet for this job only, set the job flow to start automatically, or 
execute the currently linked job flow sheet. For details, refer to Job Flow.

• Print or Batch Print: Print the selected files.

Checking File Details

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. On the Folder - File List screen, select a file.
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4. Touch File Details (Preview).

5. Select an option: 

• Rotate View

• Delete

• Change File Name

• Change Print Settings

• Print

Printing Files

1. At the control panel, press the Services Home button.

2. Touch Send from Folder.

3. Select the Scan & Other Jobs tab.

4. On the Folder - File List screen, select files.

5. Touch Print or Batch Print.

6. Select an option. If necessary, to type the number of prints, use the numeric keypad.

7. Touch Print.

Configuring or Starting a Job Flow

For detailed information on job flow, refer to Job Flow.

Job Flow is a feature that allows you to register transfer settings of scan data, such as a transfer method and 
destination, to simplify data-transfer tasks.

Job flow sheets are categorized into two types according to the target. One type of job flow sheet targets files 
stored in folders, and the other type of job flow targets scan files. This section describes the first type of job flow 
sheet, targeting files stored in folders.

You can execute a job flow on files stored in a folder. You can configure the job flow to start automatically or you 
can start the job flow manually: 

• Automatic: To start a job flow automatically: 

1. Ensure that the job flow sheet is linked to a folder. For details, refer to Linking a Job Flow Sheet to a Folder.

2. Select Auto Start.

When files are stored in the linked folder, the files are processed automatically using the parameters established 
in the job flow sheet.

• Manual: For details on starting a job flow manually, refer to Starting a Job Flow Manually.

Link Job Flow Sheet to Folder

You can link a job flow sheet to a folder using the following procedure or from the Tools tab in the Machine Status 
menu. For details, refer to Linking a Job Flow Sheet to a Folder.

1. At the control panel, press the Services Home button.
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2. Touch Send from Folder.

3. Select the Scan & Other Jobs tab.

4. Touch Job Flow Settings.

5. Touch Create / Change Link.

6. Select a job flow sheet to link to the folder.

7. Touch Save.

Job Flow Restrictions

A job flow sheet can be used by only one user, can be shared by multiple users, or can be used for only certain 
folders.
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Job Flow

JOB FLOW OVERVIEW

A job flow sheet allows you to process documents that are stored in private folders. A job flow is started in the 
following ways: 

• Automatically when a document is linked to a folder

• Manually by selecting a job flow sheet to act on documents that are stored in a folder

To start a job flow, link a specific job flow sheet to a folder. When a job flow is set to start automatically, documents 
are processed automatically by the job flow sheet when the files appear in the folder.

The following conditions apply to job flow sheets: 

• You can create job flow sheets, which you can then execute, modify, duplicate, or delete, as needed. You can 
perform these actions only from the private folder in which you created the job flow sheet.

• You can register the following types of document-processing in a job flow sheet: 

– Specifying destinations to FTP, SMB, and email 

– Specifying multiple destinations and batch processing 

– Printing 

The document-processing types that you can register in a job flow sheet depend on how the documents are stored 
in a private folder. Refer to the following chart:

INPUT

OUTPUT

PRINTER EMAIL FTP SMB

Scan Yes Yes Yes Yes

Print Stored Yes No No No

• Only the job flow sheets that you have permission to execute are shown.

• The job flow sheet feature is available only when the Network Scanning Kit is installed on the device.

Note: For additional job flow sheet information, including authentication and folders, refer to the Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide.

JOB FLOW SHEETS

Creating a Job Flow Sheet

1. At the control panel, press the Machine Status button.

2. On the Tools tab, touch Setup > Setup > Create Job Flow Sheet.

3. Touch Create.
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4. On the Create New Job Flow Sheet screen, specify the settings for the new Job Flow Sheet. From the list, select 
the item for which you want to specify settings, then touch Edit. For descriptions of the settings, refer to Job 
Flow Sheet Settings.

5. To save the Job Flow Sheet, touch Save. 

Note: The Save option is available only if a value is set in any of the following fields: Send as Email, Transfer 
via FTP, Transfer via SMB, and Print.

6. To exit the Create Job Flow Sheet screen, touch Close.

Job Flow Sheet Settings

You can specify the settings for a job flow sheet.

With the job flow sheet open, select the item for which you want to specify settings, then touch Edit.

Name

You can set the name for the job flow. Use a maximum of 128 characters.

Description

Set the description of the job flow using a maximum of 1023 characters. To view the entire description, touch the i 
icon.

Keyword

Set the keyword for the job flow using a maximum of 12 characters. You can use the keyword to search for all job 
flow sheets to which that keyword is assigned. To assign a keyword to the job flow, use one of the following options:

• In the Keyword field, type the keyword, then touch Save.

• Touch Select Keyword. From the list, select a keyword. Touch Close, then touch Save. 

Note: The administrator defines the keywords for the keyword list. The Select Keyword option is 
available only when your administrator has defined one or more keywords.

Send as Email

To send a file as email, specify the recipients for the email. You can specify up to 100 addresses. You can select 
recipients using the address book item numbers or by typing recipient names on the control panel touch screen 
keypad.

• Address Book: You can specify email recipients from the address book. The specified recipient appears on the 
Send as Email screen in the Recipient Name / Email Address field.

• New Recipient: You can specify a new email recipient. The recipient appears on the Send as Email screen in the 
Recipient Name / Email Address field. You can change the following settings: 

– Subject: You can type a subject for the email. 

– Remove: You can delete all information for the selected recipients. 

– Edit: You can confirm or change information for the selected recipients. 

• File Format: You can specify the file format for the scanned output.

• Resend Attempts: You can set the number of times to resend an email or you can disable this feature.
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Transfer via FTP (1) and Transfer via FTP (2)

Specify the server to which documents that use FTP protocols are sent. To edit information, select a setting. The 
maximum number of characters allowed are as follows:

• Name: 18 characters

• Server: 64 characters

• Save in: 128 characters

• User Name: 97 characters

• Password: 32

Note: The option Transfer via FTP (2) is available only if the option Transfer via FTP (1) is configured.

• Address Book: When the server address is registered in the address book, you can use the address book to 
specify the address. The address appears on the FTP Transfer screen.

• Resend Attempts: You can set the number of times and the frequency that the device attempts to resend the 
information.

• File Format: You can select a file format option for the scanned output. 

– TIFF / JPEG Auto Select 

– TIFF (File for Each Page) 

– mTIFF (Multi-Pages per File) 

– PDF: Options include PDF Security, PDF Signature, and Optimization For Quick Web View. 

– PDF/A 

– XPS: Options include XPS Signature and Add Thumbnail. 

Transfer via SMB (1) and Transfer via SMB (2)

Specify the server where the documents that use SMB protocols are sent. To add information, select a setting. The 
maximum numbers of characters allowed are as follows:

• Name: 18 characters

• Server: 64 characters

• Shared Name: 18 characters

• Save in: 128 characters

• User Name: 97 characters

• Password: 32 characters

Note: The option Transfer via SMB (2) is available only if the option Transfer via SMB (1) is configured.

• Address Book: When the server address is registered in the address book, you can use the address book to 
specify the address. The address appears on the SMB Transfer screen.

• Resend Attempts: You can set the number of times and the frequency that the device attempts to resend the 
information.

• File Format: You can select a file format option for the scanned output. 
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– TIFF / JPEG Auto Select 

– TIFF (File for Each Page) 

– mTIFF (Multi-Pages per File) 

– PDF: PDF options include PDF Security, PDF Signature, and Optimization For Quick Web View. 

– PDF/A 

– XPS: Options include XPS Signature and Add Thumbnail. 

Print

Set printing options for the linked job flow sheet. To disable the print feature, touch Off.

Email Notification

You can set recipients and notification options for the linked job flow sheet.

• Address Book: You can select one or more recipients for email notifications.

• New Recipient: You can specify a recipient that is not found in the Address Book.

• When to Notify: You can set the following notification conditions: 

– At the end of Job Flow: When this option is enabled, after a job flow operation completes, recipients receive 
an email notification. 

– Error Only: When this option is enabled, when an error occurs, recipients receive an email notification. 

Editing or Deleting Settings for a Job Flow Sheet

1. At the control panel, press the Machine Status button.

2. On the Tools tab, touch Setup > Setup > Create Job Flow Sheet.

3. On the Create New Job Flow Sheet screen, select the job flow sheet for which you want to edit or delete 
settings.

4. Touch Edit / Delete.

5. On the Details screen, touch Edit.

6. On the Edit Job Flow Sheet screen, select the item for which you want to edit or delete settings. For descriptions 
of the settings, refer to Job Flow Sheet Settings. 

• To edit the settings for the selected item, touch Edit, change the settings as needed, then touch Save.

• To delete the settings for the selected item, touch Delete. At the prompt, touch Delete.

7. To save the changes to the job flow sheet, touch Save.

8. To exit the Create Job Flow Sheet screen, touch Close.

Copying a Job Flow Sheet

To create a job flow sheet based on an existing job flow sheet, you can use the Copy function. You can rename the 
copy and change other settings as needed, then save the copy as a new job flow sheet.

1. Press the Machine Status button.
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2. On the Tools tab, touch Setup > Setup > Create Job Flow Sheet.

3. On the Create New Job Flow Sheet screen, select the job flow sheet that you want to copy.

4. Touch Edit / Delete.

5. On the Details screen, touch Copy.

6. On the Copy Job Flow Sheet screen, change the name for the new job flow sheet, then touch Save. The new 
job flow sheet is created.

7. To change the settings for the new job flow sheet, select the item that you want to change, then edit the 
settings as needed. For details, refer to Editing or Deleting Settings for a Job Flow Sheet.

8. Touch Save. The new job flow sheet appears in the job flow sheet list.

9. To exit the Create Job Flow Sheet screen, touch Close.

Deleting a Job Flow Sheet

1. At the control panel, press the Machine Status button.

2. On the Tools tab, touch Setup > Setup > Create Job Flow Sheet.

3. On the Create New Job Flow Sheet screen, select the job flow sheet that you want to delete.

4. Touch Edit / Delete.

5. On the Details screen, touch Delete. At the prompt, touch Delete.

6. To exit the Create Job Flow Sheet screen, touch Close.

Locating a Job Flow Sheet Using the Search Function

To locate a job flow sheet quickly, you can search using the following methods: 

• Search by Name: You can use all or part of the job flow sheet name.

• Search by Keyword: You can use keywords. There are two ways to search by keyword: 

– You can type a keyword into the Search by Keyword field. 

– You can use Select Keyword. This option allows you to choose a keyword from the list of keywords that was 
set up by your administrator. 

Note: If your administrator has not defined any keywords, the Select Keyword option is not available.

To search for a job flow sheet:

1. At the control panel, press the Machine Status button.

2. On the Tools tab, touch Setup > Setup > Create Job Flow Sheet
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3. Select a search method: 

• Search by Name: In the Search by Name field, type all or part of the job flow sheet name. 

Note: The Search by Name field is case-sensitive. For example, if you are looking for a job flow sheet named 
Accounting Department, you can type Accounting or Department in the Search by Name field. If you 
type accounting in the Search by Name field, the Accounting Department job flow sheet is not listed in 
the results.

• Search by Keyword: Choose a keyword search option: 

• In the Search by Keyword field, type the keyword that is assigned to the job flow sheet that you want to 
locate.

• Touch Select Keyword. From the list, select a keyword.

4. Touch Save.

You can restrict your search results using sheet filtering. For details, refer to Job Flow Sheet Filtering.

Job Flow Sheet Filtering

You can filter job flow sheets by user type.

1. At the control panel, press the Machine Status button.

2. On the Tools tab, touch Setup > Setup > Create Job Flow Sheet.

3. Touch Sheet Filtering.

4. On the Sheet Filtering screen, select the filtering options: 

• Owner: 

• System Administrator: Lists only job flow sheets that are available to users who have administrator 
permissions.

• Non-System Administrator: Lists only job flow sheets that are available to users who do not have 
administrator permissions.

Note: If you select both the System Administrator and the Non-System Administrator options, all job flow 
sheets are listed.

• Target: The target for job flow sheets is Folders. To view job flow sheets, select Folders.

5. Touch Save.

FOLDERS

Creating a Folder

To create a folder:

1. At the control panel, press the Machine Status button.

2. On the Tools tab, touch Setup > Setup > Create Folder.

3. Select an available folder.
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4. On the New Folder - Passcode screen, select a passcode option: 

• Off: Access to the folder does not require a passcode. All users are allowed access to the folder.

• On: Access to the folder requires a passcode. Users are required to type the passcode when starting the job 
flow process on the folder. 

1. In the Folder Passcode field, using the numeric keypad on the control panel, type a passcode of up to 20 
digits.

2. In the Target Operation field, select a passcode restriction option: 

• Always (All Operations): A passcode is required for all job flow sheet access to the folder.

• Save (Write): When a user attempts to edit any document in the folder, the user is prompted to 
type a passcode.

• Print / Delete (Read): When a user attempts to print or delete any document in the folder, the user 
is prompted to type a passcode.

5. Touch Save.

6. From the list, select an item for which you want to add or edit information: 

• Folder Name: Type a folder name of up to 20 characters.

• Check Folder Passcode: This option allows you to review and edit the folder passcode setting.

• Delete Documents After Retrieval: This option specifies if documents are deleted from the folder after 
they are printed or retrieved, or after they are transferred and printed through a job flow sheet.

• Delete Expired Files: This option specifies if documents are deleted from the folder after a preset period of 
time elapses. This time period is set by the administrator.

• Link Job Flow Sheet to Folder: To link a job flow sheet to the folder, select this option. Refer to Linking a 
Job Flow Sheet to a Folder.

7. To save the new folder, touch Close.

Linking a Job Flow Sheet to a Folder

You can link a job flow sheet to a folder. The linked job flow sheet directs how the documents in the folder are 
processed.

To link a job flow sheet to a folder:

1. At the control panel, press the Machine Status button.

2. On the Tools tab, touch Setup > Setup > Create Folder.

3. From the list, select a folder. If you need to create a new folder, refer to Creating a Folder.

4. Select Link Job Flow Sheet to Folder.

5. On the Link Job Flow to Folder screen, touch Create / Change Link.

6. Select the job flow sheet that you want to link to the folder, then touch Save. The Link Job Flow Sheet to Folder 
screen appears. 

Note: To search for a specific job flow sheet, refer to Locating a Job Flow Sheet Using the Search Function.
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7. To set the job flow sheet to execute automatically when a new document is saved to the folder, select Auto 
Start. If you do not select Auto Start, you are required to execute the job flow manually. For details, refer to 
Starting a Job Flow Manually.

8. Touch Close. The job flow sheet is linked to the folder.

9. To exit, touch Close again.

Unlinking a Job Flow Sheet from a Folder

To cut the link between a job flow sheet and a folder:

1. At the control panel, press the Machine Status button.

2. On the Tools tab, touch Setup > Setup > Create Folder.

3. From the list, select the folder that you want to unlink from the linked job flow sheet.

4. On the Create / Delete screen, select Link Job Flow Sheet to Folder.

5. On the Link Job Flow Sheet to Folder screen, touch Cut Link.

6. To confirm the link cut, at the prompt, touch Yes. The link between the folder and the job flow sheet is 
removed.

7. Touch Close.

Deleting a Folder

Note: When deleting a folder, all files in the folder are deleted. If a job flow sheet is linked to the folder, the 
job flow sheet is deleted.

To delete a folder:

1. At the control panel, press the Machine Status button.

2. On the Tools tab, touch Setup > Setup > Create Folder.

3. On the Create Folder screen, select the folder that you want to delete.

4. Touch Delete Folder.

5. At the prompt, touch Delete.

STARTING A JOB FLOW MANUALLY

If a job flow sheet was not set to Auto Start when the job flow sheet was linked to a folder, you are required to start 
the job flow manually.

1. At the control panel, press the Services button.

2. Touch Send from Folder.

3. Select the Scan & Other Jobs tab.

4. From the list, select a folder.
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5. On the File List screen, select one or more files. 

Note: If there are no files in the folder, scan and store a file to the folder. For details, refer to Store to Folder.

6. After selecting files, you can view the file settings or make changes to the way that the files are processed. 

a. Select an option, then make the necessary changes. 

• Review: View the file settings.

• Delete: Delete the selected files from the folder.

• File Details (Preview): Preview the file, rotate the file, change the file name, change the print settings, 
or delete the file.

• Job Flow Settings: You can link a new job flow sheet or a different job flow sheet to the folder. You 
can disconnect the link to the currently linked job flow sheet or select a temporary job flow sheet that 
executes on this job only. To modify settings before executing the job flow, perform any of the 
following options, as needed: 

– To disconnect the job flow sheet from the folder, touch Cut Link. 

– To link a different job flow sheet to the folder, touch Create / Change Link, select a job flow sheet 
or create a new job flow sheet, then touch Save. 

– To link a different job flow sheet to the folder for this job only, touch Select Job Flow Sheet, select 
a job flow sheet to execute on this job, then touch Close. 

– To instruct the selected job flow to execute automatically when a file is saved to the folder, select 
Auto Start. 

• Print: Print the selected file or change print settings for the file.

• Batch Print: Print all of the selected files or change print settings for all of the selected files.

b. Touch Close.

7. To execute the job flow, touch Job Flow Settings, then touch Start Current Job Flow. 

The job flow sheet executes the job flow on the files that you selected in the folder.

8. To close the folder, touch Close.
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Fax Overview

Faxing is an optional feature of your multi-function printer. It can be configured in a variety of different ways to 
offer you the most convenient method for faxing an original document. 

• EEmmbbeeddddeedd FFaaxx: A document is scanned at the multi-function printer and sent directly to a fax machine.

• IInntteerrnneett FFaaxx: A document is scanned at the multi-function printer and emailed to a recipient.

• FFaaxxiinngg ffrroomm yyoouurr CCoommppuutteerr: Using the settings in the print driver, the current print job is sent as a fax.

Note: Fax capability must be enabled by the System Administrator before use. For details, refer to the 
System Administrator Guide.
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Loading Documents

There are two methods to load documents: 

• Document feeder: Use the document feeder to print or scan a single sheet or multiple sheets.

• Document glass: Use the document glass to print or scan a single sheet or a bound book.

1. Before you load the document, remove any paper clips and staples.

2. Load the document using the appropriate method: 

• Document feeder: Load the document face up, then adjust the document guides to match the size of the 
document that you loaded.

• Document glass: Load the document face down, position the document using the rulers and size guides, 
then close the scanner cover.

Note: Users can scan up to 5000 impressions per job.
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Sending a Fax

To send a fax using the multifunction printer Embedded Fax:

1. Load the original document on the document glass or in the document feeder.

2. At the control panel, press Services Home.

3. Touch Fax.

4. To enter the recipient fax number manually, do one of the following: 

• Enter the fax number using the alphanumeric keypad, then touch Add. 

To enter pauses in the fax number, refer to Inserting Pauses in Fax Numbers.

• Touch New Recipients, enter the number using the touch screen keyboard, touch Add, then touch Close.

5. To use a number previously stored in the Address Book: 

a. Touch Address Book.

b. Select an option from the list.

c. Touch the arrows to scroll through the list.

d. Touch the needed address.

e. Touch Add, then touch Close.

Note: To use the address book, addresses are required in the Address Book . For details, refer to Adding 
Address Book Entries.

Note: Chain Dial can be performed when viewing the list of individual addresses in the Address Book. 
For details, refer to Using Chain Dial.

6. To include a cover page: 

a. Touch Cover Page, then touch Print Cover Page.

b. To add a previously created comment, touch Comments. You can add a previously created comment for 
Recipient's Comment or Sender's Comment. Touch an available comment, then touch Save. For details, refer 
to Creating Fax Comments.

c. Touch Save.

7. Adjust fax options if necessary. For details, refer to Selecting Fax Settings.

8. Press the green Start button. The printer scans the pages and transmits the document when all pages are 
scanned.

IInnsseerrttiinngg PPaauusseess iinn FFaaxx NNuummbbeerrss

Some fax numbers require one or more pauses during the dialing sequence. To insert a pause in a fax number:

1. Using the alphanumeric keypad, begin entering the fax number.

2. To insert a pause, represented by a hyphen, in the required location, press the Dial Pause button.

3. Continue entering the fax number.
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Sending an Internet Fax

If an SMTP email server is connected to the network, a document can be sent to an email address. This feature 
eliminates the need for a dedicated telephone line. When sending an Internet Fax, the document is scanned and 
sent to an email address.

Note: The Internet Fax service must be enabled before use, and an SMTP server requires configuration. For 
more information, refer to the Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press System 
Administrator Guide.

To send an Internet Fax: 

1. Place the original document on the document glass or in the document feeder.

2. On the printer touch screen, touch Services Home, then touch Internet Fax.

3. Touch New Recipient.

4. To enter the recipient email address, do one of the following: 

• Enter the address using the touch screen keyboard, then touch Add. Repeat for each recipient, then touch 
Close.

• Touch Address Book, touch the needed address in the scroll list, then touch Add. When all recipients have 
been added, touch Close.

5. Adjust fax options if necessary. For details, refer to Selecting Fax Settings.

6. Press the green Start button. The printer scans the pages then sends the document as an email attachment 
when all pages have been scanned.
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Faxing from Your Computer

A document stored on your computer can be sent as a fax using the print driver.

Note: To fax from your computer, fax must be installed in the multi-function printer and enabled by the 
System Administrator.

1. In your software application, click File, then Print.

2. Select your printer from the list.

3. Access the print driver settings by selecting Properties or Preferences (Windows), or Xerox Features for 
Macintosh. The title of the button may vary depending on your application.

4. Select printer features. 

• Windows: Click the Paper/Output tab.

• Macintosh: Click Copies and Pages, then click Xerox Features.

5. Click the Job Type menu, then click Fax.

6. Click Add Recipients.

7. Enter the recipient's name and fax number. If desired, complete the additional information.

8. If desired, click the Cover Sheet tab, choose an option, then click OK.

9. If desired, click the Options tab, choose your options, then click OK.

10. Click OK.

11. Send the fax: 

• Windows: Click OK.

• Macintosh: Click Print.

For details, click the Help button in the Fax window.

136 Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide

Faxing



Receiving Faxes

Printer configuration is required before you can receive and print a fax using the Embedded Fax and Internet Fax. 
For system configuration, contact your system administrator. For more information, refer to the Xerox® PrimeLink® 

B9100/B9110/B9125/B9136 Production Press System Administrator Guide.
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Selecting Fax Settings

SETTING 2-SIDED FAXING

1. On the touch screen, touch Fax.

2. Touch 2–Sided Scanning, then touch the needed option: 2–Sided or 2–Sided, Rotate Side 2.

SELECTING THE ORIGINAL TYPE

1. Touch Fax on the touch screen.

2. Touch Original Type, then touch the desired option (Text, Photo and Text, Photo).

SETTING THE FAX RESOLUTION

1. Touch Fax on the touch screen.

2. Touch Resolution, then touch the desired option: 

• Standard 200x100 dpi 

• Fine 200 dpi 

• Super Fine 400 dpi 

• Super Fine 600 dpi 

Note: For Server Fax, touch Standard or Fine.

ADJUSTING LAYOUT

Layout settings allow you to adjust the original size, set page scanning for book faxing, and reduce or enlarge the 
fax image.

Adjusting the Original Size

1. Touch Fax on the touch screen.

2. Touch the Layout Adjustment tab, then touch Original Size.

3. Touch one of the following: 

• Auto Detect, to automatically identify standard size originals.

• Manual Size Input, for manual definition of the scan area using standard paper dimensions.

• Mixed Size Originals, for scanning originals of different standard sizes.

4. Touch Save.

Book Faxing

1. Touch Fax on the touch screen.
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2. Touch the Layout Adjustment tab, then touch Book Faxing.

3. Touch one of the following options: 

• Off (Default).

• Left Page then Right, then touch Both Pages, Left Page Only or Right Page Only.

• Right Page then Left, then touch Both Pages, Left Page Only or Right Page Only.

• Top Page then Bottom, then touch Both Pages, Top Page Only or Bottom Page Only.

4. Touch Save.

Reduce/Enlarge

1. Touch Fax on the touch screen.

2. Touch the Layout Adjustment tab, then touch Reduce/Enlarge.

3. Touch a preset percentage, or touch the plus or minus buttons to specify a variable percentage.

4. Touch Save.

Lighten/Darken

1. Touch Fax on the touch screen.

2. Touch the Layout Adjustment tab, then touch Lighten/Darken.

3. Adjust the settings to lighten or darken the fax.

4. Touch Save.

FAX OPTIONS

The Fax Options tab contains options that allow you to specify how the fax is transmitted.

Note: With the exception of Priority Send/Delay Start, these settings are not available for Server Fax.

To adjust these settings: 

1. On the touch screen, touch Fax, then touch the Fax Options tab.

2. Touch the desired option, touch the desired settings, then touch Save.

OPTION VALUES 

Confirmation Options Off/On; print report after each fax transmission. 

Starting Rate G3 Auto, Forced 4800 bps 

Priority Send/Delay Start Priority Send: Off/On; Delay Start: Off, Specific Time (touch Specific 
Time and then touch desired settings) 

Transmission Header Text Off, Display Header 

Recipient Print Sets 1 Set, Multiple Sets (touch Multiple Sets, then touch plus or minus 
buttons to set quantity) 
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OPTION VALUES 

Pages per Side Off/On (touch plus or minus buttons to set quantity) 

Remote Folder Send to Folder: Off/On, Folder Number, Folder Passcode (enables 
sending a file directly to a folder on a remote fax machine by setting 
the Folder Number and Folder Passcode using the alphanumeric 
keypad) 

F Code Off/On (F Code is a file transmission method enabled by setting the F 
Code and Folder Password using the alphanumeric keypad or touch 
screen keyboard) 

MORE FAX OPTIONS

Further optional fax settings are provided. To adjust these settings: 

1. On the touch screen, touch Fax, then touch the More Fax Options tab.

2. Touch the desired option, touch the desired settings, then touch Save.

Note: These settings are not available for Server Fax.

OPTION VALUES 

Remote Polling Off, poll a Remote Device (retrieve files stored on a remote fax 
machine by using the Remote Folder feature) 

Store for Polling Off, Store for Free Polling and Store for Secure Polling (fax 
documents stored in the printer are made available for remote 
polling by enabling Free Polling or Secure Local Polling, then 
touching the folder and file) 

On-Hook (Manual Send/Receive) Manual Send: touch On-Hook, touch Manual Send, then use the 
touch screen keyboard to enter destination and passcode Manual 
Receive: touch On-Hook, touch Manual Receive, then press green 
Start button 

INTERNET FAX OPTIONS

Additional Internet Fax options are provided. To make these settings:

1. On the touch screen, touch Internet Fax, then touch the Internet Fax Options tab.

2. Touch the desired option, touch the desired settings, then touch Save.

Note: For details, refer to the System Administrator Guide.
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OPTION VALUES 

Acknowledgement Report Confirmation Options: Off, print report after each fax transmission Read 
Receipts: request read receipt from recipient’s fax server to be sent to 
sender indicating the result of the transmission; recipient’s server must 
support the MDN standard. 

Internet Fax Profile TIFF-S: use for A4, 210 x 297mm (8.5 x 11 in.) originals with Standard or 
Fine Resolution TIFF-F or TIFF-J: use for A3, 297x420mm (11 x 17 in.) 
originals with Superfine Resolution 

Pages per Side Off, On (touch plus or minus buttons to set quantity) 

Starting Rate G3 Auto, Forced 4800 bps, G4 Auto 

Transmission Header Text Off, Display Header 
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Adding Address Book Entries

The address book can store email, server, fax, and Internet fax addresses. Addresses can be stored for individuals, or 
groups containing multiple individuals.

Note: Address Book entries can be managed in the Embedded Web Server. For details, refer to the Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide.

ADDING AN INDIVIDUAL ADDRESS

1. On the control panel, press the Machine Status button.

2. On the touch screen, touch the Tools tab.

3. Touch Setup and Calibration, touch Setup, then touch Add Address Book Entry.

4. On the next screen, touch an available address in the scroll list.

5. Touch Address Type, touch the desired address type, then touch Save. Each address book type requires 
different settings.

6. Touch each needed item in the list, enter the information using the alphanumeric keypad or touch screen 
keyboard, then touch Save.

7. When all needed settings have been configured, touch Save to complete the address book entry.

DELETING AN INDIVIDUAL ADDRESS

1. On the control panel, press the Machine Status button.

2. On the touch screen, touch the Tools tab.

3. Touch Setup and Calibration, touch Setup, then touch Add Address Book Entry.

4. On the next screen, touch the needed address in the scroll list.

5. Touch Delete Entry, then touch Delete to confirm.

ADDING A GROUP

Create a group to send a fax to multiple individuals. Groups can include both previously stored individuals and 
group entries.

Note: Individual entries must be configured before groups can be defined.

1. On the control panel, press the Machine Status button.

2. On the touch screen, touch the Tools tab.

3. Touch Setup and Calibration, touch Setup, then touch Create Fax Group Recipients.

4. On the next screen, touch an (available) group in the scrolling list.

5. On the next screen, touch the Group Name field, enter a name for the group using the touch screen keyboard, 
then touch Save.
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6. Touch the Speed Dial field, then enter the Speed Dial number for the desired individual using the 
alphanumeric keypad.

7. Touch Add to this Group.

8. Repeat steps 6 and 7 until all individuals have been added to the group.

9. When all entries have been added, touch Save, then touch Close.

DELETING A GROUP

1. On the control panel, press the Machine Status button.

2. On the touch screen, touch the Tools tab.

3. Touch Setup and Calibration, touch Setup, then touch Create Fax Group Recipients.

4. On the next screen, touch the desired group in the scrolling list.

5. Touch Delete, then touch Delete to confirm.

USING CHAIN DIAL

Chain Dial creates a single fax recipient telephone number by adding two or more fax numbers together into a 
single number. For example, an area code or extension number could be stored separately from the rest of the 
telephone number. Access Chain Dial from the Address Book. 

1. On the touch screen, touch Fax.

2. Touch Address Book.

3. Touch List all public entries from the drop-down list.

4. Touch Chain Dial.

5. To add numbers do one of the following: 

• Touch the desired speed dial entry from the scrolling list. Touch the scroll arrows if necessary.

• Enter a number using the alphanumeric keypad.

• Touch the keyboard button, enter a number using the touch screen keyboard, then touch Save.

6. Touch Add. The numbers are added together in the Recipient List.

7. Touch Save. The combined number appears as a single recipient in the Recipient(s) list.

8. Touch Close. The fax can now be sent.
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Creating Fax Comments
1. On the control panel, press the Machine Status button.

2. On the touch screen, touch the Tools tab.

3. Touch Setup, then touch Add Fax Comment.

4. On the next screen, touch an available comment in the scroll list.

5. On the touch screen keyboard, enter up to an 18–character comment, then touch Save.

6. Touch Close. The comment is ready to use.
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Stored Programming Overview

Frequently used features and job settings can be saved as Stored Programming, which can be accessed using a 
shortcut button. 

Stored Programming remembers feature settings and can also record a series of operations. You can record the 
hierarchy of screens shown for each step. For example, you can use Stored Programming to record the following 
actions: press the Machine Status button, and show the Print Reports screen.

• You can record up to 100 consecutive operations in each stored program

• You can store up to 40 programs

• A stored program can become invalid in the following instances: 

– If changes are made to default values or paper tray settings in the system 

– If buttons are added or removed from the touch screen, since stored programming only remembers the 
location of a button on the screen. It does not remember the name of the button. For example, button 
positions can change when you add or delete a job flow or a job template. 

– If changes are made to the values of the watermark feature when a watermark is used in a stored program 

– If the password to the folder that is used in the stored program is changed after the program is stored 

– System Settings, Job Flow Sheets, Network Scanning, Address Book and the Browse feature for Scan to PC 
cannot be used with Stored Programming. 

For a complete list of notes and restrictions, refer to Notes and Restrictions on Registering Stored Programs.
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Storing a Program

Note:  

• The following actions terminate the registration process: 

– Pressing the Interrupt button on the control panel 

– The Auto Reset feature causes a timeout 

– An error message, such as for a paper jam, appears 

• To ensure that the printer registers the program properly, do not perform the following procedures while 
storing a program: 

– Remove or insert a paper tray 

– Load or reload paper in Tray 5 

• You cannot edit a stored program. To save different settings, store a new program.

1. Press the Machine Status button.

2. Touch the Tools tab, then in the Features column, touch Stored Programming.

3. Touch Store. 

Note: To register a stored program for the Build Job feature, refer to Storing a Program for Build Job.

4. From the numbered list, select an available numbered button. 

Note:  

• To return to the previous screen or to advance to the next screen, touch the up and down arrows.

• A tone is generated while registering the program to job memory. To change the tone volume, refer to 
Setting the Audio Tones for Stored Programming Registration in the System Administrator Guide.

• When storing a program for Tray 5, to ensure that the program does not become corrupted, store both 
the paper size and the paper type. If the program becomes corrupted, you cannot select the program.

5. Select the feature type for the program that you want to store. 

Note: Features that are not available for use with Stored Programming are grayed-out. For example, Network 
Scanning and Job Flow Sheets are not available.

6. Set the feature options. After changing the settings on each tab, touch Save.

7. To end registration and store the program, press the Start button. 

Note: To cancel registration, press the Interrupt button.

Note: At the time the program is stored, the assigned program name is (No Name). To rename a stored 
program, refer to Naming or Renaming a Stored Program.
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Storing a Program for Build Job

The Build Job feature allows you to apply different settings to various segments of a job. You can use Stored 
Programming to store a program that contains specific settings to be used with the Build Job feature. When using 
Build Job, you can recall a stored program and apply it to a specific segment of the job. If each job segment 
requires different settings, you can select a different stored program for each job segment, as needed.

1. Press the Machine Status button.

2. Touch the Tools tab. In the Features column, touch Stored Programming.

3. Touch Store Build Job.

4. From the numbered list, select an available numbered button. 

Note:  

• To return to the previous screen or to advance to the next screen, touch the up and down arrows.

• A tone is generated while registering the program to job memory. To change the tone volume, refer to 
Stored Programming Tone in the System Administrator Guide.

• When storing a program for Tray 5, to ensure that the program does not become corrupted, store both 
the paper size and the paper type. If the program becomes corrupted, you cannot select the program.

The tabs for the Copy feature appear and the printer begins to beep, which indicates that the printer is in 
programming mode.

5. Set the feature options that you want to apply to a segment of the job. After changing each setting, touch 
Save.

6. To end programming mode and store the program, press the Start button or the Clear All button. 

Note:  

• To cancel the registration, press the Interrupt button.

• At the time that the Build Job program is stored, the assigned program name is (No Name). To rename a 
stored program, refer to Naming or Renaming a Stored Program.

• The Build Job icon is assigned automatically to the stored program and cannot be changed.

7. Load the first original document into the document feeder or on the document glass.

8. Set the feature options for this document, as needed. After changing each setting, touch Save.
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Naming or Renaming a Stored Program

You can use up to 18 characters in a Stored Program name.

1. Press the Machine Status button.

2. Touch the Tools tab, then touchStored Programming.

3. Touch Enter / Change Name.

4. Select the stored program that you want to rename. 

Note: To return to the previous screen or to advance to the next screen, touch the up and down arrows.

5. Type the new name for the stored program, then touch Save.

6. Touch Close.
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Notes and Restrictions on Registering Stored Programs

The following notes and restrictions apply when you register stored programs. 

• When storing a program for Tray 5, to ensure that the program does not become corrupted, store both the 
paper size and the paper type. If the program becomes corrupted, you cannot select the program.

• If any of the following operations is performed while a program is registered, the stored program may not be 
registered or may not work correctly. 

– Removing or inserting a paper tray 

– Loading paper in the bypass tray 

• After the stored program is registered, performing any of the following operations can corrupt the program. If 
the program becomes corrupted, you cannot select the program. 

– If the stored program has the Watermark feature and the default values of that feature are changed 

– If the stored program has an operation for a folder and the passcode for the folder is changed 

– If the settings of the control panel are changed 

– If the services assigned to the Custom buttons are changed 

– If any setting is changed for Tools > System Settings > Copy Service Settings > Preset Buttons 

– If the selection is made from a list of the Address Book or Job Flow Sheet 

– If any optional components installed on the printer, such as a finisher, are changed, and the associated 
buttons are no longer available 

– If the measurement unit, millimeters or inches, is changed 

– If a job is selected from the list of the stored jobs in Job Status > Secure Print Jobs & More 

– Selecting items using the scroll bar 

• The following features and operations cannot be registered in Stored Programming: 

– Registration and call of a stored program 

– A diagnostic request 

– System Settings 

– The Media Print - Text button on the Services Home screen 

– The Store to USB button on the Services Home screen 

– The Network Scanning, Job Flow Sheets, and Web Applications buttons on the Services Home screen 

– The Custom button to which the Network Scanning or Job Flow Sheets service is assigned. 

– Buttons that cannot be selected 

– The Language button on the Services Home screen 

– The Screen Brightness button on the Services Home screen 

– Scrolling operation while previewing 

– The Browse button for the Scan to PC service 
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– Operations to edit email addresses for the email service: These operations include the pop-up menu items 
Keyboard, Remove, and Edit. To display these pop-up menu items, select Recipient(s) or From. 

– The Power Saver button 

• A stored program registration is canceled in the following cases: 

– When the Interrupt button is pressed 

– When the Auto Clear feature causes a time-out 

– When a pop-up window, such as a paper jam window, appears 
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Calling a Stored Program

When you call a stored program, the last screen that was shown when you registered the stored program appears.

Note: To call a stored program for Build Job, refer to Using Stored Programs with the Build Job Feature.

1. Load the original document into the document feeder or onto the document glass.

2. Press the Services Home button.

3. Touch Stored Programming. 

Note: If you do not see the Stored Programming icon on the Services Home screen, your system 
administrator has not allowed the icon to appear on the Services Home screen.

4. Select the number of a stored program that contains the feature and options that you want to use. You can 
select only registered numbers.

5. After the stored program is called, select other options, as needed.

6. Press the Start button. 

The program executes. To clear the program and exit, press the Clear All button twice.

USING STORED PROGRAMS WITH THE BUILD JOB FEATURE

You can set up a multiple-segmented job using the Build Job feature on the Copy screen while Build Job is running.

To set up a job and use one or more stored Build Job programs:

1. Load the original document into the document feeder or onto the document glass.

2. Press the Services Home button, then touch Copy.

3. Set the feature options, as needed. After changing settings on each tab, touch Save.

4. Select the Job Assembly tab, then touch Build Job. Touch On, then touch Save.

5. Press the Start button. 

The document scans and you are prompted to load your next original document.

6. Load the next original document, then touch Change Settings.

7. Touch Job Assembly.

8. Touch Stored Programming.

9. From the list of stored Build Job programs, select the stored Build Job program that contains the features that 
you want to use for the next segment of the job.

10. If necessary, change the settings, then press the Start button.

11. Repeat the process until you have scanned all of your original documents and applied the settings required to 
each segment. After the last set of original documents scans, touch Last Original. 

As the job processes, for each segment, the settings from the stored Build Job program that you selected for 
that segment are applied.

12. To exit, press the Clear All button.
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Deleting Stored Programs
1. Press the Machine Status button.

2. Touch the Tools tab, then touch Stored Programming.

3. Touch Delete.

4. Select the stored program that you want to delete.

5. To confirm the deletion, touch Delete.

6. Touch Close. 

Note: Deleted stored programs cannot be restored.
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Stored Program Icons

You can add or change a stored program icon.

1. Press the Machine Status button.

2. Touch the Tools tab, then touch Stored Programming.

3. Touch Assign / Change Icon.

4. Select the stored program for which you want to add or change the icon. 

Note: To return to the previous screen or to advance to the next screen, touch the up and down arrows.

5. Select an icon, then touch Save. 

The icon is added to the stored program and appears on the button for the stored program.
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Media Print - Text Overview

The installation of the USB Enablement Kit allows the printer to retrieve and print .pdf, .tiff, and .xps document files. 
This feature is called the Media Print - Text feature. When a USB memory device is connected to the printer, the 
printer can print the data stored in the USB memory device. The Media Print - Text feature prints data stored in text 
format. The feature includes index printing that prints a list of files retrieved in the mode.

Ensure that you back up data onto media. Data stored on media can be lost or damaged for the following reasons: 

• When powering off or powering on the printer, or disconnecting or connecting the USB memory device

• When receiving the effect of electrical noise or an electrical discharge

• When a failure or repair occurs

• When damage results from a natural disaster
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Supported File Formats

You can use the following file formats:

• PDF: PDF 1.3 or later 

Extension: .pdf

• TIFF: Grayscale 4bit or 8bit uncompressed, 8bit or 24bit JPEG compressed, and MH/MMR compressed 

Extension: .tiff

• XPS files 

Extension: .xps

– If the medium contains more than 900 files, the printer recognizes the first 900 files, which includes all files 
inside and outside of folders. 

– PDF files that are saved on a Mac OS® do not appear onscreen, and you cannot print the files. 

– If a filename contains characters that are not supported by the printer, the filename does not appear 
onscreen. 

– Filenames can be 1–240 characters. 
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Notes and Restrictions

The following notes and restrictions apply to the Media Print - Text feature: 

• Printing speed depends on the size and number of files on the USB memory device.

• Before storing document files, format the media with a computer. In Media Print - Text mode, files are printed 
from the top-level directory on the USB memory device. A file or folder name can be recognized even if it 
exceeds eight characters.

• Do not connect multiple USB memory devices to the printer simultaneously. 

• The printer does not support some types of USB memory devices, such as those with an encryption function or 
with multiple partitions. 

• Do not connect or disconnect the USB memory device while the printer is retrieving or printing the data, or 
accessing the USB memory device. 

• To print a password-protected PDF, ensure that the printer is configured with the password that opens the PDF. 
Refer to Configuring the Device to Print a Password-Protected PDF.
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Selecting Media Files from a USB Memory Device
1. At the control panel, insert the USB memory device into the USB memory slot.

2. The USB Device Detected screen appears. Select one of the following: 

• Store to USB

• Media Print - Text

3. To use the Media Print - Text feature, touch Media Print - Text. 

Note:  

• Do not disconnect the USB memory device while the printer retrieves the files.

• Index numbers 001–900 are assigned automatically to the retrieved files.

4. After the files are retrieved, to select files, touch Select All, Select From List, Select Range, or Index Print. 

The Index Print option prints a list with a maximum of 32 files selected from the USB drive with the index 
numbers assigned automatically. The Index Print option is enabled when certain paper supplies are selected. 

Note: If Paper Supply is set to Auto Select, you cannot activate the Index Print option.

5. Select one or more files, then touch Save. If necessary, select a folder in the USB drive, then select files. 

Note: If you select a password-protected PDF file, an error message appears on the screen and the print job 
is canceled. Refer to Configuring the Device to Print a Password-Protected PDF.

6. After you select the files, to set the required printing options, touch the Media Print - Text tab, then touch the 
Advanced Settings tab.

7. Adjust the settings as needed. For details, refer to Setting the Printing Options. 

Depending on the types of files stored in the USB memory device or the directory configuration, all files 
selected may not print.

8. Press Start.
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Configuring the Device to Print a Password-Protected PDF
1. At the control panel, press Machine Status.

2. Touch Others > Print Mode > PDF > Password. 

The Print Mode option is set to Online by default.

3. Type a password, then touch Save. If prompted to confirm, type the password again, then touch Save.
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Setting the Printing Options

You can set the printing options on the Media Print - Text tab.

MEDIA PRINT -  TEXT PRINTING OPTIONS

TAB ITEM VALUE  

Quantity At the control panel, use the numeric keypad and enter 
the print quantity from 1–999. 

Media Print - Text Paper Supply Auto Paper Select, Trays 1–5 

Select Auto or a tray that holds any of the following 
paper sizes:  
• A3: 297 x 420 mm (11 x 17 in.) 
• B4: 250 x 353 mm (9.8 x 13.9 in.) 
• A4: 210 x 297 mm (8.5 x 11 in.) 
• A4: 210 x 297 mm (8.5 x 11 in.) Short Edge Feed 

(SEF) 
• B5: 176 x 250 mm (7 x 10 in.) 
• B5: 176 x 250 mm (7 x 10 in.) SEF 
• A5: 148 x 210 mm (5.8 x 8.3 in.) 
• A5: 148 x 210 mm (5.8 x 8.3 in.) SEF 

When you select Auto, a paper tray that matches the size 
of the document is selected automatically, and the 
document is printed at the original document size.

When the tray that you want to use does not appear 
onscreen, touch Paper Supply > More. You are offered a 
list of trays available on the printer. The trays are pre- 
loaded with a specific paper size and with a specific 
paper type. From the list that appears onscreen, select 
the required tray for your print job.

Paper Size: From the list, select the required paper size.

Paper Type: From the list, select the required paper type.

2 Sided Printing 1 Sided  

Long Edge Flip

Short Edge Flip

Output Off 

Staple 
• 1 Staple 
• 2 Staples 

Hole Punch 
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TAB ITEM VALUE 

• 2 Holes 
• 3 Holes 

Pages per Side Off 

2 Pages Up

4 Pages Up

Advanced Settings Bitmap Smoothing Off 

On

When you select a paper size that is smaller than the size that is set for the document, the document is reduced 
automatically. When you select a paper size that is larger than the document size, the document is printed at the 
original document size.The items that appear on the Media Print - Text and Advanced Settings tabs can vary 
depending on the combination of the options that are installed on the printer. 

INDEX PRINT

In Media Print - Text mode, the printer can print the following information:  

• Filenames, with a maximum of five lines and 240 characters

• The dates that you stored the documents on the USB memory device

• The total file quantity. You can select maximum of 32 files. If more than 32 files are selected, the following 
message appears at the top of the screen: Too many files selected. Select 32 files or less.

For the Index Print option, you can use the numeric pad to set the print quantity to 1–999 sets. 

When selecting Index Print, the following items are restricted:

SELECTION VALUE 

Paper Supply Trays 1–5 

Load paper of any of the following sizes in the selected 
tray:  
• A3: 297 x 420 mm (11 x 17 in.) 
• A4: 210 x 297 mm (8.5 x 11 in.) 
• A4 (8.5 x 11 in.) Short Edge Feed (SEF) 

2 Sided Printing  Off: Only 1 Sided printing is available  

Output Off 

Pages per Side Off 
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Job Status

The Job Status feature allows you to verify active, pending, and completed jobs. From the Job Status screen, you 
can cancel or print jobs that are pending.

ACTIVE JOBS TAB

You can check or cancel current or pending jobs on the Active Jobs tab.

1. At the control panel, press the Job Status button.

2. Touch the Active Jobs tab.

3. From the menu, select the type of jobs to be shown in the list: 

• All Jobs

• Printer & Print from Folder Jobs

• Scan, Fax, & Internet Fax Jobs

• Job Flow & File Transfer Jobs

4. From the list, select a job. 

Note: To navigate the list, use the up and down arrows.

5. If you want to display the Cumulative Time and Progress columns, touch Display Time. 

• Cumulative Time: This column shows the estimated time required to complete the entire job.

• Progress: This column shows the number of pages completed and the total number of pages required for 
the job.

6. To delete a job, change the order of execution, or view job progress, select a job. From the menu, select an 
option: 

• Delete

• Promote

• Job Progress

COMPLETED JOBS TAB

The Completed Jobs tab allows you to verify that a print job has completed successfully.

1. From the control panel, press the Job Status button.

2. Touch the Completed Jobs tab.

3. From the menu, select the type of jobs to be shown in the list: 

• All Jobs

• Printer & Print from Folder Jobs

• Scan, Fax, & Internet Fax Jobs

• Job Flow & File Transfer Jobs
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4. To sort the list according to job type, select Group Parent Jobs.

5. To view the details for a job, from the list, select a job.

6. To print a report for the selected job, select an option: 

• Print this Job History Report: This option prints a detailed history report for the selected job.

• Print this Job Report: This option prints a report for the selected job.

SECURE PRINT JOBS & MORE TAB

This tab allows you to print confidential documents.

1. At the control panel, press the Job Status button.

2. Touch the Secure Print Jobs & More tab.

3. Select a job type: 

• Secure Print: Refer to Secure Print.

• Sample Set: Refer to Sample Set.

• Delayed Print: Refer to Delayed Print.

• Charge Print: Refer to Charge Print.

Secure Print

You can use this feature to set a passcode for your print job. Before the job is released for printing, the printer 
prompts you to type the passcode.

1. At the control panel, press the Job Status button.

2. Touch the Secure Print Jobs & More tab.

3. Touch Secure Print.

4. From the list, select a user. 

Note:  

• To update the information shown, touch Refresh.

• To navigate the list, use the up or down arrows.

• To display a specific user ID at the top of the list, touch Go to. Using the numeric keypad, type the user 
ID.

5. Touch Job List.

6. Using the control panel keypad, type the passcode, then touch Confirm. 

• You can select up to 100 jobs. Jobs are printed in the order in which they are selected.

• To select all jobs for the selected user ID, touch Select All. To clear all selected jobs, touch Select All again.

• To view the first page of the selected job, touch Preview. If multiple jobs are selected, the Preview feature is 
not available.

Note: If a passcode is not set, the Passcode screen does not appear.
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7. Select the job to print or delete.

8. Select an option: 

• To delete the selected job, touch Delete. To confirm the deletion, touch Delete.

• To print the selected job, using the numeric keypad, type the number of sets to print, then touch Print.

Sample Set

This feature allows you to print one set for review before you print the entire job set. After printing the sample set, 
you can choose to print the entire job or to delete the job without printing.

1. At the control panel, press the Job Status button.

2. Touch the Secure Print Jobs & More tab.

3. Touch Sample Set.

4. From the list, select a user. 

• To update the information shown, touch Refresh.

• To navigate the list, use the up or down arrows.

• To display a specific user ID at the top of the list, touch Go to. Use the numeric keypad and type the user 
ID.

5. Touch Job List.

6. Select the job to print. 

• You can select up to 100 jobs. Jobs are printed in the order in which they are selected.

• To select all jobs for the selected user ID, touch Select All. To clear all the selected jobs, touch Select All 
again.

• To view the first page of the selected job, touch Preview. If multiple jobs are selected, the Preview feature is 
not available.

7. Select an option: 

• To delete the selected job, touch Delete. to confirm the deletion, touch Delete.

• To print the selected job, type the number of sets to print. Touch Print. 

The sample set prints. After the remaining sets for the job print, the job is deleted.

Delayed Print

This feature allows you to print a job at a specified time, then delete the job.

1. At the control panel, press the Job Status button.

2. Touch the Secure Print Jobs & More tab.

3. Touch Delayed Print.
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4. Select the job that you want to print or delete. 

• To update the information shown, touch Refresh.

• To navigate the list, use the up or down arrows.

• Print Time XXX:XXX shows the time to start printing.

• You can select up to 100 jobs.

• To view the first page of the selected job, touch Preview. If multiple jobs are selected, the Preview feature is 
not available.

5. Select an option: 

• To delete the selected job, touch Delete. To confirm the deletion, touch Delete.

• To print the selected Delayed Print job immediately, touch Print.

Charge Print

The Charge Print feature allows you to print or delete documents stored for each billing user ID.

1. At the control panel, press the Job Status.

2. Select the Secure Print Jobs & More tab. Touch Charge Print.

3. To show the latest information, touch Refresh.

4. Select a billing user ID. If you know the exact number of the user in the list, you can type the number into the 
Go to box using the numeric keypad.

5. Touch Job List.

6. If the Password screen appears, type the password for the user ID, then touch Confirm.

7. From the list that appears, select a document.

8. Select an option: 

• To print the selected document, touch Print.

• To delete the selected document, touch Delete.

9. Touch Close.
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Machine Status

The Machine Status button provides access to the following device status information and features: 

• Device Information

• Faults

• Supplies

• Billing Information

• Tools

DEVICE INFORMATION TAB

The Device Information tab provides general information about the Production Press. From the Device Information 
tab, you can view details that apply to the printer and access other printer information features.

GGeenneerraall IInnffoorrmmaattiioonn

MMooddeell: The printer model appears in the General Information area. Refer to the model when ordering supplies 
or contacting Xerox for support.
DDeevviiccee SSeerriiaall NNuummbbeerr: The device serial number appears in the General Information area. Use the serial 
number when you call Xerox for technical information or assistance.
CCuurrrreenntt SSyysstteemm SSooffttwwaarree: In the General Information area, you can view the version of the system software 
that is installed on the printer.
NNeettwwoorrkk CCoonnnneeccttiivviittyy IInnffoorrmmaattiioonn: The IPv4 Address, IPv6 Address, and Host Name appear in the General 
Information area.

PPaappeerr TTrraayy SSttaattuuss

You can select the Paper Tray Status button to view the current status information for each paper tray.

DDeevviiccee CCoonnffiigguurraattiioonn

You can select the Device Configuration button to show a list of the various hardware components and 
options that are available on the printer. The list shows the status of each of the components and options. 
Hardware components and options include the document feeder, paper trays, and any optional feeding and 
finishing devices that are attached to the printer.

SSooffttwwaarree VVeerrssiioonn

You can select the Software Version button to display a list of the software versions for the various Production 
Press components, such as the print engine, the controller ROM (Read-Only Memory), and any optional feeding 
and finishing devices.

PPrriinntt RReeppoorrttss

Before you can print reports, ensure that your system administrator has enabled the Print Reports button. 
Some features on the Print Reports screen are available only in administrator mode.

Note: The types of reports that are available varies, depending on the Production Press configuration.

MMaaiinntteennaannccee AAssssiissttaanntt

You can select the Maintenance Assistant button to send the diagnostic information from the printer.
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OOtthheerrss

The Print Mode and Overwrite Hard Disk features are on the Others page.
Overwrite Hard Disk 

The Overwrite Hard Disk feature prevents the document image and registered data that is recorded on the 
Xerox device hard disk from being retrieved illegally. The number of overwrites is set by the system 
administrator.

Overwriting the device hard disk is performed after every copy job that includes more than one set, and after 
each scan job is transferred to the print server. The Standby status indicates the completion of the overwriting 
process.

Print Mode 

You can use the Print Mode feature to identify which mode the printer is using for printing. You can select Off- 
Line or On-Line. You can choose from the following Print Mode options: 

• PCL Emulation: You can type an item number using the numeric keypad or you can select the current value.

• PDF: For Programming, you can type an item number using the numeric keypad or you can select the 
current value. You can add a password.

• HP-GL/2 Emulation: This option allows access to the following programming options: 

– Retrieve Programming: You can choose Factory Defaults or Custom Settings. 

– Programming: You can type an item number using the numeric keypad or you can select the current 
value. 

– Store / Delete Programming: After you select a job, you can choose Store the Current Selections or 
Delete. 

– Default Programming: You can choose Factory Defaults or Custom Settings. 

FAULTS TAB

The Faults tab provides access to fault information and error messages. To access the Faults tab, at the control 
panel, you can press the Machine Status button, then select the Faults tab.

CCuurrrreenntt FFaauullttss

To view a list of the current faults that affect the device, you can select the Current Faults button. From the 
Current Faults screen, you can select a fault and view instructions on how to fix the error.

CCuurrrreenntt MMeessssaaggeess

To view a list of the current device messages, from the Faults tab, you can select the Current Messages button. 
The messages indicate actions that are needed to continue or resume the proper operation of the device.

FFaauulltt HHiissttoorryy

To display a list of past fault codes, you can select the Fault History button. The information can be used to 
diagnose and solve device problems.
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SUPPLIES TAB

The Supplies tab provides status information about the customer-replaceable units (CRUs) that are used in the 
printer.

To access supplies information, at the control panel, press the Device Status button, then select the Supplies tab.

Each customer-replaceable unit and the status is shown.

BILLING INFORMATION TAB

Accessing Billing Information

1. At the control panel, press the Machine Status button.

2. Select the Billing Information tab.

Billing Meters and Usage Counters

The Billing Information feature shows the total number of prints and copies made by the printer and allows users to 
view specific billing meter and usage counter information.

The main Billing Information screen shows the following information: 

• The device serial number

• Black Impressions: The total number of monochrome prints and copies made on the printer.

• Total Impressions: The total number of prints and copies made on the printer.

• Black Large Impressions: The total number of large monochrome prints and copies made on the printer.

• The Usage Counters button

Usage Counters

To view usage counters, on the Billing Information tab, touch Usage Counters.

To select a counter type, from the list, select an option: 

• Impression Counters

• Sheet Counters

• Image Sent Counters

• All Usage Counters

IImmpprreessssiioonn CCoouunntteerrss

This option displays the total number of impressions. An impression is the image on one side of one sheet of 
media. This counter shows the total impression amount for copied, printed, and large impressions. 

• Black Copied Impressions: This number represents the total number of impressions for all monochrome 
copied or scanned jobs.

• Black Printed Impressions: This number represents the total number of impressions for all monochrome 
network print jobs. Network print jobs are the jobs sent from a computer to the printer.
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• Large Impressions: This number represents the total number of large impressions for all monochrome copied 
or printed jobs. Large impressions are one side of one sheet of a large document, such as A3 (11 x 17 in.).  
Large Impressions are any documents, original documents, or prints that are larger than B4 (8.5 x 14 in.).

SShheeeett CCoouunntteerrss

This option provides information on the total number of sheets that the Xerox device feeds to the output area. 
Each sheet counts as one click on the counter, regardless of whether the sheet is a one-sided or two-sided copy 
or print job.

IImmaaggeess SSeenntt CCoouunntteerrss

This option provides information on the total amounts for Internet fax images, email images, and network 
scanned images.

AAllll UUssaaggee CCoouunntteerrss

This option provides the combined count from Impression Counters, Sheet Counters, and Images Sent Counters.

User Account Billing Information

Note: The User Account Billing Information feature is available only if the Accounting feature is enabled. 

For more information on the Accounting feature, refer to the Xerox® PrimeLink® B9100/B9110/ B9125/B9136 
Production Press System Administrator Guide.

When the system administrator enables the Accounting feature, the User Account Billing Information button 
appears on the Billing Information screen. When you select the User Account Billing Information button, the 
following information appears: 

• The billing information of the currently logged-in user, including copy and scan jobs

• When you select Meter (Copy Jobs) or Meter (Scan Jobs), the following information appears: 

– Usage amount for the session 

– Total usage 

– Account Limit: The system administrator sets the account limit 

– Available Balance: The remaining unused amount for the account 

TOOLS TAB

Regular users have limited access to some of the setup features on the Tools tab. To access these features, on the 
Tools tab, touch Setup > Setup.

CCrreeaattee FFoollddeerr

You can create a folder on the device. You can store files to the folder and retrieve files from the folder to send 
for printing.

SSttoorreedd PPrrooggrraammmmiinngg

When available to users, this feature enhances productivity by saving a series of programming steps and 
assigning the steps to a specified Stored Programming option. Stored programs save frequently used features 
and job settings that you can access using a shortcut button. Stored Programming not only remembers feature 
settings, but the feature can record a series of operations. This action enables you to record the hierarchy of 
displayed screens for each step. For example, Stored Programming can record the following actions: Press the 
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Machine Status button, then show the Print Reports screen. 

Note: The Stored Programming feature is available only if the system administrator created and saved 
stored programs.

CCrreeaattee JJoobb FFllooww SShheeeett

You can create a job flow sheet. Job flow sheets specify the way that the device processes a document.

CCrreeaattee JJoobb FFllooww SShheeeett KKeeyywwoorrdd

You can create a job flow sheet keyword. A job flow sheet keyword can help to locate a specific job flow sheet.

AAdddd AAddddrreessss BBooookk EEnnttrryy

You can add address and recipient information. To add a recipient, select an available entry, then enter the 
information. To view information for an entry, select the entry.

PPaappeerr TTrraayy AAttttrriibbuutteess

The Paper Tray Attributes feature allows you to change the attributes of a paper tray, including size, type, and 
weight. 

Note: The Paper Tray Attributes feature appears on the Tools tab only if the system administrator made the 
feature available to users.

Changing the Paper Tray Attributes

1. At the control panel, press the Machine Status button.

2. Select the Tools tab.

3. Select Setup > SetupPaper Tray Attributes.

4. Select a tray.

5. Touch Change Settings.

6. If the settings are correct, touch Save. If the settings are not correct, select the correct Paper Type, then touch 
Save. 

The previous screen appears.

7. Touch Confirm. 

The Paper Tray Attributes screen appears.

8. Touch Close.
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Supported Media

RECOMMENDED MEDIA

A complete list of recommended media types is available at www.xerox.com/digital-printing/latest/PB9DS-02.pdf.

MEDIA THAT CAN DAMAGE YOUR PRINTER

Your printer is designed to use various paper and media types for print jobs. However, some media can cause poor 
output quality, increased paper jams, or damage to your printer.

Do not use the following: 

• Rough or porous media

• Inkjet paper

• Paper that has been photocopied

• Paper that has been folded or wrinkled

• Paper with cutouts or perforations

• Stapled paper

• Envelopes with windows, metal clasps, side seams, or adhesives with release strips

• Padded envelopes

• Plastic media

SUPPORTED PAPER TYPES AND WEIGHTS

Refer to the following chart for the paper types and weights that are accepted in each of the feeder paper trays 
available. Select the appropriate tray for the media that you want to use.

Note:  

• Media weight for the paper type that appears on the user interface is limited. The administrator can set 
up an additional 40 custom paper types.

• The Oversize High Capacity Feeder (OHCF) provides the best feeding performance, especially for coated 
media.

Paper type weight range can be selected in either of the following two ways:

• Determine the paper type from the following table, then apply the proper weight range using the options 
available from the control panel screen.

• Select Other Media Selection, then select the specific paper weight range from the available list on the control 
panel screen. Some features, such as Printing Reports or Auto Tray Switching provide a limited list of paper 
types.

Note: To define the image-quality setting with a different paper weight range to optimize image quality, 
refer to the Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide, in 
the Paper Tray Settings section.
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PAPER TRAYS SUPPORTED PAPER TYPES AND WEIGHTS 

Trays 1 and 2 Plain: 64–81 g/m²

Plain Reloaded: 64–105 g/m²

Bond: 82–105 g/m²

Hole Punched: 64–105 g/m²

Lightweight: 52–63 g/m²

Heavyweight 1: 106–216 g/m²

Recycled: 64–105 g/m²

Preprinted: 64–105 g/m²

Preprinted LW: 52–63 g/m²

Preprinted LW Card: 106–216 g/m²

Trays 3 and 4 All items for Trays 1 and 2

Tab Stock: 106-216 g/m²

Note:  

• For paper types and weights for Tray 5 (Bypass), refer to Tray 5 (Bypass) Specifications.

• For paper types and weights for Trays 6 and 7, refer to High Capacity Feeder Specifications or OHCF 
Specifications.

• To optimize image quality, change the weight range. Refer to the Xerox® PrimeLink® B9100/B9110/ 
B9125/B9136 Production Press System Administrator Guide, in the Paper Tray Settings section.
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SUPPORTED STANDARD PAPER SIZES

TRAY PAPER SIZES

Trays 1 and 2 Long-Edge 
Feed (LEF) 
only 

B5 (182 x 257 mm, 7.17 x 10.12 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

Executive (184 x 267 mm, 7.25 x 10.5 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

Trays 3 and 4 Short-Edge 
Feed (SEF)

A5 (148 x 210 mm, 5.83 x 8.27 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

A3 (297 x 420 mm, 11.7 x 16.5 in.)

B5 (182 x 257 mm, 7.17 x 10.12 in.)

B4 (257 x 364 mm, 10.12 x 14.33 in.)

Statement (139.7 x 215.9 mm, 5.5 x 8.5 in.)

203.2 x 254 mm (8 x 10 in.); North America only

Letter (216 x 279 mm, 8.5 x 11 in.)

US Folio (215.9 x 330.2 mm, 8.5 x 13 in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Ledger (279.4 x 431.8 mm, 11 x 17 in.)

Special A4 (226 x 310 mm, 8.9 x 12.2 in.)

DT Special A3 (310 x 432 mm, 12.2 x 17 in.)

304.8 x 457.2 mm (12 x 18 in.)

SRA3 (320 x 450 mm, 12.6 x 17.7 in.)

320 x 488 mm (12.6 x 19.2 in.)

330.2 x 457.2 mm (13 x 18 in.)

330.2 x 482.6 mm (13 x 19 in.)

LEF A4 (210 x 297 mm, 8.3 x 11.7 in.)

B5 (182 x 257 mm, 7.17 x 10.12 in.)

Executive (184.2 x 266.7 mm, 7.25 x 10.5 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

Special A4 (226 x 310 mm, 8.9 x 12.2 in.)

16K (Taiwan) (194 x 267 mm, 7.64 x 10.51 in.)

16K (Mainland China) (195 x 270 mm, 7.68 x 10.63 in.)
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Note:  

• For information about paper sizes for Tray 5 (Bypass), refer to Tray 5 (Bypass) Specifications.

• For information about paper sizes for Trays 6 and 7, refer to High Capacity Feeder Specifications or OHCF 
Specifications.

PAPER TRAY INFORMATION FOR TRAYS 1 ,  2 ,  3 ,  AND 4

The following information applies to Trays 1–4:

TTrraayyss 11––44 can accept all media weights from 52–216 g/m² (16 lb. bond–80 lb. cover).

TTrraayyss 11 aanndd 22 

• Tray 1 has a capacity of 1,100 sheets of 80 g/m² paper

• Tray 2 has a capacity of 1,600 sheets of 80 g/m² paper

• Trays 1 and 2 can accommodate media sizes including: 

– A4 210 x 297 mm or Letter 8.5 x 11 in. 

– B5 182 x 257 mm (7.26 x 10.12 in.) 

– Executive 184.2 x 266.7 mm (7.25 x 10.5 in.) 

• Trays 1 and 2 can accommodate media loaded only in the Long Edge Feed (LEF) orientation

TTrraayyss 33 aanndd 44 

• Trays 3 and 4 are adjustable

• Trays 3 and 4 each have a capacity of 550 sheets of 80 g/m² paper

• Trays 3 and 4 can accommodate media sizes from 139.7 mm x 182 mm (5.5 x 7.16 in.) to 330.2 mm x 488 
mm (13.0 x 19.2 in.)

• Trays 3 and 4 can accommodate media loaded in the Long Edge Feed (LEF) portrait orientation or the Short 
Edge Feed (SEF) landscape orientation

• Trays 3 and 4 have automatic size-detection capability 

Note: Before using the automatic size-detection feature, ask your system administrator to change the 
NVM settings for automatic size detection.
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Guidelines for Loading, Printing, and Storing Media

GENERAL MEDIA LOADING GUIDELINES

Follow these guidelines when loading paper, or any media, in the appropriate trays: 

• Fan the paper before loading it in the paper tray.

• Do not overfill the trays. Do not load paper above the maximum fill line.

• Adjust the paper guides to fit the paper size.

• Use only paper envelopes. Print envelopes 1-sided only. Use Tray 5 to print envelopes. Set Media Type to 
Heavyweight 1.

• After loading paper in a tray, ensure that you select the correct paper type on the printer touch screen.

PRINTING OR COPYING ON LABELS

You can print labels from Tray 5 (Bypass Tray), and the Oversized High Capacity Feeder (OHCF) Trays 6, and 7.

Note: The High Capacity Feeder (HCF) does not support printing on labels.

When printing on labels, adhere to the following guidelines: 

• Rotate stock frequently. Long periods of storage in extreme conditions can cause labels to curl and jam in the 
printer.

• Use labels designed for laser printing.

• Do not use vinyl labels.

• Do not use dry gum labels.

• Print only on one side of the sheet of labels.

• Do not use any sheet where labels are missing. Sheets with missing labels can damage the printer.

• Store unused labels flat, in the original packaging. Keep the sheets of labels inside the original packaging until 
you are ready to use the sheets. Return any unused sheets of labels to the original packaging and reseal it.

• Do not store labels in extremely dry or humid conditions or extremely hot or cold conditions. Storing labels in 
extreme conditions can cause print-quality problems or cause labels to jam in the printer.

PRINTING OR COPYING ON GLOSSY PAPER

You can print glossy, or coated, paper from the Oversized High Capacity Feeder (OHCF) Trays 6, and 7.

Note:  

• The High Capacity Feeder (HCF) does not support printing on glossy paper.

• Only one-sided printing is supported for glossy, or coated, paper.

When printing on glossy paper, adhere to the following guidelines: 
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• Do not open sealed packages of glossy paper until you are ready to load the paper into the printer.

• Store glossy paper flat, in the original packaging.

• Before loading glossy paper, remove all other paper from the tray. 

• Load only the amount of glossy paper that you plan to use. When you are finished printing, remove the unused 
paper from the tray. Replace the unused paper in the original packaging and seal for later use.

• Rotate paper frequently. Long periods of storage in extreme conditions can cause glossy paper to curl and jam 
in the printer.

PAPER STORAGE GUIDELINES

Providing good storage conditions for your paper and other media contributes to optimum print quality.

• Store paper in dark, cool, relatively dry locations. Most paper is susceptible to damage from ultraviolet and 
visible light. Ultraviolet light emitted by the sun, and fluorescent bulbs, is damaging to paper.

• Reduce the exposure of paper to strong lights, or to visible light for long periods of time.

• Maintain constant temperatures and relative humidity.

• Avoid storing paper in attics, kitchens, garages, or basements. These spaces are more likely to collect moisture.

• Store paper flat, either on pallets, cartons, shelves, or in cabinets.

• Avoid food or drinks in the area where paper is stored or handled.

• Do not open sealed packages of paper until you are ready to load them into the printer. Leave stored paper in 
the original packaging.

• Some special paper is packaged inside resealable plastic bags. Store the media inside the bag until you are 
ready to use the media. Keep unused media in the bag, then reseal it for protection.
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Loading Media

LOADING PAPER IN TRAYS 1  AND 2

Note: If a paper tray is opened while the printer is feeding paper from the tray, a paper jam can occur.

1. Select the appropriate paper for your print job.

2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.

4. Before loading paper into the tray, fan the sheets of paper.

5. Load and align the edge of the paper against the left edge of the tray. 

Load paper in the Long Edge Feed (LEF) or portrait direction.

6. Gently, push in the tray until it stops. 

If enabled by your system administrator, the Paper Tray Settings screen appears on the touch screen.

7. If you have made changes to the paper tray, touch Change Settings, then correct the information. If you have 
not made any changes, proceed to the next step. 

a. For Paper Type / Paper Weight, Paper Size, and Paper Color, select options as needed.

b. If necessary, make the desired changes to paper curl and alignment adjustment. 

Note: For detailed information on the paper curl and alignment adjustment options, refer to the Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide.

c. Select Save until you return to the tray settings window.

8. Touch Confirm.

LOADING PAPER IN TRAYS 3  AND 4

Note: Do not load paper above the Max line on the rear edge guide.

1. Select the appropriate paper for your print job.

2. Pull out the tray slowly until it stops.
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3. Open the ream of paper with the seam side facing up.

4. Before loading paper into the tray, fan the sheets of paper.

5. Load and align the edge of the paper against the left edge of the tray. 

Note: You can load paper in the Long Edge Feed (LEF) portrait orientation or the Short Edge Feed (SEF) 
landscape orientation.

6. To adjust the paper guides, press in the guide release and move the edge guide carefully until it touches the 
edge of the paper in the tray. 

Note: Do not load paper above the Max line on the rear edge guide.

7. Gently push in the tray until it stops. 

If enabled by your system administrator, the Paper Tray settings screen appears on the touch screen.

8. If you made changes to the paper tray, touch Change Settings, then correct the information. If you did not 
make any changes, proceed to the next step. 

a. For Paper Type / Paper Weight, Paper Size, and Paper Color, select options as needed.

b. If necessary, make changes to the paper curl and alignment adjustment options. 

Note: For detailed information on the paper curl and alignment adjustment options, refer to the Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide.

c. Touch Save on each screen until you return to the tray settings window.

9. Touch Confirm.

LOADING TAB STOCK IN TRAYS 3  AND 4

1. Select the appropriate paper for your print job.

2. Pull out the tray slowly until it stops.

3. Before loading the tab stock into the tray, fan the tab stock.

Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide 181

Paper and Media



4. Load and align the edge of the tab paper against the right edge of the tray, with the side to be copied or 
printed facing down. 

5. To adjust the paper guides, press in the guide release and move the edge guide carefully until it touches the 
edge of the media in the tray. 
Do not load media above the Max line on the rear edge guide.

6. Gently push in the tray until it stops. 

If enabled by your system administrator, the Paper Tray settings screen appears on the touch screen.

7. If you made changes to the paper tray, touch Change Settings. If you did not make any changes, proceed to 
the next step. 

a. For Paper Type / Paper Weight, Paper Size, and Paper Color, select options as needed.

b. If necessary, make changes to the paper curl and alignment adjustment options. 

Note: For detailed information on the paper curl and alignment adjustment options, refer to the Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide.

c. Touch Save on each screen until you return to the tray settings window.

8. Touch Confirm.

LOADING HOLE-PUNCH PAPER IN TRAYS 1 ,  2 ,  3 ,  AND 4

1. Select the appropriate paper for your print job.

2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.

4. Before loading paper into the tray, fan the sheets of paper.

5. Load the hole-punch paper against the left edge of the tray. 
Align the paper so that the holes are against the left edge of the tray, and ensure that the paper is loaded in 
the Long Edge Feed (LEF) orientation.

6. To adjust the paper guides, press in the guide release and move the edge guide carefully until it touches the 
edge of the paper in the tray. 

Note: Do not load paper above the Max line on the rear edge guide.

7. Gently push in the tray until it stops. 

If enabled by your system administrator, the Paper Tray Settings screen appears on the touch screen.

8. If you made changes to the paper tray, touch Change Settings, then correct the information. If you did not 
make any changes, proceed to the next step. 
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a. For Paper Type / Paper Weight, Paper Size, and Paper Color, select options as needed.

b. If necessary, make changes to the paper curl and alignment adjustment options. 

Note: For detailed information on the paper curl and alignment adjustment options, refer to the Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide.

c. Touch Save on each screen until you return to the tray settings window.

9. Touch Confirm.

LOADING MEDIA IN OPTIONAL FEEDING DEVICES

For information and instructions on loading media in the optional feeding devices, refer to the appropriate chapter.

LOADING POST-PROCESS MEDIA IN OPTIONAL FINISHING DEVICES

For information on loading post-process media in the optional finishing devices, refer to the appropriate chapter.

Loading Tab Stock with the GBC® AdvancedPunch™ Pro Device

For information on how to load media into the paper trays when a GBC® AdvancedPunch™ Pro device is attached, 
refer to the GBC AdvancedPunch Pro Customer Documentation.
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Printing on Envelopes

You can print on envelopes, but performance is not guaranteed. To maximize the chance of successful printing, 
Xerox recommends that you follow the guidelines below.

SELECTING AN ENVELOPE

The paper type of the media that you select for a specific print job determines the quality of the printed output. To 
achieve optimum print quality, consider the following factors:

• The general composition of the media, such as texture, weight, and thickness

• The application of the media in the physical design and construction of the envelope

This section highlights common envelope styles and the challenges that certain envelope types can impose.

In some cases, the composition and construction of the envelope can limit one or both of the following:

• Based on the envelope construction, the positioning of any printed content on the envelope 

• Based on the envelope composition, the types of graphic artwork or photographic images that you can use

Do not use the following envelope types:

• Pressure-seal envelopes

• Envelopes with metal closures

• Envelopes with tie closures

• Other non-standard envelopes

Envelope Styles and Considerations

The examples below apply to standard #10 commercial business envelopes, but the details apply to other sizes also.

Side Seams

Generally, envelopes with side seams are preferred for laser-type printing. The side seam design provides a large 
surface area that is uninterrupted by folds and seams.
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Diagonal Seams

Envelopes with diagonal seams can be used, and are often a cost-effective option. This style of envelope is available 
in a wide variety of designs and fold patterns.

Window

Ensure that the window envelopes that you select are compatible with laser printing.

Caution: Printing on envelopes with windows that cannot withstand the high temperature of the fuser 
results in damage to the fuser.

Peel and Stick Sealing

Envelopes with a peel-and-stick sealing design are often made from premium quality media and yield good results.
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2-sided Adhesive Pressure Seal

Caution: Do not use envelopes with a 2-sided adhesive pressure seal design. This envelope style can 
cause damage to the fuser.

Envelope Design Considerations

When you select envelopes, be aware that the physical design and quality of the envelope can impose limitations 
on print quality and handling.

The multiple surfaces that pass through the printer can present a challenge for envelope printing. For example, 
most envelopes require that the printer transfers toner onto a surface that has two, three, or four layers of thickness. 
When the envelope flaps are closed, a typical envelope has four layers of media in multiple locations. The 
illustration below shows two different envelope designs. The blue circles indicate the locations where four layers of 
media overlap.

In most cases, the printer is capable of transferring toner successfully onto thick media. However, tests have 
concluded that the location of the overlapping layers can create pressure points in certain areas. These pressure 
points can result in a void of pressure in other areas of the envelope. This phenomenon is illustrated in the next 
section.

RECOMMENDATIONS FOR SPECIFIC ENVELOPE SIZES

Some limited testing was done with the following envelope sizes. Good results were achieved, with the exception of 
wrinkling on the largest sizes, as noted in the Potential Issues section.

US:
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• No. 10: 4.1 x 9.5 in. (104.8 x 241.3 mm)

• 9 x 12 in. (228.6 x 304.8 mm)

• 6 x 9 in. (152.4 x 228.6 mm) 

EU:

• DL: 220 x 110 mm (8.7 x 4.3 in.)

• C4: 229 x 324 mm (9 x 12.8 in.)

• C5: 162 x 229 mm (6.4. x 9 in.)

TESTING AND SELECTING ENVELOPES

To know the limits of an envelope can help you to pair the correct envelope style with requirements for the printed 
output. A simple test with Microsoft® Word can help to identify envelopes that are potentially problematic.

Creating and Printing a Test File

1. Open Microsoft® Word and create a new document.

2. To change the paper size to match your envelope, click Layout > Size, then select the size of the envelope to 
be used. To specify a custom size, select More Paper Sizes. 

Note: In the following example, the selected paper size is Envelope #10.

3. Click Layout > Orientation, then select Landscape. 

4. To draw a rectangle, click Insert > Illustrations > Shapes. Allow a 7.6 mm (0.3 in.) margin between each side 
of the rectangle and the edge of the page.
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5. To fill the rectangle with 85% black: 

a. Select the rectangle.

b. From the menu bar, select the Shape Format tab.

c. From the Shape Styles section on the ribbon, click Shape Fill, then select 85% Black.

6. To set the outline option for the rectangle: 

a. Select the rectangle.

b. From the menu bar, select the Shape Format tab.

c. From the Shape Styles section on the ribbon, click Shape Outline > No Outline.

The test file setup is complete.

7. To evaluate the results, print a few samples of the test file onto the envelopes, then inspect the printed 
envelopes carefully.

Potential Issues

Where multiple layers of paper overlap on the envelope, inconsistencies can appear in the print, as shown in the 
image below. These issues are obvious in the test run. However, to avoid these problems in actual jobs, design your 
print job so that there is no printed content in the affected area.
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Wrinkles at the edges of larger envelopes can create printing irregularities. This problem is illustrated in the image 
below.

To keep individual sheets separated, the printer uses different tension on the front feed rollers and back feed rollers. 
The slight difference in feed-roller tension applied between the front and back of the envelope can cause the front 
and back panels of the envelope to become misaligned. This misalignment causes creasing at the edges of the 
envelope, as shown in the image below.

If you do not print near the edges of the envelope, you can avoid the toner-related issues shown below. However, 
the physical wrinkles to the envelope are unavoidable with large, lighter-weight paper envelopes, such as C4 or 9 x 
12 in.

This can be avoided if you use envelopes of a heavier weight. It is also possible that large, lighter-weight envelopes 
do not feed reliably. Always test the media before you commit to the print job.

Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide 189

Paper and Media



GENERAL RECOMMENDATIONS

• Before you purchase large quantities of envelopes, conduct a test print for the envelopes.

• Use envelopes that are designed and recommended for laser printers.

• Use envelopes that are not twisted, curled, or otherwise deformed. It is imperative that the structure of the 
envelope is not compromised when the glue is subjected to the high heat that the device generates.

• For envelopes with windows, only use envelopes that are designed for higher fusing temperatures, such as those 
that are generated by laser printers. Envelopes with windows that are not designed for higher fusing 
temperatures can damage the device fuser and imaging components.

• Use only the following method for loading envelopes: Load envelopes face-up, with the flap down and closed, 
and position the envelope so that the flap edge enters the device first. If you experience persistent jamming or 
issues with programming the input size, rotate the envelope 90 degrees, so that the flap faces toward the 
operator.

• The device offers a range of media settings that impact image transfer strength, image transfer speed, and 
fuser temperature. Changing the media settings affects print output. Settings that are designed for 
heavyweight media can help to ensure that toner is transferred onto the envelope in critical areas. Settings that 
are designed for lightweight media can help to minimize glossy areas.

• For the best results, adjust the layout and design to suit the envelope . If the artwork cannot be adjusted, some 
jobs require that you use a specific envelope style. In some cases, to optimize image transfer along the edge of 
the envelope, or where the envelope transitions from two layers to three layers of media, requires that you 
adjust the placement of the return address, or logo, or both.

• Avoid printing with the envelope flap open. Heat and humidity can result in a buildup of adhesive on printer 
components, which can contribute to jams and degraded print quality.

• Avoid envelopes with a thick layer of adhesive or an uneven buildup of glue along the edges of the flap.

• Do not use pressure-seal envelopes that require that you leave the flap open. Open flaps on pressure-seal 
envelopes exposes the device to adhesive.

• Store envelopes in a dry area. Excess moisture that can be released during printing and fusing can seal your 
envelopes. High humidity levels in your environment can warrant use of a humidity-controlled environment for 
printing envelopes.

• Small pockets of air trapped inside an envelope can interfere with the printing process, which can result in 
random voids. Pockets of trapped air appear to be more common in some envelope styles than they are in other 
styles. To minimize problems with air pockets, before running the print job, flatten the envelopes. When you 
select envelopes, ensure that you consider all of the job requirements.

• Some print jobs can require an envelope that is conducive to a specific application, such as automated insertion.

• Xerox recommends that, when possible, you conduct an evaluation on recycled envelope media prior to any 
large purchase or commitment. Wide variations can exist in the quality, specifications, or both, of a recycled 
product.
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SETTING UP THE DEVICE TO PRINT ENVELOPES

Loading Envelopes into the Device

With the small media bracket, load the envelopes into the Bypass Tray or the Oversize High Capacity Feeder. Use 
the following guidelines:

• Ensure that the envelope flaps are closed.

• Place the envelope with the front side facing up and the flap side in the position that works most consistently: 

– Toward the front of the device: This is the preferred position. 

– Feeding into the device 

Note: To maximize feed reliability, position the envelope so that the fewest number of layers are at the 
leading edge.

• From the Bypass Tray, you can print up to 50 envelopes in a single print job.

• The 2-Tray Oversize High Capacity Feeder can handle significantly more media than the Bypass Tray, but the 
envelope quality can affect the stability of the stack. An optional accessory is available for the 2-Tray Oversize 
High Capacity Feeder that can provide support for higher stacks of small media.

• For more information regarding the setup of the Oversize High Capacity Feeder for use with envelopes, refer to 
Envelopes.

Configuring the Device to Print the Envelopes

Adjust the Tray 5 (Bypass) or Oversize High Capacity Feeder settings at the control panel touch screen. After you 
insert the envelopes, options for tray settings can appear automatically. If the settings do not appear, select the 
following options for tray settings manually:

• Paper size: Non-standard size (variable size)

• X: Specify the length of the envelope.

• Y: Specify the width of the envelope.

• Paper type: Heavyweight 1 (106-216 g/m2) 

Note: If you get poor results initially, you can adjust the paper type setting to use heavier media. If the 
toner does not adhere well with the Heavyweight 1 setting, a heavier media setting allows more heat 
and a slower feeding speed, which can produce a better result.
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For details, refer to Tray 5 (Bypass) or Oversized High Capacity Feeder.

Selecting Paper in the Print Driver

You can use the following images as a guide to selecting paper in the print driver. To access the print driver menu 
for your device, open the document you want to print, then click File > Print. Select your device from the list of 
available printers, then click Printer Properties.
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To print on custom paper sizes, you can add a custom size to the list of available paper options. This feature allows 
you to define custom dimensions for height and width. 

To create a custom size, in the print driver, for Paper, select Other Size > Fit to New Paper Size > New. Specify the 
dimensions that you requirefor the new paper size.
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Selecting Paper in the EFI Digital Front End

When you print through the EFI Digital Front End, to facilitate paper selection, you can specify the feed source in 
which your envelopes are loaded. If required, in the driver dialog, specify the custom size that you selected on the 
device control panel touch screen. When you specify the size in the driver dialog, ensure that you use the same 
measurement units, mm or inches, that you used to specify the paper size on the device.
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Cleaning the Printer

Read and adhere to the following information when cleaning the printer:

• To avoid electric shock, before you start to clean the printer, ensure that the printer is powered off, then unplug 
the printer.

• To avoid printer damage such as discoloration, deformities, and cracked covers, do not use benzene, paint 
thinner, other volatile liquids, or spray insect repellent on the printer.

• Cleaning the printer with an excessive amount of water can cause the printer to malfunction and damage 
documents during copying.

• Document Feeder, Document Cover, and Document Glass information: 

– The document cover is the flat, white surface on the underside of the Duplex Automatic Document Feeder 
(DADF). The DADF holds the document in place on the document glass. 

– It is recommended that you clean all components of the document cover and document glass at the same 
time. These components consist of the document cover, the document glass, and the second-side scanning 
lens assembly. 

– To provide the best image quality possible on your printed or copy output, clean the document cover and 
document glass regularly. If the document cover and document glass are dirty, spots can appear on copies 
and the printer cannot detect proper document sizes. 

– If you receive the message, The Scanner may be dirty, perform the cleaning procedure for the 
document cover and document glass. To clean the scanning glass, refer to the user guide or the label 
instructions on the document feeder. 

– The document glass consists of two parts: the document glass and the glass strip. The document glass is 
the glass on which you place your document to copy it. The glass strip is a 2.54 cm (1 in.) wide strip of 
document glass to the left of the document glass. 

CLEANING THE EXTERIOR AND THE TOUCH SCREEN

1. Clean the exterior with a soft cloth moistened with water. If dirt is difficult to remove, try gently wiping the 
printer exterior with a soft cloth moistened with a small amount of neutral detergent. 

2. To clean any excess water from the exterior, use a soft cloth.
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3. Clean the touch screen with a soft cloth moistened with a neutral detergent or alcohol. 

CLEANING THE DOCUMENT COVER AND THE DOCUMENT GLASS

If the document cover and document glass become soiled: 

• Smudges can appear on copies or scanned documents.

• The printer cannot detect document sizes.

Clean the document cover and the document glass once a month with the cloth provided in the document feeder.

1. To clean the document cover: 

a. Raise the document feeder. 
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b. To remove dirt, wipe the document cover with a soft cloth moistened with water. With a soft cloth, wipe 
dry the cover. If dirt is difficult to remove, try gently wiping with a soft cloth moistened with a small 
amount of neutral detergent. 

2. To clean the document glass: 

a. To remove dirt, wipe the document glass with a soft cloth moistened with water. With a soft cloth, wipe dry 
the glass. If dirt is difficult to remove, try gently wiping with a soft cloth moistened with a small amount of 
neutral detergent. 

Caution: To avoid damaging the glass surface, do not press heavily on the document glass.

3. Gently, close the document feeder.

CLEANING THE SCANNER

To ensure optimum print quality, clean the document glass regularly. Cleaning helps avoid output with streaks, 
smears, and other marks that transfer from the glass while scanning documents.

1. Slightly dampen a soft, lint-free cloth with water.

2. Remove any paper or other media from the output tray. 

3. Open the document cover.
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4. Wipe the surfaces of the document glass and Constant Velocity Transport (CVT) glass until they are clean and 
dry. 

Note: For best results, to remove marks and streaks, use Xerox® Glass Cleaner.

5. Wipe the white underside of the document cover until it is clean and dry. 

6. Close the document cover.

CLEANING THE DOCUMENT FEEDER ROLLERS

1. Gently, lift the latch of the document feeder top cover until it is open completely in a fixed position. 
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2. While turning the rollers, gently clean them with a soft cloth moistened with water. 

Caution: To prevent drops of water from falling into the printer, use a cloth that has been thoroughly 
wrung of excess water. Drops of water on internal components can cause a printer malfunction.

If dirt is difficult to remove, try gently wiping the rollers with a soft cloth moistened with a small amount of 
neutral detergent.

3. Close the top cover of the document feeder until you hear it click into place.

4. Close the left cover of the document feeder until you hear it click into place.
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Replacing Consumable Supplies

ORDERING SUPPLIES

Order Xerox supplies, paper, and other supplies at www.xerox.com/office/PLB91XXsupplies. For contact information 
and telephone numbers in your area, click Contact Us. To enter or select your printer family and model type, click 
Supplies.

Store supply items and Xerox parts in their original packages in a convenient location.

Note: Always refer to www.xerox.com/office/supplies for the latest Customer Replaceable Units (CRUs) part 
numbers.

The following items are consumables for this printer. It is recommended that you have a supply of these items 
available to eliminate downtime when the consumables require replacement.

Customer Replaceable Units (CRUs):

• Black Toner Cartridge; reorder quantity: 1 in each box

• Waste Toner Container; reorder quantity: 1 in each box

CHECKING THE STATUS OF CUSTOMER REPLACEABLE UNITS (CRUS)

To check the status of printer supplies, at the control panel, touch the Supplies tab.

• The status message for consumable printer supplies indicates Ready, Order New, Replace Now, or other 
indications.

• For the remaining amount of toner, the status message displays 0–100%.

When it is time to order or install a CRU, a message appears on the printer touch screen. With some CRUs, the 
message indicates that the printer can continue to copy or print jobs without replacing the CRU immediately. When 
it is time to replace a consumable, a message appears on the printer touch screen, and the printer stops printing.

Always recycle or dispose of the used CRU according to the disposal instructions supplied with the new CRU.

Note: For specific image-quality problems that appear on printed output and the related corrective actions, 
refer to Troubleshooting.

REPLACING THE TONER CARTRIDGE

Warning: Replace a toner cartridge while the printer is powered on. Internal parts of the printer can be 
hot. To avoid possible injury, before you replace a toner cartridge, ensure that the printer is cool. 
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1. Open the left cover of the printer. 

2. Before you remove the toner cartridge, lay paper on the floor. This step allows any excess toner to fall on the 
paper.

3. Grasp the handle of the toner cartridge. 

4. Pull out the toner cartridge slowly, while holding the bottom of the cartridge. 

5. Dispose of the used toner cartridge as normal office waste or recycle the cartridge.

6. Remove the new cartridge from the packaging.
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7. Shake the cartridge from side to side to distribute the toner evenly. 

8. Hold the cartridge with the arrow facing up. 

9. Push in the cartridge slowly until it stops. 

10. Close the toner cover. If the cover does not close completely, ensure that the cartridge is locked and is installed 
in the appropriate orientation. 

Caution: Never use a vacuum cleaner to remove spilled toner. Sparks inside the vacuum cleaner can 
cause a fire or explosion. To remove spilled toner, use a broom, brush, or a cloth moistened with a neutral 
detergent.
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REPLACING THE WASTE TONER CONTAINER

A message appears on the printer touch screen when the waste toner container is full. If you continue copying or 
printing without replacing the waste toner container, the printer stops after copying or printing approximately 
18,000 sheets.

1. Ensure that the printer has stopped copying or printing. Open the front cover on the printer. 

2. Open the waste toner container cover, then push down the lever. 

3. With one hand, grasp the handle of the waste toner container, then pull the container halfway out of the 
printer. 
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4. With the other hand, grasp the top middle part of the waste toner container, then use both hands to pull the 
container out of the printer. 

5. Hold the used waste toner container firmly with both hands, then place the container into the plastic bag 
provided with the new waste toner container. Close the bag, then dispose of the container according to your 
local regulations. 

6. Remove the new waste toner container from the packaging.

7. Do not grip the waste toner container handle. Grasp the top middle part of the new waste toner container, 
then slide the container into the printer until it stops. 

8. Close the waste toner container cover.
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9. Close the front cover. 

If the front cover is open even slightly, a message appears on the printer touch screen, and the printer cannot 
operate.
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General Troubleshooting

Warning: Precision components and high-voltage power supplies are used on the printer. Never open or 
remove printer covers that are screwed shut, unless specifically instructed in the User Guide. A high- 
voltage component can cause electric shocks. When you open the panels and covers that are screwed shut 
to install or detach optional accessories, ensure that you follow the instructions in the User Guide. Do not 
try to alter the printer configuration or modify any parts. These actions can cause printer malfunction or 
fire.

SYMPTOMS CHECK REMEDY 

The printer is not 
powered on. 

Is the power switch on the 
printer in the off position? 

Press the power switch to the on position. 

Is the power cord plugged into 
the electrical outlet? 

Press the power switch to the off position. Plug the 
power cord into the electrical outlet, then press the 
power switch to the on position. 

Is the power cord disconnected 
from the printer or the rear of 
the rack? 

Is power of the correct voltage 
being supplied? 

Ensure that the power supply is 200 -240 V, 15 A. 
Ensure that the power supplied is of a capacity that is 
compatible with the specified maximum power 
consumption of the printer (2.8 - 3.1 KVA). 

The display is dark. Is power saver mode on? The printer is in power saver mode. To cancel power 
saver mode, press the Power Saver button on the 
control panel. 

Is the brightness dial set too low? Adjust the display brightness using the brightness dial. 

Unable to print, or 
unable to copy. 

Is a message displayed on the 
control panel? 

Follow the instructions displayed. 

Is the printer mode offline? Press the Machine Status button, then from the 
printer mode, select Online. 

Is the power cord disconnected 
from the printer or the rear of 
the rack? 

Press the power switch to the off position, then firmly 
plug in the power cord. Press the power switch to the 
on position. 

The online 
indicator does not 
light, even though 
you sent a job to 
print. 

Is the interface cable 
disconnected? 

Press the power switch to the off position, unplug the 
power cord from the electrical outlet, then check the 
interface cable connection. 

For information about network settings, refer to Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production 
Press System Administrator Guide.

Is the environment correctly set 
on the personal computer? 

Check the print driver and other environment settings 
on the personal computer. 
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SYMPTOMS CHECK REMEDY 

Is the required interface set? Verify the status of the interface port in use. 

For information about network settings, refer to Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production 
Press System Administrator Guide.

Tray 5 (Bypass) 
printing failed. 

Is the correct paper loaded in the 
tray? 

Follow the instructions that appear on the control 
panel to load paper of the correct size, then resend the 
job to print again. 

Unsatisfactory 
print quality. 

Image defect. Refer to Image Quality Troubleshooting. 

Text prints 
incorrectly, text is 
corrupted. 

Non-standard fonts are used for 
printing. 

Check the application or print driver settings. 

The online 
indicator lights, but 
copies are not 
delivered, even 
though the online 
indicator remains 
lit. 

Data remains in the printer 
memory. 

Cancel printing, or purge remaining data. 

Cannot open or 
close trays. 

Did you open a cover or power 
off the printer during printing? 

Power off the printer without closing or opening a 
paper tray. Wait several seconds, then press the power 
switch to the on position. Ensure that the printer is 
online and ready to receive data, then close or open 
the paper tray. 

Copies are not 
made at the 
required size. 

Is the document scanning glass 
or the document cover dirty? 

Clean the document glass or document cover. 

Is the document made of highly 
transparent material, such as a 
transparency? 

Place the document on the document glass, then 
before you make a copy, place a white sheet of paper 
on top of the document. 

Is the document in the correct 
position? 

Load the document correctly. 

Is the document loaded 
correctly? 

Are the document guides in the 
correct position? 

Properly set the document guides. 

Is the document folded or bent? Straighten and properly reload the document. 

Is the document a non-standard 
size? 

Enter the document size at the control panel. 
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SYMPTOMS CHECK REMEDY 

Paper is jammed or 
wrinkled often. 

Is the paper loaded properly in 
the paper tray? 

Load paper correctly. 

Is the paper tray inserted 
properly? 

Firmly push in the tray as far as possible. 

Is the paper damp? Replace with paper from a new ream. 

Is the paper curled? Either turn the paper so that the curl faces down in the 
paper tray, or replace with paper from a new ream. 

Are the paper and paper tray 
settings correct? 

Ensure that the paper and paper tray selected match 
the paper size settings. 

Refer to Paper Tray Settings in Xerox® PrimeLink® 

B9100/B9110/B9125/B9136 Production Press System 
Administrator Guide.

Are there any torn pieces of 
paper remaining inside the 
printer, or is there a foreign 
object in the printer? 

Open the door of the printer or slide out the paper tray, 
then remove the torn paper or the foreign object. 

Is unsupported paper loaded in 
the tray? 

Replace with paper that meets printer specifications. 

Is the paper tray loaded past the 
maximum fill line? 

Load paper in the paper tray so that it does not exceed 
the maximum fill line. 

Is the paper guide set correctly? Load the paper correctly, and apply the paper guides 
lightly. 

Documents are not 
fed into the 
document feeder. 

Are the documents too small? The minimum size of the document that can be loaded 
on the document feeder is A5, 148 x 210 mm (5.8 x 
8.3 in.). 

An error message 
appears after 
paper is loaded in 
paper Tray 5 
(Bypass) and the 
Start button is 
pressed. 

Check the position of the paper 
guides at the front side of paper 
Tray 5 (Bypass). 

Set the paper guides to the correct positions. 

Documents jam 
often. 

Is the right type of paper or 
media used? 

Ensure that the document feeder is loaded properly 
with acceptable media. 

Are you trying to copy irregular 
shaped documents, business 
cards, transparencies, or thin 
documents? 

Are you trying to copy Remove sticky labels, paper clips, or adhesive tape from 
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SYMPTOMS CHECK REMEDY 

documents affixed with sticky 
labels, paper clips, or adhesive 
tape? 

the document before copying. 

Are the document guides at the 
correct position? 

Properly set the document guides. 

Is part of the document ripped, 
and a piece of paper remains in 
the document feeder? 

Open the document feeder cover and check for pieces 
of paper. 

When you import originals of 
different sizes, is Mixed Size 
Originals set to ON? 

Set Mixed Size Originals to ON. 

Is an A5-size document loaded 
horizontally on the document 
feeder when the Mixed Size 
Originals feature is in use? 

Load the A5-size document vertically. 

A corner of the 
document is 
folded. 

Is the document curled? Flatten out the curl, then load the document again. 

Fuser Cleaning 
Web needs 
replacement  

The Fuser Cleaning Web needs replacement. Contact 
your System Administrator. 

For Finisher issues, refer to PR Finisher Troubleshooting.
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Image Quality Troubleshooting

When output image quality is poor, review the following table for solutions.

If image quality does not improve after you perform the relevant remedy, contact Xerox Technical Customer 
Support.

SYMPTOMS CHECK ACTION 

The copy is dirty. Is the document glass or the 
document cover dirty? 

Clean the document glass or the document cover. 

Is the document made of 
highly transparent material, 
such as a transparency? 

If the document is highly transparent, marks on the 
document cover are copied. Place a white sheet of 
paper on the document, then make a copy. 

Is the document colored, of a 
rough texture, or a blueprint? 

Either adjust the copy density or image quality, then 
retry copying. 

Are you making copies of glossy 
printing paper? 

Glossy printing paper sticks easily to the document 
glass, and often, shadows are copied and reproduced 
as dirt. Place a transparency or highly transparent film 
under the document, then retry copying. 

The copy has black 
lines. 

Is the document glass on the 
feeder dirty? 

Clean the document glass. 

The copy is too dark. Is the copy density set to Dark? Adjust the copy density. 

The copy is too 
light. 

Is the copy density set to Light? 

The copy shifts 
slightly. 

Is the paper shifting or is the 
leading edge of the paper not 
loaded flush with the tray 
corners? 

Load the paper so that it is flush against the paper tray 
corners. 

Images on the copy 
are skewed. 

Is the document loaded 
correctly? 

Load the document correctly. 

Is the paper loaded properly in 
the tray? 

Load the paper correctly. 

Is the paper guide for Tray 5 
(Bypass), set so that the tray 
touches the paper? 

Load the paper correctly. 

Are the document guides at the 
correct position? 

Load the document correctly, and align the document 
guides with the edge of the document. 

Is the paper tray set properly? Firmly push in the tray as far as possible. 

Part of the image is 
missing on the copy. 

Is the paper damp? Replace with paper from a new ream. 

Is the loaded paper folded or 

214 Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide

Troubleshooting



SYMPTOMS CHECK ACTION 

wrinkled? 

Is the document pasted 
together or folded in? 

The pasted or folded-in section can curl back and rise 
up from the surface of the document glass. Place a 
stack of white sheets on the document to hold the 
document down flat against the document glass. 

A stripe pattern 
appears in copies. 

Is the document enlargement 
ratio set too large? 

Some enlargement ratios can cause stripes. Adjust the 
copy enlargement ratio. 

Printing is faint, 
smudged, or 
unclear.  

Is the paper damp? Replace with paper from a new ream. 

The drum cartridge is depleted 
or damaged. 

Contact Xerox Technical Customer Support. 

Black dots are 
printed.  

The drum cartridge is depleted 
or damaged. 

Contact Xerox Technical Customer Support. 

Black lines are 
printed.  

The drum cartridge is depleted 
or damaged. 

Contact Xerox Technical Customer Support. 

The document glass on the 
document feeder is dirty. 

Clean the document glass. 

Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide 215

Troubleshooting
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Dirt appears at 
equal intervals.  

Dirt on the paper feed path. Print a few pages. 

The drum cartridge is depleted 
or damaged. 

Contact Xerox Technical Customer Support. 

White dots appear 
in black filled areas.  

The paper in use is unsuitable. Load suitable paper. 

The drum cartridge is depleted 
or damaged. 

Contact Xerox Technical Customer Support. 

• Printed toner 
smudges when 
rubbed with your 
finger. 

• Toner is not 
fused to the 
paper. 

• The paper is 
dirtied with 
toner. 

Is the paper damp? Replace with paper from a new ream. 

The paper in use is unsuitable. Load suitable paper. 
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SYMPTOMS CHECK ACTION 

The entire paper 
area is printed black.  

The drum cartridge is depleted 
or damaged. 

Contact Xerox Technical Customer Support. 

High-voltage power supply 
malfunction. 

Contact Xerox Technical Customer Support. 

Nothing is printed.  Two or more sheets of paper 
are feeding simultaneously, 
known as double feed. 

Fan the paper, then reset the paper. 

High-voltage power supply 
malfunction. 

Contact Xerox Technical Customer Support. 

White areas or 
stripes appear.  

Is the paper damp? Replace with paper from a new ream. 

The paper in use is unsuitable. Load suitable paper. 

The printing on the 
entire page is faint.  

If the print was made using 
Tray 5 (Bypass), the size and 
type of the loaded paper 
differed from the setting on the 
print driver. 

Load paper of the correct size and type into Bypass, 
Tray 5. Fan the paper thoroughly before you load it. 

Two or more sheets can be 
feeding at the same time. 

Fan the paper thoroughly, then reset the paper. 
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SYMPTOMS CHECK ACTION 

Paper becomes 
wrinkled.  

Text is blurred.

The paper in use is unsuitable. Replace with paper from a new ream. 

Paper is being added while it is 
being fed. 

Is the paper damp? 
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SYMPTOMS CHECK ACTION 

White patches 
appear vertically.  

The drum cartridge is depleted 
or damaged. 

Contact Xerox Technical Customer Support. 

Text or images are 
printed at an angle.  

The paper guide in the paper 
tray is not set at the correct 
position. 

Set the horizontal and vertical paper guides to the 
correct positions. 

IMAGE IS  NOT AS EXPECTED

SYMPTOMS 
YES/ 
NO  CAUSE AND ACTION 

The image is dirty 

If No, go to the next symptom.

Yes Cause The document glass or the document cover is dirty.  

Action Clean the document glass or the document cover.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document is made of a highly transparent material, 
like a transparency.  

Action If the document is highly transparent, marks on the 
document cover appear on the image. Place a white sheet 
of paper on the document, then proceed with the scan.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document is colored, of a rough texture, or a blueprint, 
for example.  

Action Adjust the copy density or the image quality, then retry 
scanning. 
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SYMPTOMS 
YES/ 
NO  CAUSE AND ACTION 

If the problem is not solved, go to the next Cause and 
Action.  

Cause Glossy printing paper is being scanned.  

Action Glossy printing paper sticks easily to the document glass. 
When shadows are scanned, the images reproduce as dirt. 
Place a transparency or highly transparent film under the 
document, then retry scanning. 

The image is too dark or too 
light 

If No, go to the next symptom.

Yes Cause Scan density is set to Dark, or to Light.  

Action Adjust the scan density.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The Original Type is inappropriate.  

Action Select an image quality that is appropriate for the 
document. 

Part of the image is missing 

If No, go to next symptom.

Yes Cause The document is pasted together or folded in.  

Action It is possible that the folded in or pasted part of the 
document is not touching the document glass. Place a 
stack of white sheets on the document to hold the 
document flat against the document glass. 

The image is not the needed 
size 

If No, go to the next symptom.

Yes Cause The document glass or the document cover is dirty.  

Action Clean the document glass or the document cover.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document is made of highly transparent material like 
a transparency.  

Action Place a white sheet of paper on the document, then scan.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document is misaligned.  

Action Load the document correctly.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document guides are in an incorrect position.  

Action Load the document correctly, then align the document 
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SYMPTOMS 
YES/ 
NO  CAUSE AND ACTION 

guides with the edges of the document.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document is a non-standard size.  

Action Enter the document size, then scan.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document is folded or bent.  

Action Straighten and reset the document properly. 

The image is coarse Yes Cause Resolution is too low.  

Action Set a higher resolution. 

Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide 221

Troubleshooting



Copy Troubleshooting

UNABLE TO COPY

SYMPTOMS YES/NO CAUSE AND ACTION 

Document is not fed properly 
from the document feeder. 

Yes Cause The document size is too small. 

If No, go to next symptom.  Action The minimum document size that can be loaded on the 
document feeder is A5.    

If the problem is not solved, go to the next Cause and 
Action.  

Cause The right type of document is not being used.  

Action The document feeder cannot be used with irregular- 
sized documents, business cards, transparencies, or thin 
documents. 

Documents with tags, paper clips, and cellophane tape 
cannot be used.

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document guides are set incorrectly.  

Action Set the document guides to match the document size.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause Part of the document is torn, and a piece of torn paper 
remains in the document feeder.  

Action Open the document feeder cover, then remove the torn 
piece of paper.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause Documents of different sizes are set.  

Action When setting documents of different sizes, ensure that 
you select Mixed Size Originals. 
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THE COPY RESULT IS  NOT AS EXPECTED

SYMPTOMS YES/NO CAUSE AND ACTION 

The copy is dirty 

If No, go to the next 
symptom.

Yes Cause The document glass or the document cover is dirty.  

Action Clean the document glass or the document cover.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document is made of highly transparent material, 
such as a transparency.  

Action If the document is highly transparent, marks on the 
document cover are copied. Place a white sheet of paper 
on the document, then make a copy.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause Color paper, rough paper, or blueprint paper is being used.  

Action The background color of the paper is copied. Either adjust 
the copy density or image quality, or specify a background 
suppression color, then retry copying.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause Glossy paper is being used.  

Action Glossy paper easily sticks to the document glass, and 
often, shadows are copied and reproduced as dirt. Place a 
transparency or highly transparent film under the 
document, then retry copying. 

The copy is too dark or too 
light 

If No, go to the next 
symptom.

Yes Cause Copy density is set to Dark, or to Light.  

Action Adjust the copy density.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The density of the document is too light.  

Action Adjust the copy density.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The original type is inappropriate.  

Action Copy the black text. If it is too light, for Original Type, 
select Text. 

The copy shifts slightly Yes Cause Paper loaded in the paper tray is misaligned. 
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If No, go to the next 
symptom.

Action Align the edges of the paper, then load it flush against the 
front tray corners. 

Part of the image is missing 
on the copy 

If No, go to the next 
symptom.

Yes Cause The paper is damp.  

Action Replace with paper from a new ream.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The paper in the paper tray has folds or wrinkles.  

Action Replace with paper from a new ream.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document is pasted together or folded in.  

Action It is possible that the folded in or pasted part of the 
document does not touch the document glass. Place a 
stack of white sheets on the document to hold the 
document down flat against the document glass. 

Stripes appear in the copy 

If No, go to the next 
symptom.

Yes Cause The document enlargement ratio is too large.  

Action Stripes can appear at some enlargement ratios. Adjust the 
copy enlargement ratio. 

Images on the copy are 
skewed 

If No, go to the next 
symptom.

Yes Cause The document is not loaded correctly.  

Action Load the document correctly.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document guides are set incorrectly.  

Action Load the document correctly and align the document 
guides with the edges of the document.   

If the problem is not solved, go to the next Cause and 
Action. 

Yes Cause The paper tray is not inserted properly.  

Action Insert the tray by firmly pushing it in as far as possible.    

If the problem is not solved, go to the next Cause and 
Action.  

Cause The paper guide for Tray 5 (Bypass), is misaligned.  

Action Load the paper correctly, and align the paper guide with 
the edge of the paper. 
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SYMPTOMS YES/NO CAUSE AND ACTION 

Copies are not made at the 
desired size 

If No, go to the next 
symptom.

Yes Cause The document glass or the document cover is dirty.  

Action Clean the document glass or the document cover.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document is made of highly transparent material, 
such as a transparency.  

Action Place a white sheet of paper on the document before 
copying.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document is misaligned.  

Action Load the document correctly.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document guides are in an incorrect position.  

Action Load the document correctly, and align the document 
guides with the edges of the document.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document is a non-standard size.  

Action Enter the document size, then copy.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document is folded or bent.  

Action Straighten and properly reset the document. 
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Print Troubleshooting

This section describes solutions for problems encountered during printing. 

• Unable to print

• The printed result is not as expected

UNABLE TO PRINT

SYMPTOMS YES/NO CAUSE AND ACTION 

Data remains in the printer. 

If No, go to the next 
symptom.

Yes Cause The printer is not powered on.  

Action Power on the printer.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The network cable is disconnected from the computer.  

Action Connect the network cable to the computer.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The network cable is disconnected from the printer.  

Action Connect the network cable to the printer. 

For information about network settings, refer to Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production 
Press System Administrator Guide.

If the problem is not solved, go to the next Cause and 
Action.  

Cause The printer mode is set to Offline.  

Action At the printer control panel, press the Machine Status 
button. On the Machine Status screen, confirm the 
printer mode. If the printer mode is Offline, on the 
Printer Mode screen, select Online.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause An error occurred with the printer.  

Action Check the error details.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The IP address or SMB network path is misconfigured.  

Action Configure a correct IP address or SMB network path. 
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SYMPTOMS YES/NO CAUSE AND ACTION 

For information about network settings, refer to Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production 
Press System Administrator Guide.

If the problem is not solved, go to the next Cause and 
Action.  

Cause The network connection between the computer and 
printer is incorrect.  

Action Contact your System Administrator.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The port is not enabled.  

Action Enable the port that is in use. 

For information about network settings, refer to Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production 
Press System Administrator Guide.

If the problem is not solved, go to the next Cause and 
Action.  

Cause There is insufficient space on the hard drive.  

Action To increase the free space, delete unnecessary data.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The printer is connected to multiple computers.  

Action Wait, then try printing again.  

Cause Lack of communication between the print server and 
the printing system (IOT).  

Action 1 Ensure that cabling is secure. 
2 Change the job or resolution to a lower setting. 
3 Send a job that the user knows was successful. 
4 Power off, then power on the print server and 

printer simultaneously. 

The printer is not printing a 
copy or a network print job. 

Yes Cause The printer is out of paper.  

Action Load paper into the printer paper tray.   

If the problem is not solved, go to the next Cause and 
Action. 
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SYMPTOMS YES/NO CAUSE AND ACTION 

Cause Paper in the printer does not match the specified size.  

Action Load paper that corresponds to the specified paper 
size.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The copy operation is performed during interrupt 
mode, and the job is interrupted.  

Action Cancel the interrupt operation.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause An error occurred in the printer.  

Action Check the error details. If the problem still persists, 
contact Xerox Technical Customer Support.  

Cause Network communication error  

Action 1 Check network settings. Verify that there is no issue 
with the local network. 

2 Power off, then power on the printer. 

THE PRINTED RESULT IS  NOT AS EXPECTED

SYMPTOMS YES/NO CAUSE AND ACTION 

Printing performed with a 
different paper size 

If No, go to the next 
symptom.

Yes Cause The paper size provided is different from the size 
specified for the tray.  

Action Change the paper size loaded in the tray, or change the 
print options to specify a tray that contains the 
appropriate size. 

The image is cut off from the 
edge of the paper 

If No, go to the next 
symptom.

Yes Cause The image exceeds the printable area of the printer.  

Action Increase the printable area of the printer, or decrease the 
document print area. 

The printed font differs from 
the font specified on the 
computer 

If No, go to the next 
symptom.

Yes Cause Font replacement is configured on the print driver.  

Action Check the font replacement table.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause Non-standard fonts are used for printing. 
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SYMPTOMS YES/NO CAUSE AND ACTION 

Action Verify the application or print driver settings. If you are 
using PostScript, download the required fonts. 

Printing is slow 

If No, go to the next 
symptom.

Yes Cause The print mode specifies print quality.  

Action When you print image data that has image quality as a 
priority, such as pictures, the print speed decreases. In the 
print mode, clear the check box for the image quality 
priority. 

The settings specified for 
print options do not take 
effect 

If No, go to the next 
symptom.

Yes Cause A print driver for another model is in use.  

Action Install the print driver for this printer model.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The optional device cannot be attached to the printer.  

Action Verify that the optional device attached is compatible 
with the printer, and reset the printer configuration. 

The printed image expands 
beyond the margins of the 
paper. 

Yes Cause The image exceeds the printable area of the printer.  

Action Increase the printable area of the printer, or decrease the 
document print area. 
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Scan Troubleshooting

Note: This feature can require an optional package. For more information, contact the Customer Support 
Center.

UNABLE TO SCAN WITH THE MACHINE

SYMPTOMS YES/NO CAUSE AND ACTION 

Document not fed properly 
from the document feeder. 

Yes Cause The document size is too small.  

Action The minimum size of the document that can be loaded 
on the document feeder is A5 (148 x 210 mm).   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The correct type of document is not loaded.  

Action You cannot use the document feeder with irregular sized 
documents, business cards, transparencies, or thin 
documents. In addition, you cannot load documents 
with tags, paper clips, or cellophane tape.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The document guides are in the incorrect position.  

Action Set the document guides to match the document size 
correctly.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause Part of the document is ripped, and a piece of paper 
remains in the document feeder.  

Action Open the document feeder cover, then remove the piece 
of paper.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause Documents of different sizes are set.  

Action When you load documents of different sizes, specify 
Mixed Size Originals, otherwise, a paper jam results.  
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UNABLE TO IMPORT THE SCANNED DOCUMENT TO THE COMPUTER

SYMPTOMS YES/NO CAUSE AND ACTION 

Unable to find the scanner 

If No, go to the next symptom.

Yes Cause The printer is not powered on.  

Action Power on the printer.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The network cable is disconnected from the computer.  

Action Connect the network cable to the computer.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The network cable is disconnected from the printer.  

Action Connect the network cable to the printer. 

For information about network settings, refer to the 
Xerox® PrimeLink® B9100/B9110/B9125/B9136 
Production Press System Administrator Guide.

If the problem is not solved, go to the next Cause and 
Action.  

Cause The Salutation port is not enabled.  

Action Enable the Salutation port. 

For information about network settings, refer to the 
Xerox® PrimeLink® B9100/B9110/B9125/B9136 
Production Press System Administrator Guide.

If the problem is not solved, go to the next Cause and 
Action.  

Cause The network connection between the computer and 
printer is abnormal.  

Action Contact your System Administrator. 

Unable to open the mailbox 

If No, go to the next symptom.

Yes Cause No mailbox is created.  

Action Create a mailbox.  

Refer to Local Disk/Mailbox in the Xerox® PrimeLink® 

B9100/B9110/B9125/B9136 Production Press System 
Administrator Guide.

If the problem is not solved, go to the next Cause and 
Action.  

Cause You have forgotten the mailbox password. 
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SYMPTOMS YES/NO CAUSE AND ACTION 

Action If you are unable to verify the password, set the 
password to Off, then reset the password. 

Refer to Local Disk/Mailbox in the Xerox® PrimeLink® 

B9100/B9110/B9125/B9136 Production Press System 
Administrator Guide.

Scanner unable to scan data 
due to TWAIN transmission 
error 

If No, go to the next symptom.

Yes Cause The scan driver is not installed.  

Action Install the scan driver. 

Operation halts during 
scanning 

Yes Cause Is the file size too large?  

Action Reduce the resolution, or choose a compressed output 
file format, then rescan. 

UNABLE TO SEND THE SCANNED DOCUMENT OVER THE NETWORK (FTP/SMB)

SYMPTOMS YES/NO CAUSE AND ACTION 

Unable to forward scanned 
documents over the network. 

Yes Cause Is the server information entered correctly in the printer?  

Action Verify that you have entered the server information 
correctly in the printer.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause Is the save location information entered correctly in the 
printer?  

Action Verify that the save location information is entered 
correctly in the printer.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause When using SMB, is the Shared Name entered correctly in 
the printer?  

Action Verify that the Shared Name is entered correctly in the 
printer.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause When using SMB (UNC Format), is the save location 
information entered correctly in the printer?  

Action Verify that the save location information is entered 
correctly in the printer. 
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SYMPTOMS YES/NO CAUSE AND ACTION 

If the problem is not solved, go to the next Cause and 
Action.  

Cause Is the login name entered correctly in the printer?  

Action Verify that the login name is entered correctly in the 
printer.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause Is the password entered correctly in the printer?  

Action Verify that the password is entered correctly in the printer. 

PROBLEMS WITH SENDING EMAIL

SYMPTOMS 
YES/ 
NO CAUSE AND ACTION 

Unable to send email Yes Cause The email address is incorrect  

Action Verify that the email address is correct.   

If the problem is not solved, go to the next Cause and 
Action.  

Cause The maximum sending email size is exceeded.  

Action Change the maximum sending email size, or reduce the 
resolution. 

For maximum email size, refer to Xerox® PrimeLink® 

B9100/B9110/B9125/B9136 Production Press System 
Administrator Guide.
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Paper Jams

If a paper jam occurs, a fault screen appears a message on the user interface that indicates the area in which the 
jam is situated. Follow the instructions provided to clear the jam and resume printer operation.

INFORMATION ABOUT PAPER JAMS

Review the following list to address paper jams:

• When paper jams inside the printer, the printer stops and an alarm sounds.

• To remove jammed paper, follow the instructions that appear on the control panel.

• Gently, remove the paper so that it does not tear. If paper is torn, ensure that you remove all the torn pieces of 
paper.

• If a piece of paper remains jammed inside the printer, the paper jam message remains on the printer touch 
screen.

• You can remove paper jams when the printer is powered on. When the printer is powered off, all information 
stored to the memory of the printer is erased.

• Do not touch components inside the printer. This action can cause print defects.

• After you clear a paper jam, printing resumes automatically from the state before the paper jam occurred.

• If a paper jam occurred during copying, press the Start button. Copying resumes from the state before the 
paper jam occurred.

Warning: When you remove jammed paper, ensure that no pieces of jammed paper are left in the 
printer. A piece of paper that remains in the printer can cause a fire. If a piece of paper is stuck in a 
hidden area, or paper is wrapped around the fuser unit or rollers, do not remove the paper forcefully. To 
prevent injury, power off the printer immediately, then contact Xerox Technical Customer Support.

DOCUMENT FEEDER JAMS

1. Gently, release the latch of the document feeder top cover, then open the cover completely. 
o 

2. Open the left cover.

234 Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide

Troubleshooting



3. If the paper is not caught in the entry of the document feeder, remove the jammed paper. 

4. If the printer touch screen message instructs you to open the inner cover, lift the lever, then open the inner 
cover. Remove the jammed paper. 

Note: If paper is stuck in the document feeder, to avoid damage to the document, do not pull on the paper 
forcefully.

5. If the paper jam is inside the left cover, remove the jammed paper. 

6. Close the following covers until they click into place. Close the covers in the following order: 

• Inner cover

• Top cover

• Left cover
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7. If you cannot find a paper jam, slowly raise the document feeder. If the document is there, remove it. 

8. Close the document feeder.

9. If indicated on the printer touch screen message, raise the feeder tray area, then remove the document. 

10. Gently, return the feeder tray to the original position.

11. After you remove the jammed document, follow the onscreen instructions to reload the document set into the 
document feeder. 

Note: Ensure that there is no torn, wrinkled, or folded paper in the document set. To scan torn, wrinkled, or 
folded documents, use the document glass only. The scanned document sheets are skipped automatically, 
and scanning resumes from the document sheet last scanned before the jam occurred.
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DOCUMENT JAMS UNDER THE DOCUMENT FEEDER BELT

1. Open the document feeder. 

2. To remove the jammed document, grip the belt lever, then release the document feeder belt. 

3. Gently return the belt to the original position. 

4. Close the document feeder.

5. Follow the instructions to reload the entire document set into the document feeder. 

Note: Ensure that there are no torn, wrinkled, or folded documents in the document set. To scan torn, 
wrinkled, or folded documents, use the document glass, only. The scanned document sheets are skipped 
automatically, and scanning resumes from the document sheet last scanned before the jam occurred.
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PAPER JAMS IN TRAYS 1–4

Tip: Always ensure that you clear all paper jams, including any small ripped pieces of paper, before you proceed 
with your copy or print jobs.

1. Pull out the tray where the paper jam occurred. 

Note: To avoid tearing paper, before pulling out a tray, review where the paper jam occurred. Torn paper 
that remains inside the printer can cause printer malfunction.

2. Remove the jammed paper and any torn pieces. 

3. Push in the tray gently until it comes to a stop.

PAPER JAMS IN TRAY 5  (BYPASS)

Tip: Always ensure that you clear all paper jams, including any small, ripped pieces of paper, before you proceed 
with any copy or print jobs.
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1. Open the top cover of Tray 5 (Bypass). 

2. Remove the jammed paper and any paper that is loaded from the Bypass Tray. 

Note: If paper is torn, check inside the printer and remove it.

3. Open the tray cover, then remove the jammed paper. 
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4. Close the tray cover. 

5. Reload the paper into the tray, then resume copying or printing.

Envelope Jams in the Bypass Tray

Note: Envelopes can be fed only from the bypass tray. Verify that the envelopes are a supported type.

Carefully read and adhere to the following guidelines when using envelopes in the bypass tray: 

• Always ensure that the bypass tray guides are against the edges of the envelopes.

• Verify that the attributes of the paper tray are set correctly.

• Some wrinkle is expected on the back of the fed envelope.

PAPER JAMS IN TRANSPORT UNIT 4

Tip: Always ensure that you clear all paper jams, including any small ripped pieces of paper, before you proceed 
with your copy or print jobs.

1. Before you open the front cover, ensure that the printer has stopped printing. 

240 Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide

Troubleshooting



2. Pull out Tray 1. 

3. Pull out Transport Unit 4. Tray 2 comes out as you pull out Transport Unit 4. 

4. Lift lever 4a, then remove the jammed paper. 

Note: If paper is torn, check inside the printer and remove it.

5. Return lever 4a to the original position. 

6. Push in Tray 2 gently until it comes to a stop. Transport Unit 4 is inserted simultaneously.

7. Push in Tray 1 gently until it comes to a stop.

8. Close the front cover completely. If the front cover is open even slightly, the printer does not operate.
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PAPER JAMS INSIDE THE MAIN UNIT

Always ensure that you clear all paper jams, including any small ripped pieces of paper, before you proceed with 
your copy or print jobs. 

Warning: Never touch a labeled area found on the fuser unit or nearby that indicates High Temperature 
and Caution. Contact can lead to burns.

1. Before you open the front cover, ensure that the device has stopped printing. 

2. Rotate the green lever at the center of the transfer module to the right, until it is in the horizontal position. Pull 
out the transfer module to the end. 

3. Lift lever 2b to remove jammed paper. Rotate knob 2a to remove the jammed paper. 
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4. If paper is jammed at the top of the transfer module or inside the fuser unit, pull out the paper toward the left 
to remove it. If you cannot remove the paper, lift lever 2c, then try to remove the paper. 

5. Lift lever 2c as necessary, move lever 2d, then remove the jammed paper. 

6. Rotate knob 2f as necessary, then remove the jammed paper. 
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7. Move lever 3b on the right of the fuser unit as necessary, then remove the jammed paper. 

If the jammed paper remains inside and it is difficult to remove, return the transfer module to the original 
position, then pull out the duplex module. Try again to remove the jammed paper.

8. Lower the handle under the center of the transfer module, then remove the jammed paper. 

9. Insert the transfer module completely, then rotate the green lever 2 to the left. 

Note: If the lever cannot be turned, pull out the transfer module to the middle, then insert it again.

10. Close the front cover completely. If the front cover is open even slightly, the printer does not operate.
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LOWER LEFT COVER JAMS

Note: This procedure shows how to clear a jam when trays 6 and 7 of either the optional HCF or optional 
OHCF are not present. If you have either an HCF or an OHCF, open the front cover to optional trays 6 and 7 
to access this area.

1. Open the lower left cover. 

2. Remove the jammed paper. 

Note: If paper is torn, check inside the printer, then remove it.

3. Close the lower left cover. 

Note: If the lower left cover is open, a message appears on the user interface, and the printer cannot 
operate.

PAPER JAMS IN THE BOTTOM-RIGHT DOOR

Tip: Always ensure that you clear all paper jams, including any small ripped pieces of paper, before you proceed 
with your copy or print jobs.
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1. Ensure that the machine has stopped printing before you open the front door of the Interface Decurler Module. 

2. Slide the door latch downward and open the bottom-right door. 

3. Remove the jammed paper. 

Note: If paper is torn, check inside the printer, then remove it.

4. Close the bottom-right door. 

Note: If the bottom-right cover is open, a message appears on the user interface, and the printer cannot 
operate.

5. Close the front door of the Interface Decurler Module completely. If the door is open, a message appears on 
the user interface, and the printer cannot operate.
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Fax Problems

If a fax cannot be sent or received correctly, refer to the following table, then perform the indicated operation. If a 
fax still cannot be sent or received correctly, even after performing the described operations, contact your service 
representative.

PROBLEMS SENDING FAXES

SYMPTOM CAUSE SOLUTION 

The document is not scanned 
using the document feeder. 

The document is too thick, too thin, 
or too small. 

Use the document glass to send the fax. 

The document is scanned at an 
angle. 

The document feeder guides are 
not adjusted to the width of the 
document. 

Adjust the document feeder guides to 
fit the width of the document. 

The fax received by the 
recipient is blurry. 

The document is positioned 
incorrectly. 

Position the document correctly. 

The document glass is dirty. Clean the document glass. 

The text in the document is too 
faint. 

Adjust the resolution. Adjust the 
contrast. 

There may be a problem with the 
telephone connection. 

Check the telephone line, then send the 
fax again. 

There may be a problem with the 
sending fax machine. 

To ensure that your printer is operating 
correctly, make a copy. If the copy 
printed correctly, have the recipient 
check the condition of receiving fax 
machine. 

The fax received by the 
recipient is blank. 

The document was loaded 
incorrectly. 

Document feeder: place the document 
to be faxed face up. Document glass: 
place the document to be faxed face 
down. 

Fax was not transmitted. The fax number may be wrong. Check the fax number. 

The telephone line may be 
connected incorrectly. 

Check the telephone line connection. If 
the line is disconnected, connect it. 

There may be a problem with the 
receiving fax machine. 

Contact the fax recipient. 
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PROBLEMS RECEIVING FAXES

SYMPTOM CAUSE SOLUTION 

The received fax is blank. There may be a problem with the 
telephone connection or with the 
sending fax machine. 

Check that the printer can make copies. 
If the printer can make copies, have the 
sender send the fax again. 

The sender may have loaded the 
pages incorrectly. 

Contact the sender. 

The printer answers the call, but 
does not accept incoming data. 

Not enough memory. If the job contains several graphics, the 
printer might not have enough memory. 
The printer does not answer a call if 
memory is low. Delete stored 
documents and jobs, then wait for the 
existing job to complete. This increases 
available memory. 

The received fax size is reduced. The paper supply in the printer 
may not match the document size 
sent. 

Confirm the original size of the 
documents. Documents might be 
reduced based on the available paper 
supply in the printer. 

Faxes are not received 
automatically. 

The printer is set to receive faxes 
manually. 

Set the printer to automatic reception. 

The memory is full. If the paper tray is empty, load paper, 
then print the faxes stored in memory. 

The telephone line is connected 
incorrectly. 

Check the telephone line connection. If 
it is disconnected, connect it. 

There may be a problem with the 
sending fax machine. 

To ensure that your printer is operating 
correctly, make a copy. If the copy 
printed correctly, have the recipient 
check the condition of the receiving fax 
machine. 
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Fault Information

The following occurs when there are faults, such as paper jams, open doors or covers, or a printer malfunction: 

• The printer stops printing and a fault message appears on the printer control panel.

• The message includes an illustration that shows the location of the fault and a brief explanation of the 
corrective actions to clear the fault.

• Paper jams can occur in multiple areas of the printer and in any optional devices that are connected to the 
printer. When a paper jam occurs, the illustration changes to show the multiple locations and the required 
corrective actions.

• If a fault occurs with an optional device, an indicator illuminates on the optional device control panel, and 
shows the corresponding area on the device where the fault occurred.

When you clear paper jams, always refer to the following information: 

• When you remove paper jams, do not power off the printer.

• You can remove paper jams when the printer is powered on. When you power off the printer, all information 
stored to the system memory is erased.

• Before you resume print jobs, clear all paper jams, including any small, torn pieces of paper.

• To avoid possible print defects, do not touch components inside the printer.

• Gently, remove the paper, and take care not to tear it. If paper is torn, ensure that you remove all torn pieces.

• After you remove paper jams, close all doors and covers. When doors or covers are open, the printer does not 
print.

• After you clear a paper jam, printing resumes automatically from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to appear on the printer control panel. To clear any 
remaining jams, refer to the printer control panel for instructions and information.

FAULT MESSAGES

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, 
then a message appears on the printer control panel. An illustration shows the location of the fault and a brief 
explanation of corrective actions to clear the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions.

Note: For detailed information and instructions for clearing a fault, on the printer control panel, touch Faults. 
At the bottom of the fault screen, note the fault code.
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Copy Specifications

ITEM B9100, B9110, B9125, B9136 

Copier Type Console

Scanning Resolution 600 x 600 dpi, 400 x 400 dpi, 300 x 300 dpi, 200 x 200 dpi

Output Resolution 600 x 600 dpi

Note: When the Image Enhancement feature is enabled, the output 
resolution is 2400 x 2400 dpi.

Gradation 256 gradations

Warm-up Time • 300 or fewer seconds 
• 45 or fewer seconds when the main power is on 

Note: Warm-up time is based on the room temperature 23° C (73.4° F).

Copy Document For sheets and books, the maximum size is A3: 297 × 432 mm (11 × 17 in.).

Copy Paper Size Maximum: A3: 297 x 420 mm (11 x 17 in.); 330 × 488 mm (12.6 × 19.2 in.) 

Minimum: A5: 148 x 210 mm (5.75 x 8.25 in.) Postcard for Tray 5 (Bypass)

• Image loss width for A3 or smaller: leading edge 5 mm (.196 in.); trailing 
edge 5 mm (.196 in.); left and right edges 5 mm (.196 in.) 

• Image loss width for paper larger than A3: leading edge 28.0 mm (1.10 in.); 
trailing edge 28.0 mm (1.10 in.); left and right edges 16.5 mm (.649 in.) 

First Copy Output Time

Values can differ depending 
on the printer configuration.

3.9 seconds for A4

Copy Reduction 

Enlargement Ratio

100%: 1:1 ± 0.7%

Preset %: 1:0.500, 1:0.707, 1:0.816, 1:0.866, 1:1.154,1:1.225, 1:1.414, 1:1.632, 
1:2.000

Variable %: 1:0.25 to 1:4.00 in 1% increments

Continuous Copy Speed

When you adjust the image 
quality, the speed can be 
affected.

Depending on the paper 
type, the printer performance 
can be affected. 

• Xerox PrimeLink B9100 Production Press: 

A4: 210 x 297 mm; A: 8.5 x 11 in.: 1-sided: 100 ppm; 2-sided: 100 ppm

A3: 297 x 420 mm (11 x 17 in.): 1-sided: 50 ppm; 2-sided: 50 ppm

• Xerox PrimeLink B9110 Production Press: 

A4: 210 x 297 mm; A: 8.5 x 11 in.: 1-sided: 110 ppm; 2-sided: 110 ppm

A3: 297 x 420 mm (11 x 17 in.): 1-sided: 55 ppm; 2-sided: 55 ppm

• Xerox PrimeLink B9125 Production Press: 

A4: 210 x 297 mm; A: 8.5 x 11 in.: 1-sided: 125 ppm; 2-sided: 125 ppm
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ITEM B9100, B9110, B9125, B9136 

A3: 297 x 420 mm (11 x 17 in.): 1-sided: 62 ppm; 2-sided: 62 ppm

• Xerox PrimeLink B9136 Production Press: 

A4: 210 x 297 mm; A: 8.5 x 11 in.: 1-sided: 136 ppm; 2-sided: 136 ppm

A3: 297 x 420 mm (11 x 17 in.): 1-sided: 68 ppm; 2-sided: 68 ppm

Continuous Copy Pages 9999 sheets

The printer can pause temporarily to perform an image stabilization.

IEC/ISO Certified: 24734, 24735, 17991 

Note: The Fax feature is available only on the Xerox® PrimeLink® B9100 Production Press.
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Print Specifications

TYPE BUILT-IN TYPE 

Continuous Print Speed • Xerox PrimeLink B9100 Production Press: 

A4: 210 x 297 mm; A: 8.5 x 11 in.: 1-sided: 100 ppm; 2-sided: 100 ppm

A3: 297 x 420 mm (11 x 17 in.): 1-sided: 50 ppm; 2-sided: 50 ppm

• Xerox PrimeLink B9110 Production Press: 

A4: 210 x 297 mm; A: 8.5 x 11 in.: 1-sided: 110 ppm; 2-sided: 110 ppm

A3: 297 x 420 mm (11 x 17 in.): 1-sided: 55 ppm; 2-sided: 55 ppm

• Xerox PrimeLink B9125 Production Press: 

A4: 210 x 297 mm; A: 8.5 x 11 in.: 1-sided: 125 ppm; 2-sided: 125 ppm

A3: 297 x 420 mm (11 x 17 in.): 1-sided: 62 ppm; 2-sided: 62 ppm

• Xerox PrimeLink B9136 Production Press: 

A4: 210 x 297 mm; A: 8.5 x 11 in.: 1-sided: 136 ppm; 2-sided: 136 ppm

A3: 297 x 420 mm (11 x 17 in.): 1-sided: 68 ppm; 2-sided: 68 ppm

When continuously printing a single document of A4: 210 x 297 mm (8.5 x 
11 in.), speed can be reduced during the following image-quality 
adjustments:

• When High Precision is specified for the Print Mode in the PCL driver 
• When High Precision or High Image Quality is specified for the Print 

Mode in the PostScript driver 

Performance can be reduced depending on the paper type.

Resolution Output resolution: 600 × 600 dpi

Data processing resolution: 2400 x 2400 dpi

Page Description Language PostScript and PCL6

Emulation ESC/P: VP-1000; HP-GL: HP7586B; HP-GL2/RTL: HP DesignJet 750C Plus); 
PCL5c/PCLXL: HP Color LaserJet 5500; ESCP/K; KS/KSSM

Memory Capacity 512 Mbyte

Built-in Fonts PCL: European: 82 type faces; symbol: 86 sets

PostScript: European: 136 type faces

Interface Standard: Ethernet 100Base-TX/10Base-T

USB 2.0
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TYPE BUILT-IN TYPE 

Supported Protocol Ethernet: TCP/IP (SMB, LPD, Port9100, IPP, WSD, Novell® NetWare); 
NetBEUI (SMB), (IPX/SPX), (NetWare®)

Supported OS • PCL Driver 

– Windows® 10 (32 bit) 

– Windows® 10 (64 bit) 

– Windows® 8.1 (32 bit) 

– Windows® 8.1 (64 bit) 

– Windows® 7 (32 bit) 

– Windows® 7 (64 bit) 

– Windows Server® 2016 (64 bit) 

– Windows Server® 2012 R2 (64 bit) 

– Windows Server® 2012 (64 bit) 

– Windows Server® 2008 R2 (64 bit) 

– Windows Server® 2008 (32 bit) 

– Windows Server® 2008 (64 bit) 

– Mac OS X Driver 

– macOS 10.12 Sierra 

– OS X 10.11 El Capitan 

– OS X 10.10 Yosemite 

– OS X 10.9 Mavericks 
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TYPE BUILT-IN TYPE 

– OS X 10.8 Mountain Lion 

• PostScript Driver 

– Windows® 10 (32 bit) 

– Windows® 10 (64 bit) 

– Windows® 8.1 (32 bit) 

– Windows® 8.1 (64 bit) 

– Windows® 7 (32 bit) 

– Windows® 7 (64 bit) 

– Windows Server® 2016 (64 bit) 

– Windows Server® 2012 R2 (64 bit) 

– Windows Server® 2012 (64 bit) 

– Windows Server® 2008 R2 (64 bit) 

– Windows Server® 2008 (32 bit) 

– Windows Server® 2008 (64 bit) 

– macOS 10.12 Sierra 

– OS X 10.11 El Capitan 

– OS X 10.10 Yosemite 

– OS X 10.9 Mavericks 

– OS X 10.8 Mountain Lion 
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Scan Specifications

TYPE COLOR SCANNER

Scan Size For sheets and books, the maximum size is A3: 297 × 432 mm (11 × 17 in.)

Scan Resolution 600 × 600 dpi, 400 × 400 dpi, 300 × 300 dpi, 200 × 200 dpi

Scan Graduation Color: 10-bit input; 8-bit output for each RGB color

Monochrome: 1-bit input; 1-bit output

Color: 10-bit input; 8-bit output for each RGB color

Document Scan Speed 1-sided: 135 ppm

2-sided: 270 ppm

Note: If you select the Store to Folder option for A4 documents, the 
scan speed is 200 dpi.

Note:  

• 1-sided: 135 ppm 
• 2-sided: 270 ppm 

Scan to Mailbox Scans the data to TIFF, JPEG, PDF, DocuWorks, or XPS (XML Paper 
Specification), then sends the document as an email attachment.

Scan to Windows computer Scans a document, then sends the scanned data to a network computer 
using the FTP or SMB protocol.

Email Supported protocol: TCP/IP: SMTP

Output format: 
• For scanning color documents: monochrome, two colors, TIFF: 

compression types MR (Modified Huffman) and MMR (Modified 
Modified Read)  

• DocuWorks® documents and PDF® 
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Duplex Automatic Document Feeder (DADF) Specifications

ITEM SPECIFICATION

Document Size and Type Size:

Maximum: A3: 297 x 432 mm (11 x 17 in.)

Minimum: A6: 105 x 148 mm (4.1 x 5.8 in.)

Weight: 38–200 g/m2; 2 sided: 50–200 g/m2

Type: A4: 210 x 297 mm; A: 8.5 x 11 in.; A5: 148 x 210 mm (5.8 x 8.3 in.); 
216 x 356 mm short edge feed (SEF); 8.5 x 14 in. (SEF); 297 x 432 mm 
(SEF); 11 x 17 in. (SEF)

Paper Capacity 250 sheets

Note: Maximum sheet capacity for each tray is based on 80 g/m2 

paper.

Document Feeding Speed

A4: 210 x 297 mm; A: 8.5 x 11 in. 
portrait, 1-sided

• For copying 

1-sided: 100 ppm

• For scanning 

1-sided: 135 ppm

2-sided: 270 ppm

Note: If you select the Store to Folder option for A4 
documents, the scan speed is 200 dpi.
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Basic Regulations

Xerox has tested this printer to electromagnetic emission and immunity standards. These standards are designed to 
mitigate interference caused or received by this printer in a typical office environment.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to operate 
this equipment.

UNITED STATES

This product has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of 
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy. If the equipment is not installed and used in accordance with these instructions, it can cause 
harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause 
harmful interference. Users are required to correct the interference at their own expense.

Changes or modifications to this equipment not approved by Xerox can void the authority of the user to operate 
this equipment.

To maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation with 
non-approved equipment or unshielded cables is likely to result in interference to radio and TV reception.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

1. this device may not cause harmful interference, and

2. this device must accept any interference received, including interference that may cause undesired operation.

Responsible Party: Xerox Corporation

Address: 800 Phillips Road, Webster, NY 14580

Web address: www.xerox.com/en-us/about/ehs

CANADA

This Class A digital apparatus complies with Canadian ICES-003 and ICES-001.

Cet appareil numérique de la classe A est conforme à la norme NMB-003 et NMB-001 du Canada.

This device complies with Industry Canada’s licence-exempt RSSs. Operation is subject to the following two 
conditions:

1. This device may not cause interference, and

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.

Le présent appareil est conforme aux CNR d’Industrie Canada applicables aux appareils radio exempts de licence. 
L’exploitation est autorisée aux deux conditions suivantes:

1. l’appareil ne doit pas produire de brouillage, et

2. l’utilisateur de l’appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible 
d’en compromettre le fonctionnement.
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There are operational restrictions for License-Exempt Local Area Network (LE-LAN) devices: the device for operation 
in the band 5150-5250 MHz is only for indoor use to reduce the potential for harmful interference to co-channel 
mobile satellite systems.

Il y a des restrictions opérationnelles pour dispositifs de réseaux locaux exempts de licence (RL-EL): les dispositifs 
fonctionnant dans la bande 5 150-5 250 MHz sont réservés uniquement pour une utilisation à l’intérieur afin de 
réduire les risques de brouillage préjudiciable aux systèmes de satellites mobiles utilisant les mêmes canaux.

This transmitter must not be co-located or operating in conjunction with any other antenna or transmitter. This 
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator and 
your body.

Cet émetteur ne doit pas être Co-placé ou ne fonctionnant en même temps qu’aucune autre antenne ou émetteur. 
Cet équipement devrait être installé et actionné avec une distance minimum de 20 centimètres entre le radiateur et 
votre corps.

EUROPEAN UNION AND EUROPEAN ECONOMIC AREA COMPLIANCE

The CE mark applied to this product indicates compliance to applicable EU Directives.

The full text of the EU Declaration of Conformity is located at www.xerox.com/en-us/about/ 
ehs.

European Union Lot 4 Imaging Equipment Agreement

Xerox has agreed to design criteria for energy efficiency and environmental performance of our products that are in 
scope of the European Union (EU) Energy Related Products Directive, specifically the Lot 4 Imaging Equipment.

In scope products are Household and Office equipment that meet the following criteria: 

• Standard monochrome format products with a maximum speed less than 66 A4 images per minute.

• Standard color format products with a maximum speed less than 51 A4 images per minute

TO LEARN MORE ABOUT: GO TO: 

Power Consumption and Activation Time 

Default Power Saver Settings

User Guide or System Administrator Guide at www.xerox. 
com/en-us/printing-equipment

Benefits of purchasing ENERGY STAR® qualified 
products 

www.energystar.gov

Environmental Benefits of Duplex Printing 

Benefits of using lighter paper weights (60 g/m2) 
and Recyclability

Cartridge disposal and treatment 

Xerox participation in sustainability initiatives

www.xerox.com/en-us/about/ehs

Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide 261

Regulatory Information

https://www.xerox.com/en-us/about/ehs
https://www.xerox.com/en-us/about/ehs
https://www.xerox.com/en-us/printing-equipment
https://www.xerox.com/en-us/printing-equipment
http://www.energystar.gov
https://www.xerox.com/en-us/about/ehs


European Union Lot 19 Ecodesign Directive

Per European Commission Ecodesign Directive, the light source contained within this product or its components is 
intended to be used for Image Capture or Image Projection only and is not intended for use in other applications.

ENERGY STAR

The ENERGY STAR program is a voluntary scheme to promote the development and 
purchase of energy-efficient models, which help to reduce environmental impact. 
Details on the EN- ERGY STAR program and models qualified to ENERGY STAR can be 
found at the following website: www.energystar.gov.

The ENERGY STAR and ENERGY STAR mark are registered United States trademarks.

The ENERGY STAR Imaging Equipment Program is a team effort between United 
States, European Union, and Japanese governments and the office equipment 
industry to promote energy-efficient copiers, printers, fax, multifunction printers, 
personal computers, and monitors. Reducing product energy consumption helps 
combat smog, acid rain, and long-term changes to the climate by decreasing the 
emissions that result from generating electricity.

For more information on energy or other related topics, go to www.xerox.com/about-xerox/environment/enus.html
or www.xerox.co.uk/about-xerox/environment/engb.html.

Power Consumption and Activation Time

The amount of electricity that a device consumes depends on the way the device is used. This device is designed 
and configured to enable you to reduce your energy usage.

Energy Saver modes are enabled on your device to reduce energy consumption. After the last print, the device 
transitions to Ready mode. In this mode, the device can print again immediately. If the device is not used for a 
specified period, the device transitions to Low Power mode, then to Sleep mode. In these modes, only essential 
functions remain active, to reduce power consumption. The device takes longer to produce the first print after it 
exits the Power Saver modes than it takes to print in Ready mode. This delay is the result of the system waking up 
and is typical of most imaging devices on the market.

OOffffiiccee PPrroodduuccttss oonnllyy

To save power, you can configure Energy Saver modes. The following options are available:

• Job Activated: The device wakes when it detects activity. To set the delay before the device enters Sleep Mode, 
enter the number of minutes.

• Sleep and wake up at scheduled times: The device wakes and sleeps according to a schedule that you specify.

• Auto Power Off: To allow the device to power off after a period of time in Sleep Mode, select Auto Power Off. To 
set the delay before the printer power off from the Sleep Mode setting, enter the number of hours.

Note: The USB Drive, and Wired and Non-Wired network activity resets the Energy Saver timers.

This printer is shipped from the factory with Xerox Remote Print Services diagnostics that can disrupt or delay Low 
Power mode and Sleep mode. For settings of Xerox Remote Print Services features, contact your System 
Administrator or refer to the System Administrator Guide at www.xerox.com/office/PLB91XXdocs.
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To change the Energy Saver settings, refer to the User Guide at www.xerox.com/office/PLB91XXdocs. For further 
assistance, contact your System Administrator or refer to the System Administrator Guide.

To enable Auto Power Off mode, contact your System Administrator. For more information, refer to the System 
Administrator Guide at www.xerox.com/office/PLB91XXdocs.

This device is ENERGY STAR®-qualified under the ENERGY STAR Program Requirements for Imaging Equipment. The 
transition time from Ready mode to Low-Power mode can be set up to 60 minutes. The default value is 15 minutes. 
The transition time from Low-Power mode to Sleep mode can be set up to 60 minutes. The default value is set at 
45 minutes. The total transition time from Ready mode to Sleep mode can take up to 60 minutes.

To change the Power Saver settings, or enable Auto Standby capability, contact your System Administrator, or refer 
to Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide at www.xerox.com/ 
office/PLB91XXdocs.

Note: Changing the default Power Saver activation times can result in an overall higher energy consumption 
of the device. Before you turn off Power Saver mode or set a long activation time, consider the increase in 
device power consumption.

EPEAT

This device is registered in the EPEAT directory for meeting the ecolabel properties. Included is the factory defaulted 
Sleep mode enablement. In Sleep mode the printer uses less than 1 Watt of power.

To learn more about Xerox participation in sustainability initiatives, go to www.xerox.com/about-xerox/ 
environment/enus.html or www.xerox.co.uk/about-xerox/environment/engb.html.

Environmental Benefits of Duplex Printing

Most Xerox® products have duplex printing, also known as 2-sided printing, capability. This enables you to print on 
both sides of the paper automatically, and therefore helps to reduce the use of valuable resources by reducing your 
paper consumption. The Lot 4 Imaging Equipment agreement requires that on models greater than or equal to 40 
ppm color or greater than or equal to 45 ppm monochrome the duplex function has been auto enabled, during the 
setup and driver installation. Some Xerox® models below these speed bands may also be enabled with 2-sided 
printing settings defaulted on at the time of install. Continuing to use the duplex function will reduce the 
environmental impact of your work. However, should you require simplex/1-sided printing, you may change the 
print settings in the print driver.

Paper Types

This product can be used to print on both recycled and virgin paper, approved to an environmental stewardship 
scheme, which complies with EN12281 or a similar quality standard. Lighter weight paper (60 g/m²), which contains 
less raw material and thus save resources per print, may be used in certain applications. We encourage you to check 
if this is suitable for your printing needs.
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EURASIAN ECONOMIC UNION COMPLIANCE

The EAC mark applied to this product indicates certification for use on the markets of the 
Member States of the Customs Union.

TURKEY ROHS REGULATION

In compliance with Article 7 (d), we hereby certify "it is in compliance with the EEE regulation."

“EEE yönetmeliðine uygundur.”

UKRAINE ROHS COMPLIANCE

Обладнання відповідаєвимогам Технічного регламенту щодо обмеження використання деяких небезпечних 
речовин в електричному та електронному обладнані, затвердженого постановою Кабінету Міністрів України 
від 3 грудня 2008 № 1057.

The equipment complies with requirements of the Technical Regulation, approved by the Resolution of Cabinet of 
Ministry of Ukraine as of December 3, 2008, in terms of restrictions for the use of certain dangerous substances in 
electrical and electronic equipment.
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Safety Certification

This device is compliant with IEC and EN product safety standards certified by a National Regulatory Test 
Laboratory (NRTL).
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Safety Data Sheets

For Material Safety Data information regarding your printer, go to:

• Web address: https://safetysheets.business.xerox.com/en-us/

• United States and Canada: 1-800-ASK-XEROX (1-800-275-9376)

• Other markets, send an email request to EHS-Europe@xerox.com

266 Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide

Regulatory Information

https://safetysheets.business.xerox.com/en-us/
mailto:EHS-Europe@xerox.com


Copy Regulations

UNITED STATES

Congress, by statute, has forbidden the reproduction of the following subjects under certain circumstances. Penalties 
of fine or imprisonment may be imposed on those guilty of making such reproductions.

1. Obligations or Securities of the United States Government, such as:  

• Certificates of Indebtedness.

• National Bank Currency.

• Coupons from Bonds.

• Federal Reserve Bank Notes.

• Silver Certificates.

• Gold Certificates.

• United States Bonds.

• Treasury Notes.

• Federal Reserve Notes.

• Fractional Notes.

• Certificates of Deposit.

• Paper Money.

• Bonds and Obligations of certain agencies of the government, such as FHA and so on.

• Bonds. United States Savings Bonds may be photographed only for publicity purposes in connection with 
the campaign for the sale of such bonds.

• Internal Revenue Stamps. If it is necessary to reproduce a legal document on which there is a canceled 
revenue stamp, this may be done provided the reproduction of the document is performed for lawful 
purposes.

• Postage Stamps, canceled or uncanceled. For philatelic purposes, Postage Stamps may be photographed, 
provided the reproduction is in black and white and is less than 75% or more than 150% of the linear 
dimensions of the original.

• Postal Money Orders.

• Bills, Checks, or Drafts of money drawn by or upon authorized officers of the United States.

• Stamps and other representatives of value, of whatever denomination, which have been or may be issued 
under any Act of Congress.

• Adjusted Compensation Certificates for Veterans of the World Wars.

2. Obligations or Securities of any Foreign Government, Bank, or Corporation.

3. Copyrighted materials, unless permission of the copyright owner has been obtained or the reproduction falls 
within the “fair use” or library reproduction rights provisions of the copyright law. Further information of these 
provisions may be obtained from the Copyright Office, Library of Congress, Washington, D.C. 20559. Ask for 
Circular R21.
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4. Certificate of Citizenship or Naturalization. Foreign Naturalization Certificates may be photographed.

5. Passports. Foreign Passports may be photographed.

6. Immigration papers.

7. Draft Registration Cards.

8. Selective Service Induction papers that bear any of the following Registrant’s information:  

• Earnings or Income.

• Court Record.

• Physical or mental condition.

• Dependency Status.

• Previous military service.

• Exception: United States military discharge certificates may be photographed.

9. Badges, Identification Cards, Passes, or Insignia carried by military personnel, or by members of the various 
Federal Departments, such as FBI, Treasury, and so on (unless photograph is ordered by the head of such 
department or bureau).

Reproducing the following is also prohibited in certain states:

• Automobile Licenses.

• Drivers’ Licenses.

• Automobile Certificates of Title.

The preceding list is not all inclusive, and no liability is assumed for its completeness or accuracy. In case of doubt, 
consult your attorney.

For more information about these provisions contact the Copyright Office, Library of Congress, Washington, D.C. 
20559. Ask for Circular R21.

CANADA

Parliament, by stature, has forbidden the reproduction of the following subjects under certain circumstances. 
Penalties of fine or imprisonment may be imposed on those guilty of making such reproductions.

• Current bank notes or current paper money

• Obligations or securities of a government or bank

• Exchequer bill paper or revenue paper

• The public seal of Canada or of a province, or the seal of a public body or authority in Canada, or of a court of 
law

• Proclamations, orders, regulations, or appointments, or notices thereof (with intent to falsely cause same to 
purport to have been printed by the Queens Printer for Canada, or the equivalent printer for a province)

• Marks, brands, seals, wrappers, or designs used by or on behalf of the Government of Canada or of a province, 
the government of a state other than Canada or a department, board, Commission, or agency established by 
the Government of Canada or of a province or of a government of a state other than Canada
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• Impressed or adhesive stamps used for the purpose of revenue by the Government of Canada or of a province 
or by the government of a state other than Canada

• Documents, registers, or records kept by public officials charged with the duty of making or issuing certified 
copies thereof, where the copy falsely purports to be a certified copy thereof

• Copyrighted material or trademarks of any manner or kind without the consent of the copyright or trademark 
owner

This list is provided for your convenience and assistance, but it is not all-inclusive, and no liability is assumed for its 
completeness or accuracy. In case of doubt, consult your solicitor.

OTHER COUNTRIES

Copying certain documents may be illegal in your country. Penalties of fine or imprisonment may be imposed on 
those found guilty of making such reproductions.

• Currency notes

• Bank notes and checks

• Bank and government bonds and securities

• Passports and identification cards

• Copyright material or trademarks without the consent of the owner

• Postage stamps and other negotiable instruments

This list is not inclusive and no liability is assumed for either its completeness or accuracy. In case of doubt, contact 
your legal counsel.
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Fax Regulations

UNITED STATES

Fax Send Header Requirements

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other 
electronic device, including a fax machine, to send any message unless such message clearly contains in a margin 
at the top or bottom of each transmitted page or on the first page of the transmission, the date and time it is sent 
and an identification of the business or other entity, or other individual sending the message and the telephone 
number of the sending machine or such business, other entity, or individual. The telephone number provided may 
not be a 900 number or any other number for which charges exceed local or long-distance transmission charges.

For instructions on programming the Fax Send Header information, refer to the section of the System Administrator 
Guide on Setting Transmission Defaults.

Data Coupler Information

This equipment complies with Part 68 of the FCC rules and the requirements adopted by the Administrative Council 
for Terminal Attachments (ACTA). On the cover of this equipment is a label that contains, among other information, 
a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to the Telephone 
Company.

A plug and jack used to connect this equipment to the premises wiring and telephone network must comply with 
the applicable FCC Part 68 rules and requirements adopted by the ACTA. A compliant telephone cord and modular 
plug is provided with this product. It connects to a compatible modular jack that is also compliant. See installation 
instructions for details.

You can safely connect the printer to the following standard modular jack: USOC RJ-11C using the compliant 
telephone line cord (with modular plugs) provided with the installation kit. See installation instructions for details.

The Ringer Equivalence Number (REN) is used to determine the number of devices that can be connected to a 
telephone line. Excessive RENs on a telephone line could result in the devices not ringing in response to an incoming 
call. In most but not all areas, the sum of RENs should not exceed five (5.0). To be certain of the number of devices 
that can be connected to a line, as determined by the RENs, contact the local Telephone Company. For products 
approved after July 23, 2001, the REN is part of the product identifier that has the format US:AAAEQ##TXXXX. The 
digits represented by ## are the REN without a decimal point (for example, 03 is a REN of 0.3). For earlier products, 
the REN is separately shown on the label.

To order the correct service from the local Telephone Company, you could also have to quote the codes in the 
following list:

• Facility Interface Code (FIC) = 02LS2

• Service Order Code (SOC) = 9.0Y

Caution: Ask your local Telephone Company for the modular jack type installed on your line. Connecting 
this machine to an unauthorized jack can damage telephone company equipment. You, not Xerox, 
assume all responsibility and/or liability for any damage caused by the connection of this machine to an 
unauthorized jack.
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If this Xerox® equipment causes harm to the telephone network, the Telephone Company could temporarily 
discontinue service to the telephone line to which it is connected. If advance notice is not practical, the Telephone 
Company notifies you of the disconnection as soon as possible. If the Telephone Company interrupts your service, 
they can advise you of your right to file a complaint with the FCC if you believe that it is necessary.

The Telephone Company could change its facilities, equipment, operations, or procedures which could affect the 
operation of the equipment. If the Telephone Company changes something that affects the operation of the 
equipment, they should notify you in order for you to make necessary modifications to maintain uninterrupted 
service.

If you experience trouble with this Xerox® equipment, please contact the appropriate service center for repair or 
warranty information. Contact information is contained in the Machine Status menu on the printer and in the back 
of the Troubleshooting section of the User Guide. If the equipment is causing harm to the telephone network, the 
Telephone Company may request you to disconnect the equipment until the problem is resolved.

Only a Xerox Service Representative or an authorized Xerox Service provider are authorized to make repairs to the 
printer. This applies at any time during or after the service warranty period. If unauthorized repair is performed, the 
remainder of the warranty period is null and void.

This equipment must not be used on party lines. Connection to party line service is subject to state tariffs. Contact 
the state public utility commission, public service commission, or corporation commission for information.

Your office could have specially wired alarm equipment connected to the telephone line. Make sure that the 
installation of this Xerox® equipment does not disable your alarm equipment.

If you have questions about what could disable alarm equipment, consult your Telephone Company or a qualified 
installer.

CANADA

This product meets the applicable Industry Canada technical specifications.

A representative designated by the supplier should coordinate repairs to certified equipment. Repairs or alterations 
made by the user to this device, or device malfunctions, could cause the telecommunications company to request 
you to disconnect the equipment.

For user protection, make sure that the printer is properly grounded. The electrical ground connections of the power 
utility, telephone lines, and internal metallic water pipe systems, if present, must be connected together. This 
precaution could be vital in rural areas.

Warning: Do not attempt to make such connections yourself. Contact the appropriate electric inspection 
authority, or electrician, to make the ground connection.

The ringer equivalence number (REN) assigned to each terminal device provides an indication of the maximum 
number of terminals allowed to be connected to a telephone interface. The termination on an interface could 
consist of any combination of devices. The only limitation to the number of devices is the requirement that the sum 
of the RENs of the devices does not exceed 5. For the Canadian REN value, please see the label on the equipment.

Canada CS–03 Issue 9

This product has been tested to and is compliant with CS–03 issue 9.
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EUROPEAN UNION

Radio Equipment and Telecommunications Terminal Equipment Directive

This Xerox® device has been self-certified by Xerox® for pan-European single terminal connection to the analog 
public switched telephone network (PSTN) in accordance with Directive 1999/5/EC.

This device has been designed to work with the national public switched telephone networks and compatible PBX 
devices of the following countries:

PAN-EUROPEAN ANALOG PSTN AND COMPATIBLE PBX CERTIFICATIONS 

Austria Greece Netherlands 

Belgium Hungary Norway 

Bulgaria Iceland Poland 

Cyprus Ireland Portugal 

Czech Republic Italy Romania 

Denmark Latvia Slovakia 

Estonia Liechtenstein Slovenia 

Finland Lithuania Spain 

France Luxembourg Sweden 

Germany Malta United Kingdom 

This product has been tested to and is compliant with TBR21 OR ES 103 021-1/2/3 or ES 203 021-1/2/3 technical 
specifications for terminal equipment for use on analog-switched telephone networks in the European Economic 
Area.

If you have problems with your product, contact your local Xerox representative. This product can be configured to 
be compatible with other country networks. Before reconnecting the device to a network in another country, 
contact your Xerox representative for assistance.

Note: Although this product can use either loop disconnect (pulse) or DTMF tone signaling, Xerox 
recommends that you use DTMF signaling. DTMF signaling provides reliable and faster call setup.

Note: Modification of this product, or connection to external control software or control apparatus not 
authorized by Xerox, invalidates its certification.
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NEW ZEALAND

1. The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted that the 
item complies with minimum conditions for connection to its network. It indicates no endorsement of the 
product by Telecom, it does not provide any sort of warranty, and it does not imply that any Telepermitted 
product is compatible with all Telecom network services. Above all, it provides no assurance that any item will 
work correctly in all respects with another item of Telepermitted equipment of a different make or model. 

The equipment may not be capable of correct operation at the higher data speeds designated. 33.6 kbps and 
56 kbps connections are likely to be restricted to lower bit rates when connected to some PSTN 
implementations. Telecom will accept no responsibility for difficulties that arise in such circumstances.

2. Immediately disconnect this equipment should it become physically damaged, then arrange for its disposal or 
repair.

3. This modem shall not be used in any manner which could constitute a nuisance to other Telecom customers.

4. This device is equipped with pulse dialing, while the Telecom standard is DTMF tone dialing. There is no 
guarantee that Telecom lines will always continue to support pulse dialing.

5. Use of pulse dialing, when this equipment is connected to the same line as other equipment, may give rise to 
'bell tinkle' or noise and cause a false answer condition. If you encounter such problems, do not contact the 
Telecom Faults Service.

6. DTMF tones dialing is the preferred method because it is faster than pulse (decadic) dialing and is readily 
available on almost all New Zealand telephone exchanges. 

Warning: No '111' or other calls can be made from this device during a mains power failure.

7. This equipment may not provide for the effective hand-over of a call to another device connected to the same 
line.

8. Some parameters required for compliance with Telecom Telepermit requirements are dependent on the 
equipment (computer) associated with this device. The associated equipment shall be set to operate within the 
following limits for compliance with Telecom Specifications: 

For repeat calls to the same number:

• There shall be no more than 10 call attempts to the same number within any 30 minute period for any 
single manual call initiation, and

• The equipment shall go on-hook for a period of not less than 30 seconds between the end of one attempt 
and the beginning of the next attempt.

For automatic calls to different numbers:

The equipment shall be set to ensure that automatic calls to different numbers are spaced such that there is no 
less than five seconds between the end of one call attempt and the beginning of another.

9. For correct operation, total of the RNs of all devices connected to a single line at any time should not exceed 
five.

SOUTH AFRICA

This modem must be used in conjunction with an approved surge protection device.
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All Countries

If you are managing the disposal of your Xerox product, please note that the printer may contain lead, mercury, 
perchlorate, and other materials whose disposal may be regulated due to environmental considerations. The 
presence of these materials is fully consistent with global regulations applicable at the time that the product was 
placed on the market. For recycling and disposal information, contact your local authorities. Perchlorate Material: 
This product may contain one or more Perchlorate-containing devices, such as batteries. Special handling may 
apply, please refer to www.dtsc.ca.gov/hazardouswaste/perchlorate.

BATTERY REMOVAL

Batteries should only be replaced by a manufacturer-approved service facility.

276 Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide

Recycling and Disposal

http://www.dtsc.ca.gov/hazardouswaste/perchlorate/


North America

Xerox operates an equipment take-back and reuse/recycle program. Contact your Xerox representative (1-800-ASK- 
XEROX) to determine if this Xerox product is part of the program. For more information about Xerox environmental 
programs, go to www.xerox.com/en-us/about/ehs.

For recycling and disposal information, contact your local authorities.
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European Union

These symbols indicate that this product is not to be disposed of with your household waste, according to the 
Waste Electrical and Electronic Equipment (WEEE) Directive (2012/19/EU), the Battery Directive (2006/66/EC) and 
national legislation implementing those Directives.

If a chemical symbol is printed beneath the symbol shown above, in accordance with the Battery Directive, this 
indicates that a heavy metal (Hg = Mercury, Cd = Cadmium, Pb = Lead) is present in this battery or accumulator at 
a concentration above an applicable threshold specified in the Battery Directive.

Some equipment may be used in both a domestic/household and a professional/business application. Private 
households within European Union may return used electrical and electronic equipment to designated collection 
facilities free of charge. For more information about collection and recycling of old products and batteries, contact 
your local municipality, your waste disposal service or the point of sale where you purchased the items. In some 
member states, when you purchase new equipment, your local retailer may be required to take back your old 
equipment free of charge. For more information, contact your retailer.

Business Users in the European Union, in accordance with European legislation, end of life electrical and electronic 
equipment subject to disposal must be managed within agreed procedures. If you wish to discard electrical and 
electronic equipment, contact your dealer or supplier, local reseller or Xerox representative for end of life take-back 
information prior to disposal.

Improper handling of this type of waste could have a possible impact on the environment and human health due 
to potentially hazardous substances that are generally associated with EEE. Your cooperation in the correct disposal 
of this product will contribute to the effective usage of natural resources.

DISPOSAL OUTSIDE OF THE EUROPEAN UNION

These symbols are only valid in the European Union. If you wish to discard these items, please contact your local 
authorities or dealer and ask for the correct method of disposal.
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Other Countries

Please contact your local waste management authority to request disposal guidance.
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Tray 5 (Bypass) Overview

Tray 5, also called the Bypass tray, accommodates all types of stock in various size and weight ranges. Tray 5 holds 
a maximum of 250 sheets of 80 g/m2 plain paper.

There are three ways to connect Tray 5 to your printer: 

• Mounted to the optional 1-Tray or 2-Tray Oversized High Capacity Feeder

• Mounted to the optional High Capacity Feeder

• Mounted directly to the printer

There are two Tray 5 models available:

• Standard Bypass tray: Use this tray with any of the three mounting options.

• Optional Extra Long Sheets (XLS) Bypass tray: Use this tray with the 1-Tray or 2-Tray Oversized High Capacity 
Feeder only.

The supported paper types and weights for Tray 5 varies depending on how the tray is connected to your printer. 
For details, refer to Tray 5 (Bypass) Specifications. 

You can load all media that is supported by your Tray 5 configuration into either Tray 5 model, but when sheets are 
longer than 488 mm (19.21 in.), for the best results, use the optional XLS Bypass Tray mounted to the Oversized 
High Capacity Feeder.
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Loading Media in Tray 5 (Bypass)

LOADING MEDIA IN THE STANDARD BYPASS TRAY

1. Slide out the guides to the needed paper size. 

2. Select the appropriate paper stock for your print job.

3. Open the ream of paper with the seam side facing up.

4. Before you load the paper into the tray, fan the sheets of paper.

5. Load the paper into the tray.

6. Adjust the paper guides so that the guides touch the edges of the stack. 

The Tray Properties window appears.

Note: Do not load materials above the MAX line located on the guides.

7. From the Tray Properties window, verify that the correct paper information such as size, type, and weight are 
selected and match the stock that is loaded in the tray.

8. To save the information and close the Tray Properties window, touch OK.

LOADING MEDIA IN THE OPTIONAL EXTRA LONG SHEETS (XLS)  BYPASS TRAY

To load media in the Extra Long Sheets (XLS) Bypass tray, Tray 5:
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1. Loosen the four screws on the front-edge guide. 

Important: Before you make any adjustments, loosen both sides of the guide. If you adjust the guides 
forcibly, the guides can become misaligned, then a service call is required.

2. Slide out the paper guides to the appropriate paper size. 

3. Select the appropriate media for your print job.

4. Open the media with the seam side facing up.

5. Before loading paper into the XLS Bypass tray, fan the sheets of paper.

6. Insert the media into Tray 5. 

Note: To reduce the risk of multiple sheets feeding into the printer, for sheets with a length over 488 mm 
(19.21 in.), load each sheet separately. The maximum stack size is 20 sheets.
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7. Adjust the paper guides so that they touch the edges of the stack. 

The paper Tray Properties window appears on the control panel. 

Note: Do not load materials above the MAX line on the guides.

8. Tighten the four screws on the front-edge guide. 

9. On the Tray Properties window, verify that the correct paper information such as size, type and weight, are 
selected and match the media that is loaded in the XLS Bypass tray.

10. To save the information and close the Tray Properties window, touch OK.

Adjusting the Skew on Long Paper

Note: This procedure applies to loading paper in the optional XLS Bypass tray only.

If you perform the Auto Alignment procedure and the procedure fails, adjust the skew. 

To verify the alignment, then adjust the skew, perform the following steps:
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1. On the front-edge guide, loosen the four screws. 

Important: Before you make any adjustments, loosen both sides of the front-edge guides. If you adjust 
the guides forcibly, the guides can become misaligned, then a service call is required.

2. Load the paper.

3. Adjust the front-edge guides on the XLS Bypass tray and the rear-edge guides on the XLS Feeder so that the 
guides are as parallel to the printer as possible.

4. Run the Auto Alignment Adjustment procedure. Refer to the Xerox® PrimeLink® B9100/B9110/B9125/B9136 
Production Press System Administrator Guide. 

Note: Only a system administrator can perform the Auto Alignment Adjustment procedure.

If the result of the auto alignment is not satisfactory, continue to the next step.

5. Loosen the four screws on the front-edge guide.
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6. Move the rear edge of the paper to the position that corresponds to the skew amount. 

• If the skew is oriented to the left, use the right-front edge of the paper as the pivot point.

• If the skew is oriented to the right, use the left-front edge of the paper as the pivot point.

IMAGE 
REAR-EDGE GUIDE 
ADJUSTMENT 

FRONT-EDGE GUIDE 
ADJUSTMENT 

Skew is oriented to the left. Move the guides downward. Right side is higher. Left side is 

lower.

Skew is oriented to the right. Move the guides upward. Right side is lower. Left side is 

higher.

7. Tighten the four screws on the front-edge guide. To match the paper size, adjust the rear-edge guide. 

8. Rerun the Auto Alignment Adjustment procedure. Refer to the Xerox® PrimeLink® B9100/B9110/B9125/B9136 
Production Press System Administrator Guide.
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LOADING HOLE-PUNCHED PAPER IN TRAY 5  (BYPASS)

Important: If you are using the XLS Bypass tray, before proceeding, loosen the four locking screws on the 
paper guides. For details, refer to Loading Media in the Optional Extra Long Sheets (XLS) Bypass Tray.

Load and align the edge of the hole-punched paper with the holes against the right edge of the tray. 

LOADING TRANSPARENCIES IN TRAY 5  (BYPASS)

Important: If you are using the XLS Bypass tray, before proceeding, loosen the four locking screws on the 
paper guides. For details, refer to Loading Media in the Optional Extra Long Sheets (XLS) Bypass Tray.

Load the transparencies in the Long-Edge Feed (LEF) direction and align the edge of the transparencies against the 
right edge of the tray, with the side to be printed facing up.

LOADING TAB STOCK IN TRAY 5  (BYPASS)

Important: If you are using the XLS Bypass tray, before proceeding, loosen the four locking screws on the 
paper guides. For details, refer to Loading Media in the Optional Extra Long Sheets (XLS) Bypass Tray.

Load the tab stock long-edge feed (LEF), with the side to be printed facing up. Align the straight edge of the tab 
stock against the right edge of the tray, with the tabs to the left.
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LLooaaddiinngg SSttrraaiigghhtt CCoollllaatteedd TTaabbss

Load straight collated tabs with the first blank tab cutout toward the front of the tray.

LLooaaddiinngg RReevveerrssee CCoollllaatteedd TTaabbss

Load reverse collated tabs with the first blank tab cutout toward the rear of the tray.

LOADING POSTCARDS IN TRAY 5  (BYPASS)

Important: If you are using the XLS Bypass tray, before proceeding, loosen the four locking screws on the 
paper guides. For details, refer to Loading Media in the Optional Extra Long Sheets (XLS) Bypass Tray.

Load postcards Short-Edge Feed (SEF), with the side to be printed facing up.

Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide 289

Tray 5 (Bypass)



LOADING ENVELOPES IN TRAY 5  (BYPASS)

Important: If you are using the XLS Bypass tray, before proceeding, loosen the four locking screws on the 
paper guides. For details, refer to Loading Media in the Optional Extra Long Sheets (XLS) Bypass Tray.

Load envelopes in Tray 5 in the short-edge feed (SEF) or long-edge feed (LEF) direction.

LLooaaddiinngg EEnnvveellooppeess iinn TTrraayy 55 iinn tthhee SSEEFF DDiirreeccttiioonn

When loading envelopes in the SEF direction, ensure that the flaps are closed and face down. Position the envelope 
flaps along the front of the tray.

LLooaaddiinngg EEnnvveellooppeess iinn TTrraayy 55 iinn tthhee LLEEFF DDiirreeccttiioonn

When loading envelopes in the LEF direction, ensure that the flaps are closed and face down. Position the envelope 
flaps along the right side of the tray.
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Tray 5 (Bypass) Specifications

ITEM SPECIFICATION 

Paper size SEF A6 (105 x 148 mm, 4.1 x 5.8 in.)

A5 (148 x 210 mm, 5.8 x 8.3 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

A3 (297 x 420 mm, 11.7 x 16.5 in.)

B6 (128 x 182 mm, 5 x 7.17 in.)

B5 (182 x 257 mm, 7.17 x 10.12 in.)

B4 (257 x 364 mm, 10.12 x 14.33 in.)

Statement (139.7 x 215.9 mm, 5.5 x 8.5 in.)

Executive (184.2 x 266.7 mm, 7.25 x 10.5 in.)

203.2 x 254 mm (8 x 10 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

215 x 315 mm (8.46 x 12.4 in.)

US Folio (215.9 x 330.2 mm, 8.5 x 13 in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

279.4 x 381 mm (11 x 15 in.)

Ledger (279.4 x 431.8 mm, 11 x 17 in.)

Special A4 (226 x 310 mm, 8.9 x 12.2 in.)

DT Special A3 (310 x 432 mm, 12.2 x 17 in.)

304.8 x 457.2 mm (12 x 18 in.)

SRA3 (320 x 450 mm, 12.6 x 17.7 in.)

320 x 488 mm (12.6 x 19.2 in.)

330.2 x 457.2 mm (13 x 18 in.)

330.2 x 482.6 mm (13 x 19 in.)

16K (Taiwan) (194 x 267 mm, 7.64 x 10.51 in.)

8K (Taiwan) (267 x 388 mm, 10.51 x 15.28 in.)

16K (Mainland China) (195 x 270 mm, 7.68 x 10.63 in.)

8K (Mainland China) (270 x 390 mm, 10.63 x 15.35 in.)

Postcard (100 x 148 mm, 3.94 x 5.83 in.)

Reply-paid Postcard (148 x 200 mm, 5.83 x 7.87 in.)

Postcard (101.6 x 152.4 mm, 4 x 6 in.)
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ITEM SPECIFICATION 

Postcard (2L Size Photo) (127 x 177.8 mm, 5 x 7 in.)

LEF A5 (148 x 210 mm, 5.8 x 8.3 in.)

A4 (210 x 297 mm, 8.3 x 11.7 in.)

B5 (182 x 257 mm, 7.17 x 10.12 in.)

Executive (184.2 x 266.7 mm, 7.25 x 10.5 in.)

203.2 x 254 mm (8 x 10 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

A4 Cover (223 x 297 mm, 8.8 x 11.7 in.)

Letter Cover (228.6 x 279.4 mm, 9 x 11 in.)

Special A4 (226 x 310 mm, 8.9 x 12.2 in.)

16K (Taiwan) (194 x 267 mm, 7.64 x 10.51 in.)

16K (Mainland China) (195 x 270 mm, 7.68 x 10.63 in.)

Paper type and weight Tray 5 (Bypass 
Tray) with HCF or 
OHCF 

All supported paper types for Trays 1–4

Heavyweight 2: 217–253 g/m²

Heavyweight Preprinted 2: 217–253 g/m²

Heavyweight Tab Stock 2: 217–253 g/m²

Label 1: 106–216 g/m² 

Label 2: 217–253 g/m²

Transparency

Tray 5 (Bypass 
Tray) connected 
directly to the 
printer 

All supported paper types for Trays 1–4

All supported paper types for Tray 5 with HCF or OHCF

Heavyweight 3: 254-300 g/m²

Heavyweight 4: 301-350 g/m²

Preprinted Heavyweight 3: 254-300 g/m²

Preprinted Heavyweight 4: 301-350 g/m²

Tray capacity 250 sheets of 80 g/m2 of plain paper 

Note: For information on paper types and weights for Trays 1–4, refer to Supported Paper Types and 
Weights.
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High Capacity Feeder, Trays 6 and 7

The letter-size two-tray High Capacity Feeder (HCF), Trays 6 and 7, provides an extra 4000-sheet capacity for A4 
(210 x 297 mm) or 8.5 x 11 in. paper. Each tray holds 2000 sheets, from 16–lb. Bond to 80–lb. Cover, or 52–216 g/ 
m2.

The High Capacity Feeder (HCF) has four fixed Long Edge Feed (LEF) positions, which are marked on the tray:  

• B5

• 10.5 in.

• 11 in.

• A4

The High Capacity Feeder (HCF) has one variable LEF custom position, which supports custom paper sizes from 297 
x 182 mm (11.69 x 7.2 in.) to 330.2 x 241 mm (13 x 9.5 in.).
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Loading Media in the High Capacity Feeder
1. Select the appropriate paper for your print job.

2. Pull out the tray slowly until it stops. 

3. To change the paper size, perform the followings steps: 

a. Remove any paper that is loaded in the tray.

b. To move the paper guides, loosen the two screws. 

c. Adjust the paper guides to fit the new paper size, then retighten the two screws.

4. Open the ream of paper with the seam side facing up.

5. Before you load paper into the tray, fan the sheets of paper.
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6. Load the paper. Align the edges of the paper against the right edge of the tray. 

7. Gently push in the tray until it stops. 

If enabled by your System Administrator, the Paper Tray settings screen appears on the control panel touch 
screen.

8. If you made changes to the paper tray, touch Change Settings. If you did not make changes to the paper 
tray, do the following: 

a. Select options for Paper Type/Paper Weight, Paper Size, and Paper Color features.

b. If needed, make changes to Paper Curl and Alignment Adjustment options. 

c. Touch Save until you are returned to the Paper Tray settings screen.

9. To close the screen, touch Confirm.
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High Capacity Feeder Troubleshooting

PAPER JAMS IN THE HIGH CAPACITY FEEDER

Tip: Before proceeding with your copy and print jobs, ensure that all paper jams are cleared, and any small, torn 
pieces of paper are removed.

1. Before pulling out a paper tray, review where the jam occurred, then pull out the appropriate tray. 

Note: Torn paper remaining inside the printer can cause a printer malfunction.

2. Remove the jammed paper. 

Note: If paper is torn, check inside the printer, then remove the torn paper.

3. Gently push in the tray until it stops.

PAPER JAMS INSIDE THE HIGH CAPACITY FEEDER

Tip: Before proceeding with your copy and print jobs, ensure that all paper jams are cleared, and any small, torn 
pieces of paper are removed.

This section describes how to remove paper jams that occur at the following locations:

• Paper jams in the lower left cover

• Paper jams at lever 1a and knob 1c
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• Paper jams at lever 1b and knob 1c

• Paper jams at lever 1d and knob 1c

Note: Jam clearance remedies differ according to the paper jam location. Follow the instructions that appear 
on the control panel.

Paper Jams Inside the Lower Left Cover

Tip: Before proceeding with your copy and print jobs, ensure that all paper jams are cleared, and any small, torn 
pieces of paper are removed.

1. Open the front cover of the High Capacity Feeder (HCF). 

2. Grip the release lever and open the lower left cover. 
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3. Remove the jammed paper. 

Note: If paper is torn, check inside the printer, then remove the torn paper.

4. Close the lower left cover.

5. Close the front cover of the HCF completely. 

Note: The printer does not operate if the cover is open even slightly.

Paper Jams at Lever 1a and Knob 1c

Tip: Before proceeding with your copy and print jobs, ensure that all paper jams are cleared, and any small, torn 
pieces of paper are removed.

1. Open the front cover of the High Capacity Feeder (HCF). 

2. To remove the jammed paper, do the following: 
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a. Move lever 1a to the right.

b. Rotate knob 1c clockwise, then remove the jammed paper.

Note: If paper is torn, check inside the printer, then remove the torn paper.

3. Return lever 1a to the original position. 

4. Close the front cover of the HCF. 

Note: The printer does not operate if the cover is open even slightly.

Paper Jams at Lever 1b and Knob 1c

Tip: Before proceeding with your copy and print jobs, ensure that all paper jams are cleared, and any small, torn 
pieces of paper are removed.
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1. Open the front cover of the High Capacity Feeder (HCF). 

2. To remove the jammed paper, do the following: 

a. Move lever 1b to the right.

b. Rotate knob 1c clockwise, then remove the jammed paper.

Note: If paper is torn, check inside the printer, then remove the torn paper.

3. Return lever 1b to the original position.

4. Close the front cover of the HCF. 

Note: The printer does not operate if the cover is open even slightly.

Paper Jams at Lever 1d and Knob 1c

Tip: Before proceeding with your copy and print jobs, ensure that all paper jams are cleared, and any small, torn 
pieces of paper are removed.
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1. Open the front cover of the HCF. 

2. To remove jammed paper, do the following: 

a. Lift lever 1d.

b. Remove the jammed paper.

Note: If paper is torn, check inside the printer, then remove the torn paper.

3. If the paper cannot be removed in step 2, do the following steps: 

a. Rotate knob 1c clockwise.

b. Remove the jammed paper.
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4. Return lever 1d to the original position. 

5. Close the front cover of the HCF completely. 

Note: The printer does not operate if the cover is open even slightly.

FAULT INFORMATION

The following occurs when there are faults, such as paper jams, open doors or covers, or a printer malfunction: 

• The printer stops printing and a fault message appears on the printer control panel.

• The message includes an illustration that shows the location of the fault and a brief explanation of the 
corrective actions to clear the fault.

• Paper jams can occur in multiple areas of the printer and in any optional devices that are connected to the 
printer. When a paper jam occurs, the illustration changes to show the multiple locations and the required 
corrective actions.

• If a fault occurs with an optional device, an indicator illuminates on the optional device control panel, and 
shows the corresponding area on the device where the fault occurred.

When you clear paper jams, always refer to the following information: 

• When you remove paper jams, do not power off the printer.

• You can remove paper jams when the printer is powered on. When you power off the printer, all information 
stored to the system memory is erased.

• Before you resume print jobs, clear all paper jams, including any small, torn pieces of paper.

• To avoid possible print defects, do not touch components inside the printer.

• Gently, remove the paper, and take care not to tear it. If paper is torn, ensure that you remove all torn pieces.

• After you remove paper jams, close all doors and covers. When doors or covers are open, the printer does not 
print.

• After you clear a paper jam, printing resumes automatically from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to appear on the printer control panel. To clear any 
remaining jams, refer to the printer control panel for instructions and information.
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Fault Messages

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, 
then a message appears on the printer control panel. An illustration shows the location of the fault and a brief 
explanation of corrective actions to clear the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions.

Note: For detailed information and instructions for clearing a fault, on the printer control panel, touch Faults. 
At the bottom of the fault screen, note the fault code.
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High Capacity Feeder Specifications

ITEM SPECIFICATION 

Media and paper sizes Minimum: Executive: 184.2 x 266.7 mm (7.25 x 10.5 in.); B5: 257 x 182 
mm (10.12 x 7.17 in.) 

Maximum: A4: 210 x 297 mm (8.3 x 11.7 in.)

The High Capacity Feeder (HCF) has four fixed Long Edge Feed (LEF) 
positions that are marked on the tray:  
• B5 
• 10.5 in. 
• 11 in. 
• A4 
The High Capacity Feeder (HCF) has one variable LEF custom position 
297–330.2 mm (11.69–13 in.). The High Capacity Feeder supports Short 
Edge Feed (SEF) from 182–241 mm (7.2–9.5 in.).

Media and paper weight Weight: 52–216 g/m2 or 16 lb. Bond–80 lb. Cover paper 

Tray capacity Each tray holds 2000 sheets for a total of 4000 sheets when using 80 g/m2 

or Xerox 20 lb. paper. 
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Oversized High Capacity Feeder Overview

The Oversized High Capacity Feeder (OHCF) is available in a 1-tray or 2-tray option. The OHCF feeds various stock 
sizes, including standard and oversized stock up to 330.2 x 488 mm (13 x 19.2 in.). Each tray holds 2000 sheets.

Note:  

• The 2-Tray Oversized High Capacity Feeder (OHCF) is not available with Xerox® PrimeLink® B9100 
Production Press configuration.

• The 1-Tray Oversized High Capacity Feeder (OHCF) is not available with Xerox® PrimeLink® B9136 
Production Press configuration.
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Loading Media in the 1-Tray or 2-Tray OHCF

LOADING PAPER IN THE OHCF (1  OR 2  TRAYS)

1. Select the appropriate paper for your print job.

2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.

4. Before loading the sheets into the tray, fan the sheets.

5. Load paper into the tray.

6. To adjust the paper guides, press in the guide release and carefully move the edge guide until it touches the 
edges of the paper in the tray. 
Do not load materials above the MAX line on the rear edge guide.

7. If necessary, set the skew adjustment levers to the required position for your print job.

8. Gently push in the tray until it stops. 

If enabled by your System Administrator, the Paper Tray settings screen appears on the control panel touch 
screen.

9. If you made changes to the paper tray, touch Change Settings. If you did not make changes to the paper 
tray, do the following: 

a. Select options for Paper Type/Paper Weight, Paper Size, and Paper Color.

b. If needed, make changes to Paper Curl and Alignment Adjustment. 

Note: For detailed information on the Paper Curl and Alignment Adjustment options, refer to the Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide.

c. Touch Save until you are returned to the Paper Tray settings screen.

10. To close the screen, touch Confirm.

LOADING SPECIAL MEDIA

Postcard Bracket

The Postcard bracket is delivered with the OHCF from manufacturing. The Postcard bracket allows you to print on 
smaller size media without requiring post-processing cutting or sorting. The Postcard bracket accommodates 101.6 
x 152.4 mm (4 x 6 in.) short-edge feed (SEF) media.

Using the Postcard Bracket

Use the following procedure for installing and using the Postcard bracket when printing on smaller media, 101.6 x 
152.4 mm (4 x 6 in.).
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1. Pull out the tray slowly until it stops. 

2. Move the paper guides out to the farthest positions. 

3. To remove the postcard bracket, loosen the screw on the left side of the tray, then remove the bracket. 

4. To install the postcard bracket: 
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a. Place the bracket on the locating pins on the upper frame and in the grooves on the bottom of the tray.

b. To lock the postcard bracket in place, tighten the thumbscrew.

5. Load the postcard stock SEF (short-edge feed) and against the right side of the tray. 

6. Adjust the paper guides against the paper stock. 

7. Close the paper tray. At the control panel touch screen, confirm the new settings.

8. Run your print job.

9. Upon completion of your print job, remove the postcard stock and the postcard bracket from the tray.
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10. To store the postcard bracket, place the bracket in the storage area on the left side of the tray. Tighten the 
thumbscrew. 

Envelopes

Guidelines for Printing on Envelopes

For envelope guidelines and limitation information, refer to Printing on Envelopes.

Supported Envelope Sizes

For supported envelope sizes, refer to Recommendations for Specific Envelope Sizes.

Loading Envelopes in Trays 6 and 7 with the Optional Envelope Support Kit

Note: If available, use the optional Envelope Support Kit to feed and print envelopes from Trays 6 or 7.

The Envelope Support Kit enables a greater quantity of envelopes to be loaded and printed from the tray.

1. Slowly open one of the paper trays until it stops and remove the paper. 

2. Move the paper guides out to their largest position. 

3. Locate the Envelope Support Kit.
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4. Install the L-shape envelope bracket:  

a. Sit the bracket on the locating pins on the upper frame and in the grooves on the bottom of the tray.

b. Tighten the thumb screw so that it locks the L-shape envelope bracket in place.

5. Locate the larger of the plastic pieces and place it in the bottom of the tray so that it fits around the ends of 
the inboard paper guide.  

6. Locate the shorter plastic piece and install it in the tray:  
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a. Place the shorter plastic piece in the bottom of the tray so that it fits along the right side of the tray and 
into the corner, to the right of the envelope bracket that you installed. 

b. Place the magnet at the end of the piece into the corner of the tray and facing down.  
Ensure that the raised portion of the piece at the other end is facing up and on top of the cork pad on the 
tray bottom.

7. Load the envelopes SEF on top of the plastic inserts, with the flaps closed and facing down.  

Note: Always ensure that the flaps are down and positioned along the front of the tray.

8. Adjust the paper guides against the stock. 

9. Close the paper tray and confirm the new settings at the print server.

10. Run your print job.

11. Upon completion of your print job, remove the envelope stock and the Envelope Support Kit components from 
the tray.

12. Place the Envelope Support Kit components into storage.

13. Store the remaining envelopes in their original packaging.

Loading Envelopes in Tray 5 (Bypass)

Load envelopes in Tray 5 in the short edge feed (SEF) or long edge feed (LEF) direction.
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LLooaaddiinngg EEnnvveellooppeess iinn TTrraayy 55 iinn tthhee SSEEFF DDiirreeccttiioonn

When you load envelopes in the SEF direction, ensure that the flaps are closed and face down, and position the 
flaps along the front of the tray.

LLooaaddiinngg EEnnvveellooppeess iinn TTrraayy 55 iinn tthhee LLEEFF DDiirreeccttiioonn

When you load the envelopes in the LEF direction, ensure that the flaps are closed and face down, and position the 
flaps along the right of the tray.

Loading Tab Stock in the OHCF (1 or 2 Trays)

Note: If the optional GBC® AdvancedPunch™ Pro is attached to your device, for instructions on loading tab 
stock in the trays, refer to the GBC AdvancedPunch Customer Documentation.

1. Select the appropriate paper stock for your print job.

2. Pull out the tray slowly until it stops.

3. Before you load the tab stock into the tray, fan the tab stock.

4. Load and align the edges of the tab stock against the right edge of the tray in the LEF (long-edge feed) 
direction, as shown: 

5. To adjust the paper guides, press in the guide release, then carefully move the edge guide until it touches the 
edges of the paper stock in the tray. 
Do not load paper stock above the MAX line on the rear edge guide.
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6. If necessary, set the skew adjustment levers to the required position for your print job.

7. Gently push in the tray until it stops. 

If enabled by your System Administrator, the Paper Tray settings screen appears on the control panel touch 
screen.

8. If you made changes to the paper tray, touch Change Settings. If you have not made changes to the paper 
tray, do the following steps: 

a. Select options for Paper Type/Paper Weight, Paper Size, and Paper Color features.

b. If needed, make changes to the Paper Curl and Alignment Adjustment options. 

Note: For detailed information on the Paper Curl and Alignment Adjustment options, refer to the Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide.

c. Touch Save until you are returned to the Paper Tray settings screen.

9. To close the screen, touch Confirm.

10. For network print jobs, for instructions on loading tab stock into a tray, refer to your Print Server Customer 
Documentation. At the print server user interface, verify that the tab stock settings are the same as those that 
you selected for the job.

Loading Transparencies in the OHCF (1 or 2 Trays)

1. Select the appropriate paper stock for your print job.

2. Pull out the tray slowly until it stops.

3. Before you load the transparencies into the tray, fan the transparencies to prevent them from sticking together.

4. Load transparencies on top of a small stack of the same size paper. Align the edges of the transparency against 
the edges of the tray, as shown: 

5. To adjust the paper guides, press in the guide release, then carefully move the edge guide until it lightly 
touches the edges of the transparencies in the tray. 
Do not load transparencies above the MAX fill line on the rear edge guide.

6. If necessary, set the skew adjustment levers to the required position for your print job.

7. Gently push in the tray until it stops. 

If enabled by your System Administrator, the Paper Tray settings screen appears on the control panel touch 
screen.

8. If you made changes to the paper tray, touch Change Settings. If you did not make changes to the paper 
tray, do the following: 

a. Select options for the Paper Type/Paper Weight, Paper Size, and Paper Color features.
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b. If needed, make changes to the Paper Curl and Alignment Adjustment options. 

Note: For detailed information on the Paper Curl and Alignment Adjustment options, refer to the Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide.

c. Touch Save until you are returned to the Paper Tray settings screen.

9. To close the screen, touch Confirm.

Loading Hole-Punched Paper

1. Select the appropriate paper stock for your print job.

2. Pull out the tray slowly until it stops.

3. Open the ream of paper with the seam side facing up.

4. Before you load the sheets of paper into the tray, fan the sheets.

5. Load and align the paper against the right side of the tray, in the SEF (short-edge feed) direction, or in the LEF 
(long-edge feed) direction, as shown. 

6. To adjust the paper guides, press in the guide release, then carefully move the edge guide until it lightly 
touches the edges of the paper in the tray. 
Do not load paper above the MAX fill line on the rear edge guide.

7. If necessary, set the skew adjustment levers to the required position for your print job.

8. Gently push in the tray until it stops. 

If enabled by your System Administrator, the Paper Tray settings screen appears on the control panel touch 
screen.

9. If you made changes to the paper tray, touch Change Settings. If you did not make changes to the paper 
tray, do the following: 

a. Select options for the Paper Type/Paper Weight, Paper Size, and Paper Color features.

b. If needed, make changes to the Paper Curl and Alignment Adjustment options. 

Note: For detailed information on the Paper Curl and Alignment Adjustment options, refer to the Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide.

c. Touch Save until you are returned to the Paper Tray settings screen.

10. To close the screen, touch Confirm.
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Oversized High Capacity Feeder (OHCF) Troubleshooting

SKEW ADJUSTMENT LEVERS

The skew adjustment levers are found in all paper trays. The levers are used to improve the paper feed accuracy and 
to reduce paper skew problems.

1. Rear skew adjustment lever

2. Right-side skew adjustment lever 

• Ensure that the levers remain in their default positions. The default position is 0.The position of the levers 
changes only when there is a skew problem when running a specific print job or specific media type.

• Changing the skew adjustment levers from their default position can cause more skew problems when 
running certain media types, such as coated, label, and transparency.

To set the skew adjustment levers, perform the following procedure:

1. Pull out the tray slowly until it stops.

2. Slide the rear skew adjustment lever to the right.

3. Gently push in the tray until it stops.

4. From the Tray Properties window, enter the correct paper information, including size, type, weight, and if 
necessary, paper curl and alignment.

5. To save the information and close the Tray Properties window, touch OK.

6. Run your print job. 

• If the paper is fed accurately without skew and the printed output is successful, your task is complete.

• If the paper is skewed and the printed output is unsuccessful, proceed to the next step.

7. Pull out the tray until it stops.

8. Return the rear skew adjustment lever to the left, default position.

9. Slide the right-side skew adjustment lever toward the front of the paper tray.

10. Gently push in the tray until it stops.

11. From the Tray Properties window, enter the correct paper information, including size, type, weight, and if 
necessary, paper curl and alignment.
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12. To save the information and close the Tray Properties window, touch OK.

13. Run your print job. 

• If the paper is fed accurately without skew and the printed output is successful, your task is complete.

• If the paper is skewed and the printed output is unsuccessful, proceed to the next step.

14. Pull out the tray until it stops.

15. Return the right-side skew adjustment lever toward the rear of the paper tray. This is the default position of 
right-side skew adjustment lever.

16. Gently push in the tray until it stops.

17. If you are still having skew adjustment problems, refer to the Advanced Stock Setup information located in the 
Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide.

CLEARING OHCF JAMS

Tip: Always ensure that all paper jams, including any small torn pieces of paper, are cleared before proceeding with 
your print jobs.

Note: Remedies to remove jammed paper differ according to the paper jam location. To remove jammed 
paper, follow the instructions that appear on the control panel.

Paper Jams Inside the OHCF Trays

1. Pull out the tray slowly where the paper jam occurred. 
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2. Remove the jammed paper. 

Note: If paper is torn, check inside the printer, then remove the torn paper.

3. Gently push in the tray until it stops.

OHCF Paper Jams at Lever 1a and Knob 1c

1. Open the front cover of the OHCF. 

2. To remove the jammed paper, do the following steps: 

a. Pull the lever 1a to the right.

b. Rotate the knob 1c to the right.

c. Remove the jammed paper. 
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Note: If paper is torn, check inside the printer, then remove the torn paper.

3. Return lever 1a to the original position. 

4. Close the front cover of the OHCF. 

Note: If the front cover of the OHCF is not closed completely, a message appears on the printer touch 
screen, and the printer cannot operate.

OHCF Paper Jams at Lever 1b and Knob 1c

1. Open the front cover of the OHCF. 

2. To remove the jammed paper, do the following steps: 

a. Move lever 1b to the right.

b. Rotate knob 1c clockwise.

Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide 323

Oversized High Capacity Feeder



c. Remove the jammed paper. 

Note: If paper is torn, check inside the printer, then remove the torn paper.

3. Return lever 1b to the original position. 

4. Close the front cover of the OHCF. 

Note: If the front cover of the OHCF is not closed completely, a message appears on the printer touch 
screen, and the printer cannot operate.

OHCF Paper Jams at Lever 1d and Knob 1c

1. Open the front cover of the OHCF. 

2. To remove the jammed paper, do the following steps: 
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a. Lift lever 1d.

b. Remove the jammed paper. 

Note: If paper is torn, check inside the printer, then remove the torn paper.

3. If the jammed paper cannot be removed, do the following steps: 

a. Rotate knob 1c clockwise.

b. Remove the jammed paper. 

4. Return lever 1d to the original position. 

5. Close the front cover of the OHCF. 

Note: If the front cover of the OHCF is not closed completely, a message appears on the printer touch 
screen, and the printer cannot operate.
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FAULT INFORMATION

The following occurs when there are faults, such as paper jams, open doors or covers, or a printer malfunction: 

• The printer stops printing and a fault message appears on the printer control panel.

• The message includes an illustration that shows the location of the fault and a brief explanation of the 
corrective actions to clear the fault.

• Paper jams can occur in multiple areas of the printer and in any optional devices that are connected to the 
printer. When a paper jam occurs, the illustration changes to show the multiple locations and the required 
corrective actions.

• If a fault occurs with an optional device, an indicator illuminates on the optional device control panel, and 
shows the corresponding area on the device where the fault occurred.

When you clear paper jams, always refer to the following information: 

• When you remove paper jams, do not power off the printer.

• You can remove paper jams when the printer is powered on. When you power off the printer, all information 
stored to the system memory is erased.

• Before you resume print jobs, clear all paper jams, including any small, torn pieces of paper.

• To avoid possible print defects, do not touch components inside the printer.

• Gently, remove the paper, and take care not to tear it. If paper is torn, ensure that you remove all torn pieces.

• After you remove paper jams, close all doors and covers. When doors or covers are open, the printer does not 
print.

• After you clear a paper jam, printing resumes automatically from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to appear on the printer control panel. To clear any 
remaining jams, refer to the printer control panel for instructions and information.

Fault Messages

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, 
then a message appears on the printer control panel. An illustration shows the location of the fault and a brief 
explanation of corrective actions to clear the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions.

Note: For detailed information and instructions for clearing a fault, on the printer control panel, touch Faults. 
At the bottom of the fault screen, note the fault code.
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OHCF Specifications

Oversized High Capacity Feeder (OHCF), or Trays 6 and 7

ITEM SPECIFICATION 

Paper size SEF A4 (210 x 297 mm, 8.3 x 11.7 in.)

A3 (297 x 420 mm, 11.7 x 16.5 in.)

B5 (182 x 257 mm, 7.17 x 10.12 in.)

B4 (257 x 364 mm, 10.12 x 14.33 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

US Folio (215.9 x 330.2 mm, 8.5 x 13 in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Ledger (279.4 x 431.8 mm, 11 x 17 in.)

Special A4 (226 x 310 mm, 8.9 x 12.2 in.)

DT Special A3 (310 x 432 mm, 12.2 x 17 in.)

304.8 x 457.2 mm (12 x 18 in.)

SRA3 (320 x 450 mm, 12.6 x 17.7 in.)

320 x 488 mm (12.6 x 19.2 in.)

330.2 x 457.2 mm (13 x 18 in.)

330.2 x 482.6 mm (13 x 19 in.)

Postcard (100 x 148 mm, 3.94 x 5.83 in.) *

Postcard (101.6 x 152.4 mm, 4 x 6 in.) *

* The postcard bracket is required.

LEF A4 (210 x 297 mm, 8.3 x 11.7 in.)

B5 (182 x 257 mm, 7.17 x 10.12 in.)

Executive (184 x 267 mm, 7.25 x 10.5 in.)

203.2 x 254 mm (8 x 10 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

Special A4 (226 x 310 mm, 8.9 x 12.2 in.)

16K (Taiwan) (194 x 267 mm, 7.64 x 10.51 in.)

16K (Mainland China) (195 x 270 mm, 7.68 x 10.63 in.)

Custom sizes Width: 182–330 mm (7.2–13 in.)

Length: 182–488 mm (7.2–19.2 in.)
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ITEM SPECIFICATION 

With postcard bracket: 100 x 181–181 x 181 mm (3.94 x 
7.13–7.13 x 7.13 in.)

Paper weight 1-Tray unit: 52–300 g/m²; 16 lb. Bond–110 lb. Cover paper

2-Tray unit: 52–350 g/m²; 16 lb. Bond–130 lb. Cover paper

Tray capacity 2000 sheets for each tray

Important: The capacity of 2000 sheets for each tray is valid when you use 
paper that is up to 80 g/m2 (20 lb.).
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ITEM SPECIFICATION 

Paper type All supported paper types for Trays 1–4 

All supported paper types for Tray 5 (Bypass)

Coated 1: 64–105 g/m²

Coated 1A: 106–135 g/m²

Coated 1B: 136–216 g/m²

Coated 2: 217–253 g/m²

Coated 3: 254–300 g/m²

Coated 4: 301–350 g/m² **

Plain S1: 64–81 g/m²

Bond S1: 82–105 g/m²

Plain S1 Reloaded: 64–105 g/m²

Heavyweight 3: 254–300 g/m²

Heavyweight 4: 301–350 g/m² **

Heavyweight 1S1: 106–216 g/m²

Heavyweight 2S1: 217–253 g/m²

Heavyweight 3S1: 254–300 g/m²

Heavyweight 4S1: 301–350 g/m² **

Recycled S1: 64–105 g/m²

Preprinted S1: 64–105 g/m²

Preprinted HW 1S1: 106–216 g/m²

Preprinted HW 2S1: 217–253 g/m²

Preprinted HW 3S1: 254–300 g/m²

Preprinted HW 4S1: 301–350 g/m² **

Preprinted HW Card: 254–300 g/m²

Preprinted XHW Card: 301–350 g/m² **

** Only the 2-tray OHCF supports paper weights of 301–350 g/m². 

Note:  

• For information about paper types and weights for Trays 1–4, refer to Supported Paper Types and 
Weights.

• For information about paper types and weights for Tray 5 (Bypass), refer to Tray 5 (Bypass) 
Specifications.
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High Capacity Vacuum Feeder (HCVF) Overview

The following information applies to the High Capacity Vacuum Feeder:

• When a paper jam occurs, the error indicator illuminates.

• For the paper level indicator, when the corresponding tray is active, the top active indicator illuminates. The four 
center indicators, 1=25%, indicate the amount of remaining paper. When all four indicators are off, the tray is 
empty and the Empty Paper Indicator illuminates.

• In the event of fault current or a short circuit, the circuit breaker disconnects the electrical supply to the device 
automatically.

• To clear paper jams, open the right side cover.
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Circuit Breaker Switch

During normal operating conditions, the circuit breaker switch is in the up position. Before you move the HCVF, or if 
the HCVF is idle for an extended period of time, switch off the circuit breaker. To switch off the circuit breaker, move 
the switch to the down position.

1. Circuit Breaker Switch

2. Test Button

Note: When a fault is detected, the power to the circuit breaker is disconnected automatically. Do not touch 
the breakers under normal operating conditions.
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Paper and Media for High Capacity Vacuum Feeder

Important: 

• Loading paper above the maximum fill line can cause paper jams or device malfunctions.

• Position the guides correctly to match the paper size. Incorrectly positioned guides can cause misfeeds and 
paper jams.

• When the power is reconnected while the bottom plate of the tray is rising, it is possible that the plate does not 
continue to move up. In this case, pull out the tray, ensure that the plate lowers fully, then push the tray into the 
machine slowly and firmly.

Note: When paper sheets are loaded or fed, the tray makes a sound of supplying air. This sound is caused by 
the Air Assist function and not an abnormal noise.

LOADING PAPER IN THE HIGH CAPACITY VACUUM FEEDER (HCVF)  TRAYS

Important: If fewer than 100 sheets of paper are loaded, the tray guides apply too much pressure to the 
paper, which causes the paper to be skewed. Skewed paper leads to paper jams.

1. Pull out the tray toward you until it stops. 

2. Remove any paper remaining in the tray.

3. Flex the sheets back and forth and fan them, then align the edges of the stack on a level surface. This 
procedure separates any sheets that are stuck together and reduces the possibility of paper jams. 

4. Load 100–500 sheets of paper. 
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a. Align the edges of the paper against the right edge of the tray (1). 
Paper can be loaded in the long-edge-feed (LEF) or portrait direction, or in the short-edge-feed (SEF) or 
landscape direction.

b. To adjust the paper guides, press in the guide release lever and move the guides carefully until they touch 
lightly the edges of the paper in the tray (2).

5. Load the remaining sheets into the tray, then align the paper edges in the direction shown (1). To adjust the 
paper guides, press in the guide release lever and move the guides carefully until they touch lightly the edges of 
the paper (2). 

6. Gently push the tray into the press until it stops.
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Special Media

HHoollee--PPuunncchheedd PPaappeerr

For hole-punched paper, place the paper with the holes to the right when you face the front side of the High 
Capacity Vacuum Feeder (HCVF).

PPrreeccuutt TTaabbss

For precut tabs, place the paper with the tabs to the left when you face the front side of the HCVF. After you load 
the paper, install the appropriate tab guide on the end guide, at the short edge of the paper.

Note: Ensure that the tabs of the precut tab fit the notch of the tab guides.

POSTCARD SETTING

To load paper size 98–181.9 mm portrait or smaller, attach the Postcard Kit to the High Capacity Vacuum Feeder 
(HCVF) tray. The Postcard Kit can be used in the HCVF trays only. 

The following procedure defines how to load paper using postcard guides.
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1. Pull out the tray toward you until it stops. 

2. Remove any paper that remains in the tray.

3. To install the Postcard Kit, remove the postcard guides from their storage area.

4. Remove the shutters. 

a. Fold the shutters (1).

b. Lift the stack of shutters and remove them (2).

5. Insert guide B into the slits on the side (1) and bottom (2) of the tray. Tighten the screw to secure the guide 
(3). 

Caution: If the screw is not tightened fully, it can come off and hit the transport device, which can result 
in breakage of the transport device.
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6. Insert the guide A into the slit on the interior (1) and the bottom (2) of the tray. Tighten the screw to secure 
the guide (3). 

7. Load 100–500 sheets of paper, then align the paper edges in the direction shown (1). For preprinted media, 
load the paper with the printed side facing up. Hold the side guides by its grip, then move them to touch the 
long edges of the paper lightly (2). 

Note: Ensure that you load the paper in the short-edge-feed (SEF) direction. The right side of the short edge 
of the postcard is the leading edge (1).

8. Load the remaining sheets in the tray. 

a. Align the paper edges in the direction shown (1).

b. Move the end guide to touch the short-edges of the paper lightly (2). 
Adjust the paper guides by pressing in the guide release lever and carefully moving the guides until they 
touch the edges of the paper lightly.

9. Gently push the tray into the press until it comes to a stop.

10. To remove and store the postcard guides, perform the following: 

a. Remove any paper from the tray.

b. Unfasten the screw from the postcard guide.
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11. After removing the postcard guides, place the shutters in their original positions, then expand them. 

Note: Hang the edges of the shutters on the beveled shutter retainers on both ends of the adjustable side 
guide. Confirm that they are fixed firmly.

12. Store the postcard guides in their storage area.

Note: Align the triangular marks so that the shutters can be mounted in the correct orientation. In the 
following image, the mark on the guide at the top edge of the paper is not visible, and the mark on the 
guide at the bottom edge of the paper is shown in the correct state.

ENVELOPE SETTING

Before you load envelopes in the paper tray, read and adhere to the following envelope guidelines:

• Curled or waving edges: If there are envelopes with curled or waving edges, replace the envelopes or straighten 
the edges.

• Adhered or glued to each other: If applicable, remove the glue and ensure bonding surfaces of the envelopes do 
not touch.

• Glue protruded: If applicable, wipe off the glue.

• Folded or non-flat surfaces: To flatten the top surface of the pile of envelopes, do the following: 

1. Place 100 envelopes on a level tabletop.

2. Press down the higher side of the top surface of the stack of envelopes.

3. When the higher side are not flattened, reduce the number of loaded envelopes until it becomes flat.

4. Repeat the process for another 100 envelopes. For example, if you are required to prepare 300 envelopes, 
then perform the process three times.
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• Ensure that the top surface of the loaded envelopes is flattened. The height difference between the front and 
back edge of the envelope can be no more than 1 cm with the front edge of the envelope on the lower side. 
This guideline applies only when the Large Envelope Kit is not used. 

Within 1 cm

LLooaaddiinngg aanndd OOrriieennttaattiioonn IInnffoorrmmaattiioonn

• Loading side: Load envelopes with the printable side face up.

• Load direction with the flap open: Place the envelope with the flap facing to the left, when you are at the front 
of the device. 

• Load direction with the flap closed: Place the envelope with the flap facing to the right, when you are at the 
front of the device. 

• When loading self-seal envelopes, fold the flaps.

• If the weight of each envelope is different, a multifeed is detected.

• If the printed output is not as expected, due to the image orientation or the flaps being open or closed, change 
the image orientation at the print server. While changing the image orientation at the print server, do not 
change the direction of loading paper. 

Caution: If envelopes are loaded above the maximum fill line or the top of the envelope stack is not 
level, a device malfunction can occur.

If any of the following fault codes appear, reduce the number of envelopes loaded: 

• Tray 6: 078-250

• Tray 7: 078-260
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EEnnvveellooppee SSppeecciiffiiccaattiioonn

• Type: Uncoated

• Weight: Specify the weight as twice that of the actual. For example, if 70 g/m2 is indicated, specify the weight 
as 140 g/m2.

• Size: 

– Standard size: If the envelope flaps are closed, use this size. 

– Custom size: If the envelope flaps are open, use this size. 

If the output is curled, decurling is required. If the cutting surfaces of envelopes have burrs, before you load the 
envelopes in the tray, flex the envelopes back and forth and fan them.
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High Capacity Vacuum Feeder (HCVF) Troubleshooting

For a printable flowchart of the HCVF Troubleshooting, that is described in the following section, refer to 
Troubleshooting Feed Errors in the Xerox® High Capacity Vacuum Feeder in www.xerox.com. In the Customer 
Support > All Support and Drivers section of the web page, search for your Product. In the Documentation web 
page of your printer, you can find the HCVF Troubleshooting flowchart.

TROUBLESHOOTING MISFEEDS AND MULTIFEEDS IN THE HIGH CAPACITY VACUUM FEEDER 

(HCVF)

When using the optional High Capacity Vacuum Feeder (HCVF) and a misfeed or multifeed condition occurs, check 
the press user interface for one of the following fault codes.

MISFEED FAULT CODES MULTIFEED FAULT CODES 

• 078–101 
• 078–131 
• 078–132 
• 078–151 

• 077–131 
• 077–132 

• 078–125 
• 078–126 
• 078–127 

To resolve misfeed or multifeed conditions, adjust the Air Assist Values setting to a recommended value. For 
instructions on adjusting Air Assist Values, refer to Adjusting Air Assist Values.

To troubleshoot misfeeds, refer to Troubleshooting Misfeeds in the HCVF.

To troubleshoot multifeeds, refer to Troubleshooting Multifeeds in the HCVF.

Adjusting Air Assist Values

The Air Assist Values setting corresponds to a specific configuration of blower settings in the High Capacity Vacuum 
Feeder (HCVF). An adjustment to the Air Assist Values setting results in a different configuration of blower settings.

To optimize blower settings in the HCVF, adjust the Air Assist Values setting. Make adjustments according to the 
recommended troubleshooting instructions only. 

Note: Before you adjust the Air Assist Values setting, ensure that the media loaded in the HCVF adheres to 
the Paper and Media Guidelines for the HCVF.

To adjust the Air Assist Values setting, do the following:

1. At the press user interface, log in as an administrator.

2. Select Machine Status > Tools > System Settings > Common Service Settings > Paper Tray Settings.

3. At the Paper Tray Settings window, select Custom Paper Settings.

4. At the Custom Paper Settings window, a list of profiles is displayed. Each profile corresponds to a set of custom 
settings. Do one of the following: 

• To use an existing profile, select a named profile.

• To create a new profile, select an unused profile, then type a name for the profile.

5. Select Change Settings.
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6. At the Settings window, select Adjust Air Assist Values > Change Settings.

7. At the Adjust Air-Assist Values window, select Custom Table. 

Note: The Custom Table contains a set of numerical settings. Each numerical value in the Custom Table 
maps to a specific blower configuration in the HCVF.

8. To change the Custom Table setting, type the required number. Alternatively, use the up and down arrows to 
select the number.

9. To save the Custom Table setting, select Save.

10. To save the profile, select Save.

11. To close the Custom Paper Settings window, select Close.

12. To close the Paper Tray Settings window, select Close.

Troubleshooting Misfeeds in the HCVF

When using the optional High Capacity Vacuum Feeder (HCVF), the fault codes that indicate a misfeed condition 
are 078–101, 078–131, 078–132, 078–151.

For fault codes relating to multifeeds, refer to Troubleshooting Multifeeds in the HCVF.

To resolve a misfeed, follow the steps in the appropriate section.

Misfeeds when using paper weight 177 g/m² or heavier

When using paper of weights 177 g/m² or heavier, misfeed problems can occur.

1. Make the following adjustments: 

a. Change the Custom Table setting to 5. Save the setting.

b. Run a test print. If no misfeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no misfeed occurs, the problem is resolved.

e. If misfeeds continue, repeat steps 1c and 1d until the Custom Table setting reaches 8.

2. If the problem is not resolved, contact your Xerox representative.

Misfeeds when using paper weight less than 177 g/m² and printing five or fewer sheets

When using paper of weights less than 177 g/m² and printing five or fewer sheets, misfeed problems can 
occur.

Make the following adjustments:

1. Change the Custom Table setting to 32. Save the setting.

2. Run a test print. If no misfeed occurs, the problem is resolved.

3. If a misfeed occurs again, change the Custom Table setting to 33. Save the setting.

4. Run another test print. If the problem is not resolved, contact your Xerox representative.

Misfeeds when using paper weight less than 177 g/m² and printing more than five sheets
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When using paper of weights less than 177 g/m² and printing more than five sheets, misfeed problems 
can occur.

1. Make the following adjustments: 

a. Change the Custom Table setting to 5. Save the setting.

b. Run a test print. If no misfeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no misfeed occurs, the problem is resolved.

e. If misfeeds continue, repeat steps 1c and 1d until the Custom Table setting reaches 8.

2. If a misfeed occurs again, change the Custom Table setting to 32. Save the setting.

3. Run a test print. If no misfeed occurs, the problem is resolved.

4. If a misfeed occurs again, change the Custom Table setting to 33. Save the setting.

5. Run another test print. If the problem is not resolved, contact your Xerox representative.

Troubleshooting Multifeeds in the HCVF

When using the optional High Capacity Vacuum Feeder (HCVF), following fault codes indicate a multifeed 
condition: 

• 077–131, 077–132.

• 078–125, 078–126, 078–127.

For fault codes relating to misfeeds, refer to Troubleshooting Misfeeds in the HCVF.

To resolve a multifeed, follow the steps in the appropriate section.

Multifeeds when using coated paper weight 177 g/m² or heavier
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Humidity levels of 50% or higher

When using coated paper of weight 177 g/m² or heavier in humidity levels of 50% or higher, 
multifeed problems can occur.

Make the following adjustments:

1. If the paper is coated on one side only, go to step 3.

2. If the paper is coated on both sides, do the following: 

a. Change the Custom Table setting to 5. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 2c and 2d until the Custom Table value reaches 8.

3. If using paper that is coated on one side only, or if multifeeds continue, do the following: 

a. Change the Custom Table setting to 9. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 3c and 3d until the Custom Table value reaches 12.

4. If the problem is not resolved, contact your Xerox representative.
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Humidity levels below 50%

When using coated paper of weight 177 g/m² or heavier in humidity levels below 50%, multifeed 
problems can occur.

1. Make the following adjustments: 

a. Change the Custom Table setting to 9. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 1c and 1d until the Custom Table value reaches 12.

2. If multifeeds continue, do the following 

a. Change the Custom Table setting to 35. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 2c and 2d until the Custom Table value reaches 38.

3. If the problem is not resolved, contact your Xerox representative.
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Multifeeds when using uncoated paper weight 177 g/m² or heavier

When using uncoated paper of weight 177 g/m² or heavier, multifeed problems can occur.

1. Make the following adjustments: 

a. Change the Custom Table setting to 9. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 1c and 1d until the Custom Table setting reaches 12.

2. If the problem is not resolved, contact your Xerox representative.
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Multifeeds when using paper weight less than 177 g/m²

Humidity levels of 50% or higher

When using paper of weight less than 177 g/m² in humidity levels of 50% or higher, multifeed 
problems can occur.

1. Make the following adjustments: 

a. Change the Custom Table setting to 9. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 1c and 1d until the Custom Table value reaches 12.

2. If multifeeds continue, do the following: 

a. Change the Custom Table setting to 5. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 2c and 2d until the Custom Table value reaches 8.

3. If a multifeed occurs again, change the Custom Table setting to 32. Save the setting.

4. Run a test print. If no multifeed occurs, the problem is resolved.

5. If a multifeed occurs again, change the Custom Table setting to 33. Save the setting.

6. Run another test print. If the problem is not resolved, contact your Xerox representative.
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Humidity levels below 50%

When using paper of weight less than 177 g/m² in humidity levels below 50%, multifeed 
problems can occur.

1. Make the following adjustments: 

a. Change the Custom Table setting to 5.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 1c and 1d until the Custom Table value reaches 8.

2. If a multifeed occurs again, change the Custom Table setting to 32. Save the setting.

3. Run a test print. If no multifeed occurs, the problem is resolved.

4. If a multifeed occurs again, change the Custom Table setting to 33. Save the setting.

5. Run a test print. If no multifeed occurs, the problem is resolved.

6. If multifeeds continue, do the following: 

a. Change the Custom Table setting to 9. Save the setting.

b. Run a test print. If no multifeed occurs, the problem is resolved.

c. Increase the Custom Table value by one setting. Save the setting.

d. Run a test print. If no multifeed occurs, the problem is resolved.

e. If multifeeds continue, repeat steps 6c and 6d until the Custom Table value reaches 12.

7. If the problem is not resolved, contact your Xerox representative.
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High Capacity Vacuum Feeder Specifications

ITEM SPECIFICATION 

Paper size SEF A4 (210 x 297 mm, 8.3 x 11.7 in.)

A3 (297 x 420 mm, 11.7 x 16.5 in.)

B5 (182 x 257 mm, 7.17 x 10.12 in.)

B4 (257 x 364 mm, 10.12 x 14.33 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

US Folio (215.9 x 330.2 mm, 8.5 x 13 in.)

Legal (216 x 356 mm, 8.5 x 14 in.)

Ledger (279.4 x 431.8 mm, 11 x 17 in.)

Special A4 (226 x 310 mm, 8.9 x 12.2 in.)

DT Special A3 (310 x 432 mm, 12.2 x 17 in.)

304.8 x 457.2 mm (12 x 18 in.)

SRA3 (320 x 450 mm, 12.6 x 17.7 in.)

320 x 488 mm (12.6 x 19.2 in.)

330.2 x 457.2 mm (13 x 18 in.)

330.2 x 482.6 mm (13 x 19 in.)

Postcard (100 x 148 mm, 3.94 x 5.83 in.) *

Postcard (101.6 x 152.4 mm, 4 x 6 in.) *

* The postcard bracket is required.

LEF A4 (210 x 297 mm, 8.3 x 11.7 in.)

B5 (182 x 257 mm, 7.17 x 10.12 in.)

Executive (184 x 267 mm, 7.25 x 10.5 in.)

203.2 x 254 mm (8 x 10 in.)

Letter (216 x 279 mm, 8.5 x 11 in.)

Special A4 (226 x 310 mm, 8.9 x 12.2 in.)

16K (Taiwan) (194 x 267 mm, 7.64 x 10.51 in.)

16K (Mainland China) (195 x 270 mm, 7.68 x 10.63 in.)

Custom sizes Width: 182–330 mm (7.2–13 in.)

Length: 182–488 mm (7.2–19.2 in.)

With postcard bracket: 100 x 181–181 x 181 mm (3.94 x 
7.13–7.13 x 7.13 in.)
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ITEM SPECIFICATION 

Paper weight 1-Tray unit: 52–300 g/m²; 16 lb. Bond–110 lb. Cover paper

2-Tray unit: 52–350 g/m²; 16 lb. Bond–130 lb. Cover paper

Tray capacity 2000 sheets for each tray

Important: The capacity of 2000 sheets for each tray is valid when you use 
paper that is up to 80 g/m2 (20 lb.).

Paper type All supported paper types for Trays 1–4 

All supported paper types for Tray 5 (Bypass)

Coated 1: 64–105 g/m²

Coated 1A: 106–135 g/m²

Coated 1B: 136–216 g/m²

Coated 2: 217–253 g/m²

Coated 3: 254–300 g/m²

Coated 4: 301–350 g/m² **

Plain S1: 64–81 g/m²

Bond S1: 82–105 g/m²

Plain S1 Reloaded: 64–105 g/m²

Heavyweight 3: 254–300 g/m²

Heavyweight 4: 301–350 g/m² **

Heavyweight 1S1: 106–216 g/m²

Heavyweight 2S1: 217–253 g/m²

Heavyweight 3S1: 254–300 g/m²

Heavyweight 4S1: 301–350 g/m² **

Recycled S1: 64–105 g/m²

Preprinted S1: 64–105 g/m²

Preprinted HW 1S1: 106–216 g/m²

Preprinted HW 2S1: 217–253 g/m²

Preprinted HW 3S1: 254–300 g/m²

Preprinted HW 4S1: 301–350 g/m² **

Preprinted HW Card: 254–300 g/m²

Preprinted XHW Card: 301–350 g/m² **

** Only the 2-tray OHCF supports paper weights of 301–350 g/m². 
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Note:  

• For information about paper types and weights for Trays 1–4, refer to Supported Paper Types and 
Weights.

• For information about paper types and weights for Tray 5 (Bypass), refer to Tray 5 (Bypass) 
Specifications.

HHiigghh CCaappaacciittyy VVaaccuuuumm FFeeeeddeerr TTrraayy CCaappaacciittyy

• Tray 5, Bypass Tray: 250 sheets

• HCVF Trays 6 and 7: 2100 sheets for each tray

Note: The values are based on 90 g/m2 paper.

352 Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide

High Capacity Vacuum Feeder



Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide 353

Interface Decurler Modules

This appendix contains:

Interface Decurler Module Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 354

Finishing Accessories Requiring an Interface Decurler Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 355

Interface Decurler Module Components . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 356

Curl Correction on the Interface Decurler Module. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 357

Interface Decurler Module Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 360



Interface Decurler Module Overview

You can use an Interface Decurler Module (IDM) with your printer.

The Interface Decurler Module provides the following functions:

• Communication between the press and the attached finishing device.

• Alignment of the paper path between the press and the attached finishing device.

• Cooling and decurling of the paper as it exits the press.
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Finishing Accessories Requiring an Interface Decurler Module

The following finishing accessories require the Interface Decurler Module:

• GBC® AdvancedPunch® Pro

• High Capacity Stacker (HCS)
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Interface Decurler Module Components

1. Paper Jam and Error Indicator Panel

2. Interface Decurler Module Front Cover

CONTROL PANEL ON THE INTERFACE DECURLER MODULE

1. Paper Jam and Error Indicator

2. Curl Up and Curl Down Indicators

3. Manual Curl Up Button

4. Manual Curl Down Button

5. Auto Curl Button and Indicator
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Curl Correction on the Interface Decurler Module

Tip: The purpose of curl correction is to adjust paper curl as the paper leaves the printer, but before the paper 
reaches the next inline finishing device. Use the Interface Decurler Module (IDM) paper curl-correction feature while 
the printer is printing.

1. Printed media from the printer

2. Interface Decurler Module paper path

3. Printed media from the Interface Decurler Module to inline finishing device

As media enters the module, it moves to the decurler for curl correction. The decurler has a decurler roll that applies 
pressure to the media, based on the following:

• System default: Auto is on.

• Manual selections made from the IDM control panel.

If you want to quickly adjust the media curl on the printed output, use the manual curl-up or curl-down buttons. If 
the printed output contains too much curl after you use these buttons, for more adjustment information, refer to 
Curl Correction Modes and Functions on the Interface Decurler Module.

From the decurler, the printed media is cooled and routed from the Inserter Decurler Module to the next inline 
finishing device that is connected to the printer.

CURL CORRECTION MODES AND FUNCTIONS ON THE INTERFACE DECURLER MODULE

Note: When you select an Interface Decurler Module (IDM) curl-correction mode, the new mode is applied 
to the next sheet that is delivered to the IDM.
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INDICATOR MODE  FUNCTION 

Auto Auto is the default mode. 
• Automatically corrects the 

paper curl by selecting the curl 
direction and amount. Auto 
mode is based on the paper size 
and orientation, and the 
finishing device that is receiving 
the output. 

• When Auto is selected, the 
indicator to the right of the 
button is illuminated. 

• Auto mode has seven 
automated settings for 
controlling paper curl: three up- 
curl settings, three down-curl 
settings, and off. 

• When using the Auto mode, an 
indicator flashes momentarily 
on the control panel. The 
control panel shows the 
preselected curl direction and 
amount of pressure applied to 
the paper. 

Off When the Off indicator is 
illuminated, for either the Auto or 
Manual modes, no curl correction is 
applied to the printed output. 
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INDICATOR MODE  FUNCTION 

Manual Upward 
Curling 

• When the printed output is 
curled up, select the curl-up 
button.  

• There are three upward curl- 
correction values. 

• The top three indicators show 
which level of upward curl 
correction is selected. 

• The top indicator is the highest 
amount of upward curl 
correction that can be applied 
to a printed output. 

Manual 
Downward Curling 

• representation of Manual 
Downward

Curling mode indicator

When the printed output is 
curled down, select the curl- 
down button.  

• There are three downward curl 
correction values. 

• The top three indicators show 
which level of downward curl 
correction is selected. 

• The bottom indicator is the 
lowest amount of downward 
curl correction that can be 
applied to a printed output. 

Pressing the curl-up button changes the curl-correction levels as shown:

Pressing the curl-down button changes the curl-correction levels as shown: 
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Interface Decurler Module Troubleshooting

PAPER JAMS ON THE INTERFACE DECURLER MODULE

The following occurs when there are faults, such as paper jams, open doors or covers, or printer malfunctions:

• The printer stops running and an error message appears on the printer touch screen.

• The message includes an illustration that shows the location of the fault and the corrective actions for clearing 
the fault.

• Paper jams can occur in multiple areas of the printer and any optional devices connected to the printer. When 
multiple jams occur, the illustration changes to show the multiple locations and the required corrective actions.

• If a fault occurs with an optional device, a status indicator on that device control panel shows the corresponding 
area on the device where the fault occurred.

When you clear paper jams, always refer to the following information:

• Do not power off the printer when removing paper jams.

• Paper jams can be removed with the printer still powered on. When the printer is powered off, all information 
stored to the system memory is erased.

• Clear all paper jams before resuming print jobs.

• Do not touch components inside the printer. Touching components can cause print defects.

• Before proceeding with print jobs, ensure that all paper jams are cleared.

• Gently remove the paper and take care not to tear it. If paper is torn, ensure that you remove all the torn paper 
pieces.

• After removing paper jams, close all doors and covers. The printer cannot print when doors or covers are open.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to appear on the printer touch screen. To clear any 
remaining jams, refer to the printer touch screen for instructions and information.
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Clearing Paper Jams on the Interface Decurler Module

1. Open the front cover on the Interface Decurler Module (IDM). 

2. Remove the jammed paper: 

a. Push down lever 1a.

b. Turn knob 1b counterclockwise.  

Note: To ensure that the jammed paper exits the area, turn the knob a minimum of 10 times.

c. Remove the jammed paper. 

Important: Remove the jammed paper by carefully pulling it out of the area.

3. Return lever 1a to the original position. 

4. If you encounter difficulty when removing jammed paper, do the following. 
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a. Push up lever 1c.

b. Carefully remove the jammed paper.

5. Return lever 1c to the original position. 

6. Close the IDM front cover.

7. If necessary, to clear paper jams from other areas of the printer, follow the instructions on the printer control 
panel.

ERROR MESSAGES ON THE INTERFACE DECURLER MODULE

When faults occur, such as paper jams, open doors or covers, or printer malfunctions, the printer stops printing, then 
a message appears on the decurler module control panel. The control panel message includes an illustration that 
shows the location of the fault, and corrective actions for clearing the fault. If a fault occurs in more than one 
location, the illustration changes to indicate the multiple locations and the required corrective actions.

Fault Code Information on the Interface Decurler Module

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, and 
a message appears on the printer control panel touch screen.

The touch screen displays a Faults button that provides information about the fault and detailed instructions for 
correcting the fault. 

Note: Interface Decurler Module faults start with the three-digit number 048. 
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Inserter Module Overview

Note: The Inserter Module requires either High Capacity Stacker or Product Ready Finisher.

Use the inserter module to load media, such as blank, pre-printed, or special stock, that you inserted into the 
finished output. The media serves as separators and covers for the finished output. The printer does not print media 
fed from the inserter module. Instead, the printer places media into the printed output at selected locations.

When using 20–lb, 75 g/m2 paper, the media holds a maximum of 200 sheets. You can load the paper in the LEF or 
SEF direction.

Note: Other names for the inserter include post-process inserter or interposer.
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Inserter Components

1. Tray T1 or Inserter Tray

2. Inserter Control Panel

3. Inserter Front Cover

INSERTER CONTROL PANEL

NUMBER COMPONENT DESCRIPTION 

1 Paper Jam Error Indicator This indicator illuminates when a 
paper jam occurs in the inserter.  

2 Curl Up or Curl Down Indicators Similar to the Interface Decurler 
Module (IDM), these indicators 
show the direction of the curl 
correction. There are only three curl- 
correction options for the inserter: 
• Top indicator: Upward curl 

correction. 
• Bottom indicator: Downward 

curl correction. 
• Middle indicator: Off. No curl 

correction. 
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NUMBER COMPONENT DESCRIPTION 

Important: If the system includes an Interface Decurler Module (IDM), the Inserter Curl Control functions 
are disabled.

3 Manual Curl Up Button When the printed output is curled 
up, select the curl-up button.  

4 Manual Curl Down Button When the printed output is curled 
down, select the curl-down button.  

Auto Curl Button Automatically corrects the paper 
curl by selecting the curl direction 
and amount.  
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Paper and Media for Inserter Tray T1

Tip: Paper fed from the inserter device is not printed on, but the paper is placed into the printed output at selected 
locations. 

SUPPORTED PAPER FOR INSERTER TRAY T1

PAPER SIZE PAPER WEIGHT TRAY CAPACITY 

A4 (210 x 297 mm) or Letter (8.5 x 
11 in.) 

A3 (297 x 432 mm) or Tabloid (11 x 
17 in.)

B4 (250 x 353 mm) or Legal (8.5 x 
14 in.) 

52–350 g/m2 uncoated 

72–350 g/m2 coated

250 sheets, based on 90 g/m2 

paper 

LOADING PAPER IN INSERTER TRAY T1

Tray T1, also known as the Post-Process Inserter or the Interposer, is used to load paper to be used as separators 
and covers. 

• Paper loaded into Tray T1 does not go through the print engine for printing. Use this tray for preprinted stock 
and for insertion into the printed output.

• Tray T1 holds a maximum of 200 sheets when using 20-lb/75 g/m2 paper.

• You can load paper in the LEF or SEF direction.

• For supported paper information, refer to Supported Paper for Inserter Tray T1.

Before using Tray T1, review the following guidelines:

• Remove any remaining paper from the tray.

• Load all the paper required for the job into the tray.

• To use the saddle stitch or bi-fold options, ensure that the paper loaded in the main feeding tray is the same 
size as the paper loaded in tray T1.

• For supported paper information, refer to Supported Paper for Inserter Tray T1.

When the inserter tray is filled with 8.5 inch wide (SEF) media, its default size is 8.5 x 14 in. If you are inserting 8.5 x 
11 in. media, you must adjust the default of NVM 769-503 using Admin Mode Tools. For additional instruction, refer 
to Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide.

To insert separator sheets or cover sheets, such as blank or pre-printed sheets, use the inserter tray T1. Paper that is 
loaded in tray T1 is inserted into the finished or printed output. You can load a maximum of 250 sheets in tray T1. 

Tip: Paper fed from the inserter device is not printed on, but the paper is placed into the printed output at selected 
locations. 

Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide 369

Inserter Module



1. Load the paper into tray T1. If the paper is pre-printed, load the paper with the printed side facing up. Align all 
edges of the paper. 

Note: To avoid possible paper jams or printer malfunctions, do not load paper above the maximum fill line.

2. Grasp the center of the paper guides and gently slide the guides to the required paper size so that the guides 
touch the edges of the paper. 

Note:  

• If the distance between the guides is too long or short for the paper, paper jams can occur.

• If set by the system administrator, the Tray Properties screen appears on the printer control panel.

3. From the Tray Properties screen, enter or verify the correct paper information.

4. To save the paper information and close the Tray Properties screen, touch OK.

PRINTING ON SPECIAL MEDIA

HHoollee--PPuunncchheedd PPaappeerr

Load hole-punched paper into tray T1, LEF (long-egde feed), and with the holes on the right side, as shown.
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TTaabb SSttoocckk

Load tab stock paper in tray T1, LEF (long-egde feed), and with the tabs on the left side, as shown.
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Inserter Troubleshooting

INSERTER PAPER JAMS

The following occurs when there are faults, such as paper jams, open doors or covers, or a printer malfunction:

• The printer stops printing and a fault message appears on the printer control panel.

• The message includes an illustration that shows the location of the fault along and a brief explanation of 
corrective actions to clear the fault.

• Paper jams can occur in multiple areas of the printer and in any optional devices that are connected to the 
printer. When a paper jam occurs, the illustration changes to show the multiple locations and the required 
corrective actions.

• If a fault occurs with an optional device, an indicator illuminates on the device control panel and shows the 
corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the printer when removing paper jams.

• Paper jams can be removed with the printer still powered on. When you power off the printer, all information 
stored to the system memory is erased.

• Before resuming print jobs, clear all paper jams.

• To avoid possible print defects, do not touch components inside the printer.

• Before proceeding with print jobs, ensure that all paper jams, including any small, torn pieces of paper, are 
cleared.

• Gently, remove the paper, taking care not to tear it. If paper is torn, ensure that you remove all the torn pieces 
of paper.

• After removing paper jams, close all the doors and covers. When doors or covers are open, the printer does not 
print.

• After clearing a paper jam, printing resumes automatically from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to appear on the printer control panel. To clear any 
remaining paper jams, refer to the printer control panel for instructions and information.
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Clearing Paper Jams from the Inserter E1 Area

1. To clear paper jams from the inserter E1 area, do the following steps: 

a. Open the T1 cover.

b. Remove the jammed paper.

c. Remove all the paper that is loaded in the tray. 

2. Fan the paper that you removed, and ensure that all four corners of the paper are aligned correctly.

3. Reload the paper into the tray.

4. Close the T1 cover.

Clearing Paper Jams from the Inserter E2 Area

1. Open the inserter front cover. 

2. To clear paper jams from the inserter E2 area, do the following steps: 

a. Lift lever 1a.

b. Rotate knob 1b counterclockwise.
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c. Remove the jammed paper. 

3. Return lever 1a to the original position. 

4. If you have difficulty when you remove the jammed paper, do the following steps: 

a. Push lever 1c to the right.

b. Rotate knob 1b counterclockwise.

c. Remove the jammed paper. 
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5. Return lever 1c to the original position. 

6. Close the inserter front cover.

Clearing Paper Jams from the Inserter E3 Area

1. Open the inserter front cover. 

2. To remove paper jams from the inserter E3 area: 

Note: The jammed paper can be hidden behind the upper-left cover area.

a. Push down lever 1d.

b. Rotate knob 1e counterclockwise.
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c. Remove any jammed paper.

3. Return lever 1d to the original position. 

4. If you have difficulty when removing jammed paper, do the following: 

a. Lift lever 1a.

b. Rotate knob 1e counterclockwise.

c. Remove any jammed paper.

5. Return lever 1a to the original position. 

6. Close the inserter front cover.
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INSERTER FAULT MESSAGES

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, 
then a message appears on the printer touch screen. An illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions.

The touch screen displays a Faults button that provides information about the fault and detailed instructions for 
correcting the fault. The (E) code on the upper-left part of the Fault message displays which error indicator, E1, E2, 
or E3, is illuminated on the inserter control panel.

Inserter Fault Code Information

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, and 
a message appears on the printer touch screen.

The touch screen displays a Faults button that provides information about the fault and detailed instructions for 
correcting the fault.

Tip: Inserter faults are identified by the codes that start with the three-digit numbers 012, 013, and 024. 
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GBC® AdvancedPunch™ Pro
This appendix contains:

The GBC® AdvancedPunch™ Pro is an automatic hole-punch module that integrates with the press to streamline the 
production of reports, directories, pricing guides and other bound books. The hole-punch module equals or 
surpasses traditional quality while saving time and increasing productivity by eliminating the labor-intensive steps 
of manual punching. The compact AdvancedPunch Pro requires minimal space and accepts various optional, 
multiple hole-punch die sets.

The GBC® AdvancedPunch™ Pro can be connected to various optional finishing devices and sits in line with the 
devices.

Note: This optional finishing device requires the Interface Decurler Module.

The GBC® AdvancedPunch™ Pro provides the following capabilities:

• Punches a broad range of media sizes and types

• Trailing edge, LEF (Long-Edge Feed), and SEF (Short-Edge Feed) hole punching

• A die set detection control panel shows the die type and cycle count

• User die set options include comb, wire, coil, and 3–7 hole varieties to enable the most popular binding formats

• Operates at rated print engine speed for most paper sizes 

• Quick-change die sets that can be interchanged without any tools

• All die sets include an identification label that provides users with the hole pattern and name

• Convenient storage area for two extra die sets adjacent to the Punch Chip Container

For detailed information and instructions for using the GBC® AdvancedPunch™ Pro, refer to the guide on the 
customer documentation disk that shipped with the device, or go to www.xerox.com and in the Search box, type 
GBC AdvancedPunch Pro.

http://www.xerox.com
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High Capacity Stacker Overview

Note: This optional finishing device requires the Interface Decurler Module.

The High Capacity Stacker is an optional finishing device that provides large-capacity stacking and offsetting 
capabilities for production output to a stacker tray and cart. The stacker provides a top tray that is convenient for 
short stack runs.
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High Capacity Stacker (HCS) Components

NUM
BER COMPONENT DESCRIPTION 

1 Paper jam or error indicators The indicators illuminate when a paper jam occurs in HCS areas E1– 
E8. 

2 Sample button Press this button to have the HCS deliver a sample sheet to the top 
tray.  

The indicator to the left of the button blinks until a sample sheet is 
delivered to the top tray.

3 Unload button Press this button to stop printing, then remove the paper. 

4 Top tray The tray receives the printed output and sample sheets. 

The top tray holds a maximum of 500 sheets, 330 x 488 mm (13 x 
19.2 in.).

When another inline finishing device is installed, this tray is used as 
a paper path for transporting media through the HCS to another 
connected finishing device.

5 Circuit breaker switch The circuit breaker switch is on the rear of the HCS. If there is an 
electrical failure or a shorted circuit, the switch shuts off electricity 
automatically. 

6 Top cover Open this cover to clear paper jams. 

7 Stacker tray or cart Collated sets, up to a total of 5000 sheets are transported to the 
stacker tray that is on a movable stacker cart. 

8 Front door Open this door to remove paper or printed output. 
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HCS CIRCUIT BREAKER

The High Capacity Stacker circuit breaker is located on the rear of the High Capacity Stacker unit.

1. Test Button

The circuit breaker switch is usually in the On position.

Note: When an electrical interruption occurs, the circuit breaker automatically switches off to discontinue the 
electrical flow to the High Capacity Stacker (HCS). For electrical information, refer to Safety.

OUTPUT TRAYS

The High Capacity Stacker (HCS) has two output trays.

1. Top Tray

2. Stacker Tray or Cart

The top tray offers the following:

• Convenience for short-stack runs, holding up to 500 sheets without offsetting.

• Delivery of purged sheets.
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CONTROL BUTTONS

1. Sample button: Press this button to output a sample sheet to the top tray.

2. Unload button: Press this button to stop printing, then remove the paper.

UNLOADING THE STACKER TRAY OR CART

Note: You can unload the High Capacity Stacker tray if the sheets are delivered to the Top Tray or to the PR 
Finisher.

1. At the HCS control panel, press the Unload button.

2. After the Unload Indicator illuminates, open the HCS front door.

3. Position the securing bar on top of the stacked paper.

4. Pull the stacker cart straight out of the HCS. 

5. Remove the securing bar.

6. Remove the paper from the stacker tray.

7. Push the empty stacker cart straight into the HCS.

8. Position the securing bar on the fixed area inside the HCS.

9. Close the front door. The tray rises to the operate position.
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HCS Troubleshooting

HCS PAPER JAMS

The following occurs when there are faults, such as paper jams, open doors or covers, or a printer malfunction:

• The printer stops running and a fault message appears on the printer touch screen.

• The message includes an illustration that shows the location of the fault and a brief explanation of corrective 
actions for clearing the fault.

• Paper jams can occur in multiple areas of the printer and in any optional devices connected to the printer. 
When multiple jams occur, the illustration changes to show the multiple locations and the required corrective 
actions.

• If a fault occurs with an optional device, an indicator illuminates on the optional device control panel and shows 
the corresponding area on the device where the fault occurred.

When clearing paper jams, always refer to the following information:

• When removing paper jams, do not power off the printer.

• Paper jams can be removed with the printer still powered on. When the power is powered off, all information 
stored to the system memory is erased.

• Before resuming print jobs, clear all paper jams.

• To avoid print defects, do not touch components inside the printer.

• Before preceding with print jobs, ensure that all paper jams, including any small, torn pieces of paper, are 
cleared.

• Gently, remove the paper, taking care not to tear it. If paper is torn, be sure to remove all the torn pieces.

• After removing paper jams, close all doors and covers. When doors or covers are open, the printer does not print.

• After clearing a paper jam, printing automatically resumes from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to appear on the printer touch screen. To clear any 
remaining jams, refer to the printer touch screen for instructions and information.
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Clearing Paper Jams from HCS Area E1

1. Open the HCS top cover. 

2. Do the following: 

a. Lift lever 1b.

b. Remove the jammed paper.

3. Return lever 1b to the original position. 

4. Close the HCS top cover.

5. If the printer indicates that there are more paper jams, follow the instructions to clear the paper jams and to 
resume printing.
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Clearing Paper Jams from HCS Area E2

1. Open the HCS top cover. 

2. Do the following: 

a. Lift lever 1b.

b. Rotate knob 1a counterclockwise.

c. Remove the jammed paper.

3. Return lever 1b to the original position. 

4. Close the HCS top cover.

5. If the printer indicates that there are more paper jams, follow the instructions to clear the paper jams and to 
resume printing.
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Clearing Paper Jams from HCS Area E3

1. Open the HCS top cover. 

2. Do the following: 

a. Lift lever 1b.

b. Rotate knob 1a counterclockwise.

c. Remove the jammed paper.

3. Return lever 1b to the original position. 

4. Do the following: 
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a. Lift lever 2b.

b. Rotate knob 2c counterclockwise.

c. Remove the jammed paper.

5. Return lever 2b to the original position. 

6. Close the HCS top cover.

7. If the printer indicates that there are more paper jams, follow the instructions to clear the paper jams and to 
resume printing.

Clearing Paper Jams from HCS Area E4

1. Open the HCS top cover. 
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2. Do the following: 

a. Push down lever 2a.

b. Remove the jammed paper.

3. Return lever 2a to the original position. 

4. Close the HCS top cover.

5. If the printer control panel indicates that there are more paper jams, follow the instructions to clear the paper 
jams and to resume printing.

Clearing Paper Jams from HCS Area E5

1. Open the HCS top cover. 
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2. Do the following: 

a. Lift lever 2b.

b. Rotate knob 2c counterclockwise.

c. Remove the jammed paper.

3. Return lever 2b to the original position. 

4. Close the HCS top cover.

5. If the printer indicates that there are more paper jams, follow the instructions to clear the paper jams and to 
resume printing.
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Clearing Paper Jams from HCS Area E6

1. Press the Unload button. 

2. Ensure that the HCS front door is unlocked, then open the door. 

3. Pull out the stacker cart slowly, then remove any jammed paper. 

4. Push the stacker cart back into the original position.

5. Close the HCS front door.

6. If the printer indicates that there are more paper jams, follow the instructions to clear the paper jams and to 
resume printing.
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Clearing Paper Jams from HCS Area E7

1. Remove any output delivered to the top tray. 

2. Open the HCS top cover. 

3. Do the following: 

a. Lift lever 1b.

b. Remove the jammed paper.
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4. Return lever 1b to the original position. 

5. Do the following: 

a. Push down lever 2a.

b. Remove the jammed paper.

6. Return lever 2a to the original position. 

7. Close the HCS top cover.

8. If the printer indicates that there are more paper jams, follow the instructions to clear the paper jams and to 
resume printing.
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Clearing Paper Jams from HCS Area E8

1. Open the HCS top cover. 

2. Do the following: 

a. Lift lever 3b.

b. Rotate knob 3a clockwise.

c. Remove jammed papers.

3. Return lever 3b to the original position. 

4. Close the HCS top cover.
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HCS FAULT MESSAGES

When faults occur, such as paper jams, open doors or covers, or a press malfunction, the printer stops printing, and 
a message appears on the printer touch screen. An illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions.

The touch screen displays a Faults button that provides information about the fault and detailed instructions for 
correcting the fault. The (E) code in the upper-left part of the fault message displays which error indicator E1–E8 is 
illuminated on the HCS control panel.

HCS Fault Code Information

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, and 
a message appears on the printer touch screen.

The touch screen displays a Faults button that provides information about the fault and detailed instructions for 
correcting the fault.

Tip: HCS faults are identified by the codes that start with the three-digit numbers 049. 

HCS HINTS AND TIPS

When you use the HCS, refer to the following hints and tips:

1. Verify the paper curl in the applicable HCS tray: 

• If no paper curl is present, and if the output is acceptable and meets your requirements, you are finished.

• If no paper curl is present, but the output is not acceptable, call for service.

• If paper curl is present, continue to the next step.

2. To correct the paper curl, use the paper curl-correction controls on top of the Interface Decurler Module (IDM).

3. If the output has not improved, adjust the paper curl again.

4. If the output still has not improved, call Xerox Technical Customer Support.
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HCS Specifications

ITEM SPECIFICATION 

Tray capacity Top tray: 500 sheets 

Stacker tray or cart: 5000 sheets 

Note: The values are based on paper weights less than 80 g/m2

Paper size Top tray Standard size Minimum Postcard 

100 x 148 mm

4 x 6 in.

Maximum SRA3 

330 x 487 mm

13 x 19 in.

Custom size Height 3.9–13 in.  

100–330.2 mm

Width 6-26 in.  

148.0–660.4 mm

Stacker tray or 
cart 

Standard size Minimum JIS BS 

Maximum SRA3 

330 x 487 mm

13 x 19 in.

Custom size Height 8–13 in.  

203.0–330.2 mm

Width 7.2–19.2 in.  

148.0–488.0 mm

Paper weight Top Tray 52–350 g/m2  

Stacker tray or 
cart 

52–350 g/m2 

HIGH CAPACITY STACKER (HCS)  MEDIA GUIDELINES

• The stacker tray or cart accepts 52–350 g/m2 coated or uncoated paper, with the possibility of using a 
degraded stock quality. The printer can exhibit higher jam rates when you use paper that is heavier 300 g/m2.

• Transparencies can deliver to the top tray, the stacker tray, or the cart. Stack height is limited to 100 
transparencies.
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• Coated paper that is lighter than 100 g/m2 does not run as reliably as coated paper that is heavier than 100 g/ 
m2. 

• Non-standard papers that are longer than 305 mm (12 in.) in the feed direction require a 210 mm (8.3 in.) 
minimum measurement across the feed direction.

• Non-standard papers that are shorter than 254 mm (10 in.) in the cross-feed direction require a 330 mm (13 
in.) minimum measurement in the feed direction.
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Crease and Two-Sided Trimmer Overview

The Crease and Two-Sided Trimmer trims the top and bottom of sheets or booklets to produce an even edge. When 
this device is combined with the SquareFold® Trimmer Module, the trimming produces a full bleed.

This optional finishing device requires one of the following Production Ready Finishers: 

• Production Ready Finisher

• Production Ready Booklet Maker Finisher

• Production Ready Finisher Plus

The Crease and Two-Sided Trimmer is an optional finishing device that provides page creasing and trimming of 
both ends of the output.

The Crease and Two-Sided Trimmer performs the following tasks:

• Trims 6–25 mm (0.24–0.99 in.) from the top and bottom of prints or booklets to produce an output with the 
required finished width and appearance.

Note: If you crease the media within 62 mm of the lead edge, the chance of jams increases. The lowest 
crease setting value of 1 cannot produce any visible crease on some media.

• Trims incoming media sizes 194 x 257 mm (7.6 x 10.1 in.) to 330.2 x 488 mm (13 x 19.2 in.).

• Trims incoming media sizes 52–350 g/m2 or coated paper 106–350 g/m2.

When this device is paired with the SquareFold® Trimmer, all sides of booklets can be trimmed, except the binding, 
which enables the creation of full-bleed booklets. For more information, refer to SquareFold® Trimmer Module.
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Crease and Two-Sided Trimmer Components

NUMBER COMPONENT DESCRIPTION 

1 Paper jam and error indicator This indicator illuminates when a paper jam occurs. 

If the indicator is blinking, before printing can resume, clear 
the paper jam.

2 Trimmer Waste Container Full 
indicator 

This indicator illuminates when it is time to empty the 
trimmer waste container. The indicator blinks when the 
waste container is full. 

3 Upper cover To clear paper jams, open the upper cover. 

4 Lower cover To empty the trimmer waste container, open the lower 
cover. 
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Crease and Two-Sided Trimmer Configuration

The Crease and Two-Sided Trimmer trims the top and bottom edge of output media, applies creases in the vertical 
direction, and overlaps two sheets of output.

NUMBER COMPONENT DESCRIPTION 

1 Dust Box The Dust Box stores trim waste. 

2 Trimmer The Trimmer trims the top and bottom edges in the process 
direction. 

3 Creaser The Creaser applies creases in the vertical direction. 

4 Registration The Registration adjusts media skew and detects the position of 
the media. 

5 Bypass The Bypass transports media through the remaining modules 
without providing finishing. 

6 Buffer The Buffer overlaps two sheets of the media. 
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Crease and Two-Sided Trimmer Maintenance

EMPTYING THE CREASE AND TWO-SIDED TRIMMER WASTE CONTAINER

When the trimmer waste container is nearing the full condition, an indicator illuminates on the top of the Crease 
and Two-Sided Trimmer.

Note: You can empty the waste container before it reaches a full condition. Empty the waste container while 
the printer is powered on. If you empty the waste container when the printer is powered off, the printer 
does not recognize that the container was emptied.

When the waste container reaches the full condition, the following changes occur: 

• The indicator changes from a steady light condition to a blinking light.

• A message appears on the printer control panel that indicates that the waste container is full.

To empty the trimmer waste container, perform the following steps:

1. Open the lower cover of the Crease and Two-Sided Trimmer. 
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2. Pull out and remove the waste container. 

3. Discard all waste. 

Important: Ensure that the waste container is empty. If waste or debris remains in the waste container, 
the trimmer can malfunction.

4. Ensure that you remove all waste and debris, especially beneath the frame that is behind the waste container. 
Use the cleaning rod to remove any remaining waste from inside the trimmer. 

5. Return the cleaning rod to its original position on the inside of the lower cover.

6. Reinsert the waste container and push it in until it stops. 

7. Close the lower cover.
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Crease and Two-Sided Trimmer Troubleshooting

CREASE AND TWO-SIDED TRIMMER PAPER JAMS

The following occurs when there are faults such as paper jams, open doors or covers, or a printer malfunction:

• The printer stops printing and a fault message appears on the printer control panel.

• The message includes an illustration that shows the location of the fault and a brief explanation of corrective 
actions to clear the fault.

• Paper jams can occur in multiple areas of the printer and in any optional device that is connected to the printer. 
When a paper jam occurs, the illustration changes to show the multiple locations and the required corrective 
actions.

• If a fault occurs with an optional device, an indicator illuminates on the optional device control panel and shows 
the corresponding area on the device where the fault occurred.

When you clear paper jams, always refer to the following information:

• Do not power off the printer when removing paper jams.

• Paper jams can be removed with the printer still powered on. When you power off the printer, all information 
stored to the system memory is erased.

• Before resuming print jobs, clear all paper jams.

• To avoid possible print defects, do not touch components inside the printer.

• Before you proceed with print jobs, ensure that all paper jams, including any small, torn pieces of paper, are 
cleared.

• Gently, remove the paper, taking care not to tear it. If paper is torn, ensure that you remove all torn pieces of 
paper.

• After you remove the paper jams, close all doors and covers. When doors or covers are open, the printer does 
not print.

• After you clear a paper jam, printing resumes automatically from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to appear on the printer control panel. To clear any 
remaining paper jams, refer to the printer control panel for instructions and information.
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Clearing Paper Jams from Trimmer Area E1

1. Open the trimmer upper cover. 

2. To remove the jammed paper, perform the following steps: 

Note: Check behind the upper cover for any hidden jammed paper.

a. Push down lever 1a.

b. Push down lever 1b.

c. Lift lever 1d.

d. Remove the jammed paper.

3. If you have difficulty removing any paper jams, perform the following steps: 

a. Rotate knob 1c clockwise.

b. Remove the jammed paper.
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4. Return the levers to the original positions. 

5. Close the trimmer upper cover.

6. If the printer control panel message indicates that there are more paper jams, follow the instructions to clear 
the paper and to resume printing.

Clearing Paper Jams from Trimmer Area E2

1. Open the trimmer upper cover. 
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2. Rotate knob 2 counterclockwise and align the mark on the knob with the open padlock icon. 

3. To remove the jammed paper, perform the following steps: 

a. Push down lever 1a.

b. Push down lever 1b.

4. If you cannot remove the jammed paper, perform the following steps: 

a. Rotate knob 1c clockwise.

b. Remove the jammed paper.
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5. Return the levers to the original positions. 

6. If you have difficulty removing any jammed paper, perform the following steps: 

a. Lift lever 1d.

b. Move lever 2a to the left.

7. To remove the jammed paper, perform the following steps: 

a. Rotate knob 2b counterclockwise.

b. Remove the jammed paper.
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8. Return the levers to the original positions. 

9. Close the trimmer upper cover.

10. If a printer control panel message indicates that there are more paper jams, follow the instructions to remove 
the paper jams and to resume printing.

Clearing Paper Jams from Trimmer Area E3

1. Open the trimmer upper cover. 

2. Rotate knob 2 counterclockwise and align the mark on the knob with the open padlock icon. 

3. To remove the jammed paper, perform the following steps: 

Note: Check behind the upper cover for any hidden jammed paper.
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a. Push down lever 2c.

b. Remove the jammed paper.

4. Return lever 2c to the original position. 

5. Close the trimmer upper cover.

6. If a printer control panel message indicates that there are more paper jams, follow the instructions to remove 
the jammed paper and to resume printing.

Clearing Paper Jams from Trimmer Area E4

1. Open the trimmer upper cover. 

2. To remove the jammed paper, do the following steps: 
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a. Push down lever 2c.

b. Lift lever 2d.

c. Move lever 2e to the right.

3. To remove the jammed paper, perform the following steps: 

Note: To remove a sheet of jammed paper, grasp the end of the paper, then gently pull out the sheet.

a. Rotate knob 2f clockwise.

b. Remove the jammed paper.

4. If you have difficulty removing the jammed paper, grasp the top edge at the inner-right side of the sheet, and 
gently pull out the sheet. 
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5. Return the levers to the original positions. 

6. Close the trimmer upper cover.

7. If a printer control panel message indicates that there are more paper jams, follow the instructions to clear the 
paper jam and to resume printing.

Clearing Paper Jams from Trimmer Area E5

1. Open the trimmer upper cover. 

2. To remove the jammed paper, perform the following steps: 

a. Move lever 3a to the right.

b. Move lever 3b to the left.
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3. To remove the jammed paper, perform the following steps: 

a. Rotate knob 3c clockwise.

b. Remove the jammed paper.

4. To remove the jammed paper, perform the following steps: 

a. Rotate knob 2f counterclockwise.

b. Remove the jammed paper.

5. Return the levers to the original positions. 

6. Close the trimmer upper cover.

7. If a printer control panel message indicates that there are more paper jams, follow the instructions to clear the 
paper jams and to resume printing.
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Clearing Paper Jams from Trimmer Area E6

1. Open the trimmer upper cover. 

2. To remove the jammed paper, perform the following steps: 

a. Move lever 3a to the right.

b. Push down lever 4b.

c. Move lever 4c to the right.

d. Remove the jammed paper.

3. To remove the jammed paper, perform the following steps: 

a. Rotate knob 4d counterclockwise.

b. Remove the jammed paper.
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4. To remove the jammed paper, perform the following steps: 

a. Move lever 4a to the right.

b. While holding lever 4a, rotate knob 2f counterclockwise.

c. Remove the jammed paper.

5. To remove the jammed paper, perform the following steps: 

a. Rotate knob 3c clockwise.

b. Remove the jammed paper.

6. Return the levers to the original positions. 

7. Close the trimmer upper cover.
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8. If a printer control panel message indicates that there are more paper jams, follow the instructions to clear the 
paper jams and to resume printing.

Clearing Paper Jams from Trimmer Area E7

1. Open the trimmer upper cover. 

2. Move lever 3a to the right.

3. Rotate knob 2f counterclockwise five or more times. 

4. Pull out and push in the trimmer waste container continuously three or more times. 
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5. Return the lever to the original position. 

6. If indicator E7 remains illuminated, perform the following steps: 

a. Open the lower cover. 

b. From the location inside the lower cover, remove the supplied cleaning rod. 
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c. Move lever 3a to the right, then move lever 3d to the right. 

d. Use the cleaning rod to sweep any remaining waste or debris from inside the trimmer into the trimmer 
waste container. 

e. If you have difficulty sweeping waste into the trimmer waste container, use the cleaning rod to gather the 
waste, then remove the waste by hand. 

f. Return the levers to the original positions.

7. Ensure that all waste and debris is removed, especially beneath the frame that is behind the waste container. 
Use the cleaning rod to remove any remaining waste from inside the trimmer. 

Note: For information, refer to Emptying the Crease and Two-Sided Trimmer Waste Container. 

8. Close the trimmer upper and lower covers.
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9. If a printer control panel message indicates that there are more paper jams, follow the instructions to clear the 
paper jams and to resume printing.

CREASE AND TWO-SIDED TRIMMER FAULT MESSAGES

When faults occur such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, 
then a message appears on the printer control panel. An illustration shows the location of the fault with a brief 
explanation of corrective actions to clear the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions.

The printer control panel displays a Faults button that provides information about the fault and detailed 
instructions to correct the fault. The E code in the upper-left part of the Fault message shows which error indicator 
E1–E7 is illuminated on the Crease and Two-Sided Trimmer indicator panel.

Crease and Two-Sided Trimmer Fault Code Information

When faults occur such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, 
then a message appears on the printer control panel.

The control panel displays a Faults button that provides information about the fault and detailed instructions for 
correcting the fault.

Tip: Crease and Two-Sided Trimmer faults are identified by the codes that start with the three-digit numbers 012, 
013, 014, 024, and 028.
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Crease and Two-Sided Trimmer Specifications

ITEM SPECIFICATIONS 

Function • Trims 6–25 mm (0.2–0.9 in.) from the head and the foot of the 
sheets, the inboard and outboard edges. 

• Provides full–bleed trim for booklets when used with the SquareFold® 

Trimmer 
• Create an attractive crease fold 

Paper size for 2–sided sheet trim • Minimum: 194.0 x 210.0 mm (7.7 x 8.3 in.) 
• Maximum: 330.0 x 488.0 mm (13.0 x 19.2 in.) 

Paper size for 2–sided booklet trim • Minimum: 194.0 x 257.0 mm (7.6 x 10.12 in.) 
• Maximum: 330.0 x 488.0 mm (13.0 x 19.2 in.) 

Paper Weight • Trim: 52–350 g/m2 

• Crease: 106–350 g/m2 

• Bypass: 52–350 g/m2 

Creasing • For booklets, scores outside cover and innermost sheet 
• For sheets, scores all folds for offline folding so that sheets exit flat 

The Crease and Two–Sided Trimmer contains a Buffer Assembly to regulate the booklet processing and keep pace 
with print engine productivity.
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C/Z Folder Overview

The C/Z Folder requires the use of an Interface Decurler Module and one of the following Production Ready 
Finishers:

• Production Ready Finisher

• Production Ready Booklet Maker Finisher

• Production Ready Finisher Plus

For information on these finishers, refer to Production Ready Finishers.

The C/Z Folder is an optional finishing device that provides C-fold and Z-fold output for the following paper sizes:  

• A4 (210 x 297 mm) or Letter (8.5 x 11 in.)

• A3 (297 x 420 mm) or Tabloid (11 x 17 in.)

To produce folded output, select the Fold feature.

• To use the fold feature, ensure that the orientation of the document is Short Edge Feed (SEF). Ensure that you 
select a tray that contains SEF media.

• There are three types of folds available: 

– C–Fold 

– Z–Fold 

– Z–Fold Half Sheet 
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C/Z Fold Types

CC--FFoolldd

A C-Fold has two folds which creates a three-panel output. 

ZZ--FFoolldd

A Z-Fold has two folds that are folded in opposite directions, resulting in a type of fan fold. 

ZZ--FFoolldd HHaallff SShheeeett ((sshhoowwnn hheerree wwiitthh aa 33--hhoollee ppuunncchh))

As with a regular Z-Fold, the Z-Fold Half-Sheet has two folds that are folded in the opposite directions. The 
difference between a regular Z-Fold and a Z-Fold Half Sheet is that the Z-Fold Half Sheet is not folded in two 
equal folds. The two folds are unequal which allows one edge of the Z-Fold Half Sheet to have a longer edge, 
and the longer edge allows for stapling or hole punching. 
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C/Z Folder Components

Note: For detailed information about the folding feature, refer to Adjust Fold Position in the Xerox® 

PrimeLink® B9100/B9110/B9125/B9136 Production Press System Administrator Guide.

NUMBER COMPONENT DESCRIPTION 

1 C/Z fold output tray Receives output sheets. 

2 C/Z fold output tray button Press this button to open the output tray. 

C/Z FOLD OUTPUT

NUMBER COMPONENT DESCRIPTION 

1 C/Z fold output tray 
button 

When you press the button, the indicator flashes. When the output 
tray is unlocked and the indicator shows a steady light on, pull out 
the output tray. 

2 C/Z fold output tray  C-Fold or Z-Fold jobs are delivered to this tray only.  

Note: C/Z Fold jobs cannot be delivered to any other tray.

3 Production Ready Finisher 
Top Tray 

This tray receives Z–Fold Half Sheet output. 

4 Stack Tray This tray receives Z–Fold Half Sheet output. 
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C/Z Folder Troubleshooting

C/Z FOLDER PAPER JAMS

• The printer stops printing and a fault message appears on the printer control panel.

• The message includes an illustration that shows the location of the fault and a brief explanation of the 
corrective actions to clear the fault.

• Paper jams can occur in multiple areas of the printer and in any optional devices that are connected to the 
printer. When a paper jam occurs, the illustration changes to show the multiple locations and the required 
corrective actions.

• If a fault occurs with the C/Z Folder, an indicator illuminates on the control panel of the PR Finisher. The 
indicator on the PR Finisher shows the corresponding area on the C/Z Folder where the fault occurred.

When you clear paper jams, always refer to the following information: 

• Do not power off the printer when removing paper jams.

• Paper jams can be removed with the printer still powered on. When you power off the printer, all information 
stored to the system memory is erased.

• Before resuming print jobs, clear all the paper jams.

• To avoid possible print defects, do not touch components inside the printer.

• Before you proceed with print jobs, ensure that all paper jams, including any small, torn pieces of paper, are 
cleared.

• Gently remove the paper, taking care not to tear it. If paper is torn, ensure that you remove all the torn pieces 
of paper.

• After you remove the paper jams, close all doors and covers. When doors or covers are open, the printer does 
not print.

• After you clear a paper jam, printing resumes automatically from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to appear on the printer control panel. To clear any 
remaining jams, refer to the printer control panel for instructions and information.
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Clearing Paper Jams from Folder Area E10

1. Open the folder front cover. 

2. To remove jammed paper, do the following: 

a. Lift lever 2a.

b. Rotate knob 2b to the left.

c. Remove the jammed paper.

3. Return levers 2a and 2b to their original positions. 

4. Close the folder front cover.

5. If the printer indicates that there are more paper jams, follow the instructions to clear the paper and to resume 
printing.
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Clearing Paper Jams from Folder Area E11

1. Open the folder front cover. 

2. To remove jammed paper, do the following: 

a. Pull lever 2g to the right.

b. Rotate knob 2c counterclockwise.

c. Remove jammed paper.

3. Return lever 2g to its original position. 

4. Close the folder front cover.

5. If the printer indicates that there are more paper jams, follow the instructions to clear the paper and to resume 
printing.
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Clearing Paper Jams from Folder Area E12

1. Open the folder front cover. 

2. Pull open the C/Z fold output tray 2d. 

3. To remove jammed paper, do the following: 

a. Pull lever 2e to the right.

b. Rotate knob 2c counterclockwise.

c. Remove the jammed paper.
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4. Return lever 2e to the original position. 

5. If you have difficulty removing any paper jams, do the following: 

a. Pull lever 2f to the right.

b. Rotate knob 2c counterclockwise.

c. Remove the jammed paper.

6. Return lever 2f to the original position. 
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7. To close the C/Z fold output tray 2d, push in the tray completely. 

8. Close the folder front cover.

9. If the printer control panel indicates that there are more paper jams, follow the instructions to clear the paper 
jam and to resume printing.

C/Z FOLDER FAULT MESSAGES

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, and 
a message appears on the printer touch screen. An illustration shows the location of the fault with a brief 
explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions. 

The touch screen displays a Faults button that provides information about the fault and detailed instructions for 
correcting the fault. The E code on the upper-left part of the Fault message shows which error indicator, E1–E7, is 
illuminated on the C/Z Folder indicator control panel.

C/Z Folder Fault Code Information

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, and 
a message appears on the printer touch screen.

The touch screen displays a Faults button that provides information about the fault and detailed instructions for 
correcting the fault.

Tip: C/Z Folder faults are identified by codes that start with the three-digit numbers 012 and 013.
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C/Z Folder Specifications

ITEM SPECIFICATION 

Z-Fold Half Sheet Paper size A3, Tabloid: 297 x 432 mm (11 x 17 in.) 

JIS B4

Paper weight Uncoated: 
• 52–105 g/m2 

• 52–63 g/m2 for thin paper 
• 64–81 g/m2 for plain paper 
• 64–105 g/m2 for recycled paper, plain paper manual duplex, 

drilled paper, and preprinted papers 

Tri-fold (C or Z) Paper size A4, Letter: 210 x 297 mm (8.5 x 11 in.) 

Paper weight 52–105 g/m2 (Uncoated) 

Tray capacity 30 sheets 
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Overview of the Production Ready Finishers

Three Production Ready (PR) Finishers are available with your printer:

• Production Ready (PR) Finisher

• Production Ready (PR) Booklet Maker Finisher

• Production Ready (PR) Finisher Plus

Note: Throughout this chapter, the PR Finisher, PR Booklet Maker Finisher, and PR Finisher Plus are referred 
to simply as the finisher. Any differences between the finishers are distinguished by using the specific 
finisher name.

The Production Ready Finisher and Production Ready Booklet Maker Finisher provide the following capabilities: 

• Handling media as small as A5, 148 x 210 mm (5.83 x 8.27 in.)

• Handling large-sized media, with the following maximum sizes: 

– 330.2 x 488 mm (13 x 19.2 in.) for the stacker tray and the booklet tray 

– 330.2 x 660 mm (13 x 26 in.) for the top tray 

The Production Ready Finisher consists of a top tray, a stacker tray, and a variable-length stapler and optional hole- 
punch. The Production Ready Finisher also includes an Inserter Module. The Inserter Module allows you to insert 
pre-printed or plain separator sheets into the printed output at specific locations. The Production Ready Finisher can 
staple up to 100 sheets with one or two staples.

The Production Ready Finisher Plus provides the same features as the Production Ready Finisher, but also adds a 
Finishing Transport Module, which enables an inline connection to available third-party finishing devices.

The Production Ready Booklet Maker Finisher provides the same features as the Production Ready Finisher, but also 
creates booklets of up to 30 sheets.

Note: There are several options available that supplement the features of the Production Ready Finishers, 
including Basic Punch, C/Z Folder, and Crease and Two-Sided Trimmer. The Production Ready Booklet Maker 
Finisher also offers the SquareFold Trimmer. For details on these options, refer to their respective appendices.

PRODUCTION READY (PR)  FINISHER

The PR Finisher consists of the following components:  
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• Two output trays: Top Tray and Stacker Tray

• Stapler

• Optional Basic Punch

PRODUCTION READY (PR)  BOOKLET MAKER FINISHER

The Production Ready (PR) Booklet Maker Finisher provides all the same features as the PR Finisher Plus. Production 
Ready (PR) Booklet Maker Finisher creates saddle-stitched booklets automatically of up to 30 sheets and does bi- 
folding.

The PR Finisher consists of the following components:

• Three output trays: Top Tray, Stacker Tray, Booklet Output Tray

• Booklet Maker Unit

• Stapler

• Optional Basic Punch

PRODUCTION READY (PR)  FINISHER PLUS

The Production Ready (PR) Finisher Plus includes the same features and functions as the PR Finisher. The PR Finisher 
Plus serves as an interface to transfer paper between the printer and any third-party finishing device that is 
attached to the printer.
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Production Ready Finisher Components

COMPONENTS FOR THE PR FINISHER AND PR BOOKLET MAKER FINISHER

1. Paper Jam or Error Indicator

2. Top Tray

3. Stacker Tray

4. Booklet Tray*

5. Booklet Output Button*

6. Front Cover

7. Staple Waste Container

8. Basic Staple Cartridge for Side Stitch

9. Two Booklet Staple Cartridges for Saddle Stitch*

10. Hole Punch Waste Container

Note: * Available only with the PR Booklet Maker Finisher.
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Finisher Output Trays

1. Top tray

2. Stacker tray

3. Booklet tray*

*Available only with the PR Booklet Maker Finisher

Top Tray

The top tray has the following capabilities:

• Receives printed output and sample sheets

• Capacity of 500 sheets measuring 330 x 488 mm (13 x 19.2 in.)

• Collects all sheets that are automatically ejected before and after a jam

• Receives all media types and sizes produced by the system

If output sheets are not ejected completely, the printer detects a Paper Full condition. If this condition is detected 
frequently, change the angle of the top tray.

To change the top tray angle, refer to the following guidelines:

• For normal usage, keep the tray in the lower, default position. 

Important: Continual usage of the tray in the upper position can cause paper jams or output sheets 
to fall from the tray upon delivery.

• When using the following paper types, change the angle of the tray to the upper position. The following paper 
types can cause frequent Paper Full conditions: 

– Lightweight, 106 g/m2 or lighter, coated paper 

– Coated paper whose edges are 364 mm (14.3 in.) or longer 

– Long paper 

Note: If sheets are curled, changing the tray angle has no effect.
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A B 

Default, lower angle Raised, upper angle 

To change the angle of the tray:

1. Move the top tray from the lower position AA, to the upper position BB.

2. Insert the tabs at the base of the tray into the upper position, BB. 

Stacker Tray

The stacker tray has the following capabilities:

• Offset-capable for unstapled, single-staple, or multiple-staple sets

• Maximum capacity: 

– PR Finisher: 3,000 sheets 

– PR Finisher Plus and PR Booklet Maker Finisher: 2,000 sheets 

Side stitch jobs are delivered to the stacker tray only.

Note: When 2000 or more sheets of paper with excessive downward curl are delivered to the output tray, 
the output stack can fall from the tray. To correct the excessive downward curl of the paper, on the Interface 
Decurler Module, set the curl-correction level to the lowest level. On the Inserter, change the curl-correction 
setting to downward. For information, refer to Paper Curl Correction with the PR Finishers.
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Booklet Tray

Note: The booklet tray is attached to the PR Booklet Maker Finisher. If the SquareFold® Trimmer is installed, 
the booklet tray is attached to the SquareFold® Trimmer.

Bi-Fold and Bi-Fold with Saddle Stitch jobs are delivered to the booklet tray only.

Paper Curl Correction with the PR Finishers

If sheets are curled when they are delivered to any of the finisher trays, refer to the following information:

• Printing on A5, Long-Edge Feed (LEF): 148 x 210 mm (5.83 × 8.27 in.) paper with an upward curl can cause 
paper jams. If upward curl occurs, on the Interface Decurler Module, set the curl-correction level to the highest 
setting. On the Inserter, change the setting to an upward curl.

• Printing on heavyweight paper with a downward curl can cause paper jams. If downward curl occurs, on the 
Interface Decurler Module, set the curl-correction level to the lowest setting. On the Inserter, change the setting 
to downward curl.

• Printing on paper that weighs 157 g/m2 or more, or printing on paper that has up curl can cause paper jams. If 
either situation occurs, on the Interface Decurler Module, set the curl-correction level to the highest setting. On 
the Inserter, change the setting to an upward curl.

For more information about the paper curl-correction features, refer to Curl Correction Modes and Functions on the 
Interface Decurler Module and Inserter Control Panel.

Bi-Fold Feature for the Production Ready Booklet Maker Finisher

Note: The Bi-Fold feature is available only with the Production Ready (PR) Booklet Maker Finisher. 

• To use the Bi-Fold feature, the orientation of documents is short-edge feed (SEF). You can select a tray that 
contains SEF stock.

• You can select the Bi-Fold feature from the print driver or network print jobs, or from the scanner for copy or 
scan jobs.

• A bi-fold is sometimes referred to as a single fold.

Important: The C-Fold and Z-Fold options are available only with the C/Z Folder. For more information on the 
C/Z Folder, refer to C/Z Folder.

A bi-fold or single fold has one fold that creates two panels in the output.

There are three bi-fold options available:

• Bi-Fold Single Sheet

• Bi-Fold Multiple Sheets
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• Bi-Fold Multiple Sheets Stapled

Note: For detailed information about fold types, refer to the System Administrator Guide and the Adjust Fold 
Positions topic.

Booklet Output Button

To remove finished booklets from the finisher, press the booklet output button.

Note: If the SquareFold® Trimmer is installed, when you press the booklet output button, the booklets move 
to the booklet tray that is installed on the SquareFold® Trimmer.
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PR FINISHER PLUS COMPONENTS

1. Finisher Module

2. Finisher Module Paper Jam or Error Indicators

3. Finisher Top Tray

4. Finisher Stacker Tray

5. Finishing Transport

6. Finishing Transport Paper Jam or Error Indicators

7. Finishing Transport Front Cover

8. Finisher Module Front Cover

9. Finisher Staple Waste Container

10. Finisher Basic Stapler for Side Stitching

11. Finisher Hole Punch Waste Container option

Note: For details on the functions of your third-party finishing device, refer to the manual that was supplied 
with the device.
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PR Finisher Maintenance

FINISHER CONSUMABLE SUPPLIES

You can order Xerox supplies, including staples, staple cartridges, and staple waste containers at www.xerox.com/ 
office/PLB91XXsupplies. For contact information and telephone numbers in your area, click Contact Us. To enter or 
select your printer family and model type, click Supplies.

Store supply items and Xerox parts in their original packages in a convenient location.
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SUPPLY ITEM 

SUPPLY UNIT SHIPPED 
WITH FINISHER AND 
REORDER QUANTITY REPRESENTATION 

Staple Cartridge and Staple 
Waste Container for: 
• PR Finisher 
• PR Booklet Maker Finisher 
• PR Finisher Plus 

Part number 8R13041
• Four staple cartridges: 5000 

staples per cartridge 
• One staple waste container 

per carton 

PR Booklet Maker Finisher 
Staple Refill Cassette 

Part number 8R12941Three 
pack: 5000 staple refills each 

PR Booklet Maker Finisher 
Staple Cartridge 

Part number 8R13177One 
cartridge per carton 
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CHECKING THE STATUS OF FINISHER CONSUMABLES

When a consumable reaches the time for replacement, a message appears on the control panel touch screen. The 
control panel message indicates when it is time to order and install a new consumable item. With some Customer 
Replaceable Units (CRUs), the control panel message indicates that the printer continues to run print jobs without 
replacing the item immediately. When it is time to replace a consumable, a message appears and the printer stops 
printing.

To check the status of your consumables:

1. At the control panel, press the Machine Status button. 

2. Select the Supplies tab. 

The list of consumables appears according to type. Finisher consumables, such as staple cartridges and waste 
containers, are listed in the SMart Kits section. Each list item shows a status. To view more items in the list, use 
the up and down arrows.

3. To view status details for an item, touch the item. A details page for the item opens. To close the page and 
return to the list view, touch Close. 

REPLACING THE BASIC STAPLE CARTRIDGE FOR SIDE STITCHING

Note: Before performing this procedure, ensure that the printer is not printing.

1. Open the finisher front cover. 

2. Pull out R1, then remove it from the printer. 
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3. Hold the staple cartridge at the position of the arrow, then remove the staple cartridge from the unit. 

4. Insert a new staple cartridge into the unit. 

5. Insert R1 into the original position in the printer. 

6. Close the finisher front cover.

REPLACING THE BOOKLET STAPLE CARTRIDGE FOR SADDLE STITCHING

Note: Before performing this procedure, ensure that the printer is not printing.

Note: This procedure is applicable only to the PR Booklet Maker Finisher.
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1. Open the finisher front cover. 

2. Pull out the Saddle Stitch Unit 3 toward you until it stops. 

3. To remove the staple cartridge, hold the tabs on the cartridge, then pull the cartridge out of the printer. 

Note: There are two booklet staple cartridges provided. The message on the printer control panel touch 
screen indicates which cartridge needs replacement.
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4. While holding the tabs on the new staple cartridge, push in the cartridge until it stops. 

Note: Ensure that the marks are aligned.

5. Push the Saddle Stitch Unit 3 into the finisher gently, until the unit stops. 

6. Close the finisher front cover.

REPLACING THE STAPLE REFILL  CASSETTE FOR SADDLE STITCHING

When you run out of staples for the saddle-stitcher, you can replace the staple cassette without having to replace 
the entire staple cartridge. To replace the staple cassette with a refill:

1. Remove the staple cartridge as directed in Replacing the Booklet Staple Cartridge for Saddle Stitching.
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2. To open the staple cartridge, squeeze the small tabs on either side of the cartridge. The staple cartridge opens. 

3. To prepare the cartridge for the removal of the empty staple cassette, position the top part of the cartridge 
under the lower part of the cartridge. 
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4. To remove the empty staple cassette, hold the staple cassette on both ends. Press in the tab on the end of the 
staple cassette that has arrows on the sides and lift the cassette out of the cartridge. 

5. To install the staple refill cassette into the cartridge, place the tab on the end of the staple refill cassette into 
the small hole in the cartridge. Press the staple cassette firmly into the cartridge until it clicks into place. 

6. Replace the staple cartridge into the printer as directed in Replacing the Booklet Staple Cartridge for Saddle 
Stitching.

REPLACING THE FINISHER STAPLE WASTE CONTAINER

WARNING: To avoid personal injury, use care when removing the staple waste container.

When the staple waste container is full, a message appears on the printer control panel. When the message 
appears, replace the container with a new waste container.

Important:  

• Before performing this procedure, ensure that the printer is not printing.

• Ensure that the printer remains powered on when replacing the staple waste container. If powered off, 
the printer does not recognize the replacement of the waste container, and the message remains 
displayed.

• After you replace the waste container, close the finisher front cover. Ensure that the printer can print a 
test page.

Note: A staple waste container is shipped with the basic staple cartridge.
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1. Open the finisher front cover. 

2. Move the lock lever under R5 toward the left, to the opened-lock icon. 

3. Pull out R5, then remove the finisher staple waste container from the printer. 
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4. Place the used staple waste container into the supplied plastic bag. 

Note: Do not disassemble used waste containers. Return the used staple waste containers to the Xerox 
Customer Support Center. 

5. Lower the new staple waste container into position, then gently push in the container until it stops. 

WARNING: To prevent injury, do not put your fingers on top of the container.

6. Move the lock lever under R5 toward the right, to the closed-lock icon. 

7. Close the finisher front cover.
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EMPTYING THE HOLE PUNCH WASTE CONTAINER

When the hole punch waste container is full, a message appears on the printer control panel. When the message 
appears, empty the waste container of all paper scraps.

Note: Basic Punch is an optional feature. The waste container is present only if the Basic Punch option is 
part of your printer configuration.

Important:  

• Before performing this procedure, ensure that the printer is not printing.

• Ensure that the printer remains powered on when replacing the staple waste container. If powered off, 
the printer does not recognize the replacement of the waste container, and the message remains 
displayed.

• After you replace the waste container, close the finisher front cover. Ensure that the printer can print a 
test page.

1. Open the finisher front cover. 

2. Pull out R4, then remove it from the printer. 
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3. Discard all waste from the hole-punch waste container. 

Important: Ensure that you empty the container completely. If any waste or scraps remain in the waste 
container, the container becomes full before a full message appears on the control panel, causing a 
fault to occur.

4. Return R4 to the original position in the printer.

5. Close the finisher front cover.

Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide 457

Production Ready Finishers



PR Finisher Troubleshooting

PAPER JAMS IN THE PR FINISHER AND PR BOOKLET MAKER FINISHER

The following actions occur when there are faults, such as paper jams, open doors or covers, or a printer 
malfunction:

• The printer stops printing and a fault message appears on the printer touch screen.

• The fault message includes an illustration that shows the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams can occur in multiple areas of the printer and in any optional devices that are connected to the 
printer. When a paper jam occurs, the illustration changes to show the multiple locations and the required 
corrective actions.

• If a fault occurs with an optional device, an indicator illuminates on the optional device control panel and shows 
the corresponding area on the device where the fault occurred.

When you clear paper jams, always refer to the following information:

• When you remove paper jams, keep the printer powered on. When you power off the printer, all information 
stored to the system memory is erased. 

• To minimize print defects, do not touch components inside the printer.

• Before you resume the print jobs, ensure that you clear all paper jams, including torn pieces of paper.

• Gently, remove torn paper, taking care not to tear it. Ensure that you remove all the torn pieces of paper.

• After you remove all paper jams, close all doors and covers. When doors or covers are open, the printer cannot 
print.

• After you clear a paper jam, printing resumes automatically from the state before the paper jam occurred.

• If you do not clear all paper jams, an error message continues to appear on the printer touch screen. To clear 
any remaining jams, follow the instructions on the printer touch screen.

PAPER JAMS IN THE PR FINISHER PLUS

When a paper jam occurs in the PR Finisher Plus, an indicator illuminates on the Finisher Module or the Finishing 
Transport Module.
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The following actions occur when there are faults, such as paper jams, open doors or covers, or a printer 
malfunction:

• The printer stops printing and a fault message appears on the printer touch screen.

• The fault message includes an illustration that shows the location of the fault along with a brief explanation of 
corrective actions for clearing the fault.

• Paper jams can occur in multiple areas of the printer and in any optional devices that are connected to the 
printer. When a paper jam occurs, the illustration changes to show the multiple locations and the required 
corrective actions.

• If a fault occurs with an optional device, an indicator illuminates on the optional device control panel and shows 
the corresponding area on the device where the fault occurred.

When you clear paper jams, always refer to the following information:

• When you remove paper jams, keep the printer powered on. When you power off the printer, all information 
stored to the system memory is erased. 

• To minimize print defects, do not touch components inside the printer.

• Before you resume the print jobs, ensure that you clear all paper jams, including torn pieces of paper.

• Gently, remove torn paper, taking care not to tear it. Ensure that you remove all the torn pieces of paper.

• After you remove all paper jams, close all doors and covers. When doors or covers are open, the printer cannot 
print.

• After you clear a paper jam, printing resumes automatically from the state before the paper jam occurred.

• If you do not clear all paper jams, an error message continues to appear on the printer touch screen. To clear 
any remaining jams, follow the instructions on the printer touch screen.
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CLEARING PAPER JAMS IN THE PR FINISHERS

Clearing Paper Jams from Finisher Area E1

1. Open the finisher front cover. 

2. To remove the jammed paper, do the following: 

Note: Grasp the leading edge of the jammed sheet of paper, then pull out the sheet.

a. Push lever 1a to the left.

b. Remove the jammed paper.

3. If you have difficulty removing any paper jams, do the following: 
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a. Rotate knob 1b clockwise.

b. Remove the jammed paper.

4. Return lever 1a to the original position. 

5. Close the finisher front cover.

Clearing Paper Jams from Finisher Area E2

1. Open the finisher front cover. 

2. To remove the jammed paper, do the following: 

Note: The jammed paper can be hidden behind the upper cover.
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a. Pull lever 1c to the right.

b. Rotate knob 1e clockwise.

c. Remove the jammed paper.

3. Return lever 1c to the original position.  

4. Close the finisher front cover.

Clearing Paper Jams from Finisher Area E3

1. Pull out the jammed paper from the finisher top tray.  

2. Open and close the finisher front cover.  
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Clearing Paper Jams from Finisher Area E4

1. Open the finisher front cover. 

2. To remove the jammed paper, do the following steps: 

a. Pull lever 1d to the right.

b. Rotate knob 1e clockwise.

c. Remove the jammed paper.

3. Return lever 1d to the original position. 

4. Close the finisher front cover.
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Clearing Paper Jams from Finisher Area E5

1. Open the finisher front cover. 

2. To remove the jammed paper, do the following steps: 

a. Pull lever 1d to the right.

b. Rotate knob 1f counterclockwise.

c. Remove the jammed paper.

3. Return lever 1d to the original position.  

4. Close the finisher front cover.
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Clearing Paper Jams from Finisher Area E6

1. Pull out the jammed paper from the finisher stacker tray.  

2. Open and close the finisher front cover. 

Clearing Paper Jams from Finisher Booklet Area E7

1. Open the finisher front cover. 

2. To remove the jammed paper, do the following steps: 
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a. Push lever 3a to the left.

b. Remove the jammed paper.

3. If you have difficulty removing paper jam, do the following steps: 

a. Pull out the Saddle Stitch Unit 3.

b. Remove the jammed paper.

4. Return lever 3a to the original position.  
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5. Gently, push in the Saddle Stitch Unit 3 until it stops.  

6. Close the finisher front cover.

Clearing Paper Jams from Finisher Booklet Area E8

1. Open the finisher front cover. 

2. Release latch 3a, then check for a paper jam. If there is no jammed paper, pull out Saddle Stitch Unit 3 
toward you until it stops. 

3. To remove the jammed paper, do the following steps: 
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a. Rotate knob 3b counterclockwise.

b. Remove the jammed paper.

4. Gently push in Saddle Stitch Unit 3 until it stops. 

5. Close the finisher front cover.

Clearing Paper Jams from Finisher Booklet Area E9

1. Open the finisher front cover. 

2. To remove the jammed paper, do the following steps: 
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a. Rotate knob 3b clockwise.

b. Remove the jammed paper from the booklet tray area.

3. Close the finisher front cover.

CLEARING PAPER JAMS IN THE PR FINISHER PLUS

Clearing Paper Jams in the Finisher Module Area E7

1. Open the finisher front cover. 

2. Remove any jammed paper.

3. To clear paper jams from area E7: 

Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide 469

Production Ready Finishers



a. Release latches 3a and 3b. 

b. Rotate knob 1b clockwise and remove the jammed paper.  

c. Return latches 3a and 3b to their original positions. 

4. Close the finisher front cover.
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Clearing Paper Jams in the Finishing Transport

Clearing Paper Jams in Finishing Transport Area 1

1. Open the Finishing Transport front cover. 

2. To remove the jammed paper: 

a. Release latch 1.

b. Remove the jammed paper.

3. Return latch 1 to the original position. 

4. Close the Finishing Transport front cover.
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Clearing Paper Jams in Finishing Transport Area 2

1. Open the Finishing Transport front cover. 

2. To remove the jammed paper: 

a. Release latch 2.

b. Rotate the knob counterclockwise.

c. Remove the jammed paper.

3. Return latch 2 to the original position. 

4. Close the Finishing Transport front cover.

472 Xerox® PrimeLink® B9100/B9110/B9125/B9136 Production Press User Guide

Production Ready Finishers



Clearing Paper Jams in Finishing Transport Area 3

1. Open the Finishing Transport front cover. 

2. To remove the jammed paper: 

a. Release latch 3.

b. Rotate the knob clockwise.

c. Remove the jammed paper.

3. Return latch 3 to the original position.  

4. Close the Finishing Transport front cover.
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Clearing Paper Jams in Finishing Transport Area 4

1. Open the Finishing Transport front cover. 

2. To remove the jammed paper, perform the following steps: 

a. Release latch 4.

b. Rotate the knob clockwise.

c. Remove the jammed paper.

3. Return latch 4 to the original position. 

4. Close the Finishing Transport front cover.
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FINISHER STAPLE FAULTS

Use the following procedures when stapling issues occur with the printed output, such as the sheets are not stapled 
or staples are bent. If the problems continue after you have tried the following solutions, contact a Xerox service 
representative.

NOT STAPLED BENT STAPLE 

If printed sheets are stapled as shown in the following figures, contact your service representative. 

ONE SIDE OF THE STAPLE IS 
RAISED 

STAPLE IS BENT IN THE 
REVERSE DIRECTION FLATTENED STAPLE 

ENTIRE STAPLE IS RAISED 
STAPLE IS RAISED AND THE CENTER IS PRESSED 
IN 

Important:  

• Depending on the type of paper being stapled, the staples can be bent. If the bent staples are stuck 
inside the finisher, the bent staples can cause paper jams.

• If staple jams occur, open the cover of the staple cartridge, then remove the bent staples. Do not open 
the cover of the staple cartridge unless you are removing jammed staples.

Clearing Staple Jams in the Basic Stapler

Note: If the staple cartridge detaches accidentally from the holder, refer to Reinserting the Basic Staple 
Cartridge.

Note: Before performing this procedure, ensure that the printer is not printing.
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1. Open the finisher front cover. 

2. Pull out R1, then remove the staple cartridge unit from the printer. 

Note: After you remove the staple cartridge unit, check the inside of the finisher for any remaining staples.

3. Open the staple cartridge unit cover, then remove the jammed staples. 

WARNING: To avoid personal injury, use care when you remove jammed staples.
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4. Reinsert the staple cartridge unit to the original position in the printer. 

5. Close the finisher front cover.

Reinserting the Basic Staple Cartridge

If a staple cartridge has been inserted incorrectly or removed accidentally, perform the following procedure to 
reinsert the staple cartridge correctly into the cartridge unit.

1. Open the finisher front cover. 

2. Pull out R1, then remove the staple cartridge unit from the printer. 
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3. Open the staple cartridge unit cover, then remove the jammed staples. 

WARNING: To avoid personal injury, use care when you remove the jammed staples.

4. Locate the lever on the back of the staple cartridge unit. 

WARNING: When you move the lever, be careful not to hurt your fingers and fingernails.

5. While holding the lever, turn the staple cartridge unit up, then remove the staple cartridge from the unit. 
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6. Remove the outside staples along the line. 

WARNING: When removing staples, be careful not to hurt your fingers.

7. Insert the staple cartridge into the staple cartridge unit. 

8. Reinsert the staple cartridge unit to the original position in the printer. 

9. Close the finisher front cover.

Clearing Staple Jams in the Booklet Stapler

Note: Before you perform this procedure, ensure that the printer is not printing.
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1. Open the finisher front cover. 

2. To remove the Saddle Stitch Unit 3, pull the unit toward you, then remove it from the printer. 

3. While holding the tabs on the staple cartridge, pull the cartridge out of the staple unit.  
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4. Remove any jammed staples. 

WARNING: To avoid personal injury, use care when removing jammed staples.

5. While holding the tabs on the new staple cartridge, push in the cartridge until it stops. 

Note: Ensure that the small arrows are aligned.

6. Push the Saddle Stitch Unit 3 into the finisher until the unit stops. 

7. Close the finisher front cover.
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FAULT MESSAGES ON THE PR FINISHER AND PR BOOKLET MAKER FINISHER

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, 
then a message appears on the printer control panel touch screen. An illustration shows the location of the fault 
with a brief explanation of corrective actions for clearing the fault. If a fault occurs in more than one location, the 
illustration changes to indicate the multiple locations and the required corrective actions.

The touch screen displays a Faults button that provides information about the fault and detailed instructions for 
correcting the fault. The E code on the upper-left part of the Fault message displays which error indicator E1–E9, is 
illuminated on the Finisher indicator panel.

Finisher Fault Code Information

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, 
then a message appears on the printer touch screen.

The touch screen displays a Faults button that provides information about the fault and detailed instructions to 
correct the fault.

Tip: Finisher faults are identified by the codes that start with the three-digit numbers 012, 013, 024, 041, 112, 
and 124.

PR FINISHER PLUS FAULT MESSAGES

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, and 
a message appears on the printer touch screen. An illustration shows the location of the fault with a brief 
explanation of corrective actions to clear the fault. If a fault occurs in more than one location, the illustration 
changes to indicate the multiple locations and the required corrective actions.

The touch screen displays a Faults button that provides information about the fault and detailed instructions for 
correcting the fault. The E code on the upper-left part of the Fault message displays which error indicator is 
illuminated on the PR Finisher Plus for Finisher Module E1–E7 or Finishing Transport Areas 1–4.

PR Finisher Plus Fault Code Information

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, and 
a message appears on the printer touch screen.
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The touch screen displays a Faults button that provides information about the fault and detailed instructions to 
correct the fault.

Tip: PR Finisher Plus faults are identified by the codes that start with the three-digit numbers 013 and 051.
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PR Finisher Specifications

ITEM SPECIFICATION 

Tray Top tray Collate and stack 

Stacker tray Collation for offsetting and offset stacking are supported 

Booklet tray Collate and stack 

Paper size Top tray Standard size Minimum Postcard 

100 x 148 mm (4 x 
6 in.)

Maximum 330.2 x 482.6 mm 
(13 x 19 in.)

Custom size Height 100–330.2 mm 
(3.94–13 in.)

Width 148.0–660.4 mm 
(5.83–26 in.)

Stacker tray Standard size Minimum A5 

148 x 210 mm 
(5.83 × 8.27 in.)

Maximum 330.2 x 482.6 mm 
(13 x 19 in.)

Custom size Height 148.0–330.2 mm 
(5.83–13 in.) 

Width 148.0–488.0 mm 
(5.83–19.21 in.) 

Booklet tray Standard size Minimum JIS B5 

182 x 257 mm (7.2 
x 10.1 in.)

Maximum 330.2 x 482.6 mm 
(13 x 19 in.)

Custom size Height 182.0–330.2 mm 
(7.17–13 in.) 

Width 257.0–488.0 mm 
(10.12–19.21 in.) 

Paper weight Top tray 52–350 g/m2 

Stacker tray 52–350 g/m2 

Booklet tray 52–350 g/m2 
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ITEM SPECIFICATION 

Tray capacity Top tray 500 sheets 

Stacker tray without 
staples 

A4: 210 x 297 mm 
(8.5 x 11 in.) 

PR Finisher: 3000 sheets  

PR Booklet Maker Finisher: 2000 sheets

JIS B4 or larger 1500 sheets 

Mix stack 350 sheets

Stacker tray with 
staples 

A4: 210 x 297 mm 
(8.5 x 11 in.) 

PR Finisher: 200 sets or 3000 sheets  

PR Booklet Maker Finisher: 200 sets or 2000 
sheets

JIS B4 or larger 100 sets or 1500 sheets 

Booklet tray 320 sheets maximum 

Note:  

• The values are based on a paper weight of 90 g/m2. 
• Mix stack is a set of paper sheets where larger sheets are placed over smaller ones. For example, A4 

over JIS B5, or JIS B4 over A4. 
• The booklet tray capacity is 16 sets if one set consists of 17 or more sheets. 

Staple Capacity 100 sheets 

Note:  

• The values are based on a paper weight of 90 g/m2. 
• For paper larger than A4 210 x 297 mm or Letter 8.5 x 11 in., the stapling 

capacity for uncoated stock is 65 sheets. 

Paper size Standard size Minimum A4 

210 x 297 mm 
(8.27 x 11.69 in.)

Maximum Special A4 

226 x 310 mm (8.9 
x 12.2 in.)

Custom size Height 182.0–297.0 mm 
(7.17–11.69 in.) 

Width 148.0–432.0 mm 
(5.83–17 in.) 

Paper weight Uncoated 52–300 g/m2 

Coated 64–216 g/m2 
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ITEM SPECIFICATION 

Stapling position one place, two places, or four places 

ITEM SPECIFICATION 

Punch with 
Punch Unit 

Paper size Standard size Maximum Special A4 

226 x 310 mm (8.9 x 12.2 in.)

Minimum two-hole or 
three-hole  

JIS B5 

182 x 257 mm (7.2 x 
10.1 in.)

four-hole  A4 

210 x 297 mm (8.5 x 
11 in.)

Custom size Height 203.0–297.0 mm (7.99–11.69 in.) 

Width 182.0–431.8 mm (7.17–17 in.) 

Paper weight Uncoated 52–300 g/m2  

Coated 64–216 g/m2 

Number of 
Holes 

two holes, four holes, or US two 
holes or three holes    

Note: The number of punch holes that you can choose depends on 
the paper size.

Saddle Stitch or 
Bi-Fold  

Capacity Saddle Stitch 30 sheets 

PR Booklet 
Maker Finisher 

Bi-Fold 5 sheets 

Note: The values are based on a paper weight of 90 g/m2.

Paper size Standard size Maximum 330.2 x 482.6 mm 
(13 x 19 in.)

Minimum JIS B5 

182 x 257 mm (7.2 x 
10.1 in.)

Custom size Height 182.0–330.2 mm 
(7.17–13 in.) 

Uncoated Width 257.0–488.0 mm 
(10.12–19.21 in.) 

Paper weight 52–300 g/m2 
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ITEM SPECIFICATION 

Coated 64–216 g/m2 

STAPLE OUTPUT CAPACITY

PRODUCTION READY FINISHER STAPLE CAPACITY BY WEIGHT AND PAPER FINISH 

PAPER TYPE AND WEIGHT A4 OR LETTER-SIZED STOCK 
SMALLER OR LARGER THAN A4 
OR LETTER-SIZED STOCK 

UNCOATED COATED UNCOATED COATED 

52‒63 g/m2 100 35 66 35 

64‒105 g/m2 100* 30 50 30 

106‒216 g/m2 20 20 20 20 

217‒300 g/m2 10 10 10 10 

301‒350 g/m2 10 10 10 10 

* Stapling of 100 pages of 64‒80 g/m2 or 81–105 g/m2 paper is possible, but not guaranteed. 

BOOKLET CAPACITIES BY PAPER WEIGHT AND TYPE

PRODUCTION READY FINISHER BOOKLET CAPACITY, STAPLED 

PAPER WEIGHT 
PAPER TYPE AND SHEET CAPACITY 

UNCOATED COATED 

60–80 g/m2 30 — 

81–90 g/m2 30 25 

91–105 g/m2 20 20 

106–128 g/m2 15 15 

129–150 g/m2 10 10 

151–176 g/m2 10 10 

177–220 g/m2 5 5 

221–256 g/m2 4 4 

257–300 g/m2 3 3 

301–350 g/m2 3 3 
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PRODUCTION READY FINISHER BOOKLET CAPACITY, UNSTAPLED 

PAPER WEIGHT 
PAPER TYPE AND SHEET CAPACITY 

UNCOATED COATED 

52–330 g/m2 5 5 

221–256 g/m2 4 4 

257–350 g/m2 3 3 
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SquareFold® Trimmer Module Overview

Note: This optional finishing device requires a Production Ready Booklet Maker Finisher. 

The SquareFold® Trimmer is an optional finishing device that flattens the spine of a booklet and performs face trim 
of the booklet.

The SquareFold® Trimmer performs the following tasks:

• Receives the booklet from the Booklet Marker area of the Finisher.

• Flattens the booklet spine to reduce the booklet thickness and to provide the appearance of a perfect-bound 
book.

• Trims and cuts away the face, that is the edge, of the booklet, which results in a neatly finished edge.

The booklet area of the finisher assembles and staples the booklet. The booklet enters the SquareFold® Trimmer 
already assembled. Ensure that you set any adjustments to the original image and its placement on the booklet 
page at the printer server.
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SquareFold® Trimmer Components

NUMBER COMPONENT DESCRIPTION 

1 Left Cover * To remove paper jams, open the left cover. 

2 Right Cover * To remove paper jams, open the left cover.  

3 Circuit Breaker Button on the 
rear of the device 

If an electrical fault or a short circuit occurs, the circuit breaker 
powers off the electricity automatically. 

4 Booklet Tray The booklet tray receives the square-fold booklet output from the 
finisher. 

5 Square-fold Adjustment 
Button 

To adjust the thickness of printed booklets, press the square-fold 
adjustment button. 

6 Paper Jam or Error Indicator When a paper jam occurs, a paper jam or error indicator 
illuminates. 

7 Trimmer Waste Container The waste container collects waste from the trimmer area of the 
device. 

* When the printer is idle or in a normal operation mode, you cannot open the covers. When an indicator is 
illuminated and a jam or fault occurs within the SquareFold® Trimmer device, you can open the covers.  

SQUAREFOLD ®  TRIMMER CIRCUIT BREAKER
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The circuit breaker button is on the rear of the device. The circuit breaker button is usually in the On position.

Note: When an electrical interruption is detected, the circuit breaker powers off automatically to discontinue 
the electrical flow to the device. For electrical information, refer to Safety.

Under normal operating conditions, do not press the circuit breaker button. Before you move the printer, to power- 
off the device, press the circuit breaker button.

OUTPUT TRAYS

1. Finisher Output Tray: The printer ejects unused sheets of paper to the finisher output tray.

2. Booklet Tray: Saddle stitch, bi-fold and trim, or square-fold jobs are delivered only to this tray.

CONTROL PANEL

NUMBER DESCRIPTION 

1 Fault indicators: When a fault or jam occurs in a particular area of the SquareFold® Trimmer 
device, fault indicators illuminate. When the trimmer waste container is pulled out or when it is 
full, the lower indicator, with the lock icon illuminates. 

Note: If El, E2, or E3 illuminates on the control panel, you can open the left and right 
covers, then the jam or fault is cleared. During normal operation or when the printer is 
idle, you cannot open the covers.

2 Select the required square-fold setting. For more information, refer to the Square Fold Adjustment 
Settings. 
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SQUAREFOLD ®  TRIMMER PAPER PATH

NUMBER DESCRIPTION 

1 The booklet leaves the booklet area of the finisher, then enters the SquareFold® Trimmer 
device. The booklet exit sensor in the SquareFold® Trimmer device detects the leading 
edge spine of the booklet, then moves the booklet to the square-fold area. 

2 When the booklet spine reaches the square-fold area, the booklet is clamped, and the 
square-folding operation begins. 

3 The booklet is flattened and the spine is squared according to the square-fold setting 
indicated on the control panel. 

4 After the booklet is flattened and the spine is squared, the booklet is moved to the 
trimmer area. 
• Based on the finished booklet size, the booklet is moved until the trailing edge reaches 

the trimmer cutter. 
• The trailing edge is trimmed, based on the finished booklet size entered for the 

trimmer mode setting. 

5 The booklet is moved to the exit area where it is transported to the booklet tray. 

Note: Booklets that exit the SquareFold® Trimmer device contain trim remnants or scraps from the previously 
trimmed booklet. Trim remnant or scrap accumulation is due to normal static electricity build-up. If booklets 
contain trim remnants or scraps, remove and discard the remnants and scraps.
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Square Fold and Trim Features

SQUARE FOLD FEATURE

The Square Fold feature is available only when the printer is connected to both a finisher with a booklet maker and 
the SquareFold® Trimmer Module.

You can access and select the Square Fold feature from your computer print driver, the printer user interface, or 
from the print server.

Square Fold Adjustment Settings

The Square Fold feature can be enabled or disabled, based on the user preference. When the feature is enabled, 
select an option for the finished booklet job.

Note: Before you print large jobs, print one or more test prints.

NUMBER DESCRIPTION 

1 When your finished booklet is five or fewer pages and printed on paper that is lighter than 
100 g/m2, select -2 / Lower / Low 2. The least amount of pressure that can be applied to the 
booklet is -2. 

2 When you want the least amount of pressure applied to the spine of the booklet, select -1 / 
Low / Low 1. The less pressure applied to the booklet, the more rounded the booklet spine 
becomes. 

3 Auto / Normal is the default setting and is used for most jobs. 

4 When you want a greater amount of pressure applied to the spine of the booklet, but not as 
much pressure as the +2 setting, select +1 / High / High 1.  

5 When you want the maximum amount of pressure applied to the spine of the booklet, select 
+2 / Higher / High 2. The more pressure that is applied, the more square the booklet spine 
becomes. The greatest amount of pressure that can be applied to the booklet is +2. 

BBooookklleett EExxaammppllee

The following images show two different booklet types:
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1. This booklet is not square-folded. It has a rounded, thicker appearance to the spine.

2. This booklet is square-folded. The booklet spine is flattened and squared, giving a perfect-bound book 
appearance.

Improving the Book-Pressing Quality

If the spine is curled or torn, you can adjust the volume of the spine. Press the Square Fold setting button.

NUMBER DESCRIPTION 

1–5 • Each time that you press the button, the pressure changes. 
• When indicator 5 is illuminated, the maximum amount of pressure is applied. 
• When indicator 1 is illuminated, the minimum amount of pressure is applied. 

6 Square Fold setting 

TRIM FEATURE

Access the trim feature from your computer print driver, the printer user interface, or from the print server.

Trim Options

When you use the trim options, always consider the following:
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• When booklets exit the SquareFold® Trimmer device, they can contain trim remnants or scraps from the 
previously trimmed booklet. Static electricity causes this build-up and it is normal. If booklets contain trim 
remnants, remove and discard the remnants.

• The trim feature can be enabled or disabled. When the feature is enabled, you can adjust the trim setting in 0.1 
mm (0.0039 in.) increments, depending on your requirements for the finished booklet job.

The trim options include the following:

• Trimming On / Off: This option enables or disables the trimming feature. The default setting is Off.

• Cut to Size: This option decreases or increases the trimmer setting. To decrease or increase the trimmer setting, 
use the left and right arrow buttons. Adjustments are made in 0.1 mm (0.0039 in.) increments.

The trim setting is based on the following:

• The number of sheets in the finished booklet

• The width of the finished booklet

• The media type, coated or uncoated

• The media weight

Note:  

• To determine the best selections for your job, experiment with various settings. For the best booklet 
output, before running larger jobs, run one or more test prints.

• Trim settings cannot be adjusted to remove less than 2 mm (0.078 in.) or more than 20 mm (0.787 in.) 
of edge material from the booklet. Adjustments less than 2 mm (0.078 in.) can produce poor trim 
quality. Adjustments greater than 20 mm (0.787 in.) result in no trimming to the booklet edge.

Trim Guidelines

The following table shows various scenarios using different paper weights, media types, and trim setting selections. 
Use this table as a guideline when selecting a trim setting for your specific job.

Note: The settings shown in the following table are provided as examples and are not meant to represent 
every possible job scenario.

SCENARIO 
NUMBER 

PAPER SIZE 
FINISHED 
BOOKLET SIZE 

PAPER 
WEIGHT 

APPROXI
MATE TRIM 
SETTING 

NUMBER 
OF PAGES 
IN A 
FINISHED 
BOOKLET 

1 
A4: 210 x 298 mm 
(8.5 x 11 in.) 

149 x 210 mm (5.5 
x 8.5 in.) 

75 g/m2; 20 lbs. 130 mm (5.11 
in.) 20 

2 
A4: 210 x 298 mm 
(8.5 x 11 in.) 

149 x 210 mm (5.5 
x 8.5 in.) 

90 g/m2; 24 lbs. 125 mm (.98 
in.) 14 

3 
A4: 210 x 298 mm 
(8.5 x 11 in.) 

149 x 210 mm (5.5 
x 8.5 in.) 

120 g/m2; 32 
lbs. 

135 mm (5.31 
in.) 10 
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SCENARIO 
NUMBER 

PAPER SIZE 
FINISHED 
BOOKLET SIZE 

PAPER 
WEIGHT 

APPROXI-
MATE TRIM 
SETTING 

NUMBER 
OF PAGES 
IN A 
FINISHED 
BOOKLET 

4 
A4: 210 x 298 mm 
(8.5 x 11 in.) 

149 x 210 mm (5.5 
x 8.5 in.) 

75 g/m2; 20 lbs. 125 mm (.98 
in.) 10 

5 
A4: 210 x 298 mm 
(8.5 x 11 in.) 

149 x 210 mm (5.5 
x 8.5 in.) 

120 g/m2; 80 
lbs. 

135 mm (5.31 
in.) 12 

6 
B4: 250 x 353 mm 
(8.5 x 14 in.) 

250 x 176.5 mm 
(8.5 x 7 in.) 

75 g/m2; 20 lbs. 172 mm (6.77 
in.) 6 

7 
B4: 250 x 353 mm 
(8.5 x 14 in.) 

250 x 176.5 mm 
(8.5 x 7 in.) 

90 g/m2; 24 lbs. 170 mm (6.69 
in.) 6 

8 
A3: 297 x 420 mm (11 
x 17 in.) 

A4: 210 x 297 mm 
(8.5 x 11 in.) 

90 g/m2; 24 lbs. 200 mm (7.87 
in.) 14 

9 
A3: 297 x 420 mm (11 
x 17 in.) 

A4: 210 x 297 mm 
(8.5 x 11 in.) 

216 g/m2; 80 
lbs. 

205 mm (8.07 
in.) 5 

10 
A3: 297 x 420 mm (11 
x 17 in.) 

A4: 210 x 297 mm 
(8.5 x 11 in.) 

80 g/m2; 20 lbs. 210 mm (8.26 
in.) 22 

11 
A3: 297 x 420 mm (11 
x 17 in.) 

A4: 210 x 297 mm 
(8.5 x 11 in.) 

90 g/m2; 24 lbs. 210 mm (8.26 
in.) 8 

12 
A3: 297 x 420 mm (11 
x 17 in.) 

A4: 210 x 297 mm 
(8.5 x 11 in.) 

120 g/m2; 80 
lbs. 

205 mm (8.07 
in.) 10 

13 
305 x 458 mm (12 x 
18 in.) 

152 x 229 mm (6 x 
9 in.) 

120 g/m2; 80 
lbs. 

220 mm (8.66 
in.) 6 

14 
305 x 458 mm (12 x 
18 in.) 

152 x 229 mm (6 x 
9 in.) 

120 g/m2; 80 
lbs. 

215 mm (8.46 
in.) 5 

15 
305 x 458 mm (12 x 
18 in.) 

152 x 229 mm (6 x 
9 in.) 

120 g/m2; 80 
lbs. 

210 mm (8.26 
in.) 4 

16 
305 x 458 mm (12 x 
18 in.) 

152 x 229 mm (6 x 
9 in.) 

105 g/m2; 28 
lbs. 

220 mm (8.66 
in.) 16 

17 
305 x 458 mm (12 x 
18 in.) 

152 x 229 mm (6 x 
9 in.) 

120 g/m2; 80 
lbs. 

210 mm (8.26 
in.) 14 
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SquareFold® Trimmer Maintenance

EMPTYING THE SQUAREFOLD ®  TRIMMER WASTE CONTAINER

When the waste container reaches the full condition, an indicator illuminates on the top of the SquareFold® 

Trimmer device. A message appears on the printer control panel that indicates that the waste container is full. 
When the message appears, dispose of the paper scraps.

Note: Keep the printer powered on when disposing of the waste. If powered off, the printer does not 
recognize that the waste container was emptied.

To empty the trimmer waste container, perform the following steps:

1. Ensure that the printer is not printing, then slowly pull out the trimmer waste container. 
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2. Hold the belt on the waste container, then remove the container with both hands. 

3. Discard all paper waste and scraps. 

Note: Ensure that the waste container is emptied completely. If any paper waste or scraps remain, the 
container becomes full before a control panel message appears, causing the printer to malfunction.

4. Reinsert the empty waste container, then slowly push in the container until it stops. 
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SquareFold® Trimmer Troubleshooting

SQUAREFOLD ®  TRIMMER PAPER JAMS

The following occurs when there are faults such as paper jams, open doors or covers, or a printer malfunction:

• The printer stops printing and a fault message appears on the printer control panel.

• The message includes an illustration that shows the location of the fault and a brief explanation of corrective 
actions to clear the fault.

• Paper jams can occur in multiple areas of the printer and in any optional devices that are connected to the 
printer. When a paper jam occurs, the illustration on the printer control panel changes to show the multiple 
locations and the required corrective actions.

• If a fault occurs with an optional device, an indicator illuminates on the optional device control panel and shows 
the corresponding area on the device where the fault occurred.

Always refer to the following information when clearing paper jams:

• Do not power off the printer when removing paper jams.

• Paper jams can be removed with the printer still powered on. When you power off the printer, all information 
stored to the system memory is erased.

• Before resuming print jobs, clear all paper jams.

• To avoid possible print defects, do not touch components inside the printer.

• Before proceeding with print jobs, ensure that all paper jams, including any small, torn pieces of paper, are 
removed.

• Gently, remove the paper, taking care not to tear it. If paper is torn, ensure that you remove all the torn pieces.

• After you remove the paper jams, close all doors and covers. When doors or covers are open, the printer does 
not print.

• After you clear a paper jam, printing resumes automatically from the state before the paper jam occurred.

• If all paper jams are not cleared, an error message continues to appear on the printer control panel. To clear any 
remaining paper jams, refer to the printer control panel for instructions and information.
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Clearing Paper Jams from SquareFold® Trimmer Areas E1 and E2

Note: Before you perform this procedure, ensure that the printer is not printing.

1. To open the left cover of the trimmer device, press the button on the cover. 

2. Remove the jammed paper. 

3. If you have difficulty removing the jammed paper, open the front cover of the finisher. 
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4. Rotate knob 3b to the right, then remove the jammed paper. 

5. If necessary, close the front cover of the finisher.

6. Close the left cover of the trimmer device.

7. If the printer control panel message indicates that there are more paper jams, follow the instructions to clear 
the paper jams and to resume printing.

Clearing Paper Jams from SquareFold® Trimmer Area E3

Note: Before you perform this procedure, ensure that the printer is not printing.

1. To open the right cover of the trimmer device, press the button on the cover. 

2. Remove the jammed paper. 
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3. Close the right cover of the trimmer device.

4. If the printer control panel message indicates that there are more paper jams, follow the instructions to clear 
the paper and to resume printing.

SQUAREFOLD ®  TRIMMER FAULT MESSAGES

When faults occur such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, and 
a message appears on the printer control panel. An illustration on the printer control panel shows the location of 
the fault with a brief explanation of corrective actions to clear the fault. If a fault occurs in more than one location, 
the illustration changes to indicate the multiple locations and the required corrective actions.

The E code in the upper-left part of the Fault message displays which error indicator E1–E3 is illuminated on the 
SquareFold® Trimmer control panel.

SquareFold® Trimmer Fault Code Information

When faults occur, such as paper jams, open doors or covers, or a printer malfunction, the printer stops printing, and 
a message appears on the printer control panel.

The control panel displays a Faults button that provides information about the fault and detailed instructions for 
correcting the fault.

Tip: SquareFold® Trimmer faults are identified by the codes that start with the three-digit number 013.

GUIDELINES FOR USING THE SQUAREFOLD ®  TRIMMER DEVICE

Full-Page Images on Booklets

When you use full-page images, ensure that the finished booklet size accommodates any full-page images, and 
that when the booklet is trimmed, these images are not truncated.

The following images are examples of a booklet with pre-printed front and back covers, with a full-page image in 
different sizes:
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1. Booklet 1 is printed on B4, 250 x 353 mm (8.5 x 14 in.) paper: The front cover, which was trimmed, displays the 
entire image.

2. Booklet 2 is printed on A4, 210 x 297 mm (8.5 x 11 in.) paper: After trimming the front cover, the image is 
truncated.

Booklet Considerations

Before you print any booklet, consider the following:

• The image location on the original document is not centered. To ensure that the image fits on the finished 
booklet, do you need to shift the image?

• What is the needed size of the finished booklet?

• Does the booklet contain full-page images?

• Are you using pre-printed covers with full-page images?

• Are you trimming the booklet?

Considerations for Obtaining the Required Booklet Output

To ensure that you get your required output, follow these tips:

• Always run one or more test prints of your job before running a larger output quantity.

• Review your test prints for truncated images or text.

• If any images or texts need shifting, use the various selections from your print driver application. Refer to your 
print driver Help information.

Note: It takes one or more test prints before you achieve your required output.
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SquareFold® Trimmer Specifications

ITEM SPECIFICATIONS 

Paper size • Maximum: 330.2 x 488 mm (13 x 19.21 in.) 
• Minimum: 182 x 257 mm (7.16 x 10.11 in.) 

Trim size 2–20 mm (0.078–0.787 in.), adjustable in 0.1 mm (0.0039 in.) increments  
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